
Help document

OLYMPUS Cleanliness Inspector
CIX ASW 1.5

English



Any copyrights relating to this documentation shall belong to 
Olympus Soft Imaging Solutions GmbH. 

We at Olympus Soft Imaging Solutions GmbH have tried to make the information contained 
in this document as accurate and reliable as possible. Nevertheless, Olympus Soft Imaging 

Solutions GmbH disclaims any warranty of any kind, whether expressed or implied, as to any 
matter whatsoever relating to this document, including without limitation the merchantability 
or fitness for any particular purpose. Olympus Soft Imaging Solutions GmbH will from time to 

time revise the software described in this document, and reserves the right to make such 
changes without obligation to notify the purchaser. In no event shall Olympus Soft Imaging 

Solutions GmbH be liable for any indirect, special, incidental, or consequential damages 
arising out of purchase or use of this document or the information contained herein.

No part of this document may be reproduced or transmitted in any form or by any means, 
electronic or mechanical for any purpose, without the prior written permission of Olympus 

Soft Imaging Solutions GmbH.
All brands are Trademark or registered Trademark of their respective owners.

© Olympus Soft Imaging Solutions GmbH
All rights reserved

5UM_CIX-ASW-1.5_Zambesi_en_00_07052021
Olympus Soft Imaging Solutions GmbH, Johann-Krane-Weg 39, D-48149 Münster, Germany 

Tel. (+49)251/79800-0, fax (+49)251/79800-6060





Contents
1 Overview - OLYMPUS Cleanliness Inspector . . . . . . . . . . . . . 14

2 Safety instructions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

3 Software updates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

4 About this help document . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
4.1 Icons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
4.2 Writing conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
4.3 MS Windows conventions for selecting more than one object  . . . . . . . . . . . 18

5 Start page - OLYMPUS Cleanliness Inspector . . . . . . . . . . . .20
5.1 [System Information]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
5.2 First steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

6 [Inspect Sample] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30
6.1 [Inspect Sample] > [Mount Sample] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
6.1.1 Mounting the sample . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31
6.2 [Inspect Sample] > [Acquire overview image]. . . . . . . . . . . . . . . . . . . . . . . . . . 32
6.2.1 Acquiring the overview image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
6.3 [Inspect Sample] > [Select inspection configuration]  . . . . . . . . . . . . . . . . . . . 34
6.3.1 Selecting an inspection configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
6.4 [Inspect Sample] > [Edit Settings]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
6.4.1 Editing inspection settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
6.4.2 Exposure time and threshold for particles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
6.4.3 [Edit Exposure Time and Threshold for Particles] . . . . . . . . . . . . . . . . . . . . . . . . . . . .41
6.4.4 Threshold for reflecting particles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
6.4.5 [Edit threshold for reflecting particles]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
6.4.6 Inspection area and focus points  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
6.4.7 [Edit Inspection Area and Focus Points] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
6.5 [Inspect Sample] > [Acquiring focus points] . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
6.5.1 Acquiring focus points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .51
4OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
6.6 [Inspect Sample] > [Acquire Sample] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
6.6.1 Acquiring images of the sample  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
6.7 [Inspect Sample] > [Check Results]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
6.7.1 Checking the results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
6.8 [Inspect Sample] > [Review Sample] > [Particle View]  . . . . . . . . . . . . . . . . . . 56
6.8.1 [Review Sample] > [Particle View] tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
6.9 [Inspect Sample] > [Review Sample] > [Sample Image] . . . . . . . . . . . . . . . . . 62
6.9.1 [Review Sample] > [Sample Image] tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
6.10 [Inspect Sample] > [Review Sample] > [Live Observation] . . . . . . . . . . . . . . . 70
6.10.1 [Review Sample] > [Live Observation] tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
6.11 [Inspect Sample] > [Review Sample] > [Snapshot View] . . . . . . . . . . . . . . . . . 74
6.11.1 [Review Sample] > [Snapshot View] tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
6.12 Solution [CIX Height Measurement] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
6.12.1 Measuring the particle height automatically  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
6.12.2 Measuring the particle height manually . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
6.13 [Create Report]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

7 [Inspect Multiple Samples]  . . . . . . . . . . . . . . . . . . . . . . . . . . .84
7.1 [Inspect Multiple Samples] > [Mount Sample] . . . . . . . . . . . . . . . . . . . . . . . . . 84
7.1.1 Mount Sample  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
7.2 [Inspect Multiple Samples] > [Acquire overview image] . . . . . . . . . . . . . . . . . 88
7.2.1 Acquiring the overview image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
7.3 [Inspect Multiple Samples] > [Select Inspection Configuration]  . . . . . . . . . . 90
7.3.1 Selecting an inspection configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91
7.4 [Inspect Multiple Samples] > [Edit Settings] . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
7.4.1 Editing inspection settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
7.4.2 Exposure time and threshold for particles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
7.4.3 [Edit Exposure Time and Threshold for Particles] . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
7.4.4 Threshold for reflecting particles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
7.4.5 [Edit threshold for reflecting particles]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
7.4.6 Inspection area and focus points  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
7.4.7 [Edit Inspection Area and Focus Points] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
7.5 [Inspect Multiple Samples] > [Acquire Focus Points]. . . . . . . . . . . . . . . . . . . 110
5 OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
7.5.1 Acquiring focus points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
7.6 [Inspect Multiple Samples] > [Acquire Sample] . . . . . . . . . . . . . . . . . . . . . . . 112
7.6.1 Acquiring images of the sample  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
7.7 [Inspect Multiple Samples] > [Check Results] . . . . . . . . . . . . . . . . . . . . . . . . . 114
7.7.1 Checking the results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

8 [Review Results]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
8.1 [Review Results] > [Select Sample] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
8.1.1 Selecting a sample  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
8.2 [Review Results] > [Review Sample] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
8.3 [Review Results] > [Create Report] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

9 [Create Report]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
9.1 [Create Report] > [Select Sample]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
9.1.1 Selecting a sample  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
9.2 [Create Report]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
9.2.1 Creating a report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
9.3 Displaying and editing reports in Microsoft Word . . . . . . . . . . . . . . . . . . . . . 128
9.3.1 Saving a report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
9.3.2 Saving as a new report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
9.3.3 Olympus Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

10 [Manage Data]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
10.1 Managing Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
10.2 [Manage Data] > [Settings] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
10.2.1 Editing the settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
10.3 [Manage Data] > [Restore Samples] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

11 [Create Statistics]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
11.1 [Create Statistics] > [Select Samples] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141
11.2 [Create Statistics] > [Display Data] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
11.3 Displaying Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
6OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
12 [Inspection Configurations] . . . . . . . . . . . . . . . . . . . . . . . . . . 150
12.1 [Inspection Configurations] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
12.1.1 Editing an inspection configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
12.1.2 [Inspection Configurations] > [Open] (Page 1 of 2) . . . . . . . . . . . . . . . . . . . . . . . . .154
12.1.3 Editing inspection configurations > [Open] (Page 1 of 2) . . . . . . . . . . . . . . . . . . . . 155
12.1.4 [Inspection Configurations] > [Open] (Page 2 of 2)  . . . . . . . . . . . . . . . . . . . . . . . . 158
12.1.5 Editing inspection configurations > [Open] (Page 2 of 2) . . . . . . . . . . . . . . . . . . . . 159
12.2 [Inspection Configurations] > [Standards]. . . . . . . . . . . . . . . . . . . . . . . . . . . . 166
12.2.1 Editing standards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
12.2.2 [Inspection Configurations] > [Standards] > [Open] . . . . . . . . . . . . . . . . . . . . . . . . 170
12.2.3 Editing standards > [Open] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
12.3 [Inspection Configurations] > [Particle Families] . . . . . . . . . . . . . . . . . . . . . . 176
12.3.1 Editing particle families  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
12.4 [Inspection Configurations] > [Particle Families] > Open . . . . . . . . . . . . . . . 180
12.4.1 Editing particle families > Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
12.5 [Inspection Configurations] > [Particle Types] . . . . . . . . . . . . . . . . . . . . . . . . 184
12.5.1 Editing particle types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
12.6 [Inspection Configurations] > [Particle Types] > Open . . . . . . . . . . . . . . . . . 188
12.6.1 Editing particle types > Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

13 [Sample Information Fields]  . . . . . . . . . . . . . . . . . . . . . . . . . 190
13.1 Specifying sample information fields . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

14 [Report Templates] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
14.1 Editing report templates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
14.2 Editing a report template in Microsoft Word . . . . . . . . . . . . . . . . . . . . . . . . . 200
14.2.1 Inserting a general section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .201
14.2.2 Inserting a field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
14.2.3 Inserting a section with specific placeholders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
14.2.4 Deleting a section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
14.2.5 Saving a report template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
14.2.6 Olympus Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
7 OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
15 [User Rights]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .206
15.1 Managing users rights  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
15.1.1 Assigning or changing user roles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
15.1.2 Adding users or groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208

16 [Hardware] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210

17 [Calibration] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
17.1 Calibrating the system  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
17.2 Calibrating stage limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214
17.3 Calibrating the Camera-To-Stage Rotation . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
17.4 XY Objective Shift / Parfocality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218
17.5 Shading correction, white balance and exposure correction  . . . . . . . . . . . . 220
17.6 Rotation / Magnification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222
17.7 Manual Magnification Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224
17.8 Defining the overview area  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
17.9 Manual Z-Axis Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230

18 [Check System]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .232
18.1 [Check System] > [Mount Particle Standard Device] . . . . . . . . . . . . . . . . . . . 232
18.1.1 Mounting a particle standard device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
18.2 [Check System] > [Acquire Overview Image]  . . . . . . . . . . . . . . . . . . . . . . . . . 236
18.2.1 Acquiring the overview image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
18.3 [Check System] > [Edit Settings] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238
18.3.1 Editing inspection settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239
18.4 [Check System] > [Acquire Focus Points]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 242
18.4.1 Acquiring focus points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
18.5 [Check System] > [Acquire Sample] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .244
18.5.1 Acquiring the sample . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
18.6 [Check System] > [Check Results] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
18.6.1 Checking the results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
18.7 [Check System] > [Review Sample]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248
8OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
18.7.1 Reviewing the sample  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249

19 Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .252

1 Overview - Software mode [Analyze Materials] . . . . . . . . . . .4
1.1 Changing the software mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.2 Range of functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.3 Example images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
1.4 About this help document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2 User interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
2.1 Appearance of the user interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.2 Document group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.3 Overview - Tool windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
2.4 Overview - Toolbars  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
2.4.1 [CIX Standard] toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3 Working with documents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.1 Saving documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.2 Closing documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.3 Opening documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

4 Acquiring images  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20
4.1 [Camera Control] toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
4.2 [Acquisition Settings] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
4.2.1 [Acquisition Settings] > [Acquisition] > [General]  . . . . . . . . . . . . . . . . . . . . . . . . . . .21
4.2.2 [Acquisition Settings] > [Document Name] > [Snapshot] . . . . . . . . . . . . . . . . . . . . 23
4.2.3 [Acquisition Settings] > [Saving] > [Snapshot] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
4.3 Acquiring snapshots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5 Processing images. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28
5.1 Viewing images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
5.1.1 Enlarging or reducing the size of the image in the image window  . . . . . . . . . . . . 28
9 OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
5.1.2 Viewing information about an image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
5.1.3 Software options for the scale bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
5.1.4 Software options for the info stamp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
5.2 Drawing on images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
5.2.1 [Drawing] toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
5.2.2 Using the continuous drawing mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
5.2.3 Working with drawing objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
5.3 Using image processing functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
5.3.1 [Process Menu] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
5.3.2 Changing the image brightness  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

6 Measuring images interactively  . . . . . . . . . . . . . . . . . . . . . . .42
6.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
6.2 Performing interactive measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
6.2.1 Measuring image objects interactively  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
6.2.2 Outputting various measurement parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
6.2.3 Measuring several images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

7 [Materials Solutions] tool window . . . . . . . . . . . . . . . . . . . . .52
7.1 Structure of the tool window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
7.2 Starting an analysis process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
7.3 Selecting the image source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
7.4 Settings for the stage path. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
7.4.1 Selecting a stage path  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .61
7.4.2 Defining samples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
7.4.3 Defining scan areas and/or XY-positions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
7.4.4 Aligning a sample . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
7.4.5 Selecting an inspection mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
7.4.6 Selecting a focus mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
7.5 Entering the sample information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
7.6 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

8 [Grains Intercept]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
10OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
8.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
8.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
8.3 Performing an intercept analysis. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
8.3.1 Adding and deleting intercept points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
8.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

9 [Grains Planimetric]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92
9.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
9.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
9.2.1 [Sample type] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
9.2.2 [Second phase] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
9.2.3 [Grain boundaries] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
9.2.4 [Image results] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
9.3 Performing a planimetric measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
9.3.1 Adding and deleting grain boundaries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
9.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

10 [Layer Thickness] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
10.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
10.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
10.2.1 [Settings] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
10.2.2 [Edit borders] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
10.2.3 [Image results] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .125
10.3 Performing a layer thickness measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . 128
10.3.1 Performing an automatic layer thickness measurement . . . . . . . . . . . . . . . . . . . . . 128
10.3.2 Performing a layer thickness measurement with magic wand (closed layer) . . . . . 135
10.3.3 Performing a manual layer thickness measurement  . . . . . . . . . . . . . . . . . . . . . . . . 139
10.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

11 [Cast Iron]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
11.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
11.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
11.2.1 [Settings] step for unetched samples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .148
11 OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
11.2.2 [Settings] step for etched samples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
11.3 Performing a cast iron analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
11.3.1 Performing a cast iron analysis (unetched sample)  . . . . . . . . . . . . . . . . . . . . . . . . . 153
11.3.2 Performing a cast iron analysis (etched sample)  . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
11.3.3 Adding, separating and deleting particles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165
11.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170

12 [Inclusions Worst Field] & [Inclusion Content] . . . . . . . . . . 172
12.1 Overview - Inclusions Worst Field analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
12.2 Overview - Analysis of the Inclusion Content . . . . . . . . . . . . . . . . . . . . . . . . . 174
12.3 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
12.3.1 [Settings] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
12.3.2 [Image results] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
12.4 Performing an inclusions worst field analysis . . . . . . . . . . . . . . . . . . . . . . . . . 183
12.5 Performing an analysis of the inclusion content. . . . . . . . . . . . . . . . . . . . . . . 187
12.5.1 Editing inclusions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
12.6 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198

13 [Porosity]  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .202
13.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
13.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
13.2.1 [Settings] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
13.2.2 [Target values] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 209
13.2.3 [ROIs] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
13.2.4 [Threshold] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .214
13.2.5 [Image results] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .217
13.3 Performing a porosity measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220
13.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228

14 [Phase Analysis] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .232
14.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232
14.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
14.2.1 [ROIs] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
12OLYMPUS Cleanliness Inspector CIX ASW 1.5



Contents
14.2.2 [Threshold] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240
14.2.3 [Image results] step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244
14.3 Performing a phase analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
14.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254

15 [Coating Thickness]. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .256
15.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256
15.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
15.2.1 [Settings] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
15.2.2 [Measurement] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
15.3 Measuring the coating thickness. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
15.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

16 [Dendrite Arm Spacing] . . . . . . . . . . . . . . . . . . . . . . . . . . . . .274
16.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
16.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
16.2.1 [Settings] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
16.2.2 [Measurement] step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
16.3 Measuring dendrite arm spacing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281
16.4 Software options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288

17 Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .290
13 OLYMPUS Cleanliness Inspector CIX ASW 1.5



1  Overview - OLYMPUS Cleanliness Inspector
1 Overview - OLYMPUS Cleanliness Inspector
The OLYMPUS Cleanliness Inspector System is a complete system that 
performs fully automated optical cleanliness analyses. Optical 
cleanliness analysis is a method for determining the pollution degree of 
components. The cleanliness analysis quantifies and analyzes the 
particles in a sample. The system uses standardized methods of analysis 
to perform classifications in accordance with international standards.
The OLYMPUS Cleanliness Inspector is comprised of a microscope 
system, a computer, a monitor and this software. The OLYMPUS 
Cleanliness Inspector Software (CIX ASW) offers all of the functions that 
are required for a cleanliness analysis. 
Simple workflows take you step-by-step through the inspection, 
detection and classification of the particles. The results of the 
cleanliness analysis can be saved and output to a report.

Inspection Configurations
In the OLYMPUS Cleanliness Inspector Software, the guidelines by 
which the sample is inspected and particles are classified are specified 
in an inspection configuration. Several predefined inspection 
configurations that can be used to inspect a sample are available in the 
software. If necessary, you can customize an inspection configuration to 
your company's own standards or define a new inspection 
configuration.
Standards supported by the cleanliness analysis
The guidelines for the characterization of residue particles in a 
cleanliness analysis are specified by international standards. The 
OLYMPUS Cleanliness Inspector Software supports a number of these 
standards. The parameters of the standards are included in the 
software when you buy it and are stored in the inspection 
configurations. 

The OLYMPUS CIX100 Cleanliness Inspector System is not US FDA (United 
States Food & Drug Administration) 21 CFR Part 820 compliant. 
The OLYMPUS CIX100 Cleanliness Inspector System is capable of meeting 
US FDA 21 CFR Part 11 requirements that pertain to the device. 
However it is the responsibility of the customer to ensure full compliance with 
21 CFR Part 11 by incorporating the controls outside the scope of the 
OLYMPUS CIX100 Cleanliness Inspector System.
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1  Overview - OLYMPUS Cleanliness Inspector
[Analyze Materials] software mode
The [Analyze Materials] software mode is available when the [CIX 
Interactive Measurement Solution] software solution has been activated 
in your OLYMPUS Cleanliness Inspector Software. The [Analyze 
Materials] software mode provides a range of image acquisition 
functions and automatic image analysis functions. Additional software 
solutions that perform materials science analysis processes can be 
purchased for this software mode.
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2  Safety instructions
2 Safety instructions
The following safety instructions and icons warn you of dangers or give 
you useful tips.

Symbols on the hardware

This icon indicates useful notes, tips and important information about this 
product.

ATTENTION The exclamation mark and the word ATTENTION indicate situations where 
irreparable damage to the product can occur if ignored.

CAUTION Pinching hazard
When the stage moves, gaps appear.
This creates a pinching hazard.
Make sure that you are not within the stage’s range of movement when it is 
moving.
Try never to put your hands or fingers into any gaps.
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3  Software updates
3 Software updates
Please contact the local distributor from whom you acquired the 
product to inquire about software updates for the OLYMPUS 
Cleanliness Inspector Software (CIX ASW).
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4  About this help document
Icons
4 About this help document
This help document describes the OLYMPUS Cleanliness Inspector 
Software (CIX-ASW) which is a part of the OLYMPUS Cleanliness 
Inspector System. This help document provides context-sensitive help 
topics for the software functions. Context-sensitive means that the help 
document displays the help topic for the page from which it was called 
up.
You can open this help document by clicking the [Help] button. The 
[Help] button appears on every page in the software. You can also 
open the help document using the F1 key.
This help document is also available as a PDF file so that you can open 
the help document at any time independently of the software. You can 
find the PDF file in your software's installation directory or in the 
“Manuals” folder on the desktop of your Windows operating system.

4.1 Icons
 This icon is a cross reference to the glossary. You can find an 

explanation of the term it precedes in the glossary.

4.2 Writing conventions
A touchscreen monitor is supplied with the OLYMPUS Cleanliness 
Inspector System. You can either operate the OLYMPUS Cleanliness 
Inspector Software with a mouse or by tapping the touchscreen. For 
consistency, this help document describes operating the software with 
a mouse.

4.3 MS Windows conventions for selecting more than one object
Selecting single non-consecutive objects
Hold down the [Ctrl] key and click the required objects.
Selecting a series of objects
Hold down the [Shift] key and click on the first and last object that you 
want to select.
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MS Windows conventions for selecting more than one object
Selecting all objects
Use the [Ctrl + A] keyboard shortcut.
Selecting all objects and deselecting some
Hold down the [Shift] key and click on the first and last object that you 
want to select. Then hold down the [Ctrl] key and click the objects that 
you want to clear. 
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The OLYMPUS Cleanliness Inspector Software's functions are divided 
into the following areas: 

[Sample analysis] Sample analysis involves the inspection, detection and classification of 
samples. This is the central area in the software. You use it to perform a 
cleanliness analysis and to review the results.
Before you start the inspection by clicking the [Inspect Sample] button 
or the [Inspect Multiple Samples] button, the system has to be 
configured and calibrated using the pages accessed by the buttons in 
the [System configuration] area. You can open the results of saved 
inspections at any time with the [Review Results] button. You can then 
output the results of the inspection using the [Create Report] button.

[Data
management]

You manage the saved sample information and reports in the [Data 
management] area. Samples and reports can be deleted on these 
pages. The image data for a sample can also be compressed or 
archived to free up storage capacity. You can use the functions in the 
[Create Statistics] workflow to create charts and tables from the saved 
sample information to analyze statistically.

[Advanced
microscopy]

You can acquire additional software solutions to enhance the 
functionality of your OLYMPUS Cleanliness Inspector System. The 
[Advanced microscopy] area is available if you have installed the [CIX 
Interactive Measurement Solution] software solution or if you have 
purchased and installed other software solutions that perform materials 
science analysis processes. Which analysis processes and measurement 
functions are available in the [Analyze Materials] software mode 
depends on the software solutions that have been installed. You can 
find more information in the “Software mode [Analyze Materials]” 
section of this help document.

[System
configuration]

The OLYMPUS Cleanliness Inspector System is already configured and 
calibrated when it is delivered. This means that you only have to 
perform a few configuration steps and calibrations before you can start 
the cleanliness analysis. However, if you want to define your own 
standards and customize the software to your company's particular 
requirements, there are extensive configuration options available in the 
pages accessed by the buttons in the [System configuration] area. This 
includes the inspection configuration's configuration pages in which the 
most important parameters for the inspection of the sample are stored. 
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In addition, you have access to the calibration processes and hardware 
configurations as well as to the pages for creating report templates and 
sample information fields. Alternatively, the software administrator can 
manage the user rights and assign different access rights to the users. 
The system configuration area also contains the function for checking 
the system.

You can find a short introduction to working with the software on page 26 of 
the [First steps] chapter.

1 Clicking the [Inspect Sample] button starts the workflow that inspects the 
sample. This workflow requires an inspection configuration. Inspection 
configurations can be defined in the pages that are accessed by the 
[Inspection Configurations] button in the system configuration area. You can 
find more information on page 30 of the [Inspect Sample] chapter.
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2 Clicking the [Inspect Multiple Samples] button starts the workflow that 
inspects several samples. This workflow requires an inspection configuration. 
Inspection configurations can be defined in the pages that are accessed by 
the [Inspection Configurations] button in the system configuration area. You 
can find more information on page 84 of the [Inspect Multiple Samples] 
chapter.

3 Clicking the [Review Results] button opens an overview of all of the saved 
results of a sample inspection.
You can find more information on page 116 of the [Review Results] chapter.

4 Clicking the [Create Report] button opens the page where you can create 
reports. A report compiles the results of a sample inspection in a Word or a 
PDF file.
You can find more information on page 122 of the [Create Report] chapter.

5 Clicking the [Manage Data] button opens the page where you can manage 
data. The image data can be compressed, archived, and restored on this 
page.
You can find more information on page 130 of the [Manage Data] chapter.

6 Clicking the [Create Statistics] button opens the pages where you can create 
charts and tables that you can then analyze statistically.
You can find more information on page 140 of the [Create Statistics] chapter. 

7 Clicking the [Analyze Materials] button opens the [Analyze Materials] software 
mode. This software mode is available if the [CIX Interactive Measurement 
Solution] software solution or other purchased software solutions that 
perform materials science analysis processes are activated. You can find more 
information in the “Software mode [Analyze Materials]” section of this help 
document.

8 Clicking the [Inspection Configurations] button opens the pages where you 
can specify settings for the inspection configurations. This includes the 
[Inspection Configurations], [Standards], [Particle Families] and [Particle 
Types] pages. You can find more information on page 150 of the [Inspection 
Conf igurations] chapter.

9 Clicking the [Sample Information Fields] button opens the configuration page 
where you can specify fields to be inserted in the [Inspect Sample] workflow. 
Additional information about the sample can be entered in these fields. You 
can find more information on page 190 of the [Sample Information Fields] 
chapter.

10 Clicking the [Report Templates] button opens the page where you can edit 
report templates. You can find more information on page 194 of the [Report 
Templates] chapter.
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11 Clicking the [User Rights] button opens the page where you can define user 
rights. You can find more information on page 206 of the [User Rights] 
chapter. 

12 Clicking the [Hardware] button opens the dialog box where you can 
configure the hardware components. You can find more information on page 
210 of the [Hardware] chapter.

13 Clicking the [Calibration] button opens the dialog box that contains the 
calibration processes. You can find more information on page 212 of the 
[Calibration] chapter.

14 Clicking the [Check System] button starts the workflow that checks the system 
using a  particle standard device. In this workflow, rather than a sample, a 
particle standard device is scanned and the objects on it are detected. The 
system compares the results of this inspection with the known dimensions of 
the particle standard device. This enables you to check the system and the 
current calibrations. If discrepancies are found, a message suggesting 
optimization measures appears. You can find more information on page 232 
of the [Check System] chapter.

15 This area shows the name of the user and the active user role. If the active 
user has been given additional user roles, these can be selected from a list by 
clicking the small arrow. Changing the user role requires restarting the 
software. You can find more information on page 206 of the [User Rights] 
chapter.

16 Clicking the [System Information] > [About] button opens a dialog box that 
contains additional information about the system and the software. Clicking 
the [More System Information] button opens the [System Information] dialog 
box. 
Clicking the [System Information] > [Languages] button opens a list with all of 
the supported languages. To change the user interface's language, select the 
language you want. In the message that appears, confirm that you want to 
restart the software in the selected language. 
Clicking the [System Information] > [Deactivate License] button opens the 
software deactivation wizard.

16 Clicking the [Help] button opens the help document.

16 Clicking the [Exit] button closes the software.
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5.1 [System Information]
You can find additional information about the system and the software 
on the [System Information] page.

1 Clicking the [Save Customer Support Information As...] button opens MS-
Windows Explorer and saves all of the important system information in a file. 
This file is helpful when requesting support from customer service.
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[System Information]
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5.2 First steps
User Rights
If you are logged in as an administrator, you can manage user rights. 
User rights enable you to determine which software functions each user 
of the software can access. 
You can find more information about user rights in the [User Rights] 
chapter.
Calibrations
The OLYMPUS Cleanliness Inspector System has already been 
configured and calibrated. Only the [Stage Limits] calibration process 
needs to be performed regularly. If you start a sample inspection and 
all of the calibrations are not up to date, you are informed of the 
missing calibrations and can perform them straight away. All of the 
calibration processes can be accessed with the [Calibration] button on 
the start page. You can find more information about the calibration 
processes in the [Calibration] chapter.
Check System
Your software enables you to check the system and the calibrations 
with the help of a particle standard device in the [Check System] 
workflow before starting a sample inspection. It is recommended to 
always perform the [Check System] workflow when you have made 
changes to the hardware or to the calibrations. You can find more 
information about checking the system in the [Check System] chapter.
Hardware
Because the OLYMPUS Cleanliness Inspector System is already 
configured, you only need to make changes in these dialog boxes 
when you purchase additional hardware components.
Inspect Sample
You perform the inspection of the sample and then check the results in 
the [Inspect Sample] workflow. You select an inspection configuration 
and thereby specify the parameters to be used for the analysis of the 
sample in this workflow. You can find more information about 
inspecting the sample in the [Inspect Sample] chapter.
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Configurations
If your company has its own specifications, your software gives you 
access to the configuration options using the [Inspection 
Configurations] button. You can modify inspection configurations and 
standards or create new ones on these pages. You can find more 
information about the inspection configurations in the [Inspection 
Conf igurations] chapter. 
The [Sample Information Fields] chapter contains additional 
configuration options. You define fields in which you can save 
additional information about a sample in the [Inspect Sample] workflow 
on these pages. You can find more information about the sample 
information fields in the [Sample Information Fields] chapter.
Review Results
After a sample inspection finishes, its results are displayed. If you save 
the results, you can access them again at any time using the [Review 
Results] button.
You can find more information about reviewing results in the [Review 
Results] chapter.
Create Report
The results of a sample inspection can be output as a report in a Word 
document or a PDF document.
You can find more information about creating reports in the [Create 
Report] chapter.
Your software has different report templates that you can use to create 
a report. You can also adapt these template to suit your own purposes.
You can find more information about adapting report templates in the 
[Report Templates] chapter.
Manage Data
The results are saved after performing a sample inspection or creating 
a report. You can access this saved data with the [Manage Data] button 
and then compress, archive, or delete it.
You can find more information about managing data in the [Manage 
Data] chapter.
Create Statistics
With the functions in the [Create Statistics] workflow, you can create 
charts and tables from the results saved of the sample inspections. You 
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can use this information for statistical analyses. You can display and 
export the information into both charts and tables. You can create 
images of the charts to insert into presentations or reports. You can 
find more information about creating statistics in the [Create Statistics] 
chapter. 
Analyze Materials
The [Analyze Materials] software mode provides image acquisition 
functions and automatic image analysis functions. Additional software 
solutions that perform materials science analysis processes are available 
for this software mode to enhance the OLYMPUS Cleanliness Inspector 
System. Which analysis processes are available in this software mode 
depends on the software solution that has been installed. You can find 
more information in the “[Analyze Materials] software mode” section of 
this help document.
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6 [Inspect Sample]
The images of the sample are acquired and the sample is inspected in 
this workflow. The results are summarized after the inspection is 
finished.

6.1 [Inspect Sample] > [Mount Sample]

1 The size of the live-image can be enlarged or reduced in steps in the display 
area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. The 
mouse pointer turns into a hand when it's on the image. You can also change 
the display size with the mouse wheel when you're in this mode.

2 This icon displays the magnification of the current objective.

2 This icon displays the current exposure time.
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6.1.1 Mounting the sample
In this step, you place the sample in the multi-sample holder and then 
place the multi-sample holder on the stage and start the acquisition of 
an  overview image. The overview image gives you a first impression 
of the sample. You can use it to define the  inspection area.

Prerequisite  The system has been calibrated. If the calibrations aren’t all up to 
date, either a message appears telling you that calibrations are 
missing or a calibration process dialog box opens. Perform the 
required calibration. You can find more information about the 
calibration processes on page 212 of the [Calibration] chapter.

If the sample has already been mounted, you can start the acquisition 
of the overview image straight away by clicking the [Acquire Overview 
Image] button.
Mounting the sample and acquiring an overview image

1. Click the [Move Stage to Mounting Position] button.
 The stage moves to allow you to easily place the filter in the 

multi-sample holder.
2. Place the filter in the multi-sample holder.
3. Click the [Acquire Overview Image] button.
 The objective with the lowest magnification is set.
 Autofocus is activated.
 The optimum exposure time is automatically determined. 
 The acquisition of the overview image starts.
 The [Inspect Sample] > [Acquire overview image] page opens.

3 A blue square in the [Sample overview] group indicates the current position 
of the camera.

4 [Skip overview 
acquisition]

You can specify whether to acquire an overview image in the following step 
or whether to skip the acquisition of an overview image.
31 OLYMPUS Cleanliness Inspector CIX ASW 1.5



6  [Inspect Sample]
[Inspect Sample] > [Acquire overview image]

ID_20002
6.2 [Inspect Sample] > [Acquire overview image]

1 The size of the  overview image can be enlarged or reduced in steps in the 
display area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. 
The mouse pointer turns into a hand when it's on the image. You can also 
change the display size with the mouse wheel when you're in this mode.

1 Clicking the [Zoom to Fit] button adjusts the size of the overview image so 
that it fits perfectly in the display area.

2 This icon displays the magnification of the current objective.

2 This icon displays the current exposure time.

3 A blue square on the image in the [Sample overview] group shows the area 
of the sample that is currently being acquired.
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6.2.1 Acquiring the overview image
Prerequisite  This step won’t be displayed if you selected the [Skip overview 

acquisition] check box on the [Inspect Sample] > [Mount Sample] 
page.

In this step the software acquires the  overview image. The objective 
with the smallest magnification is automatically set. You can follow the 
acquisition of the overview image in the [Sample overview] group. The 
blue square shows the position on the sample that is currently being 
acquired. The images that are being acquired of the sample are 
assembled in the image in the display area. The progress bar estimates 
the duration of the acquisition of the overview image. 
After the overview image has been acquired, the [Inspect Sample] > 
[Select inspection configuration] page opens.
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6.3 [Inspect Sample] > [Select inspection configuration]

1 The size of the  overview image can be enlarged or reduced in steps in the 
display area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. 
The mouse pointer turns into a hand when it's on the image. You can also 
change the display size with the mouse wheel when you're in this mode.

1 Clicking the [Zoom to Fit] button adjusts the size of the overview image so 
that it fits perfectly in the display area. 

2 This icon displays the current objective.

2 This icon displays the current exposure time.

3 The [Available inspection configurations] list contains all of the  inspection 
configurations that are available in the software.
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6.3.1 Selecting an inspection configuration
In this step, you select the  inspection configuration that you want to 
use to inspect the sample.

1. Select the required inspection configuration in the [Available 
inspection configurations] list.
 A brief description of the selected inspection configuration and 

some of its parameters is displayed to the right of the [Available 
inspection configurations] list. You can find more information 
about inspection configurations on page 150 of the [Inspection 
Conf igurations] chapter.

2. Click the [Next] button. 
 The objective specified by the inspection configuration is 

automatically set. 
 The stage automatically moves to the center of the inspection 

area and activates the autofocus. The optimal exposure time and 
threshold are determined.

 The [Inspect Sample] > [Edit Settings] page opens.

4 This display field contains a description of the selected inspection 
configuration. A message in the display field alerts you when an objective has 
been defined in the inspection configuration but no system check has been 
successfully performed for it yet.
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6.4 [Inspect Sample] > [Edit Settings]

1 In the live-image in the display area, the automatically computed threshold is 
colored green. The display size of the live-image can be enlarged or reduced 
in steps. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. The 
mouse pointer turns into a hand when it's on the image. You can also change 
the display size with the mouse wheel when you're in this mode.

1 Clicking the [Autofocus] button focuses the image automatically. You may 
need to perform the autofocus several times to focus the image. The joystick 
can also be used for manual focusing.

2 The display size of the  overview image in the [Sample overview] group can 
be enlarged or reduced in steps. To do this, click the [Zoom Out] or [Zoom In] 
button repeatedly. Clicking a different position on the sample in the overview 
image changes the position of the sample in the display area.

3 [Inspection 
settings]

Depending on which inspection configuration has been selected, different 
entries will be editable in the  [Inspection settings] group. The appearance 
and the functions of the buttons can vary depending on which inspection 
configuration has been selected.
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6.4.1 Editing inspection settings
In this step, you can adjust some of the settings before the inspection of 
the sample.
In the fields in the [Sample information] group, you can enter additional 
information about the sample. This data is saved together with the 
results of the inspection. 

Editing the exposure time and thresholds for particles
Prerequisite  The exposure time and the  thresholds can only be edited if 

manual editing was specified in the inspection configuration. 
If manual editing is not allowed, the exposure time and the 
threshold are set automatically.

3 Clicking the button with a gear wheel opens a dialog box where you can 
change settings.

The inspection configuration has several different options for specifying how the threshold values and 
the exposure time are determined. You can find more information on page 158 of the [Inspection 
Conf igurations] > [Open] (Page 2 of 2) chapter.
3 Clicking the [One Time Auto Exposure] button automatically computes the 

exposure time. 
3 Clicking the [One Time Auto Threshold for Particles] button automatically 

computes the  threshold.
4 [Sample 

information]
The [Sample information] group contains all of the fields that were specified 
on the [Sample Information Fields] page. They appear in the order that they 
were specified. Some of the fields are mandatory and have to be filled in 
before the sample inspection can be performed. You can find more 
information on page 190 of the [Sample Information Fields] chapter.
The sample information that you enter can be saved so that it doesn’t have to 
be re-entered for other samples that have the same parameters. All of the 
sample information that has been saved can be accessed in the list in the 
[Preset] field.

An inspection configuration specifies which  inspection settings can be 
edited in the [Inspect Sample] workflow. Different settings options and buttons 
are available in the [Inspection settings] group depending on which inspection 
configuration has been selected.
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1. Click the [Edit Exposure Time and Threshold for Particles] button.
 The [Edit exposure time and threshold for particles] dialog box 

opens. 
 First set the exposure time and then set the threshold.
 You can find more information about this dialog box on page 40 

of the Exposure time and threshold for particles chapter.

Editing thresholds for reflecting particles
You can set an individual threshold for the reflective areas of a particle. 
The reflecting pixels inside a particle are detected and computed with 
the pixels of the particle's overall area. When the particle has more than 
a certain amount of reflecting areas, it is counted as a reflecting particle 
in the inspection results. 

1. Click the [Edit Threshold for Reflecting Particles] button.
 The [Edit threshold for reflecting particles] dialog box opens. 
 You can find more information about this dialog box on page 44 

of the Threshold for reflecting particles chapter.

Editing the inspection area and focus points
Prerequisite  The focus points can only be edited if manual editing of focus 

points was specified in the inspection configuration. 
If editing the focus points manually is not allowed, the focus 
settings specified in the inspection configuration are used. 

1. Click the [Edit Inspection Area and Focus Points] button.
 The [Inspection Area and Focus Points] dialog box opens. 
 You can find more information about this dialog box on page 46 

of the Inspection area and focus points chapter.

Entering sample information
The fields displayed in the [Sample information] group are either 
specified by the inspection configuration or were activated on the 
[Sample Information Fields] page. You can enter additional information 
about the samples in these fields. This information will be saved 
together with the results of the inspection. This information can be 
output to a report.
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You can save the parameters in a preset if you want to re-use the 
sample information that you entered for other samples as well. Enter a 
name in the [Preset] field and click the [Save Selected Preset] button.
Click the [Delete Selected Preset] button if you want to delete the 
sample information that is currently selected in the [Preset] list.
When a field has a yellow frame around it and a warning icon, it means 
that this is a mandatory field that must be filled in. It can also mean that 
the value that has been entered is invalid. The inspection can't be 
started as long as any of the fields has a yellow frame around it. You 
can find more information about the [Sample Information Fields] page 
on page 190 of the [Sample Information Fields] chapter.
Performing the inspection

1. Click the [Run Inspection] button.
 The [Inspect Sample] > [Acquire Focus Points] page opens. 
 You can find more information about this page on page 50 of 

the [Inspect Sample] > [Acquiring focus points] chapter.
 If you haven't defined a focus map for focusing the sample, the 

[Acquire Focus Points] page is skipped and the acquisition of the 
sample starts straight away. 
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6.4.2 Exposure time and threshold for particles

1 The display area shows the live-image of the current sample position. 
Changes to the exposure time can be seen in the live-image straight away. 
When the [Toggle Preview] button next to the [Threshold for particles] slide 
control is activated, the particles defined by the  threshold are shown in 
color in the image.

2 The current position on the sample is shown by a small square in the overview 
image in the [Sample overview] group. Clicking a different position on the 
sample in the overview image changes the position of the sample in the 
display area.

3 The dialog box contains the slide control and the button that set the exposure 
time and the threshold.
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6.4.3 [Edit Exposure Time and Threshold for Particles]

You specify the exposure time and the  thresholds for the particles in 
the [Edit exposure time and threshold for particles] dialog box. These 
settings are used for the inspection of the sample. First set the exposure 
time and then set the threshold. 
The inspection configuration has several different options for specifying 
how the threshold values and the exposure time are determined. You 
can find more information on page 158 of the [Inspection Conf igurations] 
> [Open] (Page 2 of 2) chapter.
Specifying the exposure time

1. There are several different ways of setting the exposure time:
 Use the slide control.
 Click the [-] or [+] buttons to adjust the exposure time in small 

steps.
 Enter an exposure time in the field, then press the [Enter] key.
 Alternatively, you can have the exposure time automatically 

computed. To do this, click the [One Time Auto Exposure] 
button.

2. Close the dialog box with [OK]. 
 This exposure time will be used for all high resolution images 

that are acquired during the sample inspection.
Specifying the threshold for particles
Make sure to set the thresholds carefully because they have a 
considerable influence on the results of the sample inspection.

1. Select a position on the sample that contains typical particles. 
2. Switch on the threshold value preview. To do so, click the [Toggle 

Preview] button. The intensity range defined by the thresholds is 
colored green.
This allows you to view the results in the image straight away and 
to readjust the settings if required.

3. There are several different ways of setting the threshold for 
particles:

It may be possible to manually set only the exposure time or only the 
threshold, depending on the settings in the inspection configuration.
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 Use the slide control.
 Click the [-] or [+] buttons to adjust the threshold in small steps.
 Enter a threshold in the field, then press the [Enter] key.
 Alternatively, you can have the threshold automatically 

computed. To do this, click the [One Time Auto Threshold for 
Particles] button.

4. Set the threshold so that only particles are detected and colored 
green. 

5. Check the thresholds on other positions on the sample.
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6.4.4 Threshold for reflecting particles

1 The display area shows the live-image of the current sample position. When 
the [Toggle Preview] button is activated, the changes to the threshold can be 
seen in the live-image straight away. 

2 The current position on the sample is shown by a small square in the overview 
image in the [Sample overview] group. Clicking a different position on the 
sample in the overview image changes the position of the sample in the 
display area.

3 The dialog box contains the slide control and the buttons that set the 
threshold.
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6.4.5 [Edit threshold for reflecting particles]
You specify the  threshold for reflecting areas of a particle in the [Edit 
threshold for reflecting particles] dialog box.
Make sure to set the thresholds carefully because they have a 
considerable influence on the results of the sample inspection.

1. Select a position on the sample that contains reflecting particles. 
The reflecting areas are colored magenta.

2. Switch on the threshold value preview. To do so, click the [Toggle 
Preview] button. This allows you to view the results in the image 
straight away and to readjust the settings if required.

3. Set the threshold so that the reflecting areas of a particle are 
detected and then colored magenta. 
There are several different ways of setting the threshold for 
reflecting particles:
 Use the slide control.
 Click the [-] or [+] buttons to adjust the threshold in small steps.
 Enter a threshold in the field, then press the [Enter] key.
 Alternatively, you can have the threshold for reflecting particles 

automatically computed. To do this, click the [One Time Auto 
Threshold for Reflecting Particles] button.

4. Check the thresholds on other positions on the sample.
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6.4.6 Inspection area and focus points

1 The display area shows the live-image of the current sample position.
2 If the [Edit Inspection Area] edit mode is active, a circle that shows the  

inspection area is displayed on the overview image.
If the [Edit Focus Points] edit mode is active, the focus points are shown on 
the overview image. 

3 Clicking the [Edit Inspection Area] button activates the edit mode for the 
inspection area. The inspection area is identified with a circle in the overview 
image. The size of the circle can be changed.

3 [Inspection area] The diameter and the area of the inspection area, and the total number of 
images that will be acquired during the sample inspection are displayed in the 
[Inspection area] group.

3 Clicking the [Maximize Inspection Area] button enlarges the inspection area 
to its maximum possible size. The software defines a maximum diameter for 
the inspection area of 42.5 mm.
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6.4.7 [Edit Inspection Area and Focus Points]

You can check and, if necessary, change the  inspection area and the 
focus points in the [Edit Inspection Area and Focus Points] dialog box.
Editing the inspection area

1. First select the edit mode. Click the [Edit Inspection Area] button.
2. The overview image displays a circle that defines the inspection 

area. Click on the circle. 
 A handle appears on the perimeter of the circle. 

3. Change the size of the circle. Move the mouse pointer onto the 
handle. Drag the selection marker in the direction you want. 

4. Change the position of the circle. Move the mouse pointer onto 
the circle. The mouse pointer turns into a four-headed arrow. Drag 
the circle to the required position.

5. If you want to save the size of the inspection area as a default for 
all subsequent inspections, click the [Save Inspection Area as 
Default] button.
 The inspection area that you specify is used for subsequent 

inspections of the sample until you specify a new inspection 
area.

3 Clicking the [Save Inspection Area as Default] button saves the current size of 
the inspection area and applies it to all subsequent inspections.

3
 

Clicking the [Edit Focus Points] button activates the edit mode for focus 
points. The focus points are shown in the overview image. They can be 
moved within the inspection area.

3 [Focus points] The total number of focus points is displayed in the [Focus points] group. 
3 [Focus mode] This option specifies the focus mode that will be used to focus the sample. 

You can select between a  focus map, the current Z-position, or focusing 
on every frame.

The functions for editing focus points are only displayed if the editing of focus 
points is allowed by the inspection configuration.
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Maximizing the inspection area
1. Click the [Maximize Inspection Area] button.
 The inspection area enlarges to its maximum possible size.

Editing focus points

1. Click the [Edit Focus Points] button.
 All of the focus points are displayed in the overview image. 
 The [Count] field displays how many focus points are specified 

by the currently selected option.
2. Select a focus method in the [Focus points] group.
 The [Use current Z-position] option uses the Z-position for the 

acquisition of the images that is set at the point in time when 
you start the sample inspection. You start the sample inspection 
by clicking the [Run Inspection] button. The Z-position isn't 
changed during the acquisition of the images. 

 With the [Focus on every frame] option, the sample inspection 
focuses before acquiring every frame. With this option, the 
inspection of the sample can take a very long time.

 The [Focus map] option enables you to acquire well-focused 
images of the whole sample when the surface of the sample is 
uneven.

3. If you have selected the [Focus map] option: The entries in the list 
determine how densely the focus points are arranged on the focus 
map. Select the density of the focus points according to the 
properties of your sample. If you select a high density, a lot of 
positions will be used for the acquisition of the focus map. The 
focus map then becomes more exact, but its acquisition takes 
longer. The following entries are available:
 3 points
 Low density
 Medium density
 High density

Place the focus points on areas of the sample that have clear structures and 
that contain as many particles as possible.
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Focusing on focus points
You can also focus on focus points in a focus map manually.

1. Select the [Manual Focus] check box.
 The first focus point is shown in green in the overview image.

2. Bring the sample into focus.
3. Click the [Validate Focus Point] button to confirm a focus point that 

has been manually focused.
 The stage moves to the next focus point.

4. Focus on each of the focus map’s focus points and validate them.
 If you are focusing on the focus points manually, the software 

skips the [Acquiring focus points] automated step.

Moving focus points
1. The position of the focus points can be changed. To do this, click 

on a focus point in the overview image.
 The stage moves to this focus point. 
 The current focus point is shown in the live-image in the display 

area.
2. Drag the focus point to the new position.

Adding or deleting focus points
As soon as you add or delete a focus point from a focus map, the [User 
defined density] entry appears in the [Focus map] list.
• Click the [Add Focus Point] button to create a new focus point. Move 

the focus point to the required position.
• Click the [Delete Focus Point] button to delete the selected focus 

point.
• Click the [Validate Focus Point] button to confirm a focus point that 

has been manually focused.
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6.5 [Inspect Sample] > [Acquiring focus points]

1 The overview image in the [Sample overview] group displays the distribution 
of the focus points on the sample. 

2 The information in the [Focus points] group is constantly refreshed. 
The following information is shown: 
[Total number]: The total number of focus points.
[Processed]: The number of focus points that have already been processed.
[Without focus]: The number of focus points for which the focus position 
could not be found.
[Warning limit]: The maximum number of focus points that could not be 
focused. A warning appears when the limit is exceeded.
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6.5.1 Acquiring focus points

The focus points for the  focus map are acquired in this step. After 
the focus points have been acquired, the [Inspect Sample] > [Acquire 
Sample] page opens.
Focus points warning limit
If a warning appears advising you that the maximum number of 
positions where focus can't be found has been exceeded, you can 
nevertheless continue the inspection. However, the acquisitions of the 
sample may not be sufficiently focused.
When the focus points warning limit has been reached you have the 
following options: 
• Answer the question [Do you want to cancel the focus points 

acquisition and return to page 'Edit Settings'?] with [No]. Continue 
with the acquisition. Afterwards check the sample to see whether it is 
sufficiently focused. 
If the acquisitions are out of focus, change the position of the focus 
points in the [Edit Inspection Area and Focus Points] dialog box on 
the [Inspect Sample] > [Edit Settings] page. Then continue with the 
inspection.

Or: • Answer the question [Do you want to cancel the focus points 
acquisition and return to page 'Edit Settings'?] with [Yes]. The [Inspect 
Sample] > [Edit Settings] page opens. Click the [Edit Inspection Area 
and Focus Points] button. In the [Edit Inspection Area and Focus 
Points] dialog box, change the position of the focus points. 
In [Inspection Configurations] > [Open] (page 2 of 2), you can 
increase the focus points warning limit if the sample can be 
sufficiently focused with fewer focus points.

You can find more information about editing focus points in the [Edit 
Inspection Area and Focus Points] chapter on page 47.

The [Inspect Sample] > [Acquire Focus Points] page is only displayed if you 
defined a focus map and the focus points weren’t defined manually.
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ID_20009
6.6 [Inspect Sample] > [Acquire Sample]

1 The display area shows the live-image of the current sample position.
2 The  overview image in the [Sample overview] group is overwritten with the 

high resolution images. The individual images are assembled into one single 
image.

3 The [Sample information] group contains information about the sample, for 
example the standard used for the sample inspection and the measurement 
parameters used to classify the particles. The [Count result] field displays what 
the result refers to. 

4 The [Sample results] group displays the number of particles for each  
particle class. The [Overall approval] field displays the overall result of the 
sample inspection. The results are constantly refreshed during the acquisition 
of the sample. 
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6.6.1 Acquiring images of the sample
The images of the sample are acquired and the number of particles is 
determined in this step. 
The [Sample information] group shows some of the criteria by which 
the particle is being classified. This information is specified in the 
inspection configuration. 
The results in the [Sample results] group are constantly refreshed 
during the acquisition of the images. The bars next to the particle 
classes show how many particles have been found in that  particle 
class. If you defined a maximum permitted value, this value is shown 
with a colored mark on the bar. This allows you to see whether the 
permitted number of particles in a particle class has been exceeded 
before the inspection is finished. If the permitted number of particles in 
a particle class is exceeded, the particle class, and therefore also the 
overall result, is classed as [NOK].
You can click the [Stop] button to abort the acquisition of the sample at 
any time. This can be useful if during the acquisition it becomes clear 
that the overall approval is classed as [NOK]. Select whether you want 
to discard the interim results or to examine them or save them for your 
records. If you select to save the interim results, the workflow continues 
without acquiring additional images. You can check the interim results 
on the pages that follow.
After the images have been acquired, the [Inspect Sample] > [Check 
Results] page opens.
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6.7 [Inspect Sample] > [Check Results]

1 Clicking the [Particle Overlay] button shows or hides the class color of the 
particles. 

2 The results are sorted into  particle classes in the table.
3 The [Sample information] group contains information about the sample, for 

example the standard used for the sample inspection and the measurement 
parameters used to classify the particles. 

4 Clicking the [Review Results] button opens the next page, the [Inspect 
Sample] > [Review Sample] page. This page displays the results in detail.

5 The overall results of the inspection are displayed in the [Sample results] 
group. 
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6.7.1 Checking the results
This page gives you an overview of the results of the cleanliness 
analysis. The particles that were detected are sorted into  particle 
classes in the table. Each particle class is assigned a different color. The 
particles in the overview image and in the live-image are colored 
according to their particle class. This gives you a visual impression of 
the number and size of the particles in a particular particle class. 
The [Inspect Sample] > [Review Sample] page displays the results in 
detail. Clicking the [Review Results] button on the navigation bar opens 
the [Inspect Sample] > [Review Sample] page.
Click the [Create Report] button in the navigation bar to create a report. 
The [Create Report] page opens.
You can find more information on page 126 of the [Create Report] 
chapter.
55 OLYMPUS Cleanliness Inspector CIX ASW 1.5



6  [Inspect Sample]
[Inspect Sample] > [Review Sample] > [Particle View]

ID_30002
6.8 [Inspect Sample] > [Review Sample] > [Particle View]
This page contains the results of the sample inspection. The display 
area contains different tabs for viewing and checking the results.

1 [Particle View] tab The [Particle View] tab's display area shows a thumbnail of every particle that 
was detected. Clicking a thumbnail selects the row with that particle's 
parameters in the [Classification Table] table and in the [Particle Table] table.
Double clicking a thumbnail opens the image in the display area of the 
[Sample Image] tab. 

1 [Sample Image] 
tab

You can find more information on page 62 of the [Inspect Sample] > [Review 
Sample] > [Sample Image] chapter.

1 [Live Observation] 
tab

You can find more information on page 70 of the [Inspect Sample] > [Review 
Sample] > [Live Observation] chapter.

1 [Snapshot View] 
tab

You can find more information on page 74 of the [Inspect Sample] > [Review 
Sample] > [Snapshot View] chapter.
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2 Clicking the [Acquire EFI Snapshots] button starts the  EFI acquisition for the 
selected particles. 
The button is only available immediately after the sample inspection, as long 
as the sample is still under the objective and a live-image is possible. 

If the [CIX Height Measurement] solution and its associated hardware are installed, the function for 
measuring the particle height is available. Depending on how your system is configured, you may 
have a button for automatically measuring the particle height next to the button for manually 
measuring the particle height. The buttons are only displayed immediately after the sample has been 
inspected in the [Inspect Sample] > [Review Sample] workflow. You can find step-by-step instructions 
for this function on page 80 of the Solution [CIX Height Measurement] chapter.
2 Clicking the [Measure Particle Height] button starts the automatic 

measurement of the particle height.

2 Clicking the [Measure Particle Height Manually] button opens the dialog box 
for manually measuring the particle height.

2 Clicking the [Delete particles] button deletes the selected particle.

2 A particle's  particle family can be changed. Clicking the [Change particle 
families] button opens a list of the available particle families. The button 
becomes active as soon as a particle is selected. The particle type is automati-
cally determined according to the combination of the particle families.

2 Clicking the [Undo] button undoes the last action.
Clicking the [Redo] button redoes the last action that was undone.

3 [Particle location] Different groups are displayed in this display area depending on which tab is 
selected:
When the [Particle View] tab is selected, the [Particle location] group is 
displayed. Clicking a thumbnail in the [Particle View] tab moves the navigation 
tool to the corresponding position on the sample in the overview image.

4 [Sample 
information]

The [Sample information] group contains information about the sample. The 
standard that is currently being used is selected in the [Standard] list. 
Additional standards with which the particles that were detected can be 
analyzed are available in the list. The [Particle type] list contains the particle 
types that were defined in the inspection configuration and that can be 
detected by the inspection. If you select a particle type in the [Particle type] 
list, only particles of that type are displayed in the results tables.
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6.8.1 [Review Sample] > [Particle View] tab
Various tools that you can use to edit the particles are available in the 
toolbar above the display area in the [Particle View] tab. You also have 
the option of analyzing the sample again with a different standard.

Prerequisite  The buttons for editing particles are active when at least one 
particle has been selected. 

Acquiring an EFI image
Prerequisite  The button for the EFI acquisition is only available immediately after 

the sample inspection, as long as the sample is still under the 
objective and a live-image is possible. 

You can acquire an  EFI image of one or more particles 
simultaneously.

1. Select one or more particles in the [Particle View] tab or in the 
particle table. 

2. If you have configured a  real color slider and you want to 
display the particles in their actual colors in the EFI image: On the 
[Live Observation] tab, click the [Real Color Mode] button. Insert 
the real color slider into your microscope. Go back to the [Particle 
View] tab. 

3. Click the [Acquire EFI snapshots] button.
 The EFI acquisition begins. 
 The snapshots are automatically combined into an EFI image.

5 [Sample results] The overall results of the inspection are displayed in the [Sample results] 
group.

6 [Classification 
Table] 

The results of the particle classification are displayed in the [Classification 
Table] table.

6 [Particle Table] Every particle that was detected is listed together with its measured 
parameters in the [Particle Table] list. If there is a link to a snapshot, the name 
of the snapshot is shown in the [Snapshot] column.

6 Click the [Export to Excel] button to export the classification table or the 
particle table into an MS-Excel file.
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 After the acquisition has been completed the EFI image will be 
displayed in the [Snapshot Gallery] group.

 The EFI image is linked to the particle that was selected in the 
[Particle View] tab.

 The link to a particle is indicated by a link icon.
 If a report template contains the [Insert Largest Particle Images 

Section] placeholder, the largest particles that were detected by 
the inspection will be inserted into the report. If one of these 
largest particles is linked to an EFI image, the EFI image will be 
used in the report. You can find more information on page 203 
of the Inserting a section with specific placeholders chapter. 

Measuring Particle Height
You can find more information about this function on page 80 of the 
Solution [CIX Height Measurement] chapter.

Deleting Particles
1. Select one or more particles in the display area.
 You can select more than one particle using the MS Windows 

conventions for selecting several objects simultaneously.
2. Click the [Delete Particles] button.
 The particle is deleted from the display area and from the results 

in the classification table and the particle table.
 The results are re-computed.

Changing the particle family
A particle type is defined by at least one particle family, or by the 
combination of several particle families. When you change a particle's 
particle family, the particle is automatically assigned to a different 
particle type.
Example: A particle has been assigned to the [Reflecting Fiber] particle 
type. You now want to assign it to the [Fiber] particle type. 

1. Select the particle in the display area or in the particle table.
2. Click the [Change Particle Families] button.
 The available particle families are displayed.
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 Because the [Reflecting Fiber] particle type is defined by the 
[Fiber] and [Reflecting] particle families, the [Fiber] and 
[Reflecting] check boxes are selected.

3. Change the particle family. Select or clear the appropriate check 
box. In this example, clear the [Reflecting] check box. The [Fiber] 
check box remains selected.

4. Click the [OK] button.
 The particle is assigned to the [Fiber] particle type. 
 The results are re-computed.

[Sample information]
You can analyze the sample again with a different standard by selecting 
the required standard in the [Standard] list. The [Classification Table] 
and [Particle Table] results tables are updated accordingly. The 
thumbnails in the [Particle View] tab are refreshed.
[Sample results]
The overall results of the inspection are displayed in the [Sample 
results] group. Which values are shown depends on the inspection 
configuration and the standard that it uses.
The [Approval reference] field displays which reference the overall 
result relates to. For example, the [Contamination class] approval 
reference means that the overall result of the inspection relates to the 
 contamination class and its maximum permitted value. 
The [Overall approval] field displays the overall result of the inspection. 
The overall result is either [OK] or [NOK].
The [Code] field is only displayed if the standard being used requires a 
result code.
[Classification Table]
The results are displayed by particle class in the classification table. Each 
row displays a particle class and the number of particles it contains. The 
columns that the table contains vary depending on the standard being 
used. The [Contamination Class] column is displayed if the standard 
requires classification by contamination. If a maximum permitted value 
was specified then the [Maximum] column contains the maximum 
permitted value. If this value is exceeded by the contamination class or 
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the number of particles, the result is classed as [NOK] in the [Approval] 
column.
[Particle Table]
Every particle that was detected is listed together with its measured 
parameters in the particle table. You can filter the particle table by  
particle type using the [Particle type] list in the [Sample information] 
group.
Exporting the table
Use the [Export to Excel] button to export the data in the classification 
table or in the particle table into an MS-Excel sheet.
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ID_30003
6.9 [Inspect Sample] > [Review Sample] > [Sample Image]

1 [Sample Image] 
tab

The image in the [Sample Image] tab's display area shows the position on the 
sample that has been selected by the navigation tool in the overview image in 
the [Sample navigation] group. Clicking a particle in the [Particle Table] table 
moves the navigation tool to the corresponding position in the overview 
image.

1 The size of the image can be enlarged or reduced in steps in the display area. 
To do this, click the [Zoom Out] or [Zoom In] button repeatedly.

1 Clicking the [Zoom to Fit] button adjusts the size of the composite image of 
the sample so that it fits perfectly in the display area.

1 Clicking the [Snapshot] button acquires a snapshot of the segment of the 
sample that is currently shown in the display area. Snapshots are saved to the 
[Snapshot View] tab and can be managed there. Snapshots can be measured 
and then output to a report together with their measurement values. You can 
find more information on page 74 of the [Inspect Sample] > [Review Sample] 
> [Snapshot View] chapter.
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1 Clicking the [Particle Overlay] button shows or hides the class color of the 
particles.

If the [CIX Height Measurement] solution and its associated hardware are installed, the function for 
measuring the particle height is available. Depending on how your system is configured, you may 
have a button for automatically measuring the particle height next to the button for manually 
measuring the particle height. The buttons are only displayed immediately after the sample has been 
inspected in the [Inspect Sample] > [Review Sample] workflow. You can find step-by-step instructions 
for this function on page 80 of the Solution [CIX Height Measurement] chapter.
1 Clicking the [Measure Particle Height] button starts the automatic 

measurement of the particle height.

1 Clicking the [Measure Particle Height Manually] button opens the dialog box 
for manually measuring the particle height.

1 Clicking the [Delete particles] button deletes the selected particle in the 
thumbnail view and in the [Particle Table] table. The button becomes active as 
soon as a particle is selected.

1 Clicking the [Split particle] button activates the function with which merged 
particles can be separated. The button becomes active as soon as a particle is 
selected.

1 Clicking the [Merge particles] button activates the function with which 
particles can be merged.

1 Clicking the [Create Particle] button activates the drawing function with which 
a particle can be created.

1 A particle's  particle family can be changed. Clicking the [Change particle 
families] button opens a list of the available particle families. The button 
becomes active as soon as a particle is selected. The particle type is automati-
cally determined according to the combination of the particle families.

1 Clicking the [Undo] button undoes the last action.
Clicking the [Redo] button redoes the last action that was undone.

2 [Sample 
navigation]

Clicking a position on the overview image in the [Sample navigation] group 
moves the navigation tool to the corresponding position on the sample. The 
image in the display area also shows this position on the sample.
63 OLYMPUS Cleanliness Inspector CIX ASW 1.5



6  [Inspect Sample]
[Inspect Sample] > [Review Sample] > [Sample Image]
6.9.1 [Review Sample] > [Sample Image] tab
Various buttons that you can use to edit the particles are available in 
the [Sample Image] tab. You can create, merge, split or delete particles 
for example. You can also acquire an image of a particular particle, if 
you want to output the image to a report for example.
Acquiring a snapshot

1. From the thumbnails in the [Particle View] tab or the particle table, 
select a particle that you want to acquire an image of. 

2. Double click the thumbnail.
 The particle is shown in the display area of the [Sample Image] 

tab.
3. Adjust the way the image is displayed. 
 Use the [Zoom In] and [Zoom Out] buttons to show the required 

segment of the image in the display area.
4. Click the [Snapshot] button.
 An image is acquired and is opened in the [Snapshot View] tab.
 The image is displayed in the [Snapshot gallery] group.

3 [Sample 
information]

The [Sample information] group contains information about the sample. The 
standard that is currently being used is selected in the [Standard] list. 
Additional standards with which the particles that were detected can be 
analyzed are available in the list. The [Particle type] list contains the particle 
types that were defined in the inspection configuration and that can be 
detected by the inspection. If you select a particle type in the [Particle type] 
list, only particles of that type are displayed in the results tables.

4 [Sample results] The overall results of the inspection are displayed in the [Sample results] 
group.

5 [Classification 
Table] 

The results of the particle classification are displayed in the [Classification 
Table] table.

5 [Particle Table] Every particle that was detected is listed together with its measured 
parameters in the [Particle Table] list. If there is a link to a snapshot, the name 
of the snapshot is shown in the [Snapshot] column.

5 Click the [Export to Excel] button to export the classification table or the 
particle table into an MS-Excel file.
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 The snapshot is linked to the particle that was selected in the 
[Particle View] tab.

 The linked snapshot is identified by a chain link icon.
5. Use the [Arbitrary Line] measurement function to make 

measurements on the snapshot. 
You can find more information about creating and editing snapshots in 
the [Inspect Sample] > [Review Sample] > [Snapshot View] chapter on 
page 74.

Measuring Particle Height
You can find more information about this function on page 80 of the 
Solution [CIX Height Measurement] chapter.

Deleting Particles
1. Click the [Particle Overlay] button to apply the class color to the 

particles. 
2. Select one or more particles in the display area or in the particle 

table.
 The selected particles are cross hatched.
 You can select more than one particle using the MS Windows 

conventions for selecting several objects simultaneously.
3. Click the [Delete Particles] button.
 The particle is deleted from the display area and from the results 

in the classification table and the particle table.
 The results are re-computed.

Separating particles
1. Click the [Particle Overlay] button to apply the class color to the 

particles. 
2. In the display area or in the particle table, select the particle that 

you want to split.
 The selected particle is cross hatched.

3. Click the [Split particle] button.
 Edit mode is activated. 
 The mouse pointer turns into a cross in the display area. You can 

use this cross to draw a polyline.
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4. Define a start point. Left click the position outside the cross 
hatched area where you want to start splitting the particle. 
 Left clicking creates control points that are connected by a line. 

This draws a separation line through the particle.
 Make sure that the start point and the end point are outside the 

cross hatched area, otherwise the particle can't be split.

The start point and the end point are outside the cross hatched area.

 Right click to finish defining the line.
5. Click the [Split Selected Particle] button.
 The particle is split along the line that was drawn and the results 

are updated. 

The color of the particles shows the different size classes that the particles are assigned to after 
being split.
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Merging particles
1. Click the [Particle Overlay] button to apply the class color to the 

particles. 
2. In the display area or in the particle table, select the particles that 

you want to merge.
3. Click the [Merge particles] button.
 Edit mode is activated.

4. You can also select the particles that you want to merge in this 
mode.
 The selected particles are cross hatched. 
 If you want to undo a selection, click the relevant cross hatched 

particle. 
5. Select all of the particles that you want to merge.
6. Confirm the selection by clicking the [Merge selected particles] 

button.
 The particles are merged and the results are updated.

Creating particles
1. Click the [Create Particle] button.
 Edit mode is activated.
 The mouse pointer changes shape.

2. Define the particle that you want to add with as many clicks of the 
mouse as are required. 
 The start and end points don't have to be precisely on top of 

each other because the software automatically converts the line 
to a (closed) polygon.

3. Right click to finish drawing the particle. 
4. Using the handles, you can still change the particle that has been 

drawn. To do this, move the pointer exactly onto a marker. The 
mouse pointer changes its shape. You can grab and drag the 
handle.

5. Click the [Create Particle] button to leave edit mode.
6. The particle will be drawn and will be included in the results of the 

inspection.
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Changing the particle family
A particle type is defined by at least one particle family, or by the 
combination of several particle families. When you change a particle's 
particle family, the particle is automatically assigned to a different 
particle type.
Example: A particle has been assigned to the [Reflecting Fiber] particle 
type. You now want to assign it to the [Fiber] particle type. 

1. Select the particle in the display area or in the particle table.
2. Click the [Change Particle Families] button.
 The available particle families are displayed.
 Because the [Reflecting Fiber] particle type is defined by the 

[Fiber] and [Reflecting] particle families, the [Fiber] and 
[Reflecting] check boxes are selected.

3. Change the particle family. Select or clear the appropriate check 
box. In this example, clear the [Reflecting] check box. The [Fiber] 
check box remains selected.

4. Click the [OK] button.
 The particle is assigned to the [Fiber] particle type. 
 The results are re-computed.

Changing what is shown in the display area
This is how you change the position on the sample on the image in the 
display area: 

1. Left click on the required position in the overview image in the 
[Sample navigation] group.

2. Alternatively, click on the frame in the middle of the navigation tool 
and drag it to the required position on the sample. 

3. To change the size of the frame in the middle of the navigation 
tool, move the mouse pointer to one of the edges of the frame. 
 The mouse pointer changes into a double arrow.

4. Drag the edge of the frame to the required size.

If the particle that you added is cross hatched, it doesn't have the minimum 
required particle size and can't be classified.
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You can also click on a particle in the [Particle Table] table to display it 
in the image in the display area.
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6.10 [Inspect Sample] > [Review Sample] > [Live Observation]
As long as the sample is still under the objective, you can view the 
particle using the live-image display area and acquire images of 
particular positions on the sample. If you are using a  real color slider 
with your microscope, the reflecting particles or reflecting areas of a 
particle will not be blue, the actual color of the sample will be displayed.

This tab is only displayed immediately after the sample has been inspected in 
the [Inspect Sample] > [Review Sample] workflow.

1 [Live Observation] 
tab

The display area in the [Live Observation] tab shows the live-image of the 
current position on the sample.

1 The size of the live-image can be enlarged or reduced in steps in the display 
area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly.

1 Clicking the [Zoom to Fit] button adjusts the size of the live-image so that it 
fits perfectly in the display area.
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1 Clicking the [Autofocus] button focuses the live-image automatically.

1 Clicking the [Snapshot] button acquires a snapshot of the segment of the 
sample that is currently shown in the display area. These images are saved to 
the [Snapshot gallery] tab and can be managed there. The images can be 
measured and then output to a report together with their measurement 
values. You can find more information on page 74 of the [Inspect Sample] > 
[Review Sample] > [Snapshot View] chapter.

1 The [Real Color Mode] button is available if you have configured a  real 
color slider with your system and you have inserted it into your microscope. 
Clicking the [Real Color Mode] button activates the real color mode.

1 Clicking the [Cross Hair] button shows a cross hair in the display area. The 
cross hair marks the center of the live-image.

1 To adjust the exposure time, click the [-] and [+] buttons repeatedly or use 
the slide control. 

1 Clicking the [One Time Auto Exposure] button automatically computes the 
exposure time.

1 Clicking this button opens a list of the available objectives. To change the 
magnification of the live-image in the display area, select an objective with a 
different magnification.

2 Clicking a position on the overview image in the [Stage navigation] group 
moves the stage to the corresponding position on the sample.

3 [Sample 
information]

The [Sample information] group contains information about the sample. The 
standard that is currently being used is selected in the [Standard] list. 
Additional standards with which the particles that were detected can be 
analyzed are available in the list. The [Particle type] list contains the particle 
types that were defined in the inspection configuration and that can be 
detected by the inspection. If you select a particle type in the [Particle type] 
list, only particles of that type are displayed in the results tables.

3 [Manual height 
measurement] 

The [Manual height measurement] group appears when you click the 
[Measure Particle Height Manually] button in the [Particle View] tab or in the 
[Sample Image] tab. You can find more information about measuring particle 
height in the Solution [CIX Height Measurement] chapter on page 80.

4 [Sample results] The overall results of the inspection are displayed in the [Sample results] 
group.
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6.10.1 [Review Sample] > [Live Observation] tab
Straight after inspecting the sample, you can view the particles in the 
live-image and acquire images of particular positions on the sample in 
the [Live Observation] tab. A snapshot of a particle can be linked to that 
particle's parameters. When a snapshot has been linked to the particle's 
parameters, the [Snapshot Name] column in the [Particle Table] table 
contains the corresponding name of the snapshot. 
Acquiring a snapshot

1. From the thumbnails in the [Particle View] tab or the particle table, 
select a particle that you want to acquire a snapshot of. 

2. Go to the [Live Observation] tab.
3. Click the [Cross Hair] button. 
 The particle will be identified by a cross hair in the center of the 

live-image.
4. Adjust the way the image is displayed in the display area. 
 Change the objective if required. 
 Adjust the exposure time.
 Use the [Zoom In] and [Zoom Out] buttons to show the required 

segment of the image in the display area.
 Focus the particle.

5. Click the [Snapshot] button.
 A snapshot is acquired and is opened in the [Snapshot View] tab.
 The snapshot is displayed in the [Snapshot gallery] group.
 The snapshot is linked to the particle that was selected in the 

[Particle View] tab.
 Linked snapshots are identified by a chain link icon.

5 [Classification 
Table] 

The results of the particle classification are displayed in the [Classification 
Table] table.

5 [Particle Table] Every particle that was detected is listed together with its measured 
parameters in the [Particle Table] list. If there is a link to a snapshot, the name 
of the image is shown in the [Snapshot] column.

5 Click the [Export to Excel] button to export the classification table or the 
particle table into an MS-Excel file.
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6. Use the [Arbitrary Line] measurement function to make 
measurements on the snapshot. 

7. You can find more information about creating and editing 
snapshots in the [Inspect Sample] > [Review Sample] > [Snapshot 
View] chapter on page 74.

Snapshots are only automatically linked to a particle if a thumbnail or a particle 
is selected in the [Particle Table] table at the time when the snapshot is 
created.
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6.11 [Inspect Sample] > [Review Sample] > [Snapshot View]
The [Snapshot View] tab contains all of the snapshots that have been 
acquired for a sample. The snapshots that have been acquired can be 
measured using the [Arbitrary Line] measurement function and output 
to a report.

1 [Snapshot View] 
tab

The display area of the [Snapshot View] tab displays the snapshot that is 
selected in the [Snapshot gallery] group.

1 The size of the image can be enlarged or reduced step by step in the display 
area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly.

1 Clicking the [Zoom to Fit] button adjusts the size of the image so that it fits 
perfectly in the display area.

1 Clicking the [Measurement Overlay] button shows or hides the measurement 
objects on an image.
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1 Clicking the [Arbitrary Line] button activates the measurement function that 
measures lengths. The values resulting from this measurement are displayed 
next to the measurement object in the image and also in the [Measurements] 
table on the right. 

1 Clicking this buttons opens a drop-down list of colors that can be applied to 
the measurement object.

1 Clicking the [Delete] button deletes the selected measurement. 

2 [Snapshot 
location]

The position of the selected image is indicated with a cross hair in the 
overview image in the [Snapshot location] group.

3 [Snapshot 
information]

The [Snapshot information] group contains information about each particle 
and a comments field where you can make your own annotations.

3 Clicking the [Link to Particle] button creates a link between a snapshot that 
has been acquired and a particle.
Clicking the [Remove Link to Particle] button breaks an existing link between a 
snapshot that has been acquired and a particle.

4 Clicking the [Export to Excel] button exports the measurement values for an 
image to an MS-Excel sheet.

4 Clicking the [Delete] button deletes the measurement that is currently 
selected in the [Measurements] table. You can select more than one 
measurement using the MS Windows conventions for selecting several 
objects simultaneously.

4 [Measurements] The [Measurements] table lists all of the measurement values for an image.
5 [Snapshot gallery] The [Snapshot gallery] group contains all of the snapshots that were acquired 

of the sample using the [Snapshot] button. The number of images is limited 
to a maximum of 20 per sample.

5 Clicking the [Copy Snapshot to Clipboard] button copies the image to the 
clipboard. You can paste the image to a Microsoft Word or Microsoft Power 
Point document using the [Ctrl+V] keyboard shortcut. 

5 Clicking the [Save Snapshot As] button opens MS-Windows Explorer to save 
the snapshot to a different data directory or disk. 

5 Clicking the [Delete Snapshots] button deletes the snapshot that is currently 
selected.
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6.11.1 [Review Sample] > [Snapshot View] tab
In the [Snapshot View] tab, you manage all of the snapshots for a 
sample and also the links to the particles.
Acquiring a snapshot
You can acquire snapshots using the [Sample Image] and the [Live 
Observation] tab.
Using the [Sample Image] tab, you can acquire a snapshot from the 
images of the sample at any time. Detailed information can be found in 
the [Review Sample] > [Sample Image] tab chapter on page 64.
In the [Live Observation] tab, you can only acquire a snapshot 
immediately after the sample has bee inspected, as long as the sample 
is still under the objective. Detailed information can be found in the 
[Review Sample] > [Live Observation] tab chapter on page 72.
Outputting a snapshot to a report.
In order for one or more snapshots to be output to a report, the report 
template must have a placeholder for snapshots. You can find more 
information about inserting sections in report templates on page 203 of 
the [Inserting a section with specific placeholders] chapter. If 
measurements were performed on the snapshots, these will be 
displayed in the snapshots and output to the report together with the 
measurement values in the [Measurements] table.
Editing the snapshot information
You can enter a name for the snapshot in the [Name] field in the 
[Snapshot information] group. You can make your own annotations in 
the [Comment] field. If you insert the [Snapshot Name] and [Snapshot 
Comment] fields in a report template, these comments will be output to 
a report. 
Linking a snapshot to a particle
If a thumbnail in the display area or a particle in the [Particle Table] 
table is selected when a snapshot is acquired, the snapshot will 
automatically be linked to that particle. When the snapshot is linked to 
a particle, the [ID of linked particle] field shows the particle's particle ID. 
Double clicking a linked snapshot opens the [Particle View] tab and the 
corresponding row is selected in the particle table. This row displays the 
values that were measured.
A particle can only be linked to one snapshot.
76OLYMPUS Cleanliness Inspector CIX ASW 1.5



6  [Inspect Sample]
[Inspect Sample] > [Review Sample] > [Snapshot View]
You can use the [Link to Particle] button to create a link between a 
snapshot and a particle retroactively. 

1. In the [Snapshot gallery] group, select the snapshot that you want 
to link to a particle retroactively.

2. So that the link between the snapshot and the particle is created 
correctly, the appropriate particle in the sample has to be selected. 
You can select the particle's thumbnail in the [Particle View] tab. 
Alternatively, select the particle in the [Particle Table] table.

3. Select the [Snapshot View] tab.
4. Click the [Link to Particle] button.
 The snapshot will be linked to the particle and to the measured 

values in the particle table.
 The linked snapshot is identified by a chain link icon.
 The ID of the linked particle is displayed in the [Sample 

information] group.

Removing a link
You can use the [Remove Link to Particle] button to remove a link 
between a snapshot and a particle.

1. Select the linked snapshot in the [Snapshot gallery] group.
2. Click the [Remove Link to Particle] button.
 The link will be removed. 
 The chain link icon disappears.

Acquiring a snapshot without a link
You can also acquire snapshots that you do not link with a particular 
particle. The snapshot could be of an area of the sample that contains 
more than one particle for example. 

1. Check the particle table in one of the tabs and make sure than no 
particles are selected. 
 If a particle is selected in the particle table, deselect it. To do this, 

press the [Ctrl] key while clicking the selected entry in the particle 
table.

2. If you now click the [Snapshot] button in the [Sample Image] tab or 
in the [Live Observation] tab and acquire a snapshot, the snapshot 
will not be linked to a particular particle. 
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Performing measurements on snapshots
You can use the [Arbitrary Line] button to measure the particles in the 
snapshots manually.

1. In the [Snapshot gallery] group, select the snapshot that you want 
to measure particles on.
 The snapshot appears in the display area.

2. Click the [Measurement Overlay] button.
 In this mode, measurement objects are displayed on the image.

3. Click the [Arbitrary Line] button.
 The mouse pointer turns into a small cross.

4. Click the start point and then the end point of the length that you 
want to measure.

5. If you want to change the measurement object's color, click the 
button with the colored rectangle and select the required color 
from the list. Alternatively, you can also change the measurement 
object's color in the table on the right that contains the 
measurements.
 The measured length is shown directly next to the measurement 

object in the snapshot as well as in the table that contains the 
measurements.

Editing measurements
When you select a snapshot that contains measurements in the 
[Snapshot gallery ] group, all of the measured values for each 
measurement object are listed in the [Measurements] table. A letter is 
assigned to each measurement object so that you can associate the 
measurement object with the values in the [Measurements] table. In the 
[Name] field, you can overwrite the letters and give each measurement 
object its own name. This name also appears on the snapshot. You can 
use the button with the colored rectangle to change the color of the 
measurement object.

Copying a snapshot to the clipboard
1. In the [Snapshot gallery] group, select a snapshot that you want to 

insert into a different document, a PowerPoint presentation or a 
Microsoft Word document for example.
 Only one snapshot at a time can be copied to the clipboard.
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2. Click the [Copy Snapshot to Clipboard] button.
3. Use the [Ctrl + V] keyboard shortcut to paste the snapshot from 

the clipboard into a document.

Saving a snapshot
1. In the [Snapshot gallery] group, select the snapshot that you want 

to save to a particular data directory, for example. 
2. Click the [Save Snapshot As] button. 
 MS-Windows Explorer opens. 

3. Save the snapshot in the required data directory.

Deleting a snapshot
1. In the [Snapshot gallery] group, select the snapshot that you want 

to delete. 
 You can select more than one snapshot at a time using the MS 

Windows conventions for selecting several objects.
2. Click the [Delete Snapshots] button.
 The selected snapshots are permanently deleted.
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6.12 Solution [CIX Height Measurement]
The [CIX Height Measurement] solution enables you to measure the 
height of individual particles after the inspection. 

Prerequisites  If the [CIX Height Measurement] solution and the associated 
hardware has been installed, the function for measuring particle 
height is available. Depending on how your system is configured, 
automatic measurement of the particle height is available in 
addition to manual measurement of the particle height.

 The particle height can only be measured immediately after the 
sample inspection in the [Inspect Sample] > [Review Sample] 
workflow, as long as the sample is still under the objective and a 
live-image is possible.

6.12.1 Measuring the particle height automatically
Prerequisites  The particles must not overlap.

 The sample must have high contrast.
 The particle must fit in the field of view.

1. In the [Particle View] or [Sample Image] tab, select the particle that 
you want to measure.
 The stage moves to this position on the sample.

Automatically
measuring more
than one particle

2. You can also measure the particle height for more than one 
particle at the same time. Use the Windows conventions for 
selecting more than one object to make your selection. In the 
[Particle View] or [Sample Image] tab, select the particles that you 
want to measure automatically.

3. Click the [Measure Particle Height] button.
 The 20x objective is automatically set.
 If a particle doesn’t fit in the field of view, the automatic 

measurement won’t work. In this case, measure the particle 
height manually for this particle.

Clicking the [Measure Particle Height] button starts the automatic 
measurement of the particle height.

Clicking the [Measure Particle Height Manually] button opens the dialog box 
for manually measuring the particle height.
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 The system acquires a series of images focused at different 
depths for each particle and then compiles them into a resulting 
image that is sharply focused throughout. 

 The particle height is determined from the total movement of 
the Z-drive during the acquisition of the image series.

 The measured height of the particle is displayed in the [Height 
[µm]] column in the particle table.

6.12.2 Measuring the particle height manually
1. In the [Particle View] or [Sample Image] tab, select the particle that 

you want to measure.
 The stage moves to this position on the sample.

2. Click the [Measure Particle Height Manually] button.
 The [Manual height measurement] page opens. 

3. If you want an accurate measurement, select an objective with a 
high magnification. 

4. Focus on the paper of the filter to determine the Z-position of the 
bottom of the particle.

5. Confirm this Z-position with a click on the [Confirm initial Z-
position] button.

6. Focus on the top of the particle.
7. Confirm with [OK].
 The particle height is determined from the total movement of 

the Z-drive between the two focus planes.
 The measured height of the particle is displayed in the [Height 

[µm]] column in the particle table.
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6.13 [Create Report]
You can find the help topic for this page on page 126 of the [Create 
Report] chapter.
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7 [Inspect Multiple Samples]
This workflow can inspect up to two samples at the same time. The 
results are summarized after the inspection is finished.

7.1 [Inspect Multiple Samples] > [Mount Sample]

The [Review Sample] and [Create Report] steps don't appear in this workflow. 
When you save the results of the inspection, the individual results for each 
sample will be available in the [Review Results] workflow after the inspection 
has finished. Using the [Create Report] button on the software's start page, 
you can create a report with the saved results for each sample.

1 The size of the live-image can be enlarged or reduced in steps in the display 
area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. The 
mouse pointer turns into a hand when it's on the image. You can also change 
the display size with the mouse wheel when you're in this mode.

2 This icon displays the magnification of the current objective.
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7.1.1 Mount Sample
In this step, you place the samples in the multi-sample holder and then 
place the multi-sample holder on the stage and start the acquisition of 
an  overview image of each sample. The overview images give you a 
first impression of the samples. You can use them to define the  
inspection area.

Prerequisite  The system has been calibrated. If the calibrations aren’t all up to 
date, either a message appears telling you that calibrations are 
missing or a calibration process dialog box opens. Perform the 
required calibration. You can find more information about the 
calibration processes on page 212 of the [Calibration] chapter.

If the samples have already been mounted, you can start the 
acquisition of the overview images straight away by clicking the 
[Acquire Overview Image] button.
Mounting the samples and acquiring overview images

1. Click the [Move Stage to Mounting Position] button.
 The stage moves to allow you to easily place the filters in the 

multi-sample holder.
2. Place the filters in the multi-sample holder.
3. In the [Multiple sample view] tab, select the samples that you want 

to inspect. 
 A sample that is selected is colored blue.

4. Click the [Acquire Overview Images] button.
 The objective with the lowest magnification is set.

2 This icon displays the current exposure time.

3 [Sample overview] A blue square in the [Sample overview] group indicates the current position 
of the camera.

3 [Multiple sample 
view]

The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder.
In this tab, you can select the samples to inspect in this workflow. A sample 
that is selected is colored blue.

4 [Skip overview 
acquisition]

You can specify whether to acquire an overview image in the following step 
or whether to skip the acquisition of an overview image.
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 Autofocus is activated.
 The optimum exposure time is automatically determined. 
 The acquisition of the overview images starts.
 The [Inspect Multiple Samples] > [Acquire Overview Image] 

page opens.
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7.2 [Inspect Multiple Samples] > [Acquire overview image]

1 The size of the  overview image can be enlarged or reduced in steps in the 
display area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. 
The mouse pointer turns into a hand when it's on the image. You can also 
change the display size with the mouse wheel when you're in this mode.

1 Clicking the [Zoom to Fit] button adjusts the size of the overview image so 
that it fits perfectly in the display area.

2 This icon displays the magnification of the current objective.

2 This icon displays the current exposure time.

3 A blue square on the image in the [Sample overview] tab shows the area of 
the sample that is currently being acquired.

3 The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder.
The samples that are being inspected in this workflow are colored blue. 
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7.2.1 Acquiring the overview image
Prerequisite  This step won’t be displayed if you selected the [Skip overview 

acquisition] check box on the [Inspect Multiple Samples] > [Mount 
Sample] page.

In this step, the software acquires an  overview image of each 
sample. The objective with the smallest magnification is automatically 
set. You can follow the acquisition of the overview images in the 
[Sample overview] group. The blue square shows the position on the 
sample that is currently being acquired. The images that are being 
acquired of the sample are assembled in the image in the display area. 
The progress bar estimates how long the acquisition of the overview 
images will take. 
After the overview images have been acquired, the [Inspect Multiple 
Samples] > [Select Inspection Configuration] page opens.
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7.3 [Inspect Multiple Samples] > [Select Inspection Configuration]

1 The size of the  overview image can be enlarged or reduced in steps in the 
display area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. 
The mouse pointer turns into a hand when it's on the image. You can also 
change the display size with the mouse wheel when you're in this mode.

1 Clicking the [Zoom to Fit] button adjusts the size of the overview image so 
that it fits perfectly in the display area. 

2 This icon displays the current objective.

2 This icon displays the current exposure time.

3 The [Available inspection configurations] list contains all of the  inspection 
configurations that are available in the software.
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7.3.1 Selecting an inspection configuration
In this step, you select the  inspection configuration that you want to 
use to inspect the samples. Only one inspection configuration can be 
selected per workflow. If you want to inspect two samples, the same 
inspection configuration will be used for each sample.

1. Select the required inspection configuration in the [Available 
inspection configurations] list.
 A brief description of the selected inspection configuration and 

some of its parameters is displayed to the right of the [Available 
inspection configurations] list. You can find more information 
about inspection configurations on page 150 of the [Inspection 
Conf igurations] chapter.

2. Click the [Next] button. 
 The objective specified by the inspection configuration is 

automatically set. 
 The stage automatically moves to the center of the inspection 

area and activates the autofocus. The optimal exposure time and 
threshold are determined.

 The [Inspect Multiple Samples] > [Edit Settings] page opens.

4 This display field contains a description of the selected inspection 
configuration. A message in the display field alerts you when an objective has 
been defined in the inspection configuration but no system check has been 
successfully performed for it yet.
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7.4 [Inspect Multiple Samples] > [Edit Settings]

1 In the live-image in the display area, the automatically computed threshold is 
colored green. The display size of the live-image can be enlarged or reduced 
in steps. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. The 
mouse pointer turns into a hand when it's on the image. You can also change 
the display size with the mouse wheel when you're in this mode.

1 Clicking the [Autofocus] button focuses the image automatically. You may 
need to perform the autofocus several times to focus the image. The joystick 
can also be used for manual focusing.

2 [Sample overview] The display size of the  overview image in the [Sample overview] tab can 
be enlarged or reduced in steps. To do this, click the [Zoom Out] or [Zoom In] 
button repeatedly. Clicking a different position on the sample in the overview 
image changes the position of the sample in the display area.

2 [Multiple sample 
view]

The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder.
The samples that are being inspected in this workflow are colored blue. A 
yellow warning triangle means that required sample information is missing or 
that there is an invalid entry.
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3 [Inspection 
settings]

Depending on which inspection configuration has been selected, different 
entries will be editable in the  [Inspection settings] group. The appearance 
and the functions of the buttons can vary depending on which inspection 
configuration has been selected.

3 Clicking the [Apply inspection settings to all positions] button applies the 
inspection settings for the sample that is currently selected to all of the 
samples to be inspected in this workflow.

3 Clicking the button with a gear wheel opens a dialog box where you can 
change settings.

The inspection configuration has several different options for specifying how the threshold values and 
the exposure time are determined. You can find more information on page 158 of the [Inspection 
Conf igurations] > [Open] (Page 2 of 2) chapter.
3 Clicking the [One Time Auto Exposure] button automatically computes the 

exposure time. 
3 Clicking the [One Time Auto Threshold for Particles] button automatically 

computes the  threshold.
4 [Sample 

information]
The [Sample information] group contains all of the fields that were specified 
on the [Sample Information Fields] page. They appear in the order that they 
were specified. Some of the fields are mandatory and have to be filled in 
before the sample inspection can be performed. You can find more 
information on page 190 of the [Sample Information Fields] chapter.
The sample information that you enter can be saved so that it doesn’t have to 
be re-entered for other samples that have the same parameters. All of the 
sample information that has been saved can be accessed in the list in the 
[Preset] field.

4 Clicking the [Apply sample information to all positions] button applies the 
sample information for the sample that is currently selected to all of the 
samples to be inspected in this workflow.
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7.4.1 Editing inspection settings
In this step, you can adjust some of the settings before the inspection of 
each sample. In the fields in the [Sample information] group, you can 
enter additional information about each sample. This data is saved 
together with the results of the inspection.
The settings in this step can be identical for both samples, or they can 
be adjusted for each sample individually.
Use the schematic representation in the [Multiple sample view] tab 
where you can select each sample and get an overview of the settings 
for each sample.

Applying inspection settings to the other sample
If you want to apply the same inspection settings to both samples, you 
can adjust the settings for one sample and apply them to the other. To 
do this, after editing the inspection settings, click the [Apply inspection 
settings to all positions] button at the top right of the [Inspection 
settings] group. You can still adjust individual settings for each sample 
later.
In the [Multiple sample view] tab, you can switch between the settings 
for each sample by clicking on the relevant sample.

Editing the exposure time and thresholds for particles
Prerequisite  The exposure time and the  thresholds can only be edited if 

manual editing was specified in the inspection configuration.
If manual editing is not allowed, the exposure time and the 
threshold are set automatically.

1. In the [Multiple sample view] tab, select the sample whose settings 
you want to adjust.

2. Click the [Edit Exposure Time and Threshold for Particles] button.
 The [Edit exposure time and threshold for particles] dialog box 

opens. 

The inspection configuration specifies which  inspection settings can be 
edited in this workflow. Different settings options and buttons are available in 
the [Inspection settings] group depending on which inspection configuration 
has been selected.
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 First set the exposure time and then set the threshold.
 You can find more information about this dialog box on page 98 

of the Exposure time and threshold for particles chapter.

Editing thresholds for reflecting particles
You can set an individual threshold for the reflective areas of a particle. 
The reflecting pixels inside a particle are detected and computed with 
the pixels of the particle's overall area. When the particle has more than 
a certain amount of reflecting areas, it is counted as a reflecting particle 
in the inspection results. 

1. In the [Multiple sample view] tab, select the sample whose settings 
you want to adjust.

2. Click the [Edit Threshold for Reflecting Particles] button.
 The [Edit threshold for reflecting particles] dialog box opens. 
 You can find more information about this dialog box on page 

102 of the Threshold for reflecting particles chapter.

Editing the inspection area and focus points
Prerequisite  The focus points can only be edited if manual editing of focus 

points was specified in the inspection configuration. 
If editing the focus points manually is not allowed, the focus 
settings specified in the inspection configuration are used.

1. In the [Multiple sample view] tab, select the sample whose settings 
you want to adjust.

2. Click the [Edit Inspection Area and Focus Points] button.
 The [Inspection Area and Focus Points] dialog box opens. 
 You can find more information about this dialog box on page 

104 of the Inspection area and focus points chapter.

Entering sample information
The fields displayed in the [Sample information] group are either 
specified by the inspection configuration or were activated on the 
[Sample Information Fields] page. You can enter additional information 
about the samples in these fields. This information will be saved 
together with the results of the inspection. This information can be 
output to a report.
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You can save the parameters in a preset if you want to re-use the 
sample information that you entered for other samples as well. Enter a 
name in the [Preset] field and click the [Save Selected Preset] button.
Click the [Delete Selected Preset] button if you want to delete the 
sample information that is currently selected in the [Preset] list.
When a field has a yellow frame around it and a warning triangle, it 
means that this is a mandatory field that must be filled in. It can also 
mean that the entry is invalid. The inspection can't be started as long as 
there are missing or invalid entries. You can find more information 
about the [Sample Information Fields] page on page 190 of the [Sample 
Information Fields] chapter.

Applying sample information to the other sample
If you want to apply the same sample information to both samples, you 
can adjust the sample information for one sample and then apply it to 
the other. To do this, after entering the sample information, click the 
[Apply sample information to all positions] button at the top right of the 
[Sample information] group. You can still adjust individual settings for 
each sample later.
In the [Multiple sample view] tab, you can switch between the sample 
information for each sample by clicking on the relevant sample.

Performing the inspection
1. Click the [Run Inspection] button.
 The [Inspect Multiple Samples] > [Acquire Focus Points] page 

opens. 
 You can find more information about this page on page 110 of 

the [Inspect Multiple Samples] > [Acquire Focus Points] chapter.
 If you haven't defined a focus map for focusing the sample, the 

[Acquire Focus Points] page is skipped and the acquisition of the 
sample starts straight away. 
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7.4.2 Exposure time and threshold for particles

1 The display area shows the live-image of the current sample position. 
Changes to the exposure time can be seen in the live-image straight away. 
When the [Toggle Preview] button next to the [Threshold for particles] slide 
control is activated, the particles defined by the  threshold are shown in 
color in the image.

2 The current position on the sample is shown by a small square in the overview 
image in the [Sample overview] tab. Clicking a different position on the 
sample in the overview image changes the position of the sample in the 
display area.

2 The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder.
The sample to which the settings in this step refer has a blue frame. 

3 The dialog box contains the slide control and the button that set the exposure 
time and the threshold.
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7.4.3 [Edit Exposure Time and Threshold for Particles]

You specify the exposure time and the  thresholds for the particles in 
the [Edit exposure time and threshold for particles] dialog box. These 
settings are used for the inspection of the sample. First set the exposure 
time and then set the threshold. 
You can apply the settings in this step to both samples, or adjust them 
individually for each sample. If you want to apply the same inspection 
settings to both samples, you can adjust the settings for one sample 
and then apply them to the other. To do this, after editing the settings 
click the [Apply inspection settings to all positions] button on the 
[Inspect Multiple Samples] > [Edit Settings] page.
The inspection configuration has several different options for specifying 
how the threshold values and the exposure time are determined. You 
can find more information on page 158 of the [Inspection Conf igurations] 
> [Open] (Page 2 of 2) chapter.
Specifying the exposure time

1. There are several different ways of setting the exposure time:
 Use the slide control.
 Click the [-] or [+] buttons to adjust the exposure time in small 

steps.
 Enter an exposure time in the field, then press the [Enter] key.
 Alternatively, you can have the exposure time automatically 

computed. To do this, click the [One Time Auto Exposure] 
button.

2. Close the dialog box with [OK]. 
 This exposure time will be used for all high resolution images 

that are acquired during the sample inspection.
Specifying the threshold for particles
Make sure to set the thresholds carefully because they have a 
considerable influence on the results of the sample inspection.

1. Select a position on the sample that contains typical particles. 

It may be possible to manually set only the exposure time or only the 
threshold, depending on the settings in the inspection configuration.
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2. Switch on the threshold value preview. To do so, click the [Toggle 
Preview] button. The intensity range defined by the thresholds is 
colored green.
This allows you to view the results in the image straight away and 
to readjust the settings if required.

3. There are several different ways of setting the threshold for 
particles:
 Use the slide control.
 Click the [-] or [+] buttons to adjust the threshold in small steps.
 Enter a threshold in the field, then press the [Enter] key.
 Alternatively, you can have the threshold automatically 

computed. To do this, click the [One Time Auto Threshold for 
Particles] button.

4. Set the threshold so that only particles are detected and colored 
green. 

5. Check the thresholds on other positions on the sample.
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7.4.4 Threshold for reflecting particles

1 The display area shows the live-image of the current sample position. When 
the [Toggle Preview] button is activated, the changes to the threshold can be 
seen in the live-image straight away. 

2 The current position on the sample is shown by a small square in the overview 
image in the [Sample overview] tab. Clicking a different position on the 
sample in the overview image changes the position of the sample in the 
display area.

2 The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder.
The sample to which the settings in this step refer has a blue frame. 

3 The dialog box contains the slide control and the buttons that set the 
threshold.
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7.4.5 [Edit threshold for reflecting particles]
You specify the  threshold for reflecting areas of a particle in the [Edit 
threshold for reflecting particles] dialog box.
Make sure to set the thresholds carefully because they have a 
considerable influence on the results of the sample inspection.
You can apply the settings in this step to both samples, or adjust them 
individually for each sample. If you want to apply the same inspection 
settings to both samples, you can adjust the settings for one sample 
and then apply them to the other. To do this, after editing the settings 
click the [Apply inspection settings to all positions] button on the 
[Inspect Multiple Samples] > [Edit Settings] page.

1. Select a position on the sample that contains reflecting particles. 
The reflecting areas are colored magenta.

2. Switch on the threshold value preview. To do so, click the [Toggle 
Preview] button. This allows you to view the results in the image 
straight away and to readjust the settings if required.

3. Set the threshold so that the reflecting areas of a particle are 
detected and then colored magenta. 
There are several different ways of setting the threshold for 
reflecting particles:
 Use the slide control.
 Click the [-] or [+] buttons to adjust the threshold in small steps.
 Enter a threshold in the field, then press the [Enter] key.
 Alternatively, you can have the threshold for reflecting particles 

automatically computed. To do this, click the [One Time Auto 
Threshold for Reflecting Particles] button.

4. Check the thresholds on other positions on the sample.
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7.4.6 Inspection area and focus points

1 The display area shows the live-image of the current sample position.
2 If the [Edit Inspection Area] edit mode is active, a circle that shows the  

inspection area is displayed on the overview image.
If the [Edit Focus Points] edit mode is active, the focus points are shown on 
the overview image. 

3 Clicking the [Edit Inspection Area] button activates the edit mode for the 
inspection area. The inspection area is identified with a circle in the overview 
image. The size of the circle can be changed.

3 [Inspection area] The diameter and the area of the inspection area, and the total number of 
images that will be acquired during the sample inspection are displayed in the 
[Inspection area] group.

3 Clicking the [Maximize Inspection Area] button enlarges the inspection area 
to its maximum possible size. The software defines a maximum diameter for 
the inspection area of 42.5 mm.
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7.4.7 [Edit Inspection Area and Focus Points]

You can check and, if necessary, change the  inspection area and the 
focus points in the [Edit Inspection Area and Focus Points] dialog box.
You can apply the settings in this step to both samples, or adjust them 
individually for each sample. If you want to apply the same inspection 
settings to both samples, you can adjust the settings for one sample 
and then apply them to the other. To do this, after editing the settings 
click the [Apply inspection settings to all positions] button on the 
[Inspect Multiple Samples] > [Edit Settings] page.

Editing the inspection area
1. First select the edit mode. Click the [Edit Inspection Area] button.
2. The overview image displays a circle that defines the inspection 

area. Click on the circle. 
 A handle appears on the perimeter of the circle. 

3. Change the size of the circle. Move the mouse pointer onto the 
handle. Drag the selection marker in the direction you want. 

4. Change the position of the circle. Move the mouse pointer onto 
the circle. The mouse pointer turns into a four-headed arrow. Drag 
the circle to the required position.

3 Clicking the [Save Inspection Area as Default] button saves the current size of 
the inspection area and applies it to all subsequent inspections.

3
 

Clicking the [Edit Focus Points] button activates the edit mode for focus 
points. The focus points are shown in the overview image. They can be 
moved within the inspection area.

3 [Focus points] The total number of focus points is displayed in the [Focus points] group. 
3 [Focus mode] This option specifies the focus mode that will be used to focus the sample. 

You can select between a  focus map, the current Z-position, or focusing 
on every frame.

The functions for editing focus points are only displayed if the editing of focus 
points is allowed by the inspection configuration.
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5. If you want to save the size of the inspection area as a default for 
all subsequent inspections, click the [Save Inspection Area as 
Default] button.
 The inspection area that you specify is used for subsequent 

inspections of the sample until you specify a new inspection 
area.

Maximizing the inspection area
1. Click the [Maximize Inspection Area] button.
 The inspection area enlarges to its maximum possible size.

Editing focus points

1. Click the [Edit Focus Points] button.
 All of the focus points are displayed in the overview image. 
 The [Count] field displays how many focus points are specified 

by the currently selected option.
2. Select a focus method in the [Focus points] group.
 The [Use current Z-position] option uses the Z-position for the 

acquisition of the images that is set at the point in time when 
you start the sample inspection. You start the sample inspection 
by clicking the [Run Inspection] button. The Z-position isn't 
changed during the acquisition of the images. 

 With the [Focus on every frame] option, the sample inspection 
focuses before acquiring every frame. With this option, the 
inspection of the sample can take a very long time.

 The [Focus map] option enables you to acquire well-focused 
images of the whole sample when the surface of the sample is 
uneven.

3. If you have selected the [Focus map] option: The entries in the list 
determine how densely the focus points are arranged on the focus 
map. Select the density of the focus points according to the 
properties of your sample. If you select a high density, a lot of 
positions will be used for the acquisition of the focus map. The 

Place the focus points on areas of the sample that have clear structures and 
that contain as many particles as possible.
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focus map then becomes more exact, but its acquisition takes 
longer. The following entries are available:
 3 points
 Low density
 Medium density
 High density

Focusing on focus points
You can also focus on focus points in a focus map manually.

1. Select the [Manual Focus] check box.
 The first focus point is shown in green in the overview image.

2. Bring the sample into focus.
3. Click the [Validate Focus Point] button to confirm a focus point that 

has been manually focused.
 The stage moves to the next focus point.

4. Focus on each of the focus map’s focus points and validate them.
 If you are focusing on the focus points manually, the software 

skips the [Acquiring focus points] automated step.

Moving focus points
1. The position of the focus points can be changed. To do this, click 

on a focus point in the overview image.
 The stage moves to this focus point. 
 The current focus point is shown in the live-image in the display 

area.
2. Drag the focus point to the new position.

Adding or deleting focus points
As soon as you add or delete a focus point from a focus map, the [User 
defined density] entry appears in the [Focus map] list.
• Click the [Add Focus Point] button to create a new focus point. Move 

the focus point to the required position.
• Click the [Delete Focus Point] button to delete the selected focus 

point.
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• Click the [Validate Focus Point] button to confirm a focus point that 
has been manually focused.
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7.5 [Inspect Multiple Samples] > [Acquire Focus Points]

1 The overview image in the [Sample overview] tab displays the distribution of 
the focus points on the sample. 

2 The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder.
The sample with the blue frame is the one for which the focus points are 
being acquired.

2 The information in the [Focus points] group is constantly refreshed. 
The following information is shown: 
[Total number]: The total number of focus points.
[Processed]: The number of focus points that have already been processed.
[Without focus]: The number of focus points for which the focus position 
could not be found.
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7.5.1 Acquiring focus points

The focus points for the  focus map are acquired for each sample in 
this step. After the focus points have been acquired, the [Inspect 
Multiple Samples] > [Acquire Sample] page opens.

The [Inspect Multiple Samples] > [Acquire Focus Points] page is only displayed 
if you defined a focus map and the focus points weren’t defined manually.
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7.6 [Inspect Multiple Samples] > [Acquire Sample]

1 The display area shows the live-image of the current sample position.
2 The  overview image in the [Sample overview] tab is overwritten with the 

high resolution images. The individual images are assembled into one single 
image.

2 The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder.
The sample with the blue frame is the one that is currently being inspected

3 The [Sample information] group contains information about the sample, for 
example the standard used for the sample inspection and the measurement 
parameters used to classify the particles. The [Count result] field displays what 
the result refers to. 

4 The [Sample results] group displays the number of particles for each  
particle class. The [Overall approval] field displays the overall result of the 
sample inspection. The results are constantly refreshed during the acquisition 
of the sample. 
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7.6.1 Acquiring images of the sample
The images of the samples are acquired and the number of particles is 
determined in this step. 
The [Sample information] group shows some of the criteria by which 
the particle is being classified. This information is specified in the 
inspection configuration. 
The results in the [Sample results] group are constantly refreshed 
during the acquisition of the images. The bars next to the particle 
classes show how many particles have been found in that  particle 
class. If you defined a maximum permitted value, this value is shown 
with a colored mark on the bar. This allows you to see whether the 
permitted number of particles in a particle class has been exceeded 
before the inspection is finished. If the permitted number of particles in 
a particle class is exceeded, the particle class, and therefore also the 
overall result, is classed as [NOK].
Clicking the [Skip Current Sample] button at any time skips the 
acquisition of the first sample and switches to the next sample. This can 
be useful if during the acquisition it becomes clear that the overall 
approval is classed as [NOK]. Select whether you want to discard the 
interim results or to review them when the inspection is finished. In the 
next step, the [Check Results] step, you can review the interim results in 
detail and save them if required.
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7.7 [Inspect Multiple Samples] > [Check Results]

1 Clicking the [Particle Overlay] button shows or hides the class color of the 
particles. 

2 The [Multiple sample view] tab displays a schematic diagram of the positions 
of the samples on the multi-sample holder. Clicking one of the positions 
selects that sample and its results are displayed. If one of the samples was 
skipped and was not inspected to completion, it will be cross hatched in blue.

3 The [Sample information] group contains information about the sample, for 
example the standard used for the sample inspection and the measurement 
parameters used to classify the particles. 

4 The overall results of the inspection are displayed in the [Sample results] 
group. 

5 The results are sorted into  particle classes in the table.
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7.7.1 Checking the results
This page gives you an overview of the results of the cleanliness 
analysis. The particles that were detected are sorted into  particle 
classes in the table. Each particle class is assigned a different color. The 
particles in the overview image and in the live-image are colored 
according to their particle class. This gives you a visual impression of 
the number and size of the particles in a particular particle class. 
You can switch between the results for each sample by clicking on the 
sample position in the [Multiple sample view] tab.
When you save the results of the inspection, the individual results for 
each sample will be available in the [Review Results] workflow after the 
inspection has finished. Using the [Create Report] button on the 
software's start page, you can create a report with the saved results for 
each sample.
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8 [Review Results]
On these pages, you can open the results of all of the saved sample 
inspections at any time and output them to a report.

8.1 [Review Results] > [Select Sample]

1 The [Available samples] list contains all of the samples that have been 
inspected. Information is displayed for each sample, for example the date it 
was created.

1 The available samples can be filtered by particular criteria, parts for example. 
Clicking the [Filter] button activates or deactivates the filter that is currently 
defined.

1 Clicking the [Filter Settings] button opens a dialog box in which you can 
define a filter for the available samples.

2 This area contains information about the sample, which inspection 
configuration was used and a short description for example.
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8.1.1 Selecting a sample
On this page, select a sample whose results you want to see or for 
which you want to create a report.

Selecting a sample
1. Select a sample in the [Available samples] list. 
2. Click the [Next] button.
 The [Review Results] > [Review Sample] page opens.

Defining and using filters
If you have already saved a lot of samples, you can use a filter to limit 
the selection in the [Available samples] table.

1. Click the [Filter Settings] button. 
 The [Filter settings] dialog box opens.

2. If you want to limit the samples that appear in the table to a 
particular time period, select dates in the [Inspected from] and 
[Inspected to] fields. 

3. If you want to restrict the samples that appear in the table using 
the data in particular sample information fields, use the entries in 
the [Select a field] lists. 

4. You can select the [Part] entry, for example. The list to the right of it 
contains all of the parts that you entered on the [Edit Settings] 
page of the [Inspect Sample] workflow. 

5. Click the [Apply Filter] button to apply the filters.
 The [Available samples] table now only shows the samples that 

meet the filter criteria.
6. Click the [Close] button to save the filter.
 The filter remains defined until you delete it using the [Clear 

Filter] button in the [Filter settings] dialog box.
7. You can activate and deactivate the filter at any time by clicking the 

[Filter] button on the [Review Results] > [Select Sample] page.

If the check box in the [Compressed] column is selected, then the image data 
for this sample has been compressed. You can view the results of the 
inspection but you can't edit the individual particles any more. 
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8.2 [Review Results] > [Review Sample]
You can find the help topic for this page on page 56 of the [Inspect 
Sample] > [Review Sample] > [Particle View] chapter.
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8.3 [Review Results] > [Create Report]
You can find the help topic for this page on page 126 of the [Create 
Report] chapter.
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9 [Create Report]
On these pages, the results of a sample inspection can be compiled 
into a report and output into a Word document or to a PDF document.

9.1 [Create Report] > [Select Sample]

1 The [Available samples] list contains all of the samples that have been 
inspected. Information is displayed for each sample, for example the date it 
was created and the number of reports that were created for the sample.

1 The available samples can be filtered by particular criteria, parts for example. 
Clicking the [Filter] button activates or deactivates the filter that is currently 
defined. 

1 Clicking the [Filter Settings] button opens a dialog box in which you can 
define a filter for the available samples.

2 The [Available reports] list contains all of the reports that have been saved for 
a sample. Information is displayed for each report, for example the date it was 
created and the report template that was used.
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9.1.1 Selecting a sample
Select the sample for which you want to create a report or open an 
existing report on this page.
Selecting a sample and creating a report

1. Select a sample in the [Available samples] list. 
2. Click the [Create Report] button.
 The [Create Report] page opens. 
 You can find more information about this page on page 126 of 

the [Create Report] chapter.
Opening an existing report

1. Select a sample in the [Available samples] list. 
2. Select a report in the [Available Reports] list.
3. Click the [Open Report] button.
 The report opens.

Defining and using filters
If you have already saved a lot of samples, you can use a filter to limit 
the selection in the [Available samples] table.

1. Click the [Filter Settings] button. 
 The [Filter settings] dialog box opens.

2. If you want to limit the samples that appear in the table to a 
particular time period, select dates in the [Inspected from] and 
[Inspected to] fields. 

3. If you want to restrict the samples that appear in the table using 
the data in particular sample information fields, use the entries in 
the [Select a field] lists.

3 Clicking the [Create Report] button opens the [Create Report] page where 
you can select a report template and a standard before creating a report.

3 The [Open Report] button is only active if one of the samples in the [Available 
Reports] list already has a report. Clicking the [Open Report] button opens 
the selected report.
123 OLYMPUS Cleanliness Inspector CIX ASW 1.5



9  [Create Report]
[Create Report] > [Select Sample]
4. You can select the [Part] entry, for example. The list to the right of it 
contains all of the parts that you entered on the [Edit Settings] 
page of the [Inspect Sample] workflow. 

5. Click the [Apply Filter] button to apply the filters.
 The [Available samples] table now only shows the samples that 

meet the filter criteria.
6. Click the [Close] button to save the filter.
 The filter remains defined until you delete it using the [Clear 

Filter] button in the [Filter settings] dialog box.
7. You can activate and deactivate the filter at any time by clicking the 

[Filter] button on the [Create Report] > [Select Sample] page.
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9.2 [Create Report]

1 The [Available report templates] list contains all of the  report templates 
that are available.

2 The [Available standards] list contains all of the standards that can be used for 
analyzing particles in a report.

3 Clicking the [Create Report] button creates a report. Depending on which 
option you select, either a Word or a PDF document is created.
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9.2.1 Creating a report
On this page, you conclude the inspection of the sample with the 
creation of a report. A report contains all of the measurement results 
and data for a sample in a standardized form. A report can also contain 
images of the largest particles or the  overview image of the sample. 
If the data resulting from the inspection of the sample is saved, it can be 
output to a report at a later point in time. 

Prerequisite  Microsoft Word and Adobe Acrobat Reader have been installed on 
your computer.

You can access the [Create Report] page from various pages. It's 
possible that the [Select Sample] button in the navigation bar isn't 
available because a sample has already been selected, making this step 
unnecessary.

1. Select a  report template in the [Available report templates] list.
2. In the [Available standards] list, select the standard you want the 

report to use for the analysis of the particles. 
3. Select an output format for the report:
 Select the [Microsoft Word] option if you want the report to be a 

Word document.
 Select the [PDF] option if you want the report to be a PDF 

document. 
4. Click the [Create Report] button.
5. Enter a name for the report in the message box and confirm with 

[OK].
 The report is created and then displayed on the monitor.
 The software saves the report. You can access all of the reports 

that have been saved on the [Manage Data] page.
 You can change the report in Microsoft Word later. 

Edit the report template if you want to customize the format and 
the information contained in a report for all subsequent reports.
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9.3 Displaying and editing reports in Microsoft Word
You can edit a report in Microsoft Word retroactively, you can add text 
for example. Changes made to a report don't affect the  report 
template. 
When your software is installed, an add-in from OLYMPUS is added to 
the Microsoft Word application program. When you open a report in 
Microsoft Word, the [Olympus] tab is displayed. This add-in makes the 
following functions available in a report. 

9.3.1 Saving a report
Clicking the [Save] button in Microsoft Word saves the changes made 
to a report. You can access reports from the [Create Report] > [Select 
Sample] page or from the [Manage Data] page.

9.3.2 Saving as a new report
You can keep the original report and save the changed report under a 
new name.

1. Click the [Save as new] button.
 The [New Report] dialog box opens.

2. In the [New Report] input field, enter a name for the new report. 
3. Click the [OK] button to save the new report. 
4. Close Microsoft Word. 
 You can access the new report from the [Create Report] > 

[Select Sample] page or from the [Manage Data] page.

9.3.3 Olympus Help
Clicking the [Olympus Help] button opens this help document.
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10 [Manage Data]
On these pages, you can manage and archive or compress all of the 
sample information and reports that have been saved.

1 [Available 
samples]

The [Available samples] table contains all of the samples for which data was 
saved. Information is displayed for each sample, for example the date of the 
inspection and the number of saved reports.

1 Click the [Export to Excel] button to export the table with the available 
samples into an MS-Excel file.

1 The available samples can be filtered by particular criteria, parts for example. 
Clicking the [Filter] button activates or deactivates the filter that is currently 
defined.

1 Clicking the [Filter Settings] button opens a dialog box in which you can 
define a filter for the available samples. 

2 This area contains information about the selected sample, for example the 
inspection configuration that was used, the sample ID and additional 
comments.
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10.1 Managing Data
The [Manage Data] page gives you an overview of all of the sample 
information and reports that have been saved. On this page, you can 
manage the data. You can delete and compress samples or correct 
specific sample information. If you want to free up storage capacity on 
the computer, you can archive a sample’s image data. This saves the 
image data to an external storage device or to a particular directory on 
a network.
Defining and using filters
If you have already saved a lot of samples, you can use a filter to limit 
the selection in the [Available samples] table.

1. Click the [Filter Settings] button. 
 The [Filter settings] dialog box opens.

3 [Available reports] The [Available reports] group contains all of the reports that have been saved 
for the selected sample.

3 Clicking the [Open Report] button opens the selected report.

3 Clicking the [Delete Report] button deletes the selected report.

3 Click the [Export to Excel] button to export the table with the available reports 
for a sample into an MS-Excel file.

4 Clicking the [Opening the sample information] button opens the sample 
information that was saved for a sample.
Clicking the [Compressing samples] button compresses the image data in a 
sample analysis.
Clicking the [Archiving samples] button saves the image data for a sample on 
an external drive or on a network.
Clicking the [Restoring samples] button opens an overview of all of the 
archived samples. These archived samples can be restored.
Clicking the [Settings] button opens the [Manage Data] > [Settings] page. On 
this page, you can select the directory used to archive or restore a sample.
Clicking the [Deleting the sample] button deletes a sample and all of its 
associated data and reports.
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2. If you want to limit the samples that appear in the table to a 
particular time period, select dates in the [Inspected from] and 
[Inspected to] fields. 

3. If you want to restrict the samples that appear in the table using 
the data in particular sample information fields, use the entries in 
the [Select a field] lists. 

4. You can select the [Part] entry, for example. The list to the right of it 
contains all of the parts that you entered on the [Edit Settings] 
page of the [Inspect Sample] workflow. 

5. Click the [Apply Filter] button to apply the filters.
 The [Available samples] table now only shows the samples that 

meet the filter criteria.
6. Click the [Close] button to save the filter.
 The filter remains defined until you delete it using the [Clear 

Filter] button in the [Filter settings] dialog box.
7. You can activate and deactivate the filter at any time by clicking the 

[Filter] button on the [Manage Data] page.

Opening a report
1. Select the required sample in the [Available samples] table.
 The [Available reports] table displays all of the reports that have 

been saved for a sample. 
2. Select the report that you want to open. 
 You can use the arrows next to the column headers to sort the 

entries.
 The icon at the end of the row indicates whether the report was 

saved as a Word or as a PDF document.
3. Click the [Open Report] button.
 The report is opened either in Microsoft Word or in Adobe 

Acrobat Reader.
Deleting a report

1. Select the required sample in the [Available samples] table.
2. Select the report that you want to delete in the [Available reports] 

table.
3. Click the [Delete Report] button.
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 The report is deleted and removed from the [Available reports] 
list.

Opening the sample information
1. Select the required sample in the [Available samples] table.
2. Click the [Open Sample Information] button.
 The fields that you specified on the [Sample Information Fields] 

page and the data saved during the inspection are displayed. 

3. Change or supplement the required entries in the editable sample 
information fields.
 If you want to save the changes, click the [Close] button.
 In the message, click the [Yes] button.
 The sample results are re-computed.

Compressing samples
The [Compress Sample...] function compresses the image data that is 
saved for a sample analysis and thereby saves storage capacity. 
Reducing the file size means that the particles can't be edited 
anymore. Nevertheless, all of the other data from the sample analysis 
and the reports remains available. Reports can still be created from the 
compressed data.

1. Select the required sample in the [Available samples] table.
2. Click the [Compress Samples] button.
3. Confirm with [Yes].
 The compressed sample is identified with a check in the 

[Compressed] column. 

Archiving samples
The [Archive Samples] function archives a sample’s data to an external 
storage device or to a particular directory on a network. Archived 
samples are no longer available immediately in the software. They first 
have to be restored using the [Restore Samples].

When you change sample information, the sample results are re-computed. 
Existing reports aren't automatically updated with the new sample information 
and may therefore become invalid. 
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1. Check in the settings whether the directory to which you want to 
archive the data is selected. To do this, click the [Settings] button. 
You can find more information on page 136 of the [Manage Data] 
> [Settings] chapter.

2. Select one or more samples in the [Available samples] table.
3. Click the [Archive Samples...] button. 
 The data is moved to the storage location you selected.

Restoring samples
You can find more information on page 136 of the [Manage Data] > 
[Restore Samples] chapter.

Deleting the sample

1. Select the sample that you want to permanently delete in the 
[Available samples] table.

2. Click the [Delete Sample] button.
3. Confirm with [Yes].
 The selected sample is deleted.
 All of the reports associated with the sample are deleted.
 The sample is removed from the [Available samples] table.

When you delete a sample, all of the reports associated with it are also 
deleted.
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10.2 [Manage Data] > [Settings]
You can manage the volumes on this page. Volumes are external 
storage devices or directories on a network that can be used to archive 
or restore a sample’s image data.

1 [Available 
volumes]

The [Available volumes] list contains all of the volumes that have already been 
defined, an external storage device or a directory on a network for example. 
The image data will be archived to the selected volume. The [Restore 
Samples] function restores the image data from the currently selected 
volume. 

2 Clicking the [New Volume] button opens MS-Windows Explorer. You can use 
MS-Windows Explorer to select a new drive or directory to archive data to.

3 Clicking the [Find volume again] button opens MS-Windows Explorer. If a 
directory or an external storage device has been moved or renamed, you can 
use MS-Windows Explorer to navigate to the new directory and update the 
path.
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10.2.1 Editing the settings
Adding a volume

1. Click the [New Volume] button.
 MS-Windows Explorer opens.

2. Select the folder to which you want to archive the image data.
3. The path to this folder is added to the [Available volumes] list. 
4. Select the required volume in the [Active] column. 
 This volume will be used for archiving and restoring image data.

Updating the path for a volume
The [Find Volume Again] function updates the path for a volume when 
image data has been moved or renamed.

1. In the [Available volumes] list, select the volume that you want to 
update. 
 When a volume is selected it is highlighted in blue.

2. Click the [Find Volume Again] button.
 MS-Windows Explorer opens.

3. Use MS-Windows Explorer to navigate to the directory where the 
archived image data is located. 

4. Click the [OK] button.
 The updated path is saved. 
 The [Available volumes] list displays the updated path.

4 Clicking the [Delete Volume] button deletes the selected volume, which is 
highlighted in blue. Sample information that is archived in this directory will 
be permanently deleted.
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10.3 [Manage Data] > [Restore Samples]
The [Restore samples] function moves sample data back to your 
computer’s drive to make it available in the software again.

Restoring samples
Prerequisite  The [Restore Samples] button on the [Manage Data] page is active 

when a volume has been selected on the [Manage Data] > 
[Settings] page.

1. On the [Manage Data] > [Settings] page, check whether the 
directory to which you want to archive the data is selected. To do 

1 [Available 
samples]

All archived samples in the currently selected volume are listed in the 
[Available samples] list. This list can be filtered with the settings in the [Filter 
by] group.

2 [Filter by] In the [Filter by] group, you define the filters that select the samples in the 
[Available samples] list according to particular criteria.
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this, click the [Settings] button. You can find more information on 
page 136 of the [Manage Data] > [Settings] chapter.

2. Click the [Restore Samples] button.
 The [Manage Data] > [Restore Samples] page opens.
 All archived samples are listed in the [Available samples] list.

3. Use the fields in the [Filter by] group to filter the sample data by 
particular criteria. 
 For example, you can enter dates in the [Created from] and 

[Created to] fields to show only the samples that were inspected 
within a particular period of time. 

 Click the [Apply Filter] button to apply the filters.
 Click the [Clear Filter] button to remove the filters. All of the 

archived samples for the volume that is currently selected in the 
settings are shown. You can find more information about the 
settings on page 136 of the [Manage Data] > [Settings] chapter.

4. In the [Available samples] list, select one or more samples that you 
want to restore. 

5. Click the [Restore] button. 
6. Confirm with [Yes].
 The sample data is restored and is available in the software 

again.
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11 [Create Statistics]
On these pages, you select the samples whose sample information you 
want to use to create charts and tables that you can then analyze 
statistically.

1 This list displays the samples that were inspected with the standard that is 
currently selected in the [Standard] list. These samples are available for use in 
an analysis.

2 The samples whose image data has been archived are identified with a check 
mark in the [Archived] column. Archived and compressed samples can also 
be analyzed statistically

3 The [Standard] list contains all of the standards that were used to inspect the 
sample and whose results were then saved.

4 The [Filter by] group contains several filters that you can use to filter the 
samples in the list on the left side by particular criteria.

5 Clicking the [Export Data] button opens MS-Windows Explorer so that you 
can export the sample information for the selected samples into different file 
formats.
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11.1 [Create Statistics] > [Select Samples]
On this page you can select one or more samples that you want to 
display in a chart or table. The sample information can either be 
displayed within the software or it can be exported into a particular file 
format. 
Use the filter functions to filter the sample by particular criteria to limit 
the selection.

Prerequisite  An analysis requires sample information from at least two 
samples. The samples have to have been inspected with the same 
standard.

Selecting samples
1. The [Standard] list contains all of the standards for which the results 

of a sample inspection were saved. Select the standard for which 
you want to create the analysis. 
 The list of available samples is updated. Only the samples for the 

standard that is selected are displayed.
2. In the list of available samples, select the samples that you want to 

analyze. To do this, select the check box next to the sample ID. 
Filtering samples 3. Use the filter functions in the [Filter by] group if you want to limit 

the number of samples. Select dates in the [Inspected from] and 
[Inspected to] fields to limit the selection to a particular time 
period. 

4. You can limit the selection to particular sample information fields. 
To do this, use the entries in the [Select a field] lists.

5. Click the [Apply Filter] button to apply the filters. You can reset the 
filters using the [Clear Filter] button.

Exporting data
1. Click the [Export Data] button to export a table of the results for the 

selected samples into a separate file. You can select from the 
following file formats:

5 Clicking the [Display Data] button opens the [Create Statistics] > [Display 
Data] page. You can select different views to display the results on this page. 
You can find more information about this page on page 144 of the [Create 
Statistics] > [Display Data] chapter.
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 CSV
 XLSX
 DFG (Q-DAS ASCII-File-Format). Contamination classes can not 

be exported in this format. Only the absolute number of particles 
can be exported in this format.

2. In MS-Windows Explorer, select the drive and the directory in 
which you want to save this document.

Displaying data
1. Click the [Display Data] button to display the information in a chart 

or a table within the CIX ASW Software.
 The [Create Statistics] > [Display Data] page opens. 
 You can find more information about this page on page 144 of 

the [Create Statistics] > [Display Data] chapter.
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11.2 [Create Statistics] > [Display Data]

1 The [Chart] tab displays the results graphically.
The unit of the Y-axis correlates to the unit of the overall result. This is 
specified by the standard. In this example, the unit of measure for the Y-axis is 
 [contamination class].
The [Table] tab displays the results in a table.

2 You can use the slide controls to change the part of the chart that is 
displayed. You can use them to display only certain samples or a particular 
time period in the chart, for example. Alternatively, you can enlarge or reduce 
the size of the chart using the mouse wheel. You can click anywhere on the 
chart and drag the chart backwards and forwards or up and down in the 
display area.

3 The [Particle classes] table contains the standard and the size ranges for the 
particle classes as defined by the standard. You can show or hide a particle 
class in the chart by clicking its check box.

3 Each particle class is assigned a different color. You can change a particle 
class’ color. Clicking the one of the color buttons opens a list of the other 
available colors.
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3 If the [Date-Based X-Axis] button has been activated, the [Particle classes] 
table contains the [Marker] column. The symbols mark the mean value for this 
particle class over all of the samples analyzed on a particular day.

4 [Display approval 
maxima]

When the [Display approval maxima] check box is selected, a particle class’ 
approval threshold is indicated by a line of long dashes in the chart. The 
approval threshold defines a parameter that must not be exceeded during 
the inspection. The color of the line corresponds to the color of the particle 
class. 

4 [Display means] When the [Display means] check box is selected a particle class’ mean is 
indicated by a line of short dashes in the chart. The color of the line 
corresponds to the color of the particle class.
If the overall result for the standard is expressed in contamination classes, the 
mean is calculated from either the normalized, from the extrapolated, or from 
the absolute number of particles. These values are then converted into 
contamination classes. 

5 Clicking the [Zoom to Fit] button adjusts the size of the chart so that all of the 
sample information is displayed within the display area.

5 Clicking the [Copy Chart to Clipboard] button copies an image of the chart as 
it is currently displayed to the clipboard. You can paste the image to a 
Microsoft Word or Microsoft Power Point document using the [Ctrl+V] 
keyboard shortcut.

The following buttons change the way the chart is displayed.
5 Clicking the [Infobox] button displays an infobox and a vertical line in the 

chart. The vertical line determines the current value of the unit of measure at 
each intersection with the lines that represent the number of particles. The 
line can be moved over the chart and snaps to the nearest sample. The 
information in the infobox is constantly refreshed.
For example, depending on the standard being used either the number of 
particles or the contamination class at this position will be displayed. If the 
[Date-Based X-Axis] button is active, the infobox displays the mean value of 
the inspections for that particular day. 

5 The [Linear Y-Axis] button displays the Y-axis linearly. 

5 The [Logarithmic Y-Axis] button displays the Y-axis logarithmically. Displaying 
the chart this way ensures that smaller values are displayed even when the 
sample has large variations in size. 
This function isn’t available when the samples are classified by contamination 
class. 
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11.3 Displaying Data
The [Display Data] page opens when you click the [Display Data] button 
on the [Create Statistics] > [Select Samples] page. This page displays 
the results on the [Chart] or [Table] tabs. You can view the results of the 
analysis as a chart or as a table by switching between the tabs.
[Chart] tab
When you have selected the [Chart] tab, the unit of measure defined by 
the standard is plotted against the number of samples in the display 
area or against the date of the inspection. In the [Particle classes] table, 
you can deselect the particle classes that you don’t want to display in 
the chart. 
Use the buttons on the right-hand side to change the appearance of 
the chart.

1. Choose between displaying the Y-axis linearly or logarithmically.
 With a logarithmic representation, very small Y-values will be 

shown on a relatively larger scale while greater Y-values will be 
relatively reduced in scale.

 The Y-axis can not be displayed logarithmically if the samples 
are classified by contamination class.

2. Click the [Infobox] button to show an infobox containing 
information about each particle class. 

5 The [Sample-Based X-Axis] button displays the number of samples on the X-
axis. Each sample that was selected on the [Create Statistics] > [Select 
Samples] page is given a number.

5 The [Date-Based X-Axis] button displays the time period during which the 
samples were inspected in the X-axis. The date is used as the unit of measure 
for the X-axis. 

6 [Export Chart...] When the [Chart] tab is selected, the [Export Chart...] button is shown. 
Clicking the button opens MS-Windows Explorer to export the chart as it 
currently appears into an image. 

6 [Export Table...] When the [Table] tab is selected, the [Export Table...] button is shown. Clicking 
the button opens MS-Windows Explorer to export the table as it currently 
appears into various file formats. 
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 A vertical line appears in the chart. When you hover the mouse 
over the vertical line the mouse pointer turns into a double 
arrow. Press and hold the left mouse button to drag the line to 
the required sample or to the required date. The infobox 
constantly refreshes the information for each particle class. 

 The number of particles is displayed in the infobox in the same 
units that the standard specifies for the output of the results. If 
for example, the standard specifies classification by 
contamination, the  contamination class for each position will 
be shown in the infobox.

 If the [Date-Based X-Axis] button is active, the infobox displays 
the mean value of the inspections for that particular day.

Date display 3. Click the [Date-Based X-Axis] button to display the date as the unit 
of measure on the X-axis. 
 The X-axis displays the time period during which the samples 

were inspected.
 The sample information is sorted by date. The chart displays all 

of the sample information for each date. If from more than one 
lot of sample information was saved on a particular day, the 
highest value (1) and the lowest value (2) for each particle class is 
indicated by a horizontal line. The mean value (3) is indicated by 
a symbol.

4. Click the [Copy Chart to Clipboard] button to make an image of 
the chart as it is currently displayed. The image is copied onto the 
clipboard. You can insert the image into a different program, a 
Microsoft Power Point file for example, using the [Ctrl+V] keyboard 
shortcut.

5. Click the [Zoom to Fit] button to display all of the sample 
information in the display area. 

Exporting a chart 6. Click the [Export Chart...] button to export the chart into a separate 
file. You can select from the following file formats:
 PNG
 JPEG
 BMP

7. In MS-Windows Explorer, select the drive and the directory in 
which you want to save this chart.

1

2

3
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[Table] tab
When you select the [Table] tab, all of the selected samples are listed in 
a table. The table contains the sample ID, the date of inspection, and 
the individual particle class results for each sample that was analyzed. 
The results are classified in the table as specified by the standard. For 
example, if the standard specifies for the results to be normalized, the 
results table will contain the normalized count of particles. 
In the [Particle classes] table, you can deselect the particle classes that 
you don’t want to display in the table. 

Exporting a table 1. If required, in the [Particle classes] table, deselect the check boxes 
for the particle classes that you don’t want to export into the table. 

2. Click the [Export Table...] button to export the table into a separate 
file. You can select from the following file formats:
 CSV
 XLSX
 DFG (Q-DAS ASCII-File-Format). Contamination classes can not 

be exported in this format. Only the absolute number of particles 
can be exported in this format.

3. In MS-Windows Explorer, select the drive and the directory in 
which you want to save the table.
 In addition to the classification table with the results for the 

individual particle classes, the sample information that was 
defined by the filter on the [Create Statistics] > [Select Samples] 
page is output to the file. 
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12 [Inspection Configurations]
The  inspection configurations are defined in these configuration 
pages.

12.1 [Inspection Configurations]

1 The [Available inspection configurations] list contains all of the  inspection 
configurations that are available in the software. It also tells you the date that 
the inspection configuration was last modified. The [Type] column tells you 
whether the inspection configuration is predefined by the system or whether 
it has been created by a user. You can activate or deactivate inspection 
configurations in the [Active] column. If the check box for an inspection 
configuration is clear, this workflow is not available in the [Inspect Sample] > 
[Select Inspection Configuration] workflow.

2 This display field contains a description of the selected inspection 
configuration.
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12.1.1 Editing an inspection configuration
An  inspection configuration defines which parameters are used to 
inspect a sample. Several predefined inspection configurations that can 
be used to inspect the sample are available in the OLYMPUS 
Cleanliness Inspector Software. If necessary, you can customize an 
inspection configuration to your company's own standards or define a 
new inspection configuration.

You can access various related configuration pages using the buttons 
on the navigation bar on the [Inspection Configuration] page. Changes 

3 An inspection configuration is made up of the parameters of a standard plus 
additional parameters contained in the following configuration pages: 
[Inspection Configurations], [Standards], [Particle Families] and [Particle 
Types]. Clicking a button on the navigation bar opens the corresponding 
configuration page. A button highlighted in blue identifies the configuration 
page that is currently open.

4 Clicking the [Open] button opens the configuration page for the selected 
inspection configuration.
Clicking the [New] button opens the configuration page where you can create 
a new inspection configuration.
Clicking the [Duplicate] button copies the selected inspection configuration 
and opens the configuration page.
Clicking the [Delete...] button deletes the selected inspection configuration. 
Inspection configurations with the status [System] have been predefined by 
the system and can't be deleted.

5 Clicking the [Home] button closes the [Inspection Configuration] page. The 
start page opens.

Changing a predefined inspection configuration, however, can mean that the 
cleanliness analysis no longer complies with the standards. 
It's not possible to automatically restore an inspection configuration's original 
values after the settings have been changed and saved. 
If you want to change an inspection configuration's parameters, duplicate the 
inspection configuration and save it under a different name before editing it.

Changes made to an inspection configuration apply to all subsequent 
inspections. The results of inspections that have already been performed 
remain unchanged.
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made to these configurations effect all of the inspection configurations 
that use these parameters.
Selecting a configuration page
To view or edit parameters on a different configuration page, click the 
corresponding button on the navigation bar.
• Clicking the [Inspection Configurations] button opens the 

configuration pages where you can specify settings for the inspection 
configurations.

• Clicking the [Standards] button opens the configuration page where 
you can specify settings for the standards.

• Clicking the [Particle Families] button opens the configuration page 
where you can specify settings for the particle families.

• Clicking the [Particle Types] button opens the configuration page 
where you can specify settings for the particle types.

Opening and editing inspection configurations
1. Select an inspection configuration in the [Available inspection 

configurations] list. 
 You can use the arrows next to the column headers to sort the 

entries. You can filter the entries in the list by a particular term as 
well. To do this, enter the term in the [Filter by] field.

 A brief description of the selected inspection configuration and 
some of its parameters are displayed in the display field to the 
right of the [Available inspection configurations] list. For 
example, the magnification at which the inspection of the sample 
is performed and the standard that is specified by the inspection 
configuration for the analysis of the sample are displayed. 

2. Click the [Open] button.
 The inspection configuration opens and can now be edited.
 You can find more information on page 154 of the [Inspection 

Configurations] > [Open] (Page 1 of 2) chapter.

Creating a new inspection configuration
1. Click the [New] button.
 The Editing inspection configurations > [Open] (Page 1 of 2) 

page opens.
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2. Enter a name for your new inspection configuration in the [Name] 
field.

3. Edit the inspection configuration on the following configuration 
pages.
 You can find more information on page 154 of the [Inspection 

Configurations] > [Open] (Page 1 of 2) chapter.

Duplicating an inspection configuration
1. Select an inspection configuration in the [Available inspection 

configurations] list. 
2. Click the [Duplicate] button.
 The selected inspection configuration is copied.

3. Edit the inspection configuration on the following pages.
 You can find more information about this on page 154 of the 

[Inspection Configurations] > [Open] (Page 1 of 2) chapter.
4. Enter a new name for your inspection configuration in the [Name] 

field.

Deleting the inspection configuration

1. Select a user-defined inspection configuration in the [Available 
inspection configurations] list. 

2. Click the [Delete...] button.
 The selected inspection configuration is deleted.

Inspection configurations with the status [System] have been predefined by the 
system and can't be deleted.

Deleting a user-defined inspection configuration doesn't affect the result of 
sample inspections and reports that have already been saved.
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12.1.2 [Inspection Configurations] > [Open] (Page 1 of 2)

1 The [Name] field contains the name of the inspection configuration. The 
inspection configuration is by default given the name of the standard that has 
been selected. The [Description] field contains a short description of the 
selected inspection configuration.

2 The [Standard] list contains all of the standards that are available in the 
software. One standard is always selected.

3 The list contains the particle types that have been defined on the [Particle 
Types] configuration page. 

4 The [Available particle measurements] list contains all of the measurement 
parameters that can be applied during the sample inspection.
The [Visible in Particle Table] list contains all of the measurement parameters 
that were selected in the [Available particle measurements] list and added to 
the table. Only the measurement parameters that are in this list will be 
displayed in the particle table with the inspection results. They will each be 
displayed in their own row in the particle table.
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12.1.3 Editing inspection configurations > [Open] (Page 1 of 2)
Editing the name and description
The [Name] field contains the name of the inspection configuration that 
you selected. You'll find the inspection configuration under this name in 
the [Inspect Sample] workflow. If you have created a new inspection 
configuration, or duplicated an existing one you can change its name in 
this field.
The [Description] field contains a short description of the selected 
inspection configuration. The [Description] field is editable. For user 
defined inspection configurations, the field is empty and you can add 
your own description.

Selecting a standard
The [Standard] list contains all of the available standards. They are 
either predefined by the system or have been created by a user. One 
standard is always selected in the list, no more and no less. The [Type] 
column tells you whether the norm is predefined by the system or is 
user-defined.
To emphasize which standard is being used to analyze a sample, the 
inspection configurations that are predefined by the system are given 
the name of the standard they employ. The standard that is mentioned 
in the name of the inspection configuration is selected in the [Standard] 
list by default. 

Example If you have selected the ISO 16232-10 2007 (V) inspection configuration, 
the ISO 16232-10 2007 (V) standard is selected by default in the 
[Standard] list. 
You can view and, if required, change the parameters for each standard 
in the [Inspection Configurations] > [Standards] configuration page. 
You can find more information on page 170 of the [Inspection 
Configurations] > [Standards] > [Open] chapter.
If you don't want to analyze the sample with the default standard, we 
recommend that you duplicate the inspection configuration and save it 
under a different name before editing it. 
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Selecting a particle type
The [Particle types] list contains the  particle types that have been 
defined on the [Particle Types] configuration page. Clicking the icon 
next to a particle type opens a quick info with a definition of the 
parameters that have been specified. The [Type] column tells you 
whether the particle type is predefined by the system or is user-defined.

1. In the [Particle types] list, select one or more particle types that you 
want the inspection to detect. 
 The particle types can be selected for display in the particle table 

using the [Particle Type] list on the [Inspect Sample] > [Review 
Sample] page.

Selecting measurement parameters
Some standards specify which measurement parameters are used for 
the inspection of the sample. These measurement parameters are 
automatically stored in each standard and are displayed with the 
results. You can specify additional measurement parameters to be 
displayed in the results tables. 

1. Select a measurement parameter in the [Available particle 
measurements] list. 

2. After making your selection, click the [Add to Particle Table] button.
 The measurement parameters are added to the [Visible in 

Particle Table] list and are saved in the inspection configuration.
3. If necessary, select more measurement parameters and add them 

to the [Visible in Particle Table] list by clicking the [Add to Particle 
Table] button.
 The results for the selected measurement parameters will each 

be displayed in their own column in the inspection results. 

Opening the other configuration page 
1. Click the [Next >] button.
 The next configuration page opens. You can find more 

information about this page on page 158 of the [Inspection 
Configurations] > [Open] (Page 2 of 2) chapter. 
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12.1.4 [Inspection Configurations] > [Open] (Page 2 of 2)

1 [Inspection mode] The [Dark Particles on Bright Background] button activates the inspection 
mode that detects dark particles on a bright background.
The [Bright Particles on Dark Background] button activates the inspection 
mode that detects bright particles on a dark background.

1 [Objective] The buttons in the [Objective] display field show the objectives that are 
selectable for the inspection of the sample.

1 [Exposure time 
mode]

The entry in the [Exposure time] list determines whether the  exposure time 
is determined manually, automatically, or by a fixed value.

1 [Inspection area 
diameter]

The entries in the [Inspection area diameter] list determine whether the 
diameter of the inspection area is specified in the inspection configuration or 
whether the diameter can be set manually before the inspection.

2 [Threshold mode 
for particles]

The entry in the [Threshold mode for particles] list determines whether the  
threshold is determined manually, automatically, or by a fixed value.

2 [Threshold mode 
for reflecting 
particles]

The entry in the [Threshold mode for reflecting particles] list determines 
whether the  threshold for reflecting particles is determined manually or by 
a fixed value. 
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12.1.5 Editing inspection configurations > [Open] (Page 2 of 2)
Editing acquisition settings

1. Specify an inspection mode for the inspection configuration.
 Use the [Dark Particles on Bright Background] inspection mode 

when the sample has dark particles on a bright filter 
background.

2 [Border particles] These buttons determine how the particles on the borders of the inspection 
area are incorporated into the results.

2 [Fill holes] These settings determine how holes inside a particle are treated. Holes are 
joined up intensity ranges that are located completely inside a particle, but 
that don't belong to the particle. The way holes are handled affects the 
particle surface that is measured, among other things.

2 [Measure filter 
occupancy]

This setting determines whether the  filter occupancy is checked by the 
inspection. The percentage in the [Occupancy Warning Limit] field 
determines the maximum permissible occupancy for the inspection area.

2 [Minimal 
observable 
particle size]

The smallest particle size that the software can detect is determined by the 
system’s hardware components. If the particle classes in a norm are specified 
below this value, an error message appears.

3 [Focus mode] The entries in the [Focus mode] list determine the mode that is used to focus 
the sample. You can select between a  focus map, the current Z-position, 
or focusing on every frame.

3 [Focus point 
density]

The [Focus point density] list is only active when you have selected a focus 
map in the [Focus mode] list. 
The entry in the [Focus point density] list determines how the focus points are 
arranged on the focus map.

3 [Allow editing 
focus options]

This setting determines whether the focus point density and the focus mode 
can still be changed in the [Inspect Sample] workflow. 

3 [Focus points 
warning limit]

The [Focus points warning limit] field is only active when you have selected a 
focus map in the [Focus mode] list.
The percentage in the [Focus points warning limit] field specifies the 
maximum percentage of focus points that are permitted to be incorrectly 
focused during a sample inspection. If this percentage is exceeded, a warning 
appears.

3 [Acoustic signals] These settings specify whether an acoustic signal should sound when the 
result of an inspection is [NOK] or when an inspection finishes.
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 Use the [Bright Particles on Dark Background] inspection mode 
when the sample has bright particles on a dark filter 
background.

2. Click the button with the objective that you want to use for the 
inspection of the sample.

3. In the [Exposure Time Mode] list, select between the [Automatic] 
entry, the [Manual] entry, and the [Fixed] entry.
 A manual exposure time allows you to set any exposure time 

you want in the [Inspect Sample] > [Edit Settings] workflow. You 
can find more information about this on page 40 of the 
Exposure time and threshold for particles chapter.

 With automatic exposure time, the system computes the optimal 
exposure time to produce an evenly illuminated image.

 When you select the [Fixed] entry you specify the exposure time 
for the inspection configuration. Enter the required exposure 
time in milliseconds in the field. The inspection will use this value 
and it can’t be changed in the [Inspect Sample] > [Edit Settings] 
workflow.

4. In the [Inspection area diameter] list, select between the [Manual] 
entry and the [Fixed] entry.
 In the [Inspection area diameter] list, the [Manual] entry is 

selected by default. The diameter of the inspection area is 
42.50 mm by default. If you choose to set the inspection area 
manually, you can do so in the inspection settings in the [Inspect 
Sample] workflow.

 Certain standards specify the size of the inspection area. If you 
want to specify the size of the inspection area, select the [Fixed] 
entry. Enter the required diameter in the [Inspection area 
diameter] field.

Editing detection settings
The software has several different ways of setting the thresholds.

1. In the [Threshold mode for particles] list, select between the 
following entries.
 [Auto]: With automatic  threshold value setting, the system 

computes the optimal threshold.
 [Auto (%)]: With automatic  threshold value setting by per 

cent, you can enter a percentage in the inspection configuration 
160OLYMPUS Cleanliness Inspector CIX ASW 1.5



12  [Inspection Configurations]
[Inspection Configurations]
to be used for setting thresholds. This value is set in relation to 
the position of the highest peak in the histogram. The highest 
peak in the histogram corresponds to the background of the 
filter.
The inspection will use the value entered in the field. It can’t be 
changed in the [Inspect Sample] > [Edit Settings] workflow.

 [Manual (%)]: With  manual threshold value setting by per 
cent, you can enter a percentage in the inspection configuration 
to be used for setting thresholds. This value is set in relation to 
the position of the highest peak in the histogram. The highest 
peak in the histogram corresponds to the background of the 
filter.
This value is adopted in the [Inspect Sample] > [Edit Settings] 
workflow but you can still adjust the threshold value manually 
there.

 [Manual]: Setting  threshold values manually allows you to set 
any threshold you want in the [Inspect Sample] > [Edit Settings] 
workflow. A threshold value is still suggested automatically. It 
can, however, be changed manually. You can find more 
information on page 40 of the Exposure time and threshold for 
particles chapter.

 [Fixed]: When you select the [Fixed] entry you specify the 
threshold value in the inspection configuration. The inspection 
will use this value and it can’t be changed in the [Inspect Sample] 
> [Edit Settings] workflow.

2. In the [Threshold mode for reflecting particles] list, select between 
the following entries. 
 [Manual]: Setting threshold values manually allows you to set 

any threshold for reflecting particles you want in the [Inspect 
Sample] > [Edit Settings] workflow. You can find more 
information about this on page 44 of the Threshold for reflecting 
particles chapter.

 [Fixed]: When you select the [Fixed] entry you specify the 
threshold value in the inspection configuration. The inspection 
will use this value and it can’t be changed in the [Inspect Sample] 
> [Edit Settings] workflow.

3. Determine how the particles on the borders of the inspection area 
are incorporated into the measurement. To do this, click either the 
[Exclude] or the [Truncate] button in the [Border particles] field.
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 When the [Exclude] button is activated, every particle on the 
border of the inspection area is excluded from the analysis.

The border particles are excluded from the analysis.

 When the [Truncate] button is activated, every particle on the 
border of the inspection area is truncated. Only the area of the 
truncated particle that is inside the border is included in the 
analysis. The areas outside the border are excluded from the 
measurement.

The border particles are truncated. Only the area of the truncated particle that is inside the border 
is included in the analysis.

4. Determine how holes inside a particle are treated using the [Fill 
holes] setting.
 When the [Fill holes] check box is selected, the holes are found 

by the particle detection.
 When the [Fill holes] check box is clear, the holes are ignored by 

the particle detection.

 
The illustration shows a hole inside a particle. Whether or not the holes inside a particle are filled 
has an effect on the particle area that is measured. 

5. Use the [Measure filter occupancy] setting to specify whether to 
check the  filter occupancy in the inspection. The percentage in 
the [Occupancy Warning Limit] field determines the maximum 
permissible occupancy on the inspection area.
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 If the [Measure filter occupancy] check box is selected and the 
distribution of particles exceeds the value in the [Occupancy 
Warning Limit] field during the sample inspection, a warning 
appears.

Editing focus settings
1. In the [Focus mode] list, select a setting for focusing the sample. 
 When you select the  [Focus map] entry, the system enables 

you to acquire well-focused images of the whole sample even 
when the surface of the sample is uneven. 

 When you select the [Focus on every frame] entry, the sample 
inspection focuses before acquiring every frame. Be aware that 
this option can significantly increase the duration of the sample 
inspection.

 When you select the [Use current Z-position] entry, the Z-
position that is set when you start the sample inspection is used 
to focus the sample. The Z-position isn't changed during the 
acquisition of the images.

2. When you are using a focus map: In the [Focus point density] list, 
select how densely the focus points are to be arranged on the 
focus map. Select the density of the focus points according to the 
properties of your sample. If you select a high density, a lot of 
positions will be used for the acquisition of the focus map. The 
focus map then becomes more exact, but its acquisition takes 
longer. The following entries are available:
 [3 points]
 [Low density]
 [Medium density]
 [High density]

3. With the [Allow editing focus options] setting, specify whether the 
focus point density and the focus mode can be changed in the 
inspection settings for the sample inspection on the [Inspect 
Sample] > [Edit Settings] page.

The [Focus point density] list is only active when you have selected a focus 
map in the [Focus mode] list.
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 When the [Allow editing focus options] check box is selected, the 
focus point density and the focus mode can be changed.

4. In the [Focus points warning limit] field, enter the maximum 
percentage of focus points that are permitted to be incorrectly 
focused during a sample inspection. If this percentage is exceeded, 
a warning appears.

Adjusting general settings
1. The [Acoustic signals] settings specify when an acoustic signal 

should sound.
 When the [Inspection approval NOK] check box is selected, an 

acoustic signal sounds as soon as the maximum permitted value 
is exceeded and the result is classed as [NOK].

 When the [Inspection finished] check box is selected, an acoustic 
signal sounds after the sample has been acquired.
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12.2 [Inspection Configurations] > [Standards]

1 The [Available standards] list contains all of the standards that are available in 
the software. It also tells you the date that the standard was last modified. The 
[Type] column tells you whether the standard is predefined by the system or 
whether it has been created by a user.
You can activate or deactivate standards in the [Active] column. If the check 
box next to a standard is clear, this standard will not be available after a 
sample inspection for analyzing particles retroactively or for creating a report. 
The standards nevertheless remain available in the inspection configurations.

2 This display field contains a description of the standard that is selected in the 
[Available standards] list.

3 An  inspection configuration is made up of the parameters of a standard 
plus additional parameters contained in the following configuration pages: 
[Inspection Configurations], [Standards], [Particle Families] and [Particle 
Types]. By clicking one of the buttons on the navigation bar, you can open 
the corresponding configuration page. A button highlighted in blue identifies 
the configuration page that is currently open.
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12.2.1 Editing standards
The guidelines for the characterization of particles in a cleanliness 
analysis are dictated by industry standards. The OLYMPUS Cleanliness 
Inspector Software supports a number of these standards. These 
standards are supplied with the software. The standard's parameters 
are stored in an  inspection configuration along with additional 
parameters.
You can duplicate and modify existing standards or define your own 
standards. You can also import and export standards in order to 
exchange them with other CIX ASW users or to save them for quality 
control purposes.

Opening and editing standards
1. Select a standard in the [Available standards] list. 
 You can use the arrows next to the column headers to sort the 

entries. You can filter the entries in the list by a particular term as 
well. To do this, enter the term in the [Filter by] field.

4 Clicking the [Open] button opens the configuration page for the selected 
standard.
Clicking the [New] button opens the configuration page where you can create 
a new standard. 
Clicking the [Duplicate] button copies the selected standard and opens the 
configuration page.
Clicking the [Delete] button deletes the selected standard. Standards with the 
status [System] have been predefined by the system and can't be deleted.
Clicking the [Import] button opens MS-Windows Explorer so that you can 
import a standard.
Clicking the [Export] button opens MS-Windows Explorer so that you can 
export a standard.

Changes made to a standard will effect all subsequent inspections. The results 
of inspections that have already been performed remain unchanged.

Standards with the status [System] have been predefined by the system and 
can't be deleted. They can only be edited to a limited extent. 
If you want to edit a standard that has been predefined by the system, select it 
and open it using the [Duplicate] button. The standard is copied and can now 
be edited and saved under a different name.
167 OLYMPUS Cleanliness Inspector CIX ASW 1.5



12  [Inspection Configurations]
[Inspection Configurations] > [Standards]
 A brief description of the selected standard and some of its 
parameters are displayed to the right of the [Available 
standards] list. 

2. Click the [Open] button.
 The standard’s configuration page opens.
 You can find more information on page 170 of the [Inspection 

Configurations] > [Standards] > [Open] chapter.

Creating a new standard
1. Click the [New] button.
2. The configuration page for the standard opens and can now be 

edited.
3. Enter a name for the new standard in the [Name] field.
 You can find more information on page 170 of the [Inspection 

Configurations] > [Standards] > [Open] chapter.

Duplicating standards
1. Select a standard in the [Available standards] list.
2. Click the [Duplicate] button.
 The selected standard is copied.
 The configuration page opens and the standard can now be 

edited.
 Enter a new name for the standard in the [Name] field.
 You can find more information on page 170 of the [Inspection 

Configurations] > [Standards] > [Open] chapter.

Deleting standards

1. Select a standard in the [Available standards] list.
2. Click the [Delete] button.
 The selected standard is deleted.

Standards with the status [System] have been predefined by the system and 
can't be deleted or overwritten.
Deleting standards doesn't affect the result of sample inspections and reports 
that have already been saved.
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Importing a standard
1. Click the [Import] button.
 MS-Windows Explorer opens.

2. In MS-Windows Explorer, navigate to the standard that you want to 
import.

3. Select the standard and click the [Open] button.
4. Enter a name for the standard in the message box.
 If the name is already in use, you can overwrite the existing 

standard or save the standard under a different name.
5. Confirm with [OK].
 The standard that has been imported now appears in the 

[Available standards] list.

Exporting a standard
1. Select a standard in the [Available standards] list.
2. Click the [Export] button.
 MS-Windows Explorer opens.

3. In MS-Windows Explorer, navigate to the data directory in which 
you want to save the standard.

4. Click the [Save] button.
 A copy of the standard will be saved in the selected directory.
 The standard remains available in the software in the [Available 

standards] list.
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12.2.2 [Inspection Configurations] > [Standards] > [Open]

The areas and options that are available on this page vary depending on which standard has been 
selected.
1 The [Name] field contains the name of the standard.

The [Description] field contains a short description of the standard. For user 
defined standards, the field is empty and can be edited.

2 [Cumulative 
counting]

Some standards use  cumulative counting to classify particles. With 
cumulative counting, only the lower limits are set for a particle class so that a 
particle can be allocated to more than one particle class. 

2 [Result code] The [Result code] check box is selected if the standard additionally requires a 
 result code, a  sedimentation value, or a  surface cleanliness index 
that summarizes the results. A result code is composed of index numbers that 
can be, for example, a combination of the particle size classes and, if 
appropriate, the corresponding  contamination classes. If the 
[Sedimentation Value] entry is selected in the list, the sedimentation value is 
displayed in the results instead of a result code. If the [Surface Cleanliness 
Index] entry is selected in the list, the surface cleanliness index is displayed in 
the results instead of a result code. 
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2 [Extrapolated 
count]

If the sample's inspection area is smaller than the flow through area, the 
[Extrapolated count] function can extrapolate the result for the whole flow 
through area.

2 [Normalized 
count]

The result of a cleanliness analysis is expressed in the number of particles per 
class. A normalization computes this value with other values. The particles can 
be computed, for example, with a certain area or with the volume of the rinse 
fluid used to prepare the filter. The [Normalized count] list contains the values 
that can be computed with the particle count. A normalization isn't possible 
for all of the cleanliness analysis standards. This means that the entries that 
appear in the list depend on the standard that has been selected. The result 
code also effects which entries appear in the [Normalized count] list.

2 [Contamination 
class]

The  [Contamination class] check box is selected and active if the standard 
requires classification by contamination. It means that the particles in a 
particle class will be further classified and assigned to contamination classes. 
The standard also specifies whether the contamination class relates to the 
particle count, the normalized count or the extrapolated count.
If the standard requires classification by contamination, the user interface 
displays the [Contamination Classification] table.

2 [Approval 
maximum]

In order for the result of an inspection to be evaluated as OK, the result for a 
particle class should not exceed a certain measurement value or index 
number. 
When the [Approval maximum] check box is selected, the [Approval 
maximum] column in the [Particle classification] table becomes editable. 
The list under the [Approval maximum] check box contains up to four 
options. These entries determine whether the maximum permitted value 
applies to a measurement value or to an index number. Which entries are 
contained in the list varies depending on the standard and on the options 
that have already been selected. 
If the [Extrapolated count], [Normalized count] or [Absolute count] entries are 
selected, the maximum permitted value applies to the number of particles. 
If the [Contamination class] entry is selected, the maximum permitted value 
applies to the contamination class' index number. 

3 [Particle classifica-
tion]

The particles are classified by size in the  [Particle classification] table. The 
sample inspection allocates each particle to a class and determines the 
number of particles per class. The classification is made based on the 
parameters required by the standard that has been selected. 

3 Clicking the [Select Particle Classification Measurement] button opens a list 
with all of the measurement parameters that are available for the classification 
of the particles. The measurement parameter that is required by the standard 
is already selected.
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12.2.3 Editing standards > [Open]
This page displays several parameters that are specified by the selected 
norm or by the software. These parameters don't usually need to be 
changed. 
Name and description
The [Name] field contains the name of the standard that you selected. 
The [Name] field is editable. 
The [Description] field contains a short description of the selected 
standard. The [Description] field is editable. For user defined standards, 
the field is empty and you can add your own description. 
Additional configurations

[Cumulative
counting]

When the  [Cumulative counting] check box is selected, the particle 
classes are cumulatively arranged in the [Particle classification] table.

[Result code] If the [Result code] check box is selected, the result of the inspection will 
take the form of a result code. The [Result code] list contains various 
standards that require the results to take the form of a result code. 
The  sedimentation value or the  surface cleanliness index can also 
be displayed instead of the result code. If an industry standard with the 
[Sedimentation Value] suffix is used to inspect the sample, then the 
[Sedimentation Value] entry is automatically preset in the [Result code] 
list. The results of the sample inspection will display a sedimentation 
value instead of a result code. If the currently selected standard 
specifies the surface cleanliness index as the result, the [Surface 
Cleanliness Index] entry is automatically preset.

4 [Contamination 
classification]

The [Contamination classification] table is only shown when an analysis of 
contamination classification is required by the standard. If this is the case, 
the [Contamination class] check box is active and selected.
Particles are sorted into size classes in the [Particle classification] table, size 
class A for example. Then the particles in this size class are counted. In the 
[Contamination classification] table, these particles are sorted into different 
classes according to number and are given an index number.
A contamination classification is either made for all of the particle classes 
together, or for each individual particle class.
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[Extrapolated
count]

If the sample's inspection area is smaller than the flow through area, the 
result of the inspection can be extrapolated. To do this, select the 
[Extrapolated count] check box. 

[Normalized
count]

When the [Normalized count] check box is selected, the result of an 
inspection is computed with another value. The [Normalized count] list 
contains the values that can be computed with the particle count. 

[Contamination
class]

A  contamination class can be based on one of the following figures:
• Absolute particle count
• Extrapolated particle count
• Normalized particle count

[Approval
maximum]

When the [Approval maximum] check box is selected, the [Approval 
maximum] column in the [Particle classification] table becomes 
editable. Specify the maximum permitted value that must not be 
exceeded or use the default value. The entry that you select in the list 
under the [Approval maximum] check box specifies which value the 
maximum permitted value applies to.

[Particle classification] table
Clicking the [Select Particle Classification Measurement] button opens a 
list with all of the measurement parameters that are available for the 
classification of the particles. The measurement parameter that is 
required by the standard is already selected. An image and a short 
description are displayed for each measurement parameter. You can 
select additional measurement parameters on the Editing inspection 
configurations > [Open] (Page 1 of 2) configuration page. They will also 
be displayed in the results tables. 

[Color] Each particle class is assigned a different color. To change a particle 
class' color, click the appropriate button in the [Color] column and 
select the required color in the list. 

[Name] The [Name] column contains the name of the particle class.
[Minimum] and

[Maximum]
The minimum value and the maximum value for each particle class are 
displayed in the [Minimum] and [Maximum] columns. Clicking the [+] 
and [-] buttons increases and decreases the particle class. Clicking the 
information icon opens a quick info telling you which values are 
included or excluded.
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[Approval
maximum]

The [Approval Maximum] column in the table is editable when the 
[Approval maximum] check box is selected.
Clicking the [New Particle Class] button adds a row to the [Particle 
classification] table.

Clicking the [Delete Particle Class] button deletes the selected row.
[Contamination classification] table
The [Contamination classification] table is only shown when an analysis 
of contamination classification is required by the standard. If this is the 
case, the [Contamination class] check box is active and selected.
The contamination classification can either be performed for all of the 
particle classes together, or for each individual particle class. 

[For all particle
classes]

Click the arrow next to the button and select the [For all particle classes] 
entry if you want the [Contamination classification] table to represent all 
of the particle classes.

[Per particle class] Click the arrow next to the button and select the [Per particle class] 
entry if you want an individual contamination classification to be 
performed for each particle class. An individual [Contamination 
classification] table can now be defined for each particle class in the 
[Particle classification] table.

[Minimum] and
[Maximum]

The minimum and maximum number of particles for each 
contamination class is defined in the [Minimum] and [Maximum] 
columns. Clicking the [+] and [-] buttons increases and decreases a 
contamination class' size range. Clicking the information icon opens a 
quick info telling you which values are included or excluded.

[Contamination
class]

The  contamination class is displayed in the [Contamination Class] 
column. To change a contamination class' index number, click the 
appropriate button in the [Contamination Class] column and select the 
required index number in the list.
Clicking the [New Contamination Class] button adds a row to the 
[Contamination classification] table.

Clicking the [Delete Contamination Class] button deletes the selected 
row.
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12.3 [Inspection Configurations] > [Particle Families]

1 The [Available particle families] list contains all of the particle families that are 
available. It also tells you the date that the particle family was last modified. 
The [Type] column tells you whether the particle family is predefined by the 
system or whether it has been created by a user.

2 This display field contains the measurement parameters for the currently 
selected particle family and the values that have been set for them.

3 Clicking the [Open] button opens the configuration page for the selected 
particle family.
Clicking the [New] button opens the configuration page where you can create 
a new particle family.
Clicking the [Duplicate] button copies the selected particle family and opens 
the configuration page.
Clicking the [Delete] button deletes the selected particle family. Particle 
families with the status [System] have been predefined by the system and 
can't be deleted.
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12.3.1 Editing particle families

You can find an overview of all of the predefined  particle families on 
the [Inspection Configurations] > [Particle Families] page. 
Particles are classified by size and by different material properties. A 
particle family defines a particular material property of a particle. 
A particle family is defined by one or more measurement parameters. 
For example, a fiber can be defined with the [Fiber Length], [Max. Inner 
Circle Diameter], [Fibrousness] and [Compactness] measurement 
parameters. A reflecting particle is defined with the [Reflectance] 
measurement parameter.
Particle families form the foundations of  particle types. You can find 
more information about particle types on page 184 of the [Inspection 
Configurations] > [Particle Types] chapter.
The most important particle families and particle types are predefined 
in your system. If you have special requirements, these configuration 
pages allow you to define your own particle family and to integrate it 
into a particle type.

Opening a particle family

1. Select a particle family in the [Available particle families] list. 
 The display field to the right shows the measurement 

parameters for the selected particle family and the values that 
have been set for them. 

2. Click the [Open] button to open the configuration page for the 
particle family. You can find more information on page 180 of the 
[Inspection Configurations] > [Particle Families] > Open chapter.

Changes to a particle family affect all of the particle types and therefore also all 
of the inspection configurations that use these particle types.

Particle families with the status [System] have been predefined by the system 
and can't be deleted. They can only be edited to a limited extent.
If you want to edit a particle family that is predefined in the system, first 
duplicate it. You can find more information on page 178 of the Duplicating a 
particle family section.
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Creating a new particle family
1. Click the [New] button.
 The [Inspection Configurations] > [Particle Families] > Open 

page opens.
2. Enter a name for the new particle family in the [Name] field.
3. The table already contains a measurement parameter. You can 

change this measurement parameter.
4. Click the [Select measurement] button to change the existing 

measurement parameter. 
 The [Available measurements] list opens. 

5. Select the measurement parameter you want from the [Available 
measurements] list. 
 When you highlight a measurement parameter, a short 

description of the selected measurement parameter is displayed 
under the list. 

6. Confirm your selection with [OK].
7. Define the measurement range for the measurement parameter 

and set an upper and a lower limit. To do this, click in the [[ 
Minimum] field to enter the lower value for the measurement 
range. After you have entered a value, you can use the [-] and [+] 
buttons to adjust the measurement range.

8. Click in the [Maximum] field to enter the upper value for the 
measurement range.

9. Click the [New Measurement Range] button if you want to define 
more measurement parameters for the particle family.

10. Click the [Select measurement] button to change the measurement 
parameter that has been newly added. 

11. Define a measurement range for all of the measurement 
parameters that you have added and set an upper and a lower 
limit.

12. Click the [Close] button at the top right of the configuration page 
to conclude the creation of the particle family.

Duplicating a particle family
1. Select a particle family in the [Available particle families] list.
2. Click the [Duplicate] button.
 The selected particle family is copied. 
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 The [Inspection Configurations] > [Particle Families] > Open 
page opens.

3. In the [Name] field, change the name of the particle family.
4. If required, add additional measurement parameters or change the 

existing measurement ranges. You can find more information on 
page 178 of the Creating a new particle family section.

Deleting a particle family

1. Select the particle family that you want to delete in the [Available 
particle families] list.

2. Click the [Delete] button.
3. The selected particle family is deleted. 

Particle families with the status [System] have been predefined by the system 
and can't be deleted.
If you want to delete a particle family that is being used by a particle type, you 
must first delete the particle family from that particle type. To do this, open the 
[Inspection Configurations] > [Particle Types] > Open configuration page and 
delete the relevant particle family from the list.
179 OLYMPUS Cleanliness Inspector CIX ASW 1.5



12  [Inspection Configurations]
[Inspection Configurations] > [Particle Families] > Open

ID_60009
12.4 [Inspection Configurations] > [Particle Families] > Open

1 [Measurement] The [Measurement] column contains the names of the measurement 
parameters that define a particle family.

1 [Minimum] and 
[Maximum]

The [Minimum] column defines the minimum value at which a particle 
property is still included in this particle family.
The [Maximum] column defines the maximum value for a particle property. A 
particle that exceeds this maximum value will be excluded from this particle 
family. 
Clicking the [+] and [-] buttons increases and decreases the measurement 
range. Clicking the information icon opens a quick info telling you which 
values are included or excluded.

1 [Unit] The [Unit] column displays the units of measure for the minimum and 
maximum particle values.

The buttons (2) are only available when a user-defined particle family is open,
2 The [Select measurement] button opens a list with all of the available 

measurement parameters.
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12.4.1 Editing particle families > Open
Creating a new particle family

Example You want the sample inspection to detect only fibers with a maximum 
length of 70µm.

Prerequisite  On the [Inspection Configurations] > [Particle Families] page, click 
the [New] button and create a user-defined particle family. This 
particle family can be edited.

1. Enter a descriptive name for the particle family in the [Name] field, 
Fiber (max. 70 micrometers) for example.

2. At least one measurement parameter has been predefined in the 
table. Select a measurement parameter.

3. Click the [Select measurement] button to change the existing 
measurement parameter. 
 The [Available measurements] list opens. 

4. Select the [Fiber Length] measurement parameter from the 
[Available measurements] list. 
 When you highlight a measurement parameter, a short 

description of the selected measurement parameter is displayed 
under the list. 

5. Click the [OK] button.
6. Define the measurement range for the measurement parameter. 

Because you want to detect only fibers with a size of up to 70µm, 
an upper limit is sufficient.

7. Click in the [Maximum] field and enter a value of 70.
8. Click the [New Measurement Range] button to add another 

measurement parameter.
9. Select the newly added measurement parameter.

2 The new [New Measurement Range] button adds a new measurement 
parameter to the particle family.

2 The [Delete Measurement Range] button deletes the selected measurement 
parameter.

3 This area contains a short description of the selected measurement 
parameter.
181 OLYMPUS Cleanliness Inspector CIX ASW 1.5



12  [Inspection Configurations]
[Inspection Configurations] > [Particle Families] > Open
10. Click the [Select measurement] button.
11. Select the [Max. Inner Circle Diameter] measurement parameter 

from the [Available measurements] list.
12. Click the [OK] button.
13. Define the measurement range for the measurement parameter. 
14. Click in the [Maximum] field and enter a value of 50, for example.
15. Click the [New Measurement Range] button to add another 

measurement parameter.
16. Select the newly added measurement parameter.
17. Click the [Select measurement] button.
18. Select the [Fibrousness] measurement parameter from the 

[Available measurements] list.
19. Click the [OK] button.
20. Click in the [Minimum] field and enter a value of 20.
21. Click the [New Measurement Range] button to add another 

measurement parameter.
22. Select the newly added measurement parameter.
23. Click the [Select measurement] button.
24. Select the [Compactness] measurement parameter from the 

[Available measurements] list.
25. Click the [OK] button.
26. When you add the [Compactness] measurement parameter, the 

infinity symbol [∞] is preset in the [Minimum] and [Maximum] 
fields. This means that the measurement parameter isn’t being 
applied yet. The recommended settings for fibers is from 0 to a 
maximum of 0.3. Enter these values in the [Minimum] and 
[Maximum] fields to apply the measurement parameter.

27. Click the [Close] button at the top right of the configuration page.
 The particle family now appears as an option in the [Available 

particle families] list.
You have now defined in a particle family the particle properties that 
you want the sample inspection to take into account. In order for these 
properties to be classified by the inspection, you have to integrate this 
particle family into a particle type. You can find more information on 
page 184 of the [Inspection Configurations] > [Particle Types] chapter.
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12.5 [Inspection Configurations] > [Particle Types]

1 The [Available particle types] list contains all of the  particle types that are 
available. It also tells you the date that the particle type was last modified. The 
[Type] column tells you whether the particle type is predefined by the system 
or whether it has been created by a user.

2 This display field displays the definitions of the particle family that forms the 
selected particle type. 

3 Clicking the [Open] button opens the configuration page for the selected 
particle type.
Clicking the [New] button opens the configuration page where you can 
specify settings for the particle type.
Clicking the [Duplicate] button copies the selected particle type and opens 
the configuration page.
Clicking the [Delete] button deletes the selected particle type. Particle types 
with the status [System] have been predefined by the system and can't be 
deleted.
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12.5.1 Editing particle types
You can find an overview of all of the predefined  particle types on 
this configuration page.
A particle type is defined by at least one particle family, or by the 
combination of several  particle families. The status [Yes] means that 
the properties defined for this particle family must apply to the 
detected particle. The status [No] means that the properties defined for 
this particle family must not apply to the detected particle.
For example, the [Regular Fiber] particle type is defined by the 
following particle families.
• [Fiber]: [Yes]
• [Reflecting]: [No]

According to this definition, a particle that is assigned to the [Regular 
Fiber] particle type doesn't have any reflectance This has been excluded 
by the [Reflecting] particle family and the status [No].
However, a particle that is assigned to the [Regular Fiber] particle type 
does have the [Fiber] property. This has been included by the [Fiber] 
particle family and the status [Yes].
In this example, if the [Reflecting] particle family is not defined, the 
result will include all reflecting and non-reflecting fibers.
The [Fiber] particle family is defined with the [Fibrousness], [Max. Inner 
Circle Diameter] and [Fiber Length], and [Compactness] measurement 
parameters on the [Inspection Configurations] > [Particle Families] 
page. If the measurements made by the inspection comply with the 
measurement ranges specified for the particle family, and if the 
conditions for both particle families are met ([Reflecting Particle: No] 
and [Fiber: Yes]), then the particle will be assigned to the [Fiber] particle 
type.
You can specify in an inspection configuration which particle types are 
displayed in the results of the sample inspection. You can find more 
information on page 154 of the [Inspection Configurations] > [Open] 
(Page 1 of 2) chapter. 
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Opening a particle type

1. Select a particle type in the [Available particle types] list.
 The display field to the right shows the particle families from 

which this particle type has been defined.
2. Click the [Open] button to open the configuration page for the 

particle type. You can find more information on page 188 of the 
[Inspection Configurations] > [Particle Types] > Open chapter.

Creating a new particle type
1. Click the [New] button.
 The [Inspection Configurations] > [Particle Types] > Open 

configuration page opens.
2. Enter a name for the new particle type in the [Name] field.
3. The table already contains a particle family. You can change this 

particle family.
4. Click the small arrow next to the currently selected particle family to 

open a list of all of the available particle families. 
5. In the list, select the particle family whose properties you want to 

either apply or not apply to the particles.
 Select the [Yes] option in the column if you want the properties 

to apply.
 Select the [No] option in the column if you want the properties 

not to apply.
If you want to exclude the reflecting particle particle type for 
example, select the [Reflecting] particle family in the list. If you 
now select the [No] option in the column, the reflective 
properties will be excluded from this particle type.

6. Click the [Close] button at the top right of the configuration page 
to conclude the creation of the particle type.
 The new particle type has the status [User] in the [Available 

particle types] table.

Particle types with the status [System] have been predefined by the system and 
can't be deleted. They can not be edited.
If you want to edit a particle type that has been predefined by the system, first 
duplicate it. You can find more information on page 187 of the Duplicating a 
particle type section.
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Duplicating a particle type
1. Select a particle type in the [Available particle types] list.
2. Click the [Duplicate] button.
 The selected particle type is copied.

3. The [Inspection Configurations] > [Particle Types] > Open 
configuration page opens.

4. In the [Name] field, change the name of the particle type.
5. If necessary, add further particle families. You can find more 

information on page 186 of the Creating a new particle type 
section.

Deleting a particle type

1. In the [Available particle types] list, select the particle type that you 
want to delete. 

2. Click the [Delete] button.
 The selected particle type is deleted and will no longer be 

available to inspect the sample with. 

Particle types with the status [System] have been predefined by the system and 
can't be deleted.
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12.6 [Inspection Configurations] > [Particle Types] > Open

1 The column displays the particle families that define this particle type.
1 The settings in the [Yes] and [No] columns determine whether the properties 

of this particle family should apply or not.
The buttons (2) are only available when a user-defined particle type is open.
2 The [New Particle Family Setting] button adds a row with a new particle 

family. 

2 The [Delete Particle Family Setting] button deletes the selected particle family.

3 This area shows the measurement parameters and measurement values that 
have been defined for the selected part.
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12.6.1 Editing particle types > Open
Creating a new particle type

Example You want the sample inspection to detect only fibers with a maximum 
length of 70µm.

Prerequisites  On the [Inspection Configurations] > [Particle Families] 
configuration page, you have defined a particle family with the 
properties for fibers and a maximum fiber length of 70µm. You can 
find an example of this on page 181 of the Creating a new particle 
family section.

 On the [Inspection Configurations] > [Particle Types] page, click the 
[New] button and create a user-defined particle type.

1. Enter a descriptive name for the particle type in the [Name] field, 
Normal Fiber (max. 5 micrometers) for example.
 The table already contains at least one particle family that you 

can adapt.
2. Click the small arrow to the right of the currently selected particle 

family.
3. Select the particle family that you defined for fibers with a length of 

up to 70µm on the [Inspection Configurations] > [Particle Families] 
> Open configuration page. You can find more information in the 
Creating a new particle family example on page 181. 

4. Select the [Yes] option. This means that sample inspection will 
detect the properties of this particle family.

5. Click the [New Particle Family Setting] button to add another 
particle family.

6. Select the [Reflecting] particle family. 
7. Select the [No] option next to the [Reflecting] entry. This option 

excludes reflecting particles and fibers from the inspection.
8. Click the [Close] button at the top right of the configuration page.
 The particle type now appears as an option in the [Available 

particle types] list.
 This particle type can now be used in an inspection configuration 

so that it will be taken into account when the sample is 
inspected. You can find more information on page 154 of the 
[Inspection Configurations] > [Open] (Page 1 of 2) chapter.
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13 [Sample Information Fields]
On these pages, you can specify the fields that appear in the [Inspect 
Sample] workflow. You can enter additional information about the 
sample in these fields.

1 The [Available sample information fields] list contains all of the sample 
information fields that can be inserted into the [Inspect Sample] workflow as 
editable fields. The order of the entries in the list corresponds to the sequence 
of the fields in the [Inspect Sample] > [Edit Settings] workflow.

1 You can change the order of the entries that are selected in the list using the 
[Move Up] and [Move Down] buttons.

2 This area contains additional information about the sample information field 
that is selected in the [Available sample information fields] list.

3 Clicking the [New...] button opens the configuration page where you can 
create a new data field.
The [Edit...] button and the [Delete...] button are only active when a user-
defined sample information field is selected. 
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13.1 Specifying sample information fields
You specify which additional sample information can be saved on this 
page. To do this, select sample information fields or define your own 
sample information fields that you want to insert as editable fields on 
the [Inspect Sample] > [Edit Settings] page during the sample 
inspection. You can also specify which of these sample information 
fields are mandatory for performing the inspection of the sample. You 
can specify for a sample information field to contain certain preset 
values in a list.
Sample information fields can be inserted into a report template and 
then output to a report. You can find more information about inserting 
fields into a report template on page 202 of the [Inserting a field] 
chapter.
Selecting sample information fields

1. Select the sample information field in the [Available sample 
information fields] list that you want to insert in the [Sample 
information] group in the [Inspect Sample] > [Edit Settings] 
workflow.
 The field name, the field type and the unit are displayed in the 

display field to the right of the [Available sample information 
fields] list.

2. Activate the sample data field by selecting the check box in the 
[Active] column.

3. If you want to require this sample data field to be filled in before 
the inspection of the sample can be performed, also select the 
check box in the [Mandatory] column.

4. Specify the order of the sample information fields. Select the 
required sample information field and use the [Move Up] and 
[Move Down] buttons to change the order.

5. If you want to save the changes, click the [Close] button and 
confirm with [Yes].

Deselecting
1. Select the required sample data field in the [Available sample 

information fields] list.
2. Clear the [Mandatory] or [Active] check box in the [Available 

sample information fields] list. 
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 The corresponding selection is canceled.
 The sample information field is no longer displayed on the 

[Inspect Sample] > [Edit Settings] page.

Editing sample information fields
Prerequisite  Only user-defined sample information fields can be edited.

1. Select a user-defined sample information field.
2. Click the [Edit...] button.
 The [Edit sample information field] configuration page opens. 

You can edit the entries in the [Field name] and [Default input] 
fields.

3. If you want to save the changes, click the [OK] button.

Creating a new sample information field
1. Click the [New...] button.
 The [New sample information field] configuration page opens.

2. In the [Field name] field, enter a name for the new sample 
information field.

3. Sample information fields can have different data formats. The 
following data formats are available in the [Field type] list:
 [Text]: Letters and numbers.
 [Integer]: whole numbers, for example -10, 0 or 500.
 [Decimal number]: Whole numbers and fractions of numbers, 

e.g., 1 or 2.56.
 [Date]: Time data made up of date and time.

4. You can assign a unit of measure to whole numbers and decimal 
numbers. In the [Unit] row, select the required unit from the active 
lists. Some units allow you to select a prefix.

5. In the [Use last input as default] check box in the [Default input] 
field, you can specify whether the last value entered in the field is 
suggested for the following inspection.

6. Alternatively, you can enter a value in the [Default input] field that 
will then automatically be displayed in the corresponding sample 
information field. You can overwrite this value when necessary.

7. In the [Input list] field, enter the values that you want to appear in 
the list in the sample information field.
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8. Click the [Add] button to add this entry to the list.
9. Use the arrow buttons or the [Sort] button to order the entries. 

10. Select one of the entries and click the [Set as Default] button if you 
want this value to be adopted in the [Default input] field and then 
to appear by default in the corresponding sample information field. 

11. Click the [Delete] button if you want to delete an entry from the 
input list.

12. Select the [Restrict input to list] check box to restrict the sample 
information that can be entered to the values contained in the list. 
No other values can then be entered or added in the [Inspect 
Sample] workflow. 

13. Select the [Add input to list] check box to add the values that a user 
enters in the corresponding sample information field to the list.

Deleting a sample information field
Prerequisite  Only user-defined sample information fields can be deleted.

1. Select the user-defined sample information field that you want to 
delete.

2. Click the [Delete...] button.
 Confirm with [Yes]. 
 The selected sample information field is deleted.

If you want to remove a sample information field from the [Inspect Sample] 
workflow, it's best not to delete the sample information field. 
Inactivate the sample information field by clearing the [Active] check box in the 
[Available sample information fields] list.

If a sample information field is deleted, the data in this field is also deleted 
from all saved sample information. 
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14 [Report Templates]
On this page you can create and edit  report templates.

1 The [Available report templates] list contains all of the existing report 
templates.

1 Clicking the [Import Report Template] button opens MS-Windows Explorer so 
that you can import a report template.

1 Clicking the [Export Report Template] button opens MS-Windows Explorer so 
that you can export a report template that has been saved.

1 Clicking the [Create New Report Template] button creates a new report 
template.

1 Clicking the [Duplicate Report Template] button copies the selected report 
template.

1 Clicking the [Delete Report Template] button deletes the selected report 
template.
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14.1 Editing report templates
You edit  report templates on this page. Report templates are used 
for creating reports. A report template specifies which information is 
inserted into a report. Various report templates that are suitable for 
cleanliness analyses are supplied with the OLYMPUS Cleanliness 
Inspector Software.
• [Basic Report Template] Contains placeholders for the display of the 

most important results.
• [Check System Report Template]: Contains placeholders for the 

results of the system check. Data from the system check is identified 
with the [PSD] suffix. PSD is short for Particle Standard Device

• [Advanced Report Template]: Contains all of the placeholders for a 
comprehensive display of the results

• [Sedimentation Value Report Template]: Contains placeholders with 
fields in which the results of the inspection are expressed in a  
sedimentation value. This enables you to evaluate  particle traps, 
for example.

2 Clicking the [Edit in Microsoft Word] button opens the report template in 
Microsoft Word for further editing.

3 The name of the report is determined in the [Name] field. A description of a 
report template can be added in the [Description] field.

4 In the [Particle types] table, select the particle types that you want to display in 
a report. When a report is created, the sections that are contained in a report 
template as placeholders are automatically replicated for each of these 
selected particle types.
The [Number of Largest Particles] field specifies the number of images of the 
largest particles and the number of entries to be shown in the table of the 
largest particles. 

4 Clicking the [Move Up] and [Move Down] buttons changes the order of the 
particle types in the [Particle Types] table. This is how you can specify the 
order of the particle types in a report.

5 The entries in the [Structure for multiple particle types] list determine how the 
sections with the results for the individual particle types will be ordered in a 
report.
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• [Surface Cleanliness Index Report Template]: Contains placeholders 
with fields to display the results of a  surface cleanliness index 
inspection. 

You can use this report template straight away, or you can modify it to 
your own requirements. Report templates can be imported and 
exported. This enables you to exchange report templates with other 
users of the OLYMPUS Cleanliness Inspector System.

Importing report templates
You can import a report template that was created by another 
OLYMPUS Cleanliness Inspector Software user into your software. 

Prerequisite  The function for importing and exporting report templates is 
available in CIX ASW version 1.3 and higher.

1. Click the [Import Report Template] button to import a report 
template.
 MS-Windows Explorer opens.

2. In MS-Windows Explorer, navigate to the report template that you 
want to import.

3. Select the report template and click the [Open] button.
4. Enter a name for the report template.
5. Confirm with [OK].
 The report template that has been imported now appears in the 

[Available report templates] list.

Exporting report templates
1. Select the report template in the [Available report templates] list.
2. Click the [Export Report Template] button.
 MS-Windows Explorer opens.

3. In MS-Windows Explorer, navigate to the data directory in which 
you want to save the report template.

4. Click the [Save] button.
 A copy of the report template will be saved in the selected 

directory. 
 The report template remains available in the software in the 

[Available report templates] list.
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Creating a new report template
1. Click the [Create New Report Template] button.
 A new report template is added to the [Available report 

templates] list. The new report template has the scope of an 
advanced report template and contains the same placeholders.

2. Enter a new name for the report template in the [Name] field and 
add a description if you want.
 The report template can be opened using the [Edit in Microsoft 

Word] button and then customized in Microsoft Word.

Duplicating a report template
1. Select a report template in the [Available report templates] list. 
2. Click the [Duplicate Report Template] button.
3. You can change the report template's name in the [Name] field. 
4. Click the [Edit in Microsoft Word] button.
 The report template is opened in Microsoft Word for additional 

editing. 

Deleting report templates
1. Select the report templates that you want to delete in the 

[Available report templates] list.
2. Click the [Delete Report Template] button.
 The report template is permanently removed from the [Available 

report templates] list.

Inserting images of the largest particle types and tables with the 
largest particle types in a report

Prerequisite  The images of the largest particle types or a table with the largest 
particle types are only inserted in a report if you previously inserted 
the corresponding placeholder in a section of a report template in 
Microsoft Word with the OLYMPUS Add-in.
You can find more information on page 203 of the [Inserting a 
section with specific placeholders] chapter.

In the [Particle types] table, select the particle types that you want to 
include in a report. This selection affects the contents of the 
classification table. If, for example, you select the [Reflecting Fiber] 
particle type, then the classification table in the report will only contain 
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the results for the reflecting fibers. If you select more particle types, an 
individual classification table for each particle type will be inserted into 
the report.
In the [Number of Largest Particles] field, specify the number of images 
of the largest particles that you want to insert into the report. This value 
also specifies how many entries are contained in the table with the 
largest particle. A maximum of 10 particles can be inserted in a report. 
The [All Particles] option inserts the largest particles in the report 
regardless of their particle type. 

1. Select one or more particle types in the [Use in Report] column.
2. In the [Number of Largest Particles] field, enter how many of the 

largest particles you want to insert into the report. Alternatively, use 
the [+] and [-] buttons.

3. Check the report template that you want to use to create the 
report. If you want the largest particle types to be displayed in a 
report, the report template must contain either a section for the 
images of the largest particles or a section for the table with the 
largest particles, or both sections. 
You can find more about inserting sections on page 203 of the 
[Inserting a section with specific placeholders] chapter.

4. The entry that you select in the  [Structure for multiple particle 
types] list determines how the sections with the results for the 
individual particle types will be ordered in a report. The following 
options are available:
  [Replicate template]
  [Replicate section]
  [Replicate section in blocks]
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14.2 Editing a report template in Microsoft Word
When your software is installed, an add-in from OLYMPUS is added to 
the Microsoft Word application program. When you start Microsoft 
Word, you can see that the [Olympus] tab is displayed. This add-in 
offers several functions for editing report templates. Different sections 
with placeholders can be inserted in the report template. They will be 
replaced by the corresponding data and sample inspection results 
when the report is created.
Structure of a report template

A report template has the following areas:

1 Header and 
Footer 

The header and footer in a report template provide space for the company 
logo and text. You can also insert fields that refer to the sample. You can find 
more information about inserting fields on page 202 of the [Inserting a f ield] 
chapter.
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14.2.1 Inserting a general section
You can insert a general section into a report template with the [Insert 
Section] button. The section can be filled with fields and your own text.

A section is composed of the [Preface], [Main part] and [Postface] 
areas. The [Preface] and [Postface] areas make space available for 
introductory or concluding text and information. You can also insert 
fields that refer to the sample in this section. 
In a general section, the [Main part] provides space for text and fields. 
You can insert a general section into a report template more than once 
with the [Insert Section] button.

2 General sections can be inserted in this area of the report template, text and 
sections with specific placeholders for example.
A section is composed of the [Preface], [Main part] and [Postface] areas. The 
[Preface] and [Postface] areas provide space for fields and introductory or 
concluding text. The content that can be inserted in the [Main part] of a 
section depends on the section that is selected. 
You can find more information about inserting a general section on page 201 
of the [Inserting a general section] chapter.
You can find more information about inserting a specific section on page 203 
of the [Inserting a section with specif ic placeholders] chapter.

A new section is always inserted below the section that currently contains the 
cursor.

More than one general section can be inserted in a report template.
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14.2.2 Inserting a field
Clicking the [Insert Field] button opens the [Insert Field] dialog box. 
With this dialog box, you can insert fields into a report template that will 
display particular information in the report. Fields can be inserted into 
tables or sections, and also into headers and footers. If, for example, 
you insert the [Sample ID] field, the sample ID of the sample that was 
inspected will be displayed in every report. The sample information 
fields that were defined in the [Sample Information Fields] workflow are 
also contained in the list of available fields. 

The illustration shows the [Insert Field] dialog box.

1 The options in the [Link] group specify whether the fields apply to a 
placeholder or to the whole sample. The [Sample] option is selected by 
default.

2 The [Available fields] list contains all of the fields for which the software can 
save information to be displayed in a report. The [User] entry contains all of 
the user defined fields that were defined on the [Sample Information Fields] 
page.
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1. Click the [Insert Field] button on the [Olympus] tab.
2. The [Insert Field] dialog box opens.
3. Select the [Sample] option in the [Link] group.
4. In the [Available fields] list, select the field that you want to insert. 

Click the plus sign to expand the list.
5. Position the mouse pointer on the location in the report where you 

want to insert the field.
6. In the [Insert Field] dialog box, click the [Insert] button.
7. If necessary, add further fields.
8. Close the [Insert Field] dialog box.
9. Save the report template.

14.2.3 Inserting a section with specific placeholders

Various sections with specific placeholders are available in the software, 
images and tables for example. These sections are composed of the 
[Preface], [Main part] and [Postface] areas. 
The [Preface] and [Postface] areas make space available for 
introductory or concluding text and information. You can also insert 
fields that refer to the sample in this section.
The [Main part] area contains either a placeholder for a particular table, 
or a placeholder for an image of the sample or for the images of the 
largest particles. 

Inserting a classification table section
You can insert a section for a classification table into a report template 
using the [Insert Classification Table Section] button. You can change 
the format of the table using the formatting functions in Word.
When you create a report, the sample analysis' classification table is 
displayed in the position of this placeholder. The number of columns 
and rows depends on the standard being used to analyze the results. 

A new section is always inserted below the section that currently contains the 
cursor.

Sections with specific placeholders can only be inserted into a report once, 
otherwise you receive an error message when you attempt to create the 
report.
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The rows and columns are generated dynamically. In addition, the 
particle type that was selected in the [Particle types] table on the 
[Report Templates] page affects the contents of the classification table. 
If, for example, you select the [Reflecting Fiber] particle type, then the 
classification table in the report will only contain the results for the 
reflecting fibers.

Inserting a section for images of the largest particles
The [Insert Largest Particle Images Section] button inserts a section for 
the images of the largest particles into the report template. The number 
of images that are inserted when the report is created depends on the 
value that you set for the selected particle type on the [Report 
Templates] page. A maximum of 10 images of the largest particles can 
be inserted. If one of these largest particles is linked to an EFI image, 
the EFI image will be used in the report instead of the snapshot.
You can change the size of the placeholder. This also changes the size 
of the images of the largest particles. Click the frame of the placeholder 
in the Word document. Click one of the handles on a corner of the 
frame and drag the frame to the required size.

Inserting a section for a table with the largest particles
The [Insert Largest Particle Table Section] button inserts a table as a 
placeholder into the report template. This table contains all of the 
relevant information and values for the largest particles. The number of 
rows displayed in the table depends on the number of particles that 
you specified for the corresponding particle type on the [Report 
Templates] page. The table can contain the information for a maximum 
of 10 of the largest particles.

Inserting a sample image section
You can insert a section with a placeholder for an image of the sample 
into a report template using the [Insert Sample Image Section] button. 
When you create a report, the overview image of the sample is 
displayed in the position of the placeholder.
You can change the size of the placeholder. This also changes the size 
of the overview image. Click the frame of the placeholder in the Word 
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document. Click one of the handles on a corner of the frame and drag 
the frame to the required size.

Inserting a snapshot section
You can insert a section with a placeholder for the snapshots for a 
sample into a report template using the [Insert Snapshots Section] 
button. When you create a report, all of the snapshots that were 
acquired for a sample will be inserted in place of the placeholder. The 
number of snapshots is limited to a maximum of 20 per sample. 
If you have performed measurements on the snapshots, the 
measurement objects and the values resulting from the measurements 
are displayed on the snapshots. All of the values resulting from the 
measurements are additionally listed in a table. 
You can insert fields for additional information about the snapshots into 
the report template using the [Insert Field] button. For example, you 
can output the name of a snapshot or an annotation of a snapshot to a 
report using the [Snapshot Name] field or the [Snapshot Comment] 
field. 

14.2.4 Deleting a section
Clicking the [Delete Section] button deletes the section that contains 
the cursor.

14.2.5 Saving a report template
Clicking the [Save] button saves the changes to the report template.

14.2.6 Olympus Help
Clicking the [Olympus Help] button opens this help document.
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15 [User Rights]
You can manage the user rights for the software on this page. The user 
rights determine which software functions each user can use.

1 [My Access] A check mark in this column indicates with which group or with which user 
account the user can use the software. Lets say a user has the [Administrator] 
role. This user is also a member of a group with the [User] role. In this case 
the column contains two check marks. The user can change his role on the 
software’s start page. 

2 [Type] The icon in the [Type] column indicates whether the access rights are for a 
user or for a user group.

3 When the [Role 'User' can execute 'Check System'] check box is selected, 
users with the [User] role are allowed to perform the [Check System] 
workflow.

4 [Name] The [Name] column shows the name of the user or of the user group.
5 [Domain] The [Domain] column shows the domain of the user or of the user group.
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15.1 Managing users rights
If more than one user works with the software and you only want a 
particular user group to be able to use certain functions, the 
administrator of the software can assign different roles with different 
access rights to each user. A user is anyone who can log on to the 
operating system and start the software. For example, a user with the 
[User] role can use the sample analysis functions, but not the system 
configuration or data management functions. 
The [Administrator] role automatically applies to the user who starts the 
software for the first time. All subsequent users who haven’t yet been 
created in the software will be assigned the [Default User] role. This 
roles can be changed by the software administrator at any time.

A user can be created for each Windows user account that is set up on 
the computer. You can assign different roles to different users. You can 
also add users or user groups from the network and give them roles. 
User roles
Every user of the software can take on one of three roles, each of which 
is allocated different software functions. The software functions are 
predefined and cannot be changed.

[Role ‘Administra-
tor’]

Users with the [Administrator] role have access to all of the software’s 
functions. The administrator is authorized to manage the user rights, to 
configure the hardware, and to activate and deactivate the software 

6 User roles: 
[Administrator], 
[Power User], 
[User]

When a check box is selected, it indicates that this user role is available for this 
user. Each user role is associated with different software functions.

6 Clicking the [Remove from List] button deletes the selected user or the 
selected user group.

7 Additional users or user groups can be created in the [Add user or group] 
group.

If the administrator deletes the [Default User] role, all of the users who 
have not yet been created or assigned to a group can no longer use 
the software. 
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license. At least one user has administrator rights. It is possible for 
several users to be allocated administrator rights. 

[Role ‘Power
User’]

Users with the [Power User] role have access to sample analysis 
workflows, some buttons in the [System configuration] area, and the 
data management area.

[Role ‘User’] Users with the [User] role are authorized to perform the sample analysis 
workflows. When the [Role 'User' can execute 'Check System'] check 
box is selected, a user with the [User] role can also perform the [Check 
System] workflow.

15.1.1 Assigning or changing user roles

1. Select the check box in the role column that you want to assign to 
a user or to a group.

2. Click the [Home] button to leave the page and to save the settings.

15.1.2 Adding users or groups
1. Enter the name for the new user or for the new group in the 

[Name] field. 
 To do this, you must know the user's or the user group's login 

name. Alternatively, click the [Browse...] button and use the 
Microsoft dialog boxes to search your network for users or user 
groups.

2. Click the [Add...] button to create a new user or user group. 
3. Click the [Clear] button to delete the entries in the [Name] and 

[Domain] fields.

You can assign a user several roles. For example, an administrator can 
be assigned the [User] role as well. This means that an administrator 
can also open the software in the [User] role. Using the software in this 
role safeguards against accidentally overwriting the calibration data.
Make sure that at least one user is assigned the administrator role.
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4. If you have added a user or a user group in the table on the left 
hand side, select the check box for the role that you want to assign 
to the user or the group.
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16 [Hardware]
Because the OLYMPUS Cleanliness Inspector System is already 
configured, you only need to make changes in these dialog boxes 
when you purchase additional hardware components.
Device List
Your software has to know which hardware components your 
microscope is equipped with. Only these hardware components can be 
configured and controlled by the software. You can find the details of 
the hardware components that are available in the [Device List] dialog 
box.

Real color slider If your system is equipped with a  real color slider, select the [Real 
Color Slider] check box in the [Microscope] tab.

Device Settings
Usually various different devices, such as a camera, a microscope and a 
stage will belong to your system. In the [Device Settings] dialog box, 
you can check whether your computer can communicate with the 
hardware components that are connected.
The [Device Settings] dialog box lists all of the hardware components in 
a tree view, on its left hand side. You can find all of the camera settings 
here, for example. 
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17 [Calibration] 
You can calibrate the system with the wizard in these dialog boxes.

1 The [Camera] field shows the camera being used.
2 List of the 

calibration 
processes

The [Calibration] list shows all calibration processes that can be carried out, 
and their status. For the system to function optimally, all of the calibration 
processes should have the [Calibrated] status. 

2 Status of the 
calibration 
processes

This column displays the status of a calibration process.

2 This calibration process has been carried out successfully. The status shown is 
[Calibrated].

2 This icon can mean two things:
A calibration process is recommended but not essential and has not yet been 
carried out. In this case, the status shown is [Recommended].
Or, calibration data exists but the calibration is switched off. The status shown 
is [Disabled]. To switch the calibration back on, click the [Edit...] button.
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17.1 Calibrating the system
The OLYMPUS Cleanliness Inspector System is already configured and 
calibrated when it is delivered. Only the [Stage Limits] calibration 
process needs to be performed regularly. It's only necessary to perform 
the other calibration processes again if problems arise with image 
acquisition or if changes are made to the hardware. 
Overview of the calibration processes
• Calibrating stage limits
• Calibrating the Camera-To-Stage Rotation
• XY Objective Shift / Parfocality
• Shading correction, white balance and exposure correction
• Rotation / Magnification
• Manual Magnification Calibration
• Defining the overview area
• Manual Z-Axis Calibration

Starting a calibration
1. Select the required calibration process.
2. Click the [Calibrate...] button to start the wizard.
 A wizard will lead you through the calibration.

3 Editing calibration 
processes

With some calibration processes, you can view and edit the values that have 
been calculated during the calibration. To do this, select the required 
calibration process and click the [Edit...] button.

3 Starting a 
calibration process

Select the required calibration process and click the [Calibrate...] button.

If a  real color slider is configured for your system, you must additionally 
perform the [White balance], [Shading correction] and [Exposure correction] 
calibration processes for this microscope configuration.
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17.2 Calibrating stage limits
Use this software wizard to define the maximum stage area. The stage 
won't move beyond these stage limits for any process that you start 
with your software. 
The X and Y-limits specify how far the stage can be moved in the X and 
Y-directions. You have to carry out the [Stage Limits] calibration 
process every time you change the mechanical stage limits or restart 
the system. 
When you set the Z-limits, make sure that two side effects are taken 
into account:

1. Choose Z-limits that ensure that no objective can hit the sample.
2. The software autofocus can only function correctly if the focus 

position lies within the Z-range defined by the Z-limits. Please 
make sure, therefore, that the focus position for every position on 
the sample can be found.

Setting the stage limits along the XY-axes
1. Select the [X Axis] check box and the [Y Axis] check box in the 

[Calibrate Stage Limits] dialog box.
2. Click the [Next >] button.
 A warning appears and advises you that the microscope is 

switching to the objective with the largest working distance. 
 The stage limits will now be determined automatically. Make 

sure that no objectives will be damaged during this process.
3. Click the [Next >] button.

ATTENTION Damage to the objective
If you move the height of the Z-drive manually on the microscope, the Z-
limits that have been set become invalid. 
In this case, redefine the Z-limits so that the objective can't hit the sample.
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Setting the stage limits along the Z-axis

1. Place a sample under the microscope and select a central area with 
plenty of contrast.

2. Select the [Z Axis] check box in the [Calibrate Stage Limits] dialog 
box.

3. Check the microscope's direction of travel in the dialog box that 
appears. Click the buttons pictured on the left to check whether the 
stage moves in the expected direction. Should the stage not move 
in the expected direction, invert the direction of movement. 

4. Click the [Next >] button.
5. Focus on the sample with the 1.25x objective. If the 1.25x objective 

isn’t preset, click the [Change Objective] button to switch the 
objective.

6. Click the [Next >] button. 
7. For the calibration, use an objective that you use regularly for 

inspections. Select the required objective.
8. Click the [Next >] button. 
9. Focus on the sample using the 1.25x objective.

10. Define the upper Z-limit. To do this, enter the maximum stage 
movement towards the objective in the [Z Limit] field. We 
recommend a value of 1500 µm.
 The bottom Z-limit will be automatically set.

11. Click the [Next >] button.
12. The dialog box will list the current stage limits.
13. Click the [Finish] button to finalize the calibration and to return to 

the [Calibrations] dialog box.
 The calibration process now has the [Calibrated] status.

ATTENTION Damage to the objective
Make sure that the objective doesn't hit the sample.

ATTENTION Damage to the objective
Make sure that the objective doesn't hit the sample.
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17.3 Calibrating the Camera-To-Stage Rotation
The camera must be aligned parallel to the microscope stage. Your 
software can compensate for small rotation angles. To do this, use the 
[Calibrations] > [Camera-to-Stage Rotation] wizard.
Aligning camera and microscope stage

1. Place a sample with plenty of contrast under the microscope. You 
could use the edge of the sample holder.

2. A warning appears advising you that the objective with the lowest 
magnification will automatically be set. 

3. Bring the sample into focus. Then click the [Next >] button.
4. The system will then acquire images at various positions on the 

stage and determine a correction value from the angle of rotation 
between these images.
 If the rotation angle that you determine is more than 1°, contact 

Customer Service: support@olympus-sis.com
Phone: (+ 49) 251-79800-6444, fax: (+ 49) 251-79800-6445

5. Click the [Finish] button to finalize the calibration and to return to 
the [Calibrations] dialog box.

Checking the alignment of the camera
You can then easily check in the live-image whether the camera has 
been mounted parallel to the stage. Use the joystick to move your 
stage in the X direction, and observe the live-image. The sample 
structure shown should run parallel to the image's lower border.
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17.4 XY Objective Shift / Parfocality
XY Objective Shift
If two objectives aren't centered identically on the microscope's optical 
axis, a change of objective leads to a shift in the position on the sample 
that is displayed. Carry out the XY objective shift calibration process so 
that your software automatically corrects this shift when you change 
objectives.
Parfocality
Different objectives have different working distances. Even very small 
differences in the height of the objective become noticeable as a 
different focus position, and result in a blurred image.
[XY Objective Shift / Parfocality] calibration process
Use the [XY Objective shift/parfocality] wizard to ensure that the focus 
position is automatically adjusted when you change an objective. The 
stage will be raised or lowered by a fixed Z-value when the objective is 
changed. In this way, whenever you change an objective the image will 
always remain sharply focused. The Z-value will be given for every 
objective in relation to that of the objective with the greatest 
magnification.

Preparations  Make sure that the stage limits are correctly set. If necessary, carry 
out the [Stage limits] calibration process. You can find more 
information on page 214 of the Calibrating stage limits chapter.

 Place a sample in a multi-sample holder and place the sample 
holder on the stage.

 Select an area on the sample with plenty of contrast that will be 
easy to focus on.

Carrying out parfocality correction
1. In the dialog box, all available objectives are listed. The parfocality 

correction is applied to the objectives that are selected.
2. Select all of the objectives. For the calibration process you will 

require at least two objectives.
3. To start the calibration process, click the [Next >] button.
4. The system will then automatically switch to the first objective.
5. Bring the sample into focus.
6. If necessary, use the slide control in the wizard's dialog box to 

refocus on the sample.
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7. Click the [Next >] button to change to the next objective and focus 
again.

8. Your software will save the differences between all objectives. For 
this reason, the automatic parfocality correction also functions 
when you change from your smallest directly to your largest 
objective. 

9. When you have focused for all objectives once, a dialog box 
containing the resulting correction values will be opened. The 
objective with the greatest magnification always has the value "0", 
since it is used as a reference for all of the other objectives.

10. Click the [Finish] button to finalize the calibration and to return to 
the [Calibrations] dialog box.

11. The status of the calibration process is now [Calibrated].
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17.5 Shading correction, white balance and exposure correction

Shading correction
With optical systems containing a camera and microscope the sample 
will not, as a rule, be homogeneously illuminated, even when the whole 
system has been carefully set up. This non-homogeneous illumination 
leads to image defects that are called shading. When shading 
correction is employed, these defects in the image will be identified and 
immediately corrected in the live-image.
For the shading correction you need correction images, the dark 
current correction image and the flatfield correction image. Before you 
can use the shading correction, you have to acquire these correction 
images.
The conditions under which you acquire the correction images should 
be as similar as possible to those of the actual image acquisition.
Before you acquire correction images

1. Place a clean filter in the filter holder and mount it on the stage.
While acquiring correction images
The dark current correction image is characteristic for each camera and 
need only be acquired once. 

1. Make sure that no light falls on the camera. Use the light switch on 
the microscope frame to turn the light off.
 Select the [Skip acquisition of the dark current correction image] 

check box if a suitable correction image already exists.
2. Each correction image for the flatfield correction is valid for only 

one objective, which means that separate correction images must 
be acquired for each objective. Select the objectives for which you 
want to acquire correction images.

3. Defocus the filter until you can't recognize any details of the 
sample.

4. Follow the wizard's instructions.

If a  real color slider is configured for your system, you must additionally 
perform the [White balance], [Shading correction] and [Exposure correction] 
calibration processes for this microscope configuration.
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5. Each time you change the objective, make sure that you still can't 
recognize any details of the sample.

White balance
Carry out the [White balance] calibration process to ensure that colors 
are displayed accurately. When you use a white balance, the individual 
colors in the image will be scaled so that the white area of the image 
shown on your monitor is displayed correctly as white. The white 
balance can be carried out together with the [Shading Correction] 
calibration process.
To do this, select the [White balance] check box in the [Select 
calibration] group in the shading correction wizard dialog box.

Exposure Correction
When you change the objective, the mean image brightness will also 
change. Use the [Exposure Correction] calibration process to adjust the 
exposure time to keep the brightness of the image the same when 
changing the objective.
To perform the calibration, select the [Exposure correction] check box 
in the [Select calibration] group in the wizard’s dialog box. At least two 
objectives must be selected in order for the check box to be active.
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17.6 Rotation / Magnification

The [Rotation / Magnification] calibration process calibrates the rotation 
between the camera and the stage, and the magnification of the 
objective. 
The [Camera-To-Stage Rotation] calibration process checks whether 
the camera and microscope are askew in relation to one another. The 
angle of rotation between the camera and the stage is determined. If 
the alignment isn’t perfect, your software compensates for the rotation 
angle. 
The [Rotation / Magnification] calibration process determines the 
rotation angle with more accuracy. Additionally, the actual 
magnification of the individual objectives is determined with great 
accuracy. 

Prerequisites  The [Camera-To-Stage Rotation] calibration process has to be 
performed before the [Rotation / Magnification] calibration 
process. 

 A special calibration standard is required for the [Rotation / 
Magnification] calibration process.

1. In the dialog box, all available objectives are listed. The calibration 
is performed for the objectives that are selected.

2. Select the required objectives. The objective with the lowest 
magnification (1.25x) can’t be deselected.

3. Click the [Next >] button.
4. Confirm the message that the objective with the lowest 

magnification will automatically be set.
5. Place the special calibration standard in position 2 of the multi-

sample holder.
6. Move the field of view to the center of the rectangular calibration 

area.
7. Bring the sample into focus.
8. Click the [Next >] button.

A special calibration standard is required for the [Rotation / Magnification] 
calibration process. If this calibration is required, contact customer service: 
support@olympus-sis.com
Phone: (+ 49) 251-79800-6444, fax: (+ 49) 251-79800-6445
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 The wizard creates a focus map with each objective and scans a 
part of the calibration standard. It begins with the objective with 
the lowest magnification. The wizard determines the rotation 
angle between the camera and stage, and the actual 
magnification of the individual objectives from these 
acquisitions. 

 The rotation angle that is determined is displayed in the dialog 
box.

9. Click the [Finish] button to complete the calibration process. 
 The values that are determined are adopted by the [Manual 

Magnification Calibration] and [Camera-To-Stage Rotation] 
calibration processes.

 The actual objective magnifications that were determined are 
used for the image acquisition and the rotation angle between 
the camera and stage are compensated for. 

 You can view the values that were determined. To do this, select 
the [Manual Magnification Calibration] or [Camera-To-Stage 
Rotation] calibration process in the [Calibrations] dialog box and 
click the [Edit...] button. 
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17.7 Manual Magnification Calibration
All images you acquire using your software are automatically X/Y-
calibrated. Use the [Manual Magnification Calibration] calibration 
process if this calibration is not precise enough.
How is the magnification calibration predefined?
An image's X/Y-calibration is calculated from the size of a camera pixel 
and from the total magnification. The total magnification at the time of 
acquisition is a combination of the objective magnification and the 
camera adapter's magnification. The predefined magnification 
calibration uses the hardware components from the [Device Settings] 
dialog box and the camera's pixel size, which can be read out from the 
camera driver.

Performing a manual magnification calibration
Prerequisite  You need a particle standard device to perform a manual 

magnification calibration.

1. Place the particle standard device in position 2 of the multi-sample 
holder. 

2. All of the objectives are listed in the [Calibrate objective] list in the 
[Manual Magnification Calibration] dialog box. Select the check box 
in front of each objective that you want to calibrate.

3. Click the [Next >] button.
 The live-image is displayed in the display area.
 The objective that is about to be calibrated is named in the 

dialog box.
4. Focus on the measurement scale with the 1 mm increments on the 

particle standard device.
5. Click the [Next >] button.
6. Click the [Set Reference Distance] button.

Magnification
1.25x

7. Define as long a reference length as is possible on the particle 
standard device's measurement scale. Determine the starting and 
end point of the reference distance with your mouse pointer, for 
example, a distance of 9 mm. You define these two points by 
clicking with your left mouse button. 
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The illustration shows the measurement scale with 1 mm increments and a reference length of 
9 mm.

8. Confirm the reference length with the [Enter] key.
 The [Set Reference Distance] dialog box opens.
 Select the required unit of measure, mm for example.
 Enter the measured length in the [Distance] field. In this example 

the measured length is 9 mm.
9. Click [OK] to confirm the calibration.

10. Click the [Next >] button.
5x / 10x

magnification
11. Repeat the manual calibration for the other objectives that you've 

chosen. Use the measurement scale with the 1/10 mm increments 
for the 5x and 10x objectives.

12. Define as long a reference length as is possible. Determine the 
starting and end point of the reference distance with your mouse 
pointer, for example, a length of 1000 µm. You define these two 
points by clicking with your left mouse button. 
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The illustration shows the measurement scale with 1/10 mm increments and a reference length of 
1000 µm.

13. Confirm the reference length with the [Enter] key.
 The [Set Reference Distance] dialog box opens.
 Select the required unit of measure, µm for example.

14. Enter the measured length in the [Distance] field. In this example 
the measured length is 1000 µm.

15. Click [OK] to confirm the calibration.
16. When the last calibration has been carried out, the [Manual 

Magnification Calibration] dialog box opens. The actual objective 
magnification that was the outcome of the manual magnification 
calibration will be shown for each of the manually calibrated 
objectives. 

17. Make sure that the [Use manual calibration] check box has been 
selected.

18. Close the [Manual Magnification Calibration] dialog box with [OK].
19. When all of the objectives have been calibrated, the [Manual 

Magnification Calibration] calibration process has the "calibrated" 
status in the [Calibrations] dialog box.

Returning to the predefined values
When you have manually calibrated the objectives, you can return to 
the preset values at any time. 
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1. Select the [Manual Magnification Calibration] calibration process in 
the [Calibrations] dialog box.

2. Click the [Edit...] button.
3. Select the objective in the [Total Magnification] list in the [Manual 

Magnification Calibration] dialog box. 
4. Clear the [Use manual calibration] check box in the [Edit 

magnification] group for the required objectives. 
 The suffix [Default] indicates an objective with predefined values.
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17.8 Defining the overview area
The overview area is the maximum XY-range within which the stage is 
allowed to move during the acquisition of an overview image. During 
the [Define Overview Area] calibration, the center of the overview area 
is determined by three positions on the sample. The overview area is 
defined by the position of the center in combination with the software's 
default  inspection area size. 

Prerequisites  The stage limits have been calibrated.
 The filter is in position 1 on the right of the multi-sample holder.

1. Define the first position. Use the joystick to move the stage to the 
upper left area of the filter. 
 The center of the cross hairs should be on the border of the filter 

holder and the filter.

The illustration shows the cross hairs on the border of the filter holder and the filter.

2. Confirm with [OK].
3. Define the second position. Use the joystick to move the stage to 

the upper right area of the filter.
 The center of the cross hairs should be on the border of the filter 

holder and the filter.
4. Confirm with [OK].
5. Define the third position. Use the joystick to move the stage to the 

lower area of the filter.
 The center of the cross hairs should be on the border of the filter 

holder and the filter.
6. Confirm with [Finish].
228OLYMPUS Cleanliness Inspector CIX ASW 1.5



17  [Calibration]
Defining the overview area
229 OLYMPUS Cleanliness Inspector CIX ASW 1.5



17  [Calibration]
Manual Z-Axis Calibration

ID_50014, 
ID_50016

17.9 Manual Z-Axis Calibration

The [Manual Z-Axis Calibration] calibration process calibrates the 
positioning accuracy of the Z-axis manually. The stage moves along a 
calibration object of known height on a calibration standard. The 
distance that the Z-drive has moved is saved together with the known 
height of the calibration object.

1. Check whether the objective with the highest magnification is 
currently selected. 

2. Change the objective if required.
Changing the objective

1. On the software’s start page, click the [Hardware] button.
 The [Device List] dialog box opens.

2. Click the [OK] button.
 The [Device Settings] dialog box opens.

3. Select the [Lightpath] entry in the [Sort by] list.
4. Select the [General] <Name of the nosepiece> entry in the tree 

view.
5. Select the objective with the highest magnification from the list of 

objectives.
6. Click the [OK] button to save the selection. 
7. On the start page, click the [Calibration] button and start the 

[Manual Z-Axis Calibration] calibration process.
Calibrating the Z-axis

1. Place the special calibration standard in position 2 of the multi-
sample holder.

2. Move the stage so that the height structure of the calibration 
object as well as the bottom of the calibration object are visible in 
the image.

3. Move the Z-drive and focus on the bottom of the calibration 
object.

A special calibration standard is required for the [Manual Z-Axis Calibration] 
calibration process. If this calibration is required, contact customer service: 
support@olympus-sis.com
Phone: (+ 49) 251-79800-6444, fax: (+ 49) 251-79800-6445
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4. Click the [Next] button.
5. Move the Z-drive and focus on the top of the calibration object. 
6. Click the [Next] button.
7. Enter the height of the calibration object in the [Distance] field in 

the [Define Height Distance] dialog box.
8. Click the [Finish] button.

Viewing or reseting values
When you have manually calibrated the Z-axis, you can return to the 
preset value at any time. 

1. Select the [Manual Z-Axis Calibration] calibration process in the 
[Calibrations] dialog box.

2. Click the [Edit...] button.
3. Clear the [Enable correction] check box in the [Edit Manual Z-Axis 

Calibration] dialog box. 
 This preset value will then be displayed in the [Resulting 

calibration] field.
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18 [Check System]
You check the system and the accuracy of the calibration in this 
workflow. A  particle standard device is scanned instead of a sample.

18.1 [Check System] > [Mount Particle Standard Device]

1 The size of the live-image can be enlarged or reduced in steps in the display 
area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. The 
mouse pointer turns into a hand when it's on the image. You can also change 
the display size with the mouse wheel when you're in this mode.

2 This icon displays the magnification of the current objective.

2 This icon displays the current exposure time.

3 A blue square in the [Sample overview] group indicates the current position 
of the camera.
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18.1.1 Mounting a particle standard device
The [Check System] workflow enables you to check the system and the 
calibrations with the help of a  particle standard device. The particle 
standard device is scanned with the 5x objective and with the 10x 
objective. The results of the inspections are compared to the size of the 
particle standard device, which is know. If both of the inspections detect 
the exact same number of particles on the Particle Standard Device, the 
system check is successful and is classed as [OK]. Perform the system 
check with the objectives that you use to inspect the sample.

Prerequisites  The system has been calibrated. 
You can find more information about the calibration processes on 
page 212 of the [Calibration] chapter.

 Make sure that the particle standard device is clean and free of 
dust.

 Don't touch the particle standard device with your fingers, to avoid 
getting grease on it.

 If necessary, clean the particle standard device with a rubber dust 
blower.

 You can clean more persistent dirt off the particle standard device 
using a microfiber cloth and a little alcohol.

 Avoid getting the particle standard device dirty and only use it for 
the [Check System] workflow. 

In this step, you place the particle standard device in the multi-sample 
holder on the stage and start the acquisition of an  overview image. 
The overview image gives you a overall impression of the particle 
standard device.
Mounting the particle standard device and acquiring an overview 
image

1. Click the [Move Stage to Mounting Position] button.

4 The [Last check system results] group contains information about the last 
system check, its date and the result for example. You can select the 
objectives to be used for the next system check.

Checking the system with the [Check System] workflow is always 
recommended when you have made changes to the hardware or to the 
calibrations.
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 The stage moves to allow you to easily place the particle 
standard device in the multi-sample holder.

2. Place the particle standard device in position 2 of the multi-sample 
holder.

3. If the results of a system check are invalid, or if a system check 
hasn't yet been performed for a particular objective, this objective 
will be given a status of [Recommended]. Perform the system 
check with the objectives that you use to inspect the sample. To do 
this, select the check box next to the relevant objective.

4. Click the [Acquire Overview Image] button.
 The objective with the lowest magnification is set.
 Autofocus is activated.
 The optimum exposure time is automatically determined. 
 The acquisition of the overview image starts.
 The [Check System] > [Acquire Overview Image] page opens.
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18.2 [Check System] > [Acquire Overview Image]

1 The size of the  overview image can be enlarged or reduced in steps in the 
display area. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. 
The mouse pointer turns into a hand when it's on the image. You can also 
change the display size with the mouse wheel when you're in this mode.

1 Clicking the [Zoom to Fit] button adjusts the size of the overview image so 
that it fits perfectly in the display area.

2 This icon displays the magnification of the current objective.

2 This icon displays the current exposure time.

3 A blue square on the image in the [Sample overview] group shows the area 
of the sample that is currently being acquired.
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18.2.1 Acquiring the overview image
In this step the software acquires the  overview image of the particle 
standard device. The objective with the smallest magnification is 
automatically set. You can follow the acquisition of the overview image 
in the [Sample overview] group. The blue square shows the position on 
the particle standard device that is currently being acquired. The 
images that are being acquired of the particle standard device are 
assembled in the image in the display area. The progress bar estimates 
the duration of the acquisition of the overview image. 
After the overview image has been acquired, the [Check System] > [Edit 
Settings] page opens.
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18.3 [Check System] > [Edit Settings]

1 In the live-image in the display area, the automatically computed threshold is 
colored green. The display size of the live-image can be enlarged or reduced 
in steps. To do this, click the [Zoom Out] or [Zoom In] button repeatedly. The 
mouse pointer turns into a hand when it's on the image. You can also change 
the display size with the mouse wheel when you're in this mode.

1 Clicking the [Autofocus] button focuses the image automatically. You may 
need to perform the autofocus several times to focus the image. The joystick 
can also be used for manual focusing.

2 The display size of the  overview image in the [Sample overview] group can 
be enlarged or reduced in steps. To do this, click the [Zoom Out] or [Zoom In] 
button repeatedly. Clicking a different position on the sample in the overview 
image changes the position of the sample in the display area.

3 [Inspection 
settings]

Clicking the button with a gear wheel opens a dialog box where you can 
change settings.

4 [Sample 
information]

In the [Sample information] group, the name of the sample is displayed, in 
this case the particle standard device.
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18.3.1 Editing inspection settings
In this step, you can adjust some of the settings for the inspection of the 
particle standard device.
Editing the exposure time and thresholds for particles

1. Click the [Edit Exposure Time and Threshold for Particles] button.
 The [Edit exposure time and threshold for particles] dialog box 

opens.
 First set the exposure time and then set the threshold.
 You can find more information about this dialog box on page 40 

of the [Exposure time and threshold for particles] chapter.

Editing the inspection area and focus points
1. Click the [Edit Inspection Area and Focus Points] button.
 The [Inspection Area and Focus Points] dialog box opens.

The inspection area has already been correctly preset for the particle 
standard device. The outer circle of the particle standard device must 
be within the inspection area.

The inspection area (colored red) encompasses the outer circle of the particle standard device.

The [Check System] workflow has a focus map with 3 focus points. The focus 
points must be on areas of the particle standard device that have clear 
structures. The focus points are already preset on particles or on structures of 
the particle standard device.
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 You can find more information about this dialog box on page 46 
of the Inspection area and focus points chapter.

Performing the inspection
1. Click the [Run Inspection] button.
 The [Check System] > [Acquire Focus Points] page opens. 

If you selected the [Manual focus] check box when editing the 
focus points, the [Acquire Focus Points] page is skipped and the 
acquisition of the sample starts straight away. 
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18.4 [Check System] > [Acquire Focus Points]

1 The overview image in the [Sample overview] group displays the distribution 
of the focus points on the sample. 

2 The information in the [Focus points] group is constantly refreshed. 
The following information is shown: 
[Total number]: The total number of focus points.
[Processed]: The number of focus points that have already been processed.
[Without focus]: The number of focus points for which the focus position 
could not be found.
[Warning limit]: The maximum number of focus points that could not be 
focused. A warning appears when the limit is exceeded.
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18.4.1 Acquiring focus points

The focus points for the  focus map are acquired in this step.
After the focus points have been acquired, the [Check System] > 
[Acquire Sample] page opens.

The [Check System] > [Acquire Focus Points] page is only displayed if you 
defined a focus map.
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18.5 [Check System] > [Acquire Sample]

1 The display area shows the live-image of the current camera position.
2 The overview image in the [Sample overview] group is overwritten with high 

resolution images. The individual images are assembled into one single 
image.

3 The [Sample information] group contains information about the particle 
standard device.

4 The [Sample results] group displays the number of particles for each  
particle class. The [Overall approval] field displays the overall result of the 
system check with the particle standard device. The results are constantly 
refreshed during the acquisition of the sample.
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18.5.1 Acquiring the sample
The images of the particle standard device are acquired and the 
number of objects on it is determined in this step.
The [Sample information] group shows some of the criteria by which 
the particle is being classified. This information is specified in the 
particle standard device's inspection configuration.
The results in the [Sample results] group are constantly refreshed 
during the acquisition of the images. The bars next to the particle 
classes show how many particles have been found in that  particle 
class. The known values for the particle standard device are displayed 
with colored bars. This enables you to see whether the number of 
detected particles in a particle class matches the particle standard 
device's known values while the inspection of the particle standard 
device is still in progress.
After the images have been acquired, the [Check System] > [Check 
Results] page opens.
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18.6 [Check System] > [Check Results]

1 The results are sorted into  particle classes in the table.
2 The [Sample information] group contains information about the particle 

standard device.
3 Clicking the [Review Results] button opens the next page, the [Inspect 

Sample] > [Review Sample] page. This page displays the results in detail.
4 The overall results of the inspection are displayed in the [System check results] 

group. 
246OLYMPUS Cleanliness Inspector CIX ASW 1.5



18  [Check System]
[Check System] > [Check Results]
18.6.1 Checking the results
This page gives you an overview of the results of the system check with 
the particle standard device. The particles that were detected are sorted 
into particle classes in the table. If a class' maximum permitted value is 
exceeded, the result is classed as [NOK].
The [System check results] group shows the result of the system check 
for each objective (5x and 10x) separately. The abbreviation [n/a] means 
that this result is not available. Only when the results for both objectives 
are classed as [OK] does the [Overall approval] field receive the status 
[OK]. If the system check was only performed with one objective, the 
[Overall approval] field receives the status [n/a].
The [Check System] > [Review Sample] page displays the results and 
the individual particles in detail. If necessary, individual particles can be 
deleted on this page, dust for example.

1. Click the [Review Results] button on the navigation bar.
 The [Check System] > [Review Sample] page opens.
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[Check System] > [Review Sample]

ID_10018
18.7 [Check System] > [Review Sample]

1 [Particle View] The [Particle View] tab's display area shows a thumbnail of every particle that 
was detected. Clicking a thumbnail selects the row that contains that particle 
in the [Classification Table] and [Particle Table] tables. Particles can be deleted 
and particle families can be changed with the buttons on the toolbar. You can 
find more information about these buttons on page 56 of the [Inspect 
Sample] > [Review Sample] > [Particle View] chapter.

1 [Sample Image] The [Sample Image] tab's display area shows the position on the sample that 
is defined by the navigation tool in the overview image in the [Sample 
navigation] group. Clicking a particle in the [Particle Table] table moves the 
navigation tool to the corresponding position in the overview image. The 
toolbar above the display area contains several tools for editing the particles. 
You can find more information about these buttons on page 62 of the 
[Inspect Sample] > [Review Sample] > [Sample Image] chapter.

1 [Live Observation] The display area in the [Live Observation] tab shows the live-image of the 
current position on the sample. This tab is only displayed immediately after 
the sample has been inspected.
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[Check System] > [Review Sample]
18.7.1 Reviewing the sample
This page displays the results of the system check with the particle 
standard device in detail. The tabs in the display area make available 
three different views.
Sample information
The [Class] list contains all of the particle classes and their results. When 
you select a class, only the particles belonging to this class are 
displayed in the tab's display area. For example, if a particle class has a 

2 [Particle location], 
[Sample 
navigation], [Stage 
navigation]

Different groups are displayed in this display area depending on which tab is 
selected:
When the [Particle View] tab is selected, the [Particle location] group is 
displayed. Clicking a thumbnail in the [Particle View] tab moves the navigation 
tool to the corresponding position on the sample in the overview image.
When the [Sample Image] tab is selected, the [Sample navigation] group is 
displayed. Clicking a position on the overview image moves the navigation 
tool to the corresponding position on the sample. The image in the display 
area shows this position on the sample.
When the [Live Observation] tab is selected, the [Stage navigation] group is 
displayed. Clicking a position on the overview image moves the stage to the 
corresponding position on the sample.

3 [Classification 
Table]

The results of the inspection are displayed in the particle standard device’s 
particle classes in the [Classification Table] table. The [Absolute Count] 
column displays the number of particles that have been detected in this 
particle class. The [Maximum] column displays the maximum number of 
permissible particles in this particle class

3 [Particle Table] The [Particle Table] list displays every particle that was detected and its size. 
The [Reference Value] column displays the know sizes of the particle class as it 
is defined on the particle standard device. The [Delta Value] column displays 
the difference between these two values.

4 [Check System 
with 10x Objective]

This button is only displayed if you have selected both objectives for the 
system check on the [Check System] > [Mount Particle Standard Device] 
page.
Clicking the [Check System with 10x Objective] button changes the objective 
so that the [Check System] workflow can be performed with the 10x objective. 

5 Click the [Export to Excel] button to export the classification table or the 
particle table into an MS-Excel file.
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[Check System] > [Review Sample]
result of [NOK], you can take a closer look at the individual particles in 
this class and edit them if necessary. 
Use the [Delete particles] button in the [Particle View] or the [Sample 
Image] tab to delete dust particles or other matter that doesn't belong 
to the structure of the particle standard device.
Changing the objective and continuing with the system check

1. Click the [Check System with 10x Objective] button to continue the 
system check with the 10x objective.
 The 10x objective is set. 
 The [Check System] > [Edit Settings (10x)] page opens.
 You can now perform the [Check System] workflow with the 10x 

objective.

Results of system check
The results of the system check are shown separately for each objective 
(5x and 10x in the [System check results] group. The abbreviation [n/a] 
means that this result is not yet available. Only when the results for both 
objectives are classed as [OK] does the [Overall approval] field receive 
the status [OK]. If the system check was only performed with one 
objective, the [Overall approval] field receives the status [n/a].

Result [NOK] If the results show that the number of particles exceeds the known 
values for the particle standard device, clean the particle standard 
device. Then repeat the system check. Check whether the thresholds 
have been properly set on the [Check System] > [Edit Settings] page.
If the results show that the particles have been assigned to the wrong 
size classes, perform the [Calibrating the Camera-To-Stage Rotation] 
and [Manual Magnification Calibration] calibration processes. Then 
repeat the system check.

The [Check System with 10x Objective] button is only displayed if you have 
selected both objectives for the system check on the [Check System] > [Mount 
Particle Standard Device] page.
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19 Glossary
Exposure time and threshold value settings
Setting the image brightness (exposure time) and the  threshold 
values suitably is important so that the software can distinguish 
between the particles and the filter background when it is inspecting 
the sample.
For this evaluation of intensity, the software uses a histogram in which 
the number of pixels is plotted against the intensity. This is how the 
software determines how many pixels are present in an image, and 
their intensity. The exposure time is determined on the basis of the 
histogram, that is to say the intensity distribution in the image. 
Some guidelines define specific values for the exposure time and for 
the threshold values. This makes the results of the analyses easier to 
compare with each other. 

Example VDA The exposure time for the [VDA 19.1:2015] guideline is set so that the 
highest peak in the histogram (1) (this corresponds to the background 
of the filter) is placed at 55% of the overall intensity range.
The threshold is set to 70% of this highest peak (the background of the 
filter). The intensities that were deemed to be particles are on the left 
side of this threshold.
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Report template
A report template is a sort of "pattern" for a report. Placeholders for all 
of the information and images that a report contains are stored in a 
report template. A report template can be edited in Microsoft Word. 
A report and a report template are two independent documents. When 
changes are made to a report, these don't affect the report template. 
Inversely, changes that you have made to a report template don't 
automatically affect the report. A new report has to be created in order 
for the changes that you have made to a report template to appear in 
the report. 
Structuring the results in a report
You only have to insert the sections that act as placeholders for a 
particle type into a report template once. When the report is created, 
these sections are duplicated as often as is necessary to accommodate 
the number of particle types. General sections or a section for the 
sample image relate to the whole sample. These sections are only 
output once in a report.
Three different options for structuring reports are available on the 
pages for creating and editing report templates. These options 
determine how the sections with the results for the individual particle 
types will be ordered in a report.
• [Replicate template]
First all of the results for one particle type are inserted into the sections. 
Then these sections repeat in the same order for the other particle 
types.
• [Replicate section]
The results are organized by section. The particle types are listed one 
after the other within each section. First, the first section is displayed for 
each particle type, then the following section and so on.
• [Replicate section in blocks]
This option places the sections for the particle types that come after a 
general section in blocks. This is only applied if at least two consecutive 
sections for particle types are inserted directly after a general section in 
the report template.
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Differential counting
A differential count assigns the particles that have been detected to a 
particle class. The particle class is defined by a lower and an upper limit.

Example

The example shows a classification table resulting from a differential count.

There are standards stored in the software that support analysis using a 
 cumulative or a differential count. These standards are identified with 
the letter C (for cumulative) or the letter D (for differential).

Real color slider
A real color slider is a filter that is inserted into the microscope's light 
path. It can display the particles in their actual colors. The reflecting 
particles or reflecting areas of a particle will now not be displayed in 
blue.

EFI
EFI is the abbreviation of "Extended Focus Image". EFI uses a series of 
images focused at different depths (Focus series) to calculate a resulting 
image (EFI image) that is in sharp focus throughout. 

Result code
Some standards require the results of a cleanliness analysis to be 
summarized in a result code. The index numbers combined to form a 
result code vary from standard to standard.

Example ISO 16232-10 uses the CCC (Component Cleanliness Code) result code. 
For example, the “V (B20/C16/D18/E12/F13/G-J12)” Component 
Cleanliness Code means that the particles that were counted are 
computed with the component's wetted volume (V). In this example, 
the normalized count of particles in particle class B is assigned to 
contamination class 20, the normalized count of particles in particle 
class C is assigned to contamination class 16, and so on. 

Particle class Size range (μm)
B 5 ≤ x < 20
C 20 ≤ x < 50
D 50 ≤ x < 100
E 100 ≤ x < 200
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If an industry standard with the [Sedimentation Value] suffix is used for 
the cleanliness analysis of the ambient air, then the [Sedimentation 
Value] entry is automatically preset in the [Result code] list.

Filter occupancy
Filter occupancy assesses the distribution of particles on a filter. The 
filter occupancy is expressed in percentage of occupancy. The filter 
occupancy is determined by the ratio between the area that is covered 
by particles and the inspection area. In order to get a meaningful result, 
it’s important that the particles are evenly distributed on the filter, that 
they are not too close to each other, and that they don’t overlap. 

Focus map
A focus map is a type of height profile of the sample. A focus map is 
defined by several focus points that determine the best focus position 
at various position on the sample. The Z-position for each position is 
saved. Using the focus positions, the software extrapolates the 
topography of the surface of the sample. This means that the optimal 
focus position for any position on the sample can be determined by the 
focus map. A focus map enables you to acquire an image that is well 
focused over a large area. The software has different options for 
determining the number and position of focus points. You can choose 
the option that best suits the properties of a particular sample.

Inspection area
The inspection area is the area of the sample that is analyzed by the 
inspection. The software defines an inspection area with a diameter of 
42.5 mm by default. The size of the inspection area can be changed. 
The inspection area should be defined so that only the sample is 
shown, and no parts of the filter holder.

Inspection settings
Inspections settings are a collection of options (like the exposure time 
and the threshold) that can be adjusted immediately before a sample 
inspection is started in the [Inspect Sample] or the [Inspect Multiple 
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Samples] workflow. This is different from an inspection configuration in 
that the inspection settings can still be adjusted after the [Inspect 
Sample] workflow has started.

Inspection configuration
An inspection configuration contains all of the parameters that 
determine how the system analyzes one or more samples. These 
parameters include system specific settings as well as standards 
guidelines from various fields of industry. They can also contain user-
defined settings. An inspection configuration is made up of the 
parameters of a standard plus additional parameters contained in the 
following configuration pages: [Inspection Configurations], [Standards], 
[Particle Families] and [Particle Types].

Cumulative counting
A particle class is usually defined by a lower and an upper size 
threshold. With cumulative counts, there is no upper threshold for the 
particle class.

Example The following tables illustrate the difference between a  differential 
and a cumulative count. 

The example shows a classification table resulting from a differential count.

With a cumulative count, the particle classes are defined only by a 
lower size threshold. If the particles from the above classification table 
are cumulated, the result is as follows.

The example shows a classification table resulting from a cumulative count.
There are standards stored in the software that support analysis using a 
cumulative or a differential count. These standards are identified with 
the letter C (for cumulative) or the letter D (for differential).

Particle class Size range Number of particles
A 5 ≤ x < 15 µm 60
B 15 ≤ x < 30 µm 40
C  30 ≤ x < 100 µm 10

Particle class Size range Number of particles
A > 5 µm 60 + 40 + 10 = 110
B > 15 µm 40 + 10 = 50
C > 30 µm 10
256OLYMPUS Cleanliness Inspector CIX ASW 1.5



19  Glossary
Surface Cleanliness Index
The surface cleanliness index is similar to the  sedimentation value 
(Illig value). To measure the surface cleanliness index, particles are 
acquired using a tape lift method. It is different to a sedimentation 
value in that when the surface cleanliness index is computed, it is not 
scaled for time.

Particle
The software defines a particle as a continuous area of pixels that all lie 
within a certain intensity range. This means that the pixels belonging to 
the same particle are all roughly equally light or dark or have more or 
less the same color.

Particle traps
A particle trap gathers and fixes particles from the ambient air on a 
sedimentation surface. This determines what particles and pollution are 
present in the air. These sedimentation surfaces are analyzed after a 
specific interval and the particle on them are counted and measured.

Particle family
Particles are classified by size and by different material properties. A 
particle family defines a particular material property of a particle. 
A particle family is defined by one or more measurement parameters 
that are limited by a minimum and a maximum value. For example, a 
fiber is defined by the [Fiber Length], [Max. Inner Circle Diameter], 
[Fibrousness] and [Compactness] measurement parameters. If the 
values measured during an inspection meet the requirements for a 
fiber, the particle will be assigned to the [Fiber] particle family. 
A reflecting particle is defined with the [Reflectance] measurement 
parameter. If the values measured during an inspection meet the 
requirement for a reflecting particle, the particle will be assigned to the 
[Reflecting] particle family.
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Particle class
Particles are classified according to their size and are then assigned to a 
particle class. The OLYMPUS Cleanliness Inspector Software also assigns 
a color to the particles that have been classified. All of the particles in a 
particle class are given the same color in the image and in the results 
tables.
Example: According to the classification system in the following table, a 
particle that has a length of 120 μm would be assigned to particle class 
E.

The table is an example of a classification table.

Particle standard device
Various different particles and structures of known shape and size 
appear on a particle standard device. The software scans the particle 
standard device instead of a sample. The objects on the particle 
standard device are detected and compared to the known sizes. You 
can use a particle standard device to check the system and the 
accuracy of the calibration.

Particle class Size range (μm)
B 5 ≤ x < 20
C 20 ≤ x < 50
D 50 ≤ x < 100
E 100 ≤ x < 200
F 200 ≤ x < 300
G 300 ≤ x < 500
H 500 ≤ x < 800
I 800 ≤ x < 1000
J 1000 ≤ x
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The circular area of the particle standard device is divided into 8 segments. Each segment contains 
different particle types.

Particle type
One or more particle families can be combined into a particle type. A 
particle type consists of at least one particle family. For example, a 
particle that is both reflective and fibrous would be assigned to the 
[Reflecting Fiber] particle type. 

Threshold
The software defines a particle as a continuous area of pixels that all lie 
within a certain intensity range. Pixels belonging to the same particle 
are all more or less equally light or dark or have the same color. The 
intensity range is defined by the smallest and the largest intensity value. 
These two intensity values become the thresholds. In a sample 
inspection, you use the thresholds to determine which particles are 
found. 
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Threshold for reflecting particles
You can set a threshold for the reflecting areas of a particle in the 
software. The reflecting pixels inside a particle are detected and 
computed with the pixels of the particle's overall area. When the 
particle has more than a certain amount of reflecting areas, it is 
counted as a reflecting particle in the inspection results.

Sedimentation value
The industry standards and directives use a standardized reference size 
when analyzing the cleanliness of ambient air by evaluating particle 
traps. This is known as the sedimentation value (also as the Illig value or 
sedimentation count1). This value is arrived at by multiplying the 
number of particles in each size class with a weighting factor. These 
weighted particle counts are then added together. The sum of these 
particles is normalized for a measurement area of 1000cm2 and 
referenced to a measurement time of one hour. The result is called a 
sedimentation value.2

Overview image
An overview image of the whole sample is acquired in the lowest 
magnification before the sample is inspected. The overview image 
provides an initial quick overview of the whole sample. The overview 
image can be used for the definition of the inspection area or for the 
adjustment of the focus points. After the sample has been inspected, 
the overview image is replaced with a high-resolution image. The 
overview image is only temporarily saved.

Contamination class
Some standards classify the particles assigned to a particle class by 
contamination class as well. A contamination class is defined by a 
minimum and a maximum number of particles.

1. Technical cleanliness in assembly. Verband der Automobilindustrie e.V. (VDA). Part 2.
First edition 2010. Page 151.
2.cf. Technische Sauberkeit in der Montage. Verband der Automobilindustrie e.V. (VDA).
Part 2. First edition 2010. Pages 150-152.
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Example According to the classification scheme in the following table, a particle 
class with 40 detected particles (particle class B for example) would be 
assigned to contamination class 4.

The table shows an example of classification by contamination.

Number of particles Contamination classMore than Up to (inc.)
0 0 00
0 1 0
1 5 1
5 10 2
10 20 3
20 50 4
50 100 5
100 500 6
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1  Overview - Software mode [Analyze Materials]
Changing the software mode
1 Overview - Software mode [Analyze Materials]
The [Analyze Materials] software mode is available when the [CIX 
Interactive Measurement Solution] software solution has been activated 
in your OLYMPUS Cleanliness Inspector Software.
The [Advanced microscopy] > [Analyze Materials] button is then 
displayed on the OLYMPUS Cleanliness Inspector Software’s home 
page.
The [Analyze Materials] software mode provides a range of image 
acquisition functions and automatic image analysis functions. You can 
find more information on this topic in chapter Range of functions on 
page 11. 

1.1 Changing the software mode
When you switch to the [Analyze Materials] software mode, the user 
interface changes. 
On the start page of the OLYMPUS Cleanliness Inspector software, click 
the [Advanced microscopy] > [Analyze Materials] button to switch to 
the [Analyze Materials] software mode.
In [Analyze Materials] software mode, click the [Home], button to leave 
the [Analyze Materials] software mode. This takes you back to the start 
page of the OLYMPUS Cleanliness Inspector software.
Alternatively, click the button with the cross in the header at the top 
right of the software.
When you leave the [Analyze Materials] software mode, all of the loaded 
documents have to be closed.
4OLYMPUS Cleanliness Inspector CIX ASW



1  Overview - Software mode [Analyze Materials]
Range of functions
1.2 Range of functions
The [Analyze Materials] software mode has the following functions.
Acquiring images
You can use your system to acquire high resolution images of a sample 
in a few steps. You can first examine the live-image and adjust it 
optimally. The live-image will be constantly updated, i.e., when you, for 
example, move the stage to a different position, the live-image will be 
changed accordingly. You can switch the live-image on and off and 
acquire the parts of the sample that interest you. When you do this, you 
will create a digital image that you can save and process or analyze 
with a variety of your software's functions. You can find more 
information on this topic in chapter Acquiring images on page 26.
Measuring images
You can make various measurements on images, and, e.g., measure 
the length of a line, the perimeter of an ellipse or an angle in degrees. 
The measurement objects will be displayed in the image's drawing 
layer, and can be faded in and out. The measurement results will be 
shown in a sheet and can be differently sorted by a click of your mouse. 
You can export measurement results, for example, to the XLSX format 
(for further editing in the MS-Excel application program). You can find 
more information on this topic in chapter Measuring images 
interactively on page 48.
Using materials science analysis processes
You can measure an image, or several images at the same time, 
according to different materials science analysis processes. You can find 
all of the analysis processes in the [Materials Solutions] tool window.
The [Materials Solutions] tool window works similarly to a software 
wizard. As soon as you've started an analysis process you'll be guided 
step by step through the measurement.

The analysis processes must be purchased. The analysis processes that are 
available in your software vary depend on the software solutions that you 
purchased for your OLYMPUS Cleanliness Inspector System. Maybe you will 
only see one or two analysis processes.
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Example images
The following materials science analysis processes are available:
• [Grains Intercept], page 84
• [Grains Planimetric], page 98
• [Layer Thickness], page 124
• [Cast Iron], page 152
• [Inclusions Worst Field] & [Inclusion Content], page 180
• [Porosity], page 210 
• [Phase Analysis], page 240
• [Coating Thickness], page 264
• [Dendrite Arm Spacing], page 282

Processing images
You can process the acquired images and retroactively optimize the 
image quality according to your requirements. Numerous filters and 
functions are available for this purpose, e.g., various smoothing or 
sharpness filters, and functions to optimize the contrast. As well as this, 
you can mirror the images and also rotate them through an arbitrary 
number of degrees. You can find more information on this topic in 
chapter Processing images on page 34.

1.3 Example images
The DVD that comes with your software contains, among a lot of other 
data, also images that show different examples of use for your software. 
You can load these so-called example images from the DVD. However, 
in many cases, installing the example images on your local hard disk or 
on a network drive is more helpful. Then the example images will 
always be available, no matter where the DVD with the software 
currently is.

You can open and view the example images with your software. 
Additionally, you can use the example images to test some of your 
software's functions, for example, the automatic image analysis or the 
image processing.

Your software's user documentation often refers to these example images. You 
can directly follow some step-by-step instructions when you load the 
corresponding example image.
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About this help document
1.4 About this help document
This help document describes the [Analyze Materials] software mode in 
the OLYMPUS Cleanliness Inspector Software (CIX ASW). You can open 
this help document by clicking on the question mark button in the 
header of a dialog box or tool window. You can also use the F1 key.
This help document is also available as a PDF file. If you want to read 
the document outside of the software, you can open the "Manual_CIX-
ASW.pdf" file. The PDF file is available in the following languages: 

 English
 Japanese
 Korean
 Chinese
 French
 Spanish
 German

By default, a link to the "Manuals" folder is created on the Windows 
Desktop during the installation of the software. If you cannot find this 
link, open the software’s installation directory and double click the 
"Manuals" folder. You can then select the required language and open 
the PDF file.
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2 User interface
2.1 Appearance of the user interface

The user interface for the [Analyze Materials] software mode is different 
from the user interface for the OLYMPUS Cleanliness Inspector 
Software. 
You can find more information on starting and leaving the [Analyze 
Materials] software mode in section Changing the software mode on 
page 10.
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1 Document group The document group contains all of the images and tables that have been 
loaded. 
When you start your software, the document group is empty. While you use 
your software the document group gets filled - e.g., when you load or acquire 
images, or perform various image processing operations to change the 
source image and create a new one. You can find more information on page 
16 of the Document group chapter.

2 Tool Windows Tool windows combine functions into groups. These may be very different 
functions. For example, in the [Properties] tool window, you can find all the 
information available on the active document.
In contrast to dialog boxes, tool windows remain visible on the user interface 
as long as they are switched on. That gives you access to the settings in the 
tool windows at any time.
You can find more information on page 18 of the Overview - Tool windows 
chapter.

3 [Materials 
Solutions]

The [Materials Solutions] tool window offers several materials science analysis 
processes. Use the tool window to measure one or several images at the 
same time.
The analysis processes must be purchased. The analysis processes that are 
available in your software depend on the software solution that you 
purchased for your OLYMPUS Cleanliness Inspector System. If you have 
purchased more than one software solution they will be displayed in the 
[Materials Solutions] tool window.

4 [Measurement 
and ROI]

The [Measurement and ROI] tool window offers a number of interactive 
measurement functions. They enable you to measure distances and areas on 
an image.

5 Toolbars There are buttons for commands that you use frequently, providing you with 
quick and easy access to these functions. A toolbar groups buttons together. 
You can find more information on page 19 of the Overview - Toolbars 
chapter.

6 Status Bar The status bar shows, e.g., a brief description of each function. Simply move 
the mouse pointer over the command or button for this information. You can 
also find additional information in the status bar.
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2.2 Document group
The document group contains all loaded documents. As a rule, images 
will be loaded. You can also find other types of documents in the 
document group, tables of measurement results for example.
Appearance of the document group

1 Document group You will find the document group in the middle of the user interface. In it you 
will find all of the documents that have been loaded, and of course also all of 
the images that have been acquired. The live-image and the images resulting 
from any image processing function are also displayed there.
Note: At the same time, up to 150 documents can be loaded in the document 
group.
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2 Document bar The document bar is the document group's header.
For every loaded document, an individual tab showing the document name 
will be set up in the document group. Click the name of a document in the 
document bar to have this document displayed in the document group. 
Each type of document is identified by its own icon. The following icons will 
be used:

 True-color image
 Gray-value image
 Workbook

At the top right of each tab, a small [ x ] button is located. Click the button 
with the cross to close the document. If it has not yet been saved, the 
[Unsaved Documents] dialog box will open. You can then decide whether or 
not you still need the data.

3 Buttons in the 
document bar

The document bar contains several buttons, on the left and on the right.

Click the button with a hand on it to extract the document group from the 
user interface. In this way you will create a document window that you can 
freely position or change in size.
If you would like to merge two document groups, click the button with the 
hand in one of the two document groups. With the left mouse button 
depressed, drag the document group with all the files loaded in it, onto an 
existing one.
Prerequisite: You can only position document groups as you wish when you 
are in the  expert mode. In standard mode the button with the hand is not 
available.
You can find two arrow buttons at the top left and the top right of the 
document group.
When your software starts, the arrow buttons are inactive. The arrow buttons 
will only become active when you have loaded so many documents that all of 
their names can no longer be displayed in the document group.
If you have loaded so many images that all of their names can no longer be 
displayed in the document group, click one of the two arrows. This scrolls the 
fields with the document names to the left or to the right. That will enable you 
to see the documents that were previously not shown.
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2.3 Overview - Tool windows
In the [Analyze Materials] software mode, you can find the following 
tool windows. All of the tool windows are always displayed and can't be 
hidden.

Click the small arrow on the right to open a list of all of the loaded 
documents. If you are using more than one document group, the loaded 
documents are sorted by document group. A horizontal line divides the 
document groups from each other.
Left click the document that you want to have displayed on your monitor.
Alternatively, you can use the [Gallery] tool window to get an overview of the 
documents that have been loaded.

[Image Navigator] Use this tool window to change the segment of the image that is displayed in 
the image window.

[Properties] The image acquisition process acquires a range of additional information 
together with the image. The [Properties] tool window will show the available 
information for the active image. 
Note: Most of the data will only be saved along with your image when you use 
the TIF or VSI file format. If you use any other file format, the data will be 
irrevocably lost when you save the image.

[Gallery] The [Gallery] tool window displays thumbnails of all of the loaded images. 
Click on one of the thumbnails to activate the corresponding image in the 
image window.

[Materials Solutions] The [Materials Solutions] tool window offers different materials science 
analysis processes. You can find an overview of the available analysis 
processes in chapter Using materials science analysis processes on page 11.

[Measurement and 
ROI]

In this tool window you have fast access to all measurement functions and 
settings which effect measurements. This tool window is at the same time the 
measurement display and contains all of the values that have been measured 
on the active image. You can find more information on page 48 of the 
Measuring images interactively chapter.

[Microscope Control] Use this tool window to control your microscope. You can change objectives, 
switch back and forth between the observation methods that have been 
defined, and move the stage.
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2.4 Overview - Toolbars
In the [Analyze Materials] software mode, you can find the following 
toolbars.

[CIX Home] The [CIX Home] toolbar contains the [Home] button. In [Analyze Materials] 
software mode, click the [Home], button to leave the [Analyze Materials] 
software mode. This takes you back to the start page of the OLYMPUS 
Cleanliness Inspector software.

[CIX Standard] The [CIX Standard] toolbar contains a lot of basic functions. 
For example, with the [CIX Standard] toolbar you can load, save, and print 
image files 
You can also use this toolbar to quickly display or hide elements on the user 
interface. You can show or hide a scale bar in the image window for example.
You can find more information on this toolbar in chapter [CIX Standard] 
toolbar on page 20.

[Camera Control] The [Camera Control] toolbar contains the functions for acquiring snapshots. 
You can set the exposure time and you have access to the acquisition 
settings. You can find more information on this toolbar in chapter [Camera 
Control] toolbar on page 26.

[Microscope Control] The [Microscope Control] toolbar contains buttons for changing objectives. 
[Zoom] Use the buttons in the [Zoom] toolbar to set the size the active image is to be 

displayed on your monitor.
[Toolbox] The [Toolbox] toolbar contains numerous tools that can help you to select the 

image segments that interest you.
[Formatting Font] Use the buttons in this toolbar to format text in a text object on an image. 

You can find step-by-step instructions on working with drawing objects in 
chapter Using the continuous drawing mode on page 42.

[Drawing] Use the buttons in this toolbar to draw on images. It makes a variety of 
drawing functions (Line, Rectangle, Ellipse, Text) available to you, as well as 
options for color selection and line styles.
You can find more information on this toolbar in chapter [Drawing] toolbar 
on page 40.
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Showing toolbars
1. Right click on any toolbar to open a list of all of the available 

toolbars.
 All of the toolbars that are shown are identified with a check 

mark in front of their name.
2. Select a toolbar in the list of all of the available toolbars to show or 

hide it.

2.4.1 [CIX Standard] toolbar
The [CIX Standard] toolbar contains a lot of basic functions. 

[Open File] Click this button to load files. Images, charts and workbooks are the 
supported document types.
Click the small arrow to the right of the button. In the menu, you can 
also find a list of recently opened documents.

[Save] Click this button to save the active document to a disk.

[Save As] Click this button to save a document that has already been saved under 
a different name.

[Excel] Click this button to export a workbook with measurement results to 
Excel.

[Print] Click this button to print the active document. You can click the [Page 
Setup] button to print scale bars and info stamps together with the 
image.

[Print Preview] Click this button to display a print preview.

[Set Print 
Resolution]

Click this button to set the print resolution for an image. You can use 
this print resolution when you are burning in additional information to 
the image. Additional information can include things like the scale bar 
and the info stamp. The print resolution determines the size of the 
additional information that is burnt in.

[Copy] Click this button to copy all of the objects that are currently selected to 
the clipboard. Objects that are selected can include measurement 
objects, drawing objects, and image segments. When you want to copy 
image segments, first use the [Marquee Tool] button on the [Toolbox] 
toolbar to select the image segment.
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[Paste] Click this button to copy the contents of the clipboard to the active 
image. 

[Process Menu] Click the [Process Menu] button to open a menu with image processing 
functions. You can find more information on page 44 of the [Process 
Menu] chapter.

[Burn In Info] Click this button to burn in additional information, such as the scale bar, 
the color bar, or the info stamp to the active image. Measurement data 
or drawings can also be burnt in to the image in this way.
When you burn in information, you write this additional information 
irrevocably into the image. This additional information will then become 
an integral part of the image. All of the pixels that lie beneath the 
additional information displayed on the image, e.g., beneath the scale 
bar, will be overwritten by the burning in. In this way, image information 
is lost.

[Undo]
[Redo]

Click these buttons to undo or redo the last command to be 
performed. Clicking them again undoes or redoes the previous 
command, and so on. You can use it to restore the source image after 
an image processing function has been performed, for example.

[Scale Bar] Click this button to show a scale bar in the image window.

[Info Stamp] Click this button to show an info stamp in the image window. You can 
configure the info stamp to show various information. This information 
is acquired and saved together with the image. Examples of this include 
the objective magnification and the exposure time.

[Options] Click this button to open the [Options] dialog box. In this dialog box 
you can find a range of default settings with which you can configure 
the [Analyze Materials] software mode. You can change the 
appearance of the scale bar, for example, or the color of the interactive 
measurement objects.
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3 Working with documents
You can choose from a number of possibilities when you want to open, 
save, or close documents. As a rule, these documents will be images. 
Your software does however also support charts and workbooks.

3.1 Saving documents
You should always save important documents immediately following 
their acquisition. You can recognize documents that have not been 
saved by the star icon after the document's name.
There are a number of ways in which you can save documents.

1. To save a single document, activate the document in the 
document group. Then click the [Save] or [Save As] button. 
Alternatively, use the [Ctrl+ S] or [Ctrl+ Shift + S] keyboard 
shortcut.

2. Use the [Gallery] tool window.
Select the desired document and use the [Save] command in the 
context menu. For the selection of documents, the standard MS-
Windows conventions for multiple selection are valid.

Automatic saving 3. When you exit your software, all data that has not yet been saved 
will be listed in the [Unsaved Documents] dialog box. This gives you 
the chance to decide which document you still want to save.

4. You can also configure your software in such a way that all images 
are saved automatically after image acquisition. To do so, use the 
[Acquisition Settings] > [Saving] dialog box. 
 You can find more information on this topic in chapter 

[Acquisition Settings] > [Saving] > [Snapshot] on page 31.
16OLYMPUS Cleanliness Inspector CIX ASW



3  Working with documents
Closing documents
3.2 Closing documents
There are a number of ways in which you can close documents.

1. To close a single document, activate it in the document group and 
click the button with the cross [ x ]. You can find this button at the 
top right of the document tab next to the document name.

2. Use the [Gallery] tool window.
Select the desired document and use the [Close] command in the 
context menu. For the selection of documents, the standard MS-
Windows conventions for multiple selection are valid.

3. All of the loaded documents are automatically closed when you 
leave the [Analyze materials] software mode.
Click the [Home] button to leave the [Analyze Materials] software 
mode. This takes you back to the start page of the OLYMPUS 
Cleanliness Inspector software. 

Closing all documents
To close all loaded documents, use the [Ctrl + Alt + W] keyboard 
shortcut. You can also find the [Close All] command in the [Gallery] tool 
window's context menu.

Closing a document immediately
To close a document immediately without a query, close it with the 
[Shift] key depressed. Data you have not saved will be lost.
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3.3 Opening documents
There are a number of ways in which you can open or load documents.

1. Click the [Open File] button or use the [Ctrl + O] keyboard 
shortcut.

2. Drag the document you want, directly out of the MS-Windows 
Explorer, onto your software's document group.

Activating documents in the document group
There are several ways to activate one of the documents that has been 
loaded into the document group and thus display it on your monitor.

1. Use the [Gallery] tool window. Click the desired document there.
2. Click the title of the desired document in the document group.
3. Click the small arrow at the top right of the document group to 

open a list of all of the loaded documents. Left click the document 
that you want to have displayed on your monitor.

Note: At the same time, up to 150 documents can be loaded in the document 
group.
18OLYMPUS Cleanliness Inspector CIX ASW



3  Working with documents
Opening documents
19 OLYMPUS Cleanliness Inspector CIX ASW



4  Acquiring images
[Camera Control] toolbar
4 Acquiring images
In the [Analyze Materials] software mode, you can acquire and save 
snapshots. 

Preconditions  Your camera has been registered and configured with your system.
 The [Manual Magnification Calibration], [Shading Correction] and 

[White Balance] calibration processes have been performed.

4.1 [Camera Control] toolbar
Use the buttons in the [Camera Control] toolbar to acquire snapshots. 
You'll find the toolbar at the top, under your software's header.

4.2 [Acquisition Settings]
The [Acquisition Settings] dialog box offers you several general options 
for working with live images. 

Opening the
dialog box

You open the tool window using the [Camera Control] toolbar. In the 
toolbar, click the [Acquisition Settings] button. 

[Live] Switch to the live mode.

[Snapshot] Acquire an image.

[Manual Exposure] Switch back and forth between the manual and automatic exposure 
modes.

[Acquisition 
Settings]

Open the [Acquisition Settings] dialog box. In it, you can change 
numerous settings for the image acquisition.

[Autofocus] Click the [Autofocus] button to have the image automatically focused. 
Your software now evaluates the whole image to determine the optimal 
focus value.
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4.2.1 [Acquisition Settings] > [Acquisition] > [General]
The live-image will be allocated its own window in the document 
group. This window's header will be [Live (active)]. The behavior of this 
live window depends on the settings in the [Acquisition Settings] > 
[Acquisition] > [General] dialog box. 
Retaining the document when the live-image closes
Select the [Continue live after snapshot] check box to pause (as 
opposed to stop) the live mode while you acquire a snapshot. 
Acquiring a snapshot will then create a new image window, but the 
window for the live-image will remain active and will immediately switch 
back into the live mode.
To exit the live mode, click the [Live] button, located on the [Camera 
Control] toolbar again.

Confirming the magnification after the acquisition process has 
ended
Select the [Confirm magnification after acquisition] check box to have 
the [Calibrate Image] dialog box automatically displayed after every 
image acquisition. 
Select the Magnification (default) option when you want to use the 
objective's calibration data for the X/Y-calibration. 
Select the [Interactive Calibration] option when you want to calibrate an 
image on the basis of a linear distance you know. That can, for 
example, be a ruler or another scale that you have acquired together 
with an image. Click the [Set Reference Distance] button to define the 
reference distance in the image.
Choosing the basic unit
You can set the basic unit for the X/Y-calibration that is to be used for 
the image acquisition. To do so, select the unit you want to use from 
the [Basic Unit] list. The basic units Meters [m] and Inches [in] are 
available.
When you select another basic unit, all of the images that you from that 
moment on acquire will be automatically calibrated in this new basic 
unit. Now, all values that apply to the X/Y-calibration will be specified in 
this new basic unit. 
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These could be: 
• the labeling of the scale bar
• the calibration data in the [Properties] tool window
• the measurement results when you make measurements on an image

Note: The basic unit for the X/Y-calibration of images you have already 
acquired will not be changed, when you alter the basic unit. If you have 
acquired an image with the basic unit Meters it will remain calibrated in 
meters or in a unit derived therefrom, such as mm or µm. 
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4.2.2 [Acquisition Settings] > [Document Name] > [Snapshot]
When an image is acquired, your software allocates it a default name. 
For instance, the first image that your software acquires will be named 
[Image_01] by default. You can change this name in the [Acquisition 
Settings] > [Document Name] dialog box.

[Preview] The [Preview] field shows the name of the next image that you will 
acquire. This preview will be updated as soon as you change the 
image's name.

[Customize] An automatically created name is made up of different parts. In the 
[Customize] group, you define a prefix and specify the numbering 
system.
Defining a prefix
Enter the first part of the image's name in the [Text] field. The prefix 
[Image] has been predefined. By default, the images that are acquired 
are called [Image_01], [Image_02] etc. 
If possible don't use any special characters for the image name. Certain 
special characters, e.g. ?, are not accepted and you can't enter them. If 
the image contains special characters in its name, it may, in certain 
cases, be impossible to automatically save it. 
You can also move the prefix which you defined in the [Text] field to 
any other position in the name of the image. To do this, click the [All 
Options] button. A dialog box will open in which you can assemble an 
automatically created name from various placeholders. You can find 
the prefix defined in the [Text] field in the top position of the [Selected 
properties] column. Select the prefix and use the [Up] and [Down] 
buttons.
Defining counters
Define in the [Counter digits] field how many digits the numbering 
should consist of, e.g., 3 for the number 001. Please note that the value 
entered in the [Counter digits] field will not place an upwards limit on 
the numbering. This means that if you have entered a value of 2, for 
example, and the last image you acquired was [Image_99], the next 
image will be called [Image_100].
If you want to start the numbering from a certain value, change the 
value in the [Counter start] field. There, you can, for example, return the 
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numbering to 1 if you have acquired a great many images. Or you can 
continue the numbering of a series of images from the previous day. If 
you change the value in the [Counter start] field then the next image 
will always start with the set numbering. All additional image numbers 
will increase by a value of 1. 
Each time your software restarts, the numbering of the images will 
restart with the value set in the [Counter start] field. You can only 
change the value in the [Counter start] field, if you have cleared the 
[Reset automatically] check box.

Select the [Reset automatically] check box when you want to be sure 
that images that belong together will be consecutively, serially 
numbered without any breaks. You can then no longer change the 
numbering of the images manually.

Customizing document names
Your software supplies you with a number of placeholders that you can 
use in image names. Click the [All Options] button to select the 
placeholders that you want.

The value in the [Counter start] field may be ignored if automatic saving 
is active. In this case, your software checks whether a file with the name 
wanted already exists in the current directory. Should this file exist, the 
next higher available number will automatically be used. To switch the 
automatic storage process on or off, use the [Acquisition Settings] > 
[Saving] dialog box. 
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4.2.3 [Acquisition Settings] > [Saving] > [Snapshot]
By default, when you make an image acquisition, a new image 
document will be created and displayed in the document group. You 
can rename and save this image. If you have not already saved it when 
you end your software, you will be asked if you want to do so.
In the [Acquisition Settings] > [Saving] dialog box, you can specify 
whether you want to automatically save the image after it is acquired.
Automatically saving images after acquisition

[Destination] You can automatically save all images after acquisition. To do this, 
select the [File system] entry in the [Destination] list if you want to save 
your images as files. 
In the dialog box, the [Directory] group now becomes active. Here, you 
can define the destination location for saving your documents.

Select the [Prompt] entry in the [Destination] list. Now the [Save Image 
As] dialog box will automatically open each time an image is acquired.

[File type] In the [File type] list, select the file format in which the images should be 
saved after the acquisition. For the image file formats TIF, VSI, JPEG, 
and JPEG 2000, there are additional settings that are taken into account 
when saving images. Click the [Options] button if you want to see these 
settings or change them.

[Close after save] Select the [Close after save] check box to have the image document 
close immediately after the image has been saved. The images will then 
be saved as files. Use this possibility to avoid taking up too much of 
your computer's memory capacity when you acquire images.

At the same time, up to 150 documents can be loaded in the document 
group. When you're acquiring an image, you receive an error message 
if the maximum possible number of documents is already loaded. 
When you have switched on automatic saving, the image is acquired 
and saved to the current directory even though it can no longer be 
displayed in the document window.

Images acquired with your software always contain a range of additional 
information which can be seen in the [Properties] tool window. This 
additional information will only be retained if the images are saved in 
the TIF, BTF, or VSI format.
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Please note that you then can't see the images in your software after 
the image acquisition.

[Directory] The [Path] field shows the current directory that will be used when your 
images are automatically saved. Click the [...] button next to the [Path] 
field to select a different directory into which the images are to be 
saved after their acquisition.

[Create Subdirec-
tory]

When you save images automatically after the image acquisition, you 
have the possibility of saving images that belong together in their own 
individual directory. By default, all of the images that you acquire in one 
day will then be saved in one separate directory. On the following day, 
a new directory will be automatically opened. This enables you to 
always have a clear overview, even when you acquire a great number 
of images.
Select the [Create Subdirectory] check box to have the acquired images 
saved in their own subdirectory.
Click the [Customize] button if you want to change the name that has 
been suggested for the subdirectory. Your software supplies you with a 
number of placeholders that you can use in directory names. With your 
choice of the placeholder you also determine the criterion with which 
your directory tree structure will be organized. You can, therefore, set 
up a subdirectory for each user, for instance.
The [Preview] field shows you the current subdirectory for the next 
image acquisition. This preview will be updated as soon as you change 
the subdirectory's name.
Deactivating automatic saving
From the [Target] list, select the [No automatic save] entry to switch off 
the automatic saving of images. Now you need to save your images 
yourself after they are acquired if you want to keep the image files. In 
this case, no other functions will be available in this dialog box.
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4.3 Acquiring snapshots
Preconditions  Your camera has been registered and configured with your system.

 The [Manual Magnification Calibration], [Shading Correction] and 
[White Balance] calibration processes have been performed.

1. On the start page of the OLYMPUS Cleanliness Inspector software, 
click the [Advanced microscopy] > [Analyze Materials] button to 
switch to the [Analyze Materials] software mode.
 You can find the [Camera Control] toolbar at the upper edge of 

the user interface.
2. Click the [Live] button. 
 The live-image will now be shown in the image window in the 

document group.
3. Go to the required position on the sample.
4. Select the acquisition settings you want.
 Change the objective if required. 
 Set the exposure time.
 Use the [Zoom In] and [Zoom Out] buttons to adjust the image 

in the image window.
 Focus the image.

5. Click the [Snapshot] button.
 The acquired image will be shown in the document group.

6. Click the [Save] button to save the image. Use the recommended 
TIF or VSI file format.
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5 Processing images
5.1 Viewing images
5.1.1 Enlarging or reducing the size of the image in the image window

On the left, the whole image is displayed in the image window. On the 
right, the zoom factor has enlarged the image segment so that it can 
be viewed in higher resolution. The scale bar relates to the 
magnification of the image in the image window and is adjusted 
accordingly. Because the entire image can no longer be displayed in 
the image window, slide controls appear in the image window.
There are several different ways to change your image's zoom factor in 
the image window. 

1. Use the buttons on the [Zoom] toolbar.
2. Right click on an image window. In the context menu you will find 

several commands with which you can alter the image's zoom 
factor.

3. Rotate the mouse wheel to change the zoom factor.
4. Use the [Image Navigator] tool window. 
 In the [Image Navigator] tool window, while keeping the left 

mouse button depressed, drag the navigation frame to a smaller 
size. As soon as you release the mouse button, only the image 
segment you have selected will be shown in the image window.

 In the [Image Navigator] tool window, enter the magnification 
you want in the edit field under the image segment and press 
the [Enter] key, or use the slide control.
28OLYMPUS Cleanliness Inspector CIX ASW



5  Processing images
Viewing images
5.1.2 Viewing information about an image
Viewing image properties

1. Activate the [Properties] tool window on the left of the user 
interface. You can use the [Alt + Enter] shortcut to do this.

2. Take a look at the size of the image, in the [Image] > [Size (pixel)] 
and [Image] > [Size (calibrated)] fields. Take a look at the 
horizontal and the vertical calibration.

Displaying the scale bar
1. Repeatedly click the [Scale Bar] button on the [CIX Standard] 

toolbar. You can also use the [Shift + F4] keyboard shortcut. The 
background color of the button changes color, indicating whether 
the scale bar is shown or hidden. 
 The scale bar is displayed in the bottom right of the image 

window by default.
 Whether or not the scale bar is displayed is a global setting valid 

for all images that are loaded. You cannot display the scale bar 
only for certain images.

 The scale bar is part of the image window and not of the image. 
This means that the scale bar is not displayed when you open 
the image with a different application program.

 You can change the appearance of the scale bar in the software 
options. You can find more information on this topic in section 
Software options for the scale bar on page 36.

Displaying the info stamp
1. Repeatedly click the [Info Stamp] button on the [CIX Standard] 

toolbar. You can also use the [Shift + F5] keyboard shortcut. The 
background color of the button changes color, indicating whether 
the info stamp is shown or hidden. 
 The info stamp is displayed in the bottom left of the image 

window by default. It tells you the magnification at which the 
image was acquired.

 You can change the appearance and the contents of the info 
stamp in the software options. You can find more information on 
this topic in section Software options for the info stamp on page 
38.
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Entering image notes and displaying them in the image window
1. Activate the [Properties] tool window again.
2. Click the [Document] > [Note] field. Click the [ ... ] button and enter 

a note about the image. Close the dialog box with [OK].
3. Click the [Options] button on the [CIX Standard] toolbar to open 

the [Options] dialog box. You can also use the [Shift + F8] 
keyboard shortcut. Select the [Info Stamp] > [Properties] entry in 
the tree view.

4. In the [Available properties] list, you will find the [Document] > 
[Note] entry. Select the check box. Close the dialog box with [OK].
 Your note will now be displayed in the info stamp.

5.1.3 Software options for the scale bar
You can change the appearance of the scale bar in the software 
options.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. In the tree view, select the [Scale Bar] entry.

[Options] > [Scale Bar] > [Format]
[Text style] Select the [Show Text] check box to have the scale bar's length shown 

as an annotation beneath the scale bar. Beneath a scale bar that is 10 
µm long, an annotation [10 µm] will be displayed. Clear the check box 
to hide the labeling.
Select the text color and the font size for the scale bar's annotation.

[Line style] In the [Line style] group, you define the scale bar's appearance.
Clear the [Transparent background] check box to have your scale bar 
highlighted by a white rectangle. Select this check box to hide the white 
rectangle, that by default, underlies the scale bar. In this way, the scale 
bar will hide as little image information as possible. However, this may 
reduce the scale bar's readability.
Select a line color and the line width for the scale bar.
Choose one of the three different types of scale bar, in the [Bar] list.
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[Use fixed prefix of
the image’s

calibration unit]

Select this check box to always display the scale bar in the image's 
calibration unit. If the image's calibration unit is [µm], the length of the 
scale bar will also be in [µm] regardless of how much you zoom in to or 
out of the image. You can view the calibration unit of the image in the 
[Properties] tool window.
This check box is clear by default. The unit of the scale bar will then be 
automatically adjusted to the image's zoom factor.

[Options] > [Scale Bar] > [Display]
[Size] Choose between a small, medium or large, scale bar in the [Length] list. 

This length is not an absolute specification of the bar's length, rather it 
states the maximum permissible length of the scale bar in relation to 
the image: A small scale bar may not be longer than 1/8 of the image's 
width, a medium scale bar not longer than 1/4 of the image's width, 
and a large one not longer than 1/2 of the image's width.
The absolute length of the scale bar is computed using the current 
image calibration. The height of the scale bar's frame, and the font size, 
will not be influenced by the options that were here chosen in the 
[Length] list.

[Orientation] Select how you want the scale bar to be orientated in the image in the 
[Orientation] group.
You have the choice between a horizontal or a vertical orientation. Or 
you can display both a horizontal and a vertical scale bar in the image 
window at the same time.

                   
There are three ways of orientating a scale bar in the image window.

[Position] You can position the scale bar in any of the image window's four 
corners. Simply click the button that shows the position you want.
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It can happen that one (or more) positions aren't available. In this case, 
the position in question is already in use for another function. By using 
the info stamp, you can, in addition to the scale bar, have some 
information on the current image displayed in the image window. Then 
the info stamp's current position can't be chosen for the scale bar. The 
corresponding button is gray.

5.1.4 Software options for the info stamp
You can change the appearance and the contents of the info stamp in 
the software options. 

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. In the tree view, select the [Info Stamp] entry.

[Options] > [Info Stamp] > [General]
[Display] In the [Display] group, you define the info stamp's appearance.

Clear the [Transparent background] check box to have your info stamp 
highlighted by a white rectangle. Select the check box to have the info 
stamp displayed without a background. In this way, the info stamp will 
hide as little image information as possible. However, this may reduce 
the info stamp's readability.
Select a text color and font size for the info stamp. You can only choose 
a color when the [Transparent background] check box has been 
selected. When a background is present the text color will be 
automatically determined.

[Position] You can position the info stamp in any of the image window's four 
corners. Simply click the button that shows the position you want.

It can happen that one (or more) positions aren't available. In this case, 
the position in question is already in use for another function. For 
example, in addition to the info stamp, a scale bar can also be 
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displayed in the image window. Then, the scale bar's current position 
can't be chosen for the info stamp. The corresponding button is gray.

[Show property
name]

Select the [Show property name] check box. Now, the info stamp will 
display the name of the property and the current value. The name 
corresponds to the name of the property in the [Properties] tool 
window.
Clear the check box if you don't want to display the name of the 
property in the info stamp. Now, only the value is displayed.
Example: You want the info stamp to display the file name. With an 
image file called Testimage.tif, the [Name: Testimage.tif] entry is 
displayed in the info stamp when the check box is selected. When the 
check box is clear, only [Testimage.tif] is displayed.

[Options] > [Info Stamp] > [Properties]
In this dialog box you set which items of information are to appear in 
the image window.

[Available
properties]

The list on the left, [Available properties], shows all of the items of 
information you can possibly display in the image window.
To help you keep track of everything, every piece of information is 
allotted to a functions group. You can reduce every information group 
to a header. This enables you to hide information that doesn't interest 
you.

[Selected
properties]

The list on the right, [Selected properties], shows all of the items of 
information that are shown in the image window when the info stamp is 
used. Every item of information will be shown in its own row.

Which information is available depends on the image type, the supported 
hardware, the version of your software, and the camera being used. For this 
reason, not all information in the [Options] > [Info Stamp] > [Properties] dialog 
box will be relevant to your images. If an item of information isn’t applicable to 
your image it will not be displayed in the info stamp, even if it has been 
selected here.
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Use the buttons next to the [Selected properties] list to change the 
order of the information in the info stamp, or to delete information 
from the info stamp. You can, however, reactivate these settings any 
time.
Click the [Default] button to have the settings in the dialog box 
returned to the factory settings.

5.2 Drawing on images
The [Drawing] toolbar makes a variety of drawing functions (line, 
rectangle, ellipse, text) available to you, as well as options for color 
selection and line styles.
Click a drawing function button to insert the required drawing object. In 
an image, all the drawing objects will be written into a special drawing 
layer. This ensures that no image information is overwritten and that 
you can edit existing drawing objects at any time.
If you want to insert more than one drawing object consecutively, 
double click the required drawing function button. You then switch to a 
continuous drawing mode. The button will then appear clicked, thus 
showing the active mode. Click the button again to switch off the 
mode.

5.2.1 [Drawing] toolbar
Use the buttons in the [Drawing] toolbar to draw on the images. You'll 
find the toolbar at the bottom, above your software's status bar.

[Drawing] Use the functions in the [Draw] menu to position and arrange drawing 
objects.

[Select Drawing 
Objects]

Switch to the edit-object mode. In the edit-object mode, you can select, 
move and edit drawing objects.

[Show Drawings] Show or hide the drawing layer in the image window.

[Erase Drawings] Delete all of the drawing objects and text objects from the image.
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[Line]
[Arrow]

Click and hold the left mouse button to draw a straight line or an arrow 
on the image.  Release the mouse button to finish drawing the drawing 
object.

[Rectangle]
[Ellipse]

Click and hold the left mouse button to draw a rectangle or an ellipse 
on the image. Release the mouse button to finish drawing the drawing 
object.

[Freehand 
Polygon]

Define a closed line in any shape of your choice. While pressing the left 
mouse button, move the mouse pointer. Release the mouse button to 
finish drawing the drawing object.

[Text Field] Label the image. You can find step-by-step instructions in chapter 
Inserting text on page 42.

[Fill Color]
[Line Color]
[Text Color]

You can change the color of individual drawing objects. To do this, 
select one or more drawing objects and click the appropriate button to 
assign the active color. The active color will always be displayed on the 
button.
To change the active color click the fill color button's arrow. A color 
palette will be displayed. You can select a color from this palette or use 
the [Other] command to define a different color.

[Line Width] Select one or more drawing objects and select one of the line widths 
offered in the [Line Width] list.
A line with the width of 0 pt is 1 pixel in width.

[Line style] Select one or more drawing objects and select one of the line styles 
offered in the [Line Style] list.
Different styles of line, such as dotted and dashed, are only available for 
the thinnest line width. Therefore, when you assign a line another style, 
the line width will be automatically set at 1 Pixel.

[Arrow Style] Select one or more lines or arrows and choose one of the arrow types 
offered in the [Arrow Style] list.
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5.2.2 Using the continuous drawing mode
The ordinary drawing mode and the continuous drawing mode are 
available for drawing objects: 
When you click the [Line], [Arrow], [Rectangle], [Ellipse], [Freehand 
Polygon] or [Text Field] button once, you remain in ordinary drawing 
mode. After you have drawn the required drawing object the button 
will automatically be deselected. 
If you double click one of these buttons, however, you go to continuous 
drawing mode. Now you can draw more than one drawing object of 
the same type one after the other. The [Line], [Arrow], [Rectangle], 
[Ellipse], [Freehand Polygon] or [Text Field] buttons remains selected. 
Press the [Esc] key on your keyboard to deselect the button and leave 
continuous drawing mode. 

5.2.3 Working with drawing objects
Inserting drawing objects
Example: Add an arrow to an image and then label it.

1. Load the image that you want to label.
2. Set the zoom factor of the image window to a size at which the 

label will be easy to read. You can rotate the mouse wheel to 
change the zoom factor in the image window.

3. There is a button for each drawing object on the [Drawing] toolbar. 
Click the button with the drawing object that you want to add and 
define the drawing object on the image.
In this case, click the [Arrow] button.
 The mouse pointer changes shape when you move it onto the 

image window. A small icon indicating the selected drawing 
function attaches itself to the bottom right of the mouse pointer.

4. While pressing the left mouse button, draw the arrow. Release the 
mouse button to finish drawing the arrow.

5. Double click the arrow to open the [Drawing Object Properties] 
dialog box. Set the color and the line width here. The size of the tip 
of the arrow is automatically adjusted to suit the width of the line.
 Use the [Draw] > [Set As Default For Drawings] command if you 

want to apply the selected color and line width settings to all 
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additional drawing objects (to arrows, rectangles and ellipses for 
example). 

Inserting text
1. Click the [Text Field] button to add a rectangular text object. While 

keeping the left mouse button depressed, drag the text object to 
the desired size. 
 As long as a text object is active, its background will be displayed 

in white, in order to make the text easy to read while it's being 
entered.

2. Enter the desired text. You can write as many lines of text as you 
want. However, only the lines that are within the text object will be 
visible. All the lines that do not fit within the text object remain 
hidden from view.

3. Click once outside the text object to leave the text-entry mode. 
 The white background will disappear. By default, a text object's 

background is transparent. This ensures that the text object will 
hide as little image information as possible.

4. Then drag the text object to the size you need and format your 
text.

Formatting the complete text within a text object
1. Select a text object You can also select several text objects and 

format them at the same time.
2. Use the [Text Color] button to set the color for the text. You can 

find this button on the [Drawing] toolbar and on the [Formatting 
Font] toolbar.

3. Use the [Formatting Font] toolbar to change the font type and font 
size.

4. Use the [Fill Color], [Line Color] and [Line Width] buttons to set the 
fill color, and the line color and width. You can find these buttons 
on the [Drawing] toolbar.

Changing the default settings for text objects
1. Select a text object
2. Change the font characteristics (type, size and color) to the way 

you want a text object you insert in the future, to be.
3. Use the [Draw] > [Set As Default For Drawings] command. You will 

find the [Draw] menu on the [Drawing] toolbar.
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 The current text object will then be used as a template for all 
new text objects.

5.3 Using image processing functions
Your software offers numerous image processing functions, with which 
you can change an image that has been acquired (e.g., increase the 
image contrast or the image sharpness). 

5.3.1 [Process Menu]
Click the [Process Menu] button to open a menu with image processing 
functions. You can find this button on the [CIX Standard] toolbar.

[Edge Detection 
Filters]

Use edge detection filters to highlight the edges of objects. Edge detection 
filters, however, often increase the noise in an image, too. Therefore, it's often 
better to smooth an image, before you apply an edge filter.

[Smoothing Filters] The smoothing filter category includes filters that average the intensity values 
surrounding a pixel. The result is that extreme intensity values and static noise 
disappear. At the same time, however, intensity differences that contain image 
information will be flattened. The effect of this, is that the resulting image 
appears fuzzy because of the filtering.

[Sharpen Filters] Use sharpen filters to increase the contrast in images. Sharpen filters, however, 
often increase the noise in an image. Therefore, it's often better to smooth an 
image, before you apply a sharpen filter. 

[Morphological Filters] Use morphological filters to prepare images for the automatic image analysis. 
Morphological filters analyze the shape of objects by adding pixels to an 
object, or by deleting them from an object.

[Enhancements] The [Enhancement] menu offers you several image processing functions, with 
which you can optimize an image's contrast. It enables you to, for example, 
change the image brightness and contrast, or correct color tingeing effects.
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5.3.2 Changing the image brightness
The following step-by-step instructions describe an example of the use 
of an image processing function

1. Load the image you want to process or acquire an image to 
process.

2. Click the [Process Menu] button.
3. Use one of the commands in the menu, e.g., [Enhancements] > 

[Adjust Intensity].
 Every image processing function opens a similar dialog box in 

which you can set the parameters for the selected image 
processing function. The image processing function that is active 
will be shown in the dialog box's header.

4. Click the small arrow next to the [Preview] button to open a list of 
all of the preview functions. Select the [Original and Preview] entry.
 This preview function displays the same image segment twice in 

the dialog box. The first one shown is the source image. The 
second is the image that results when the current parameters 
are used.

 Most of the image processing functions have one or two 
parameters. These parameters that are shown in the [Settings] 
group.

5. Select the [Create new document as output] check box to have a 
new image created by the process. When you do this, the source 
image remains unchanged. 
 Clear the check box if you want the image processing function to 

change the source image. Now no new image document will be 
created. 

 As long as the image hasn't been saved, you can revert to the 
source image. To do this, click the [Undo] button. This button is 
located to the right of the [Process Menu] button.

6. Change the image processing functions' parameters. You can 
decrease the gamma value and increase the brightness, for 
example.
 After every change that is made to a parameter, the function will 

be immediately applied to the source image, and the resulting 
image will be shown in the preview window.
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7. Click the [Default] button to reapply the preset parameters in the 
[Settings] group, if the current parameter don't seem right

8. When you have found the optimal parameters, click the [OK] 
button to have the active image processing function applied to the 
image with the active parameters.
 The dialog box is closed.
 By default, the image processing function doesn't change the 

source image. A new image document is created instead.
 The new image document will not be saved automatically. This is 

indicated by the asterisk after the image name in the document 
group.
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6 Measuring images interactively
6.1 Overview

Your software offers a wide range of measurement functions. They 
enable you to quickly measure segments and areas. All the results will 
be saved together with the image and can also be output as a sheet.

Prerequisite For making measurements, correctly calibrated images are an essential 
prerequisite. 
Performing a measurement
You can find the [Measurement and ROI] tool window below the 
document window. In this tool window you have fast access to all 
measurement functions and settings which effect measurements. This 
tool window is at the same time the measurement display and contains 
all of the values that have been measured on the active image.

Starting a
measurement

Begin a measurement by clicking the measurement function you want.

Working in the
measurement

mode

As soon as you have clicked a measurement function, your software will 
automatically switch to a measurement mode. In the measurement 
mode, your mouse pointer will turn into a cross on the image. A small 
icon indicating the selected measurement function attaches itself to the 
bottom right of the mouse pointer.
The continuous measurement mode is preset by default. In this mode, 
the selected measurement function's button becomes active, indicating 
which measurement function is active. You can recognize this status by 
the button's background color.

Finishing the
measurement

mode

You can explicitly switch off the measurement mode. To do this, click on 
the active measurement function's button again.

You automatically turn off the measurement mode when you switch to 
a different mouse pointer mode. For example, click the [Select 
Measurement Objects] button to switch to the selection mode. You can 
find this button in the [Measurement and ROI] tool window. You can 
select and edit measurement objects in this mouse pointer mode.
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Changing the
default

measurement
mode

The continuous measurement mode is preset by default. If you want to 
change this preset, follow the instructions in the paragraph below.
Check whether one of the buttons on the [Measurement and ROI] tool 
window's toolbar appears clicked. Release this button. Click the 
[Options] button or use the [Shift + F8] keyboard shortcut to open the 
[Options] dialog box. Select the [Measurement and RO]I > [General] 
entry in the tree view. Select the [Switch to 'Select Measurement 
Objects' mode after creating a measurement object] check box. 
Then, when you have completed a measurement, you will automatically 
leave the measurement mode again. This means you have to select the 
measurement function again before you start each interactive 
measurement.
Displaying and saving measurement results
The measurement results will be displayed directly on the image and in 
the [Measurement and ROI] tool window. 

Saving the
measurement

results

The measurements will be saved along with the image, if you save the 
image in the TIF or VSI file format. You can, however, also export the 
measurement results in a results sheet, and save this as a file.

Showing and
hiding

measurement
results in an

image

The measurement results will be shown on the image in a special data 
layer, the measurement layer. On your monitor, image and 
measurement layer are shown together. The data of each, however, is 
individually stored if you use the TIF or VSI image file format. Try and 
picture the measurement layer as a transparency which is placed over 
the image. When you measure an image, the image data will not be 
changed by having the measurement results displayed on it.
Editing measurements
You can edit existing measurement objects at any time. The 
measurement values in the [Measurement and ROI] tool window will be 
correspondingly updated.

When you load an image file with measurement objects, it is only possible to 
edit the measurement objects if the image file has been saved in the TIF or VSI 
image file format.
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Selecting
measurement

objects

Before you can edit measurement objects, you have to select them. To 
do so, click the [Select Measurement Objects] button, and then select 
the measurement object(s). You can find this button in the 
[Measurement and ROI] tool window.
If the image is very large and many measurement objects have been 
defined, it can be difficult to find a particular measurement object in the 
image. In this case, select the measurement object that you are 
searching for in the [Measurement and ROI] tool window. Click your 
right mouse button and select the [Navigate to Measurement Object] 
command in the context menu. The measurement object you are 
looking for is then displayed in the image window.

Changing the
position and size
of measurement

objects

You can move a whole measurement object while keeping the left 
mouse button pressed.
You can also change the size of a measurement object. Move the 
pointer onto a marker. By dragging the marker with the mouse button 
depressed, you can adjust the frame's size as wished.

Change the measurement object by moving the handles.

Deleting
measurement

objects

Click the [Del] key on your keyboard in order to delete the selected 
measurement object. You can select measurement objects that you 
want to delete in the image and also in the sheet in the [Measurement 
and ROI] tool window.

Changing the
color, font, and
line thickness of

individual
measurement

objects

You can, at any time, change the color, font, and line thickness, of 
individual measurement objects. Select one or more measurement 
objects in an image and click your right mouse button to open a 
context menu. In the context menu, you'll find commands that you can 
use to change the appearance of the selected measurement objects.
Note: You can change the default color, font, and line thickness for new 
measurement objects in the software options To do so, use the 
[Measurement and ROI] > [Measurement Display] command.
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Measuring in the live mode
All of the measurement functions are also available in the live-image. 
You can therefore, e.g., quickly measure a segment in the live-image.
When you end the live mode by clicking the [Snapshot] button, the 
measurements that you carried out on the live-image are applied to the 
image that is acquired.

6.2 Performing interactive measurements
6.2.1 Measuring image objects interactively

You can measure distances or objects interactively in an image. The 
following step-by-step instructions are an example of how you can 
measure an image.
Example: You want to measure the filaments in a supraconductor. To 
do this, load a suitable image, or acquire one. Measure the diameter of 
several of the hexagonal filaments, in each case between the opposing 
vertices. Subsequently edit the measurement. Delete some of the 
measurements you've made. Enter the results in an MS-Excel sheet.

1. Acquire an image or load one.

During the installation of your software some sample images have been installed, too. You can fol-
low these step-by-step instructions for measuring images if you use the SupraConductor.tif exam-
ple image.

Setting the
labeling color

The measurement results will be written into the image according to 
the default settings, in red font color and without a background. This 
can be hard to read on some images. Change the labeling settings.
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1. Click the [Options] button or use the [Shift + F8] keyboard shortcut 
to open the [Options] dialog box.

2. Click the [Measurement and ROI] > [Measurement Display] entry in 
the tree view.

3. Click in the [Background Color] field and select a color, black for 
example.

4. Select the [Color] > [Fixed colors] option and select a suitable color 
from the palette. Select the color white to display the 
measurements in white and the labels in white on a black 
background.

5. Close the dialog box with [OK].

Measuring lengths  The following instructions describe the procedure when continuous 
measurement mode is active. Make sure that this mode is selected. 
To do so, click the [Options] button or use the [Shift + F8] 
keyboard shortcut to open the [Options] dialog box. Click the 
[Measurement and ROI] > [General] entry in the tree view. Clear 
the [Switch to 'Select Measurement Objects' mode after creating a 
measurement object] check box. The continuous measurement 
mode is now active.

1. Click the [Arbitrary Line] button, located on the toolbar at the top 
of the [Measurement and ROI] tool window.

2. In the image window, click with your left mouse button at the 
starting point and end point of the segment you want to measure.

3. Using the left mouse button, click on the start and endpoint of the 
next segment you want to measure. 

4. Click the [Arbitrary Line] button again to end the length 
measurement.

5. Take a look at the results in the tool window and in the image.

The illustration shows the image with three executed measurements. The measurement 2 has 
been selected.
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Deleting
measurement

objects

1. Click one of the measurement results in the [Measurement and 
ROI] tool window.
 The corresponding measurement object will be selected in the 

image.
2. Press the [Del] key.
 The measurement object is deleted both in the image and in the 

tool window.
 When a measurement object has been deleted, the image and 

the tool window contain one measurement object less. The IDs 
of the remaining measurement objects won't be changed by the 
deletion of a measurement object.

3. Check whether one of the buttons on the [Measurement and ROI] 
tool window's toolbar appears clicked. Release this button.

Exporting results
to MS-Excel

 

1. To do this, click the [Export to Excel] button.
2. In the In/Output dialog box you set up the directory in which the 

data is to be saved, and enter the name of the MS-Excel sheet. 
Adopt the [Excel-Sheet (*.xls)] file type.

3. Click the [Save] button to have the MS-Excel sheet with the 
measurement results saved.

Closing the image 1. Click the small button showing a cross [ x ], located at the right of 
the image name in the document group.
 You have changed the image because you've added interactive 

measurement objects. For this reason, you'll receive a query 
whether you wish to save the image or not.

2. Save the image in the TIF or VSI file format. The measurement 
objects will then also be saved in the image file. They can at any 
time, be edited deleted or augmented.
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6.2.2 Outputting various measurement parameters
Example: You want to measure the filaments in a supraconductor. 
Measure the hexagonal structure as a circular surface. Have a variety of 
measurement parameters, such as the area, the perimeter and the 
diameter, output. Have the diameter shown in the image.

1. Acquire an image or load an image, the Supraconductor.tif 
example image, for example.

Measuring areas 2. In the [Measurement and ROI] tool window, click the [2 Point 
Circle] button.

3. Left click the center point of the hexagonal structure that you want 
to measure.

4. Move your mouse, and in the process drag out the circle. Match 
the circular object as well as possible to the hexagonal structure. 
Click the left mouse button.

5. Click the [2 Point Circle] button again to switch off the 
measurement mode.

6. Take a look at the result in the [Measurement and ROI] tool 
window.

The illustration shows the image with a circle measured.

Viewing the list of
measurement

parameters

1. In the [Measurement and ROI] tool window, click the [Select 
Measurements] button.
 In the dialog box you'll see a list with all of the available 

measurement parameters. At the bottom of the dialog box you'll 
see a list of the measurement parameters that are currently 
calculated for all objects.
48OLYMPUS Cleanliness Inspector CIX ASW



6  Measuring images interactively
Performing interactive measurements
Outputting
additional

measurement
parameters

1. Select the [Diameter] measurement parameter from the [Available 
measurements] list.
 On the right, an illustration shows you how the parameter is 

calculated. You can see that there are different ways in which the 
diameter of a 2D object can be calculated.

2. Click the [Mean] entry in the list under the illustration, to select the 
[Mean (Diameter)] measurement parameter. When you do this, the 
mean value of all of the possible diameters is determined.

3. Click the [Add 'Mean (Diameter)'] button.
 This measurement parameter will be added to the list of 

measurement parameters to be calculated. All of these 
measurement parameters will be displayed in the tool window.

4. Close the dialog box with [OK].
5. Take a look at the result for the circle's diameter in the 

[Measurement and ROI] tool window.

Outputting
measurement

parameters in the
image

1. Open the [Select Measurements] dialog box.
2. At the bottom of the list of all of the calculated measurement 

parameters, click the [Mean (Diameter)] measurement parameter.
3. To the right of this list you'll see a button with a blue arrow. Click 

this button to move the measurement parameter to the top of the 
list.

4. Close the dialog box with [OK].
5. Take a look at the result for the circle's diameter in the image.
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6.2.3 Measuring several images
You want to measure the thickness of a spray coating. To do so, you 
acquire several images of the coating. Have the results from all images 
displayed simultaneously. Take a look at the mean value for all of the 
measurements.

1. Acquire or load some images.

 
During the installation of your software some sample images have been installed, too. You can 
carry these step-by-step instructions out directly with the example images SprayCoating2.tif and 
SprayCoating4.tif.

Measuring the
layer thickness

1. Activate the first image in the document group.
2. Click the [Arbitrary Line] button, located on the toolbar at the top 

of the [Measurement and ROI] tool window. Measure the thickness 
of the layer at several different places.

3. Activate the next image. Measure the thickness of the layer at 
several different places, here also.

4. Click the [Arbitrary Line] button again to switch off the length 
measurement.

 
The layer's thickness has been measured on both images.
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Displaying the
measurement

results of all of the
images

1. In the [Measurement and ROI] tool window, click the 
[Measurement and ROI Options] button.

2. Select the [Measurement and ROI] > [Results] entry in the tree 
view.

3. Clear the [Show measurement objects] > [Only of the active image] 
check box.

4. Close the dialog box with [OK].
 Now the results for both images will be shown simultaneously in 

the tool window.
 Use the [Document] measurement parameter to display the 

name of the image with which the measurement results are 
associated in the results sheet. Now, you can match the 
measurement results unambiguously to an image, even if all 
measurement results are displayed together in the tool window.

Viewing statistical
parameters

1. In the [Measurement and ROI] tool window, click the 
[Measurement and ROI Options] button.

2. Select the [Measurement and ROI] > [Results] entry in the tree 
view.
 In the [Statistics] group, you can find various statistical 

parameters.
3. Select the [Standard Deviation] check box.
4. Select the [Measurement and ROI] > [Results] entry in the tree 

view.
 Now, in the [Measurement and ROI] tool window under the 

measurement results, the chosen statistical parameter will by 
shown. 
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7 [Materials Solutions] tool window
Use the [Materials Solutions] tool window to measure an image, or 
several images at the same time, using different materials science 
analysis processes.
The [Materials Solutions] tool window works similarly to a software 
wizard. As soon as you've started an analysis process you'll be guided 
step by step through the measurement.

7.1 Structure of the tool window

1 Name of the 
analysis process

You'll find the name of the current analysis process right at the top of the tool 
window.

2 [Instructions] In the [Instructions] group, you will find instructions for what to do in this step 
and, if available, additional information.

3 Dynamic area The dynamic area is located in the middle part of the tool window. Its 
appearance differs according to which step and which analysis process has 
been chosen.

4 Current step in the 
analysis

Here, you can see at which step in the analysis you are at this moment. The 
current step is indicated by a blue arrow.
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Overview of the supported analysis processes

5 Buttons Here, you find the buttons you use to proceed to the next step in the analysis, 
or to return to the previous step. You can also cancel an analysis here. 
Depending on the current step in the analysis, not all of the buttons are 
active.

The analysis processes must be purchased. The analysis processes that are 
available in your software vary depend on the software solutions that you 
purchased for your OLYMPUS Cleanliness Inspector System. Maybe you will 
only see one or two analysis processes.

[Grains Intercept] The intercept analysis is used to measure grain sizes and to document 
them. You can find more information on page 84 of the [Grains 
Intercept] chapter.

[Grains 
Planimetric]

The grains planimetric analysis is used to measure grain sizes and to 
document them. You can find more information on page 98 of the 
[Grains Planimetric] chapter.

[Layer Thickness] By using layer thickness measurements you can measure layers on 
calibrated images automatically or interactively. You can find more 
information on page 124 of the [Layer Thickness] chapter.

[Cast Iron] The quality and consistency of cast iron depends on the distribution 
and the morphology of its carbon content. By using a cast iron analysis 
you can determine the cast iron's graphite fraction with the help of 
unetched samples. As well as that, with the help of etched samples you 
can determine the ferrite/pearlite ratio. You can find more information 
on page 152 of the [Cast Iron] chapter.

[Inclusions Worst 
Field], 

[Inclusion Content]

An inclusions worst field analysis and an analysis of the inclusion 
content are two different analysis processes used to detect non-metallic 
inclusions in metal samples. This analysis is, e.g., used to measure the 
amount, size and distribution of sulfides and oxides in steel. With the 
measurement results, different production processes can be compared, 
or the quality of a product determined. You can find more information 
on page 180 of the [Inclusions Worst Field] & [Inclusion Content] 
chapter.
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[Porosity] With a porosity measurement, you measure the percentage of the 
surface of your sample which is made up of pores as well as 
determining the number and density of the pores. 
You can find more information on page 210 of the [Porosity] chapter.

[Phase Analysis] With a phase analysis, you measure the percentage of the area fraction 
that the phase covers in your samples. You can find more information 
on page 240 of the [Phase Analysis] chapter.

[Coating 
Thickness]

Using the [Coating Thickness] analysis process you can analyze ball 
indentation cuts of thin coatings and determine their coating thickness. 
You can find more information on page 264 of the [Coating Thickness] 
chapter.

[Dendrite Arm 
Spacing]

From the dendrite arm spacing an expert can tell whether a metal alloy 
solidified quickly or slowly, among other things. Dendrites are formed in 
metal alloys when they solidify. They are branching, tree-like structures. 
You can find more information on page 282 of the [Dendrite Arm 
Spacing] chapter.
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7.2 Starting an analysis process
You start an analysis process by clicking the appropriate button in the 
[Materials Solutions] tool window.

A lot of your software's other functions aren't available while an analysis 
process is running. You can't open the [Options] dialog box, for example. 
You can't leave the [Analyze Materials] software mode before the analysis 
process that is in progress is concluded or interrupted.
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7.3 Selecting the image source
The [Materials Solutions] tool window leads you step-by-step through a 
materials science analysis process. In the [Image source] step, you 
select the image that you want to analyze. You can also analyze several 
images at the same time.

1 [Live image] If you select this option, an additional step, the [Image acquisition] step, is 
added to the analysis process. In this step, an image will be acquired of the 
position on the sample that is currently displayed in the image window. This 
image will then be evaluated in the following steps in the analysis. When the 
[Image results] step has been completed, a new image will be automatically 
acquired, then analyzed. This enables you to analyze as many images as you 
would like during the same analysis process. You can then either save the 
analyzed images or reject them.

2 [Selected images] When you select this option, all of the loaded images that are currently 
selected in the [Gallery] tool window will be analyzed. Loaded images that are 
not selected in the [Gallery] tool window, will be ignored for the analysis.

3 [Folder] When you select this option, all of the images that are in a particular directory 
will be analyzed. You can choose the directory as you wish.
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4 [Stage Path] When you select this option, a saved  stage path will be used. Use the 
[Stage path settings] step in the [Materials Solutions] tool window to define a 
stage path. You can find more information on this topic in chapter Settings 
for the stage path on page 66.
Not all materials science analysis processes support the use of stage paths. 
This is why the [Stage Path] option is only available for these analysis 
processes: [Grains Intercept], [Grains Planimetric], [Inclusions Worst Field], 
[Porosity], [Inclusion Content], [Phase Analysis].

5 [Load from file] Click on the [Load from file] button if you want to use settings that have been 
saved. For example, you can in this way load the comments from a sample 
that has already been analyzed, and adapt them for the current sample. In 
addition, with some materials science analysis processes, the slide controls 
that are available in the [Settings] step will also be set to the saved position.

6 [Get from image] Click the [Get from image] button if you want to apply the settings used for an 
image that has already been analyzed to the current analysis. To make this 
possible, the image that has already been analyzed must be opened in your 
software.

7 [Skip 'Sample 
information']

Select the [Skip 'Sample information'] check box to skip the [Sample 
information] step. As soon as you click the [Next] button, you'll go straight to 
the [Settings] step. This makes sense if you analyze numerous images of the 
same sample, and you only want to enter the information on the sample with 
the first image.
Note: When you analyze images of numerous samples, clear the [Skip 
'Sample information'] check box, because otherwise you won't see the [ New 
Sample] button.

8 [Check settings 
and results]

This list is only of significance if you are analyzing more than one image.) If 
you are only analyzing one image, leave the preset [All images] entry as it is.
If you select several images, you can choose how frequently you would like to 
check the settings with which the images are analyzed. If you would like to 
analyze a lot of images with the same settings, you can automate the analysis.

8 [All images] Select the [Check settings and results] > [All images] option if you want to 
check the settings for every image. The [Settings] step is then displayed for 
each new image. This makes sense, for example, if the images that are to be 
analyzed are very different in their image qualities.

8 [Never] Select the [Check settings and results] > [Never] option if you don't want to 
check the settings for any of the images. With this option, the system will 
jump over some steps in the analysis and the [Image results] step will be 
displayed. In general, this setting is only sensible if you have saved the 
settings to be used as a parameter set and you load them before starting the 
analysis.
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8 [First image] Select the [Check settings and results] > [First image] entry if the settings are 
only to be checked for the first image and are then to be used for all other 
images (even from other samples).

8 [First image per 
sample]

Select the [Check settings and results] > [First image per sample] entry if you 
have several samples (with several images per sample) and the settings are to 
be checked for the first image of each sample.

8 [First image per 
scan area]

The [Check settings and results] > [First image per scan area] entry is only 
displayed when you have selected the [Stage Path] option. Select this entry if 
the settings are only to be checked for the first image in each scan area and if 
the same settings are to be used for the other images of the same scan area.

8 [Image interval] Select the [Check settings and results] > [Image interval] entry if you would 
like to analyze several images and would like to check the settings at regular 
intervals. If this entry is selected, the [Image interval] field is displayed. In this 
field you could, for instance, enter 10 to check the settings for every tenth 
image.
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7.4 Settings for the stage path
The [Materials Solutions] tool window leads you step-by-step through a 
materials science analysis process. In the [Stage path settings] step, you 
define a  stage path on your sample.

1 Selecting a stage 
path

To be able to make a materials science analysis process at different positions 
on one or more samples, you have to define a stage path. You can use a 
saved stage path or you can define a new one. You can find more 
information on page 67 of the Selecting a stage path chapter.

2 Defining samples If there is more than one sample on a slide, you can define the analysis for 
more than one sample. You can enter different information for each sample. 
You can find more information on page 70 of the Def ining samples chapter.

3 Defining scan 
areas and/or XY-
positions

Use the buttons in the [Scan areas] group to define stage positions on the 
selected sample, to edit existing stage positions, and to move the stage. You 
can find more information on page 71 of the Def ining scan areas and/or XY-
positions chapter.
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7.4.1 Selecting a stage path
To be able to make a materials science analysis process at different 
positions on one or more samples, you have to define a stage path. 
You can use a saved stage path or you can define a new one.

Defining a new stage path 
1. Click the [Creates a new stage path] button to define a new stage 

path.
 If there is more than one sample on a slide, you can define the 

analysis for more than one sample. You can enter different 
information for each sample. After the analysis is finished, you 
get the results for each sample separately.

 A stage path is always linked to at least one sample. With the 
new stage path, a new entry in the [Samples] list will always be 
produced as well. If you click on the [Creates a new stage path] 
button, the [Sample information] dialog box will be opened first.

2. In the [Sample information] dialog box, you enter information 
about the sample. By default, the [Reference], [Group] and 
[Comment] fields are available to enter details about the sample.
 If you have changed the default settings, the [Reference] and 

[Group] fields can also have another name. You can change the 
default settings in the [Options] > [Materials Solutions] > 
[<Name of the analysis process>] dialog box.

4 Aligning a sample Use the functions in the [Sample alignment] group if the samples have to be 
aligned with each other on the stage. You can find more information on page 
74 of the Aligning a sample chapter.

5 Selecting an 
inspection mode

Choose between a single frame inspection and the MIA image inspection. 
You can find more information on page 77 of the Selecting an inspection 
mode chapter.

6 Selecting a focus 
mode

You can choose between different focus modes. You can find more 
information on page 78 of the Selecting a focus mode chapter.

Only one stage path can be active at a time. If you define a new stage path, 
you will automatically remove all of the currently defined samples and stage 
positions. You should thus save a stage path which you would like to use 
again before defining a new stage path.
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Click the [Options] button or use the [Shift + F8] keyboard 
shortcut to open the [Options] dialog box.

 You'll see this information when you create a workbook or a 
report at the end of the analysis.

3. Close the [Sample information] dialog box with [OK] to create the 
new stage path.
 The new stage path is added to the [Stage path] list. Once 

created, the stage path is empty and still has to be completely 
defined.

 Now, define scan areas and/or XY-positions on your sample.
Saving a stage path

1. Click the [Saves the current stage path] button, if you would like to 
use a stage path for several analyses. The following information will 
be saved:
 The number of samples
 The data entered about the sample
 All of the defined stage positions, i.e. the position markers for 

individual XY-positions and all defined scan areas
 Inspection mode and Focus mode

Using an existing stage path
1. In the [Stage path] list, you will find all of the stage paths that 

already exist. Select a stage path from the list to load the sample 
information and stage positions defined in the stage path.
 If one of the positions in the stage path is outside of the 

currently defined stage area, you will be presented with an error 
message. In this case you will not be able to load the stage path.

 The [Stage path] list contains the stage paths saved by you as 
well as those saved by any other user with [Public] access rights. 
You will not see stage paths saved by other users with [Private] 
access rights.

You can edit the stage path and thus adapt it to the current sample.
1. Double click on an entry in the [Samples] list to open the [Sample 

information] dialog box. Here, you can change all of the loaded 
sample information.
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2. Define new stage positions for individual samples, or delete 
individual stage positions from the [Scan areas] list.

3. Click the [Saves the current stage path] button to save the altered 
stage path under a new name or to overwrite the existing stage 
path.

Managing existing stage paths
1. Click this button next to the [Stage path] list to open the [Manage 

Stage Paths] dialog box. Here, you can copy an existing stage path, 
rename, or delete it.

Public stage paths can be edited, and even deleted by every user of your 
software.
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7.4.2 Defining samples
If there is more than one sample on a slide, you can define the analysis 
for more than one sample. You can enter different information for each 
sample. After the analysis is finished, you get the results for each 
sample separately. The results also contain the information that was 
entered about the sample.
The [Samples] field lists all samples which are defined in the current 
stage path. After the name of the sample, in brackets you will find the 
number of stage positions currently defined for this sample.
Adding samples

1. Click this button to add a new sample to the current stage path. 
 The [Sample information] dialog box automatically opens.

2. Enter information about the sample.

Deleting samples
1. Select one of the samples listed. 
2. Click the [Deletes the selected sample] button to delete the 

selected sample. All scan areas and XY-positions which were 
defined for this sample will also be deleted.

Viewing and changing the sample data
1. Double click on a sample to open the [Sample information] dialog 

box with the current sample information and, if necessary, to edit it.
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7.4.3 Defining scan areas and/or XY-positions
Use the buttons in the [Scan areas] group to define stage positions on 
the selected sample, to edit existing stage positions, and to move the 
stage.
The following buttons are available:

Adding XY-positions
You can mark several positions on your samples. At each XY-position, 
an image will be acquired and will be analyzed with the selected 
materials science analysis process.

1. Select a sample from the [Samples] list.
2. Move the stage to a position on the sample that you would like to 

analyze using the current analysis process.
 To move the stage, you can use the [Microscope Control] tool 

window or the joystick. The [Microscope Control] tool window is 
automatically displayed in the [Stage path settings] step.

 In the [Stage path settings] step, your system will automatically 
switch to live mode, so that you can examine the live image to 
check whether the position on the sample is suitable for analysis.

[Adds the current stage position to the selected sample]
You can find step-by-step instructions in section Adding XY-positions on 
page 71.
[Creates a new circular scan area and adds it to the selected sample]
You can find step-by-step instructions in section Adding scan areas on page 
72.
[Creates a new rectangular scan area and adds it to the selected sample]
You can find step-by-step instructions in section Adding scan areas on page 
72.
[Moves stage to the selected scan area]

[Redefines the selected scan area]
You can find step-by-step instructions in section Editing stage positions on 
page 73.
[Deletes the selected scan area]
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3. Click this button, located next to the [Scan Areas] list.
 The current position of the stage will now be saved and assigned 

to the selected sample.
4. Move the stage to the next position on the sample at which you 

would like to take a measurement.
 The stage will later be moved to the positions specified and in 

the sequence specified in the [Scan areas] list. Take this into 
account when defining the stage positions.

5. Click the button again.
6. Repeat the two last steps until you have defined all of the positions 

on the sample.

Adding scan areas
Instead of individual positions, you can also define a whole area on 
your sample for the materials science analysis process. This area can be 
rectangular or circular.

1. Click this button to define a rectangular scan area. To do so, you 
move the motorized stage to the sample in the rectangular area's 
top left-hand corner, then to the sample at its bottom right-hand 
corner.

2. Click this button to define a circular scan area by moving the stage. 
You define the scan area by moving your stage to three points, 
which are on the edge of the round scan area. Your software will 
help here with corresponding message boxes.
 Your software will automatically calculate how many individual 

images are required to completely acquire and analyze the 
defined sample area. The number of the individual images 
depends on the current magnification. If you change the 
magnification, the number of images will be recalculated. You 
do not have to redefine the scan area.

 The stage will later be moved to the positions specified and in 
the sequence specified in the [Scan areas] list. Take this into 
account when defining the stage positions.

3. In the [Inspection Mode] group, select how the scan areas are to 
be analyzed.
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Editing stage positions
You can redefine scan areas and XY-positions which have already been 
defined. In contrast to deleting a stage position and then adding a new 
one, the name of the stage position will not be changed.
You can for instance use this option to adjust an existing stage path for 
a different sample.

1. From the [Scan areas] list, select one of the stage positions shown 
e.g. [Rectangle 2].

2. Move the stage to the position on the sample to which you would 
like to move the selected stage position.

3. Click this button to redefine the selected [Rectangle 2] stage 
position. For a scan area, you will also have to redefine the size in 
this case.
 The name of the new stage position will remain unchanged 

[Rectangle 2].
67 OLYMPUS Cleanliness Inspector CIX ASW



7  [Materials Solutions] tool window
Settings for the stage path
7.4.4 Aligning a sample
With some materials science analysis processes, the analyses have to be 
carried out at certain positions on the sample. In this case, all samples 
on the stage have to be positioned the same way so that the stage path 
can go to the correct positions on the sample. Use the functions in the 
[Sample alignment] group to compensate for differing alignments of 
the samples on the stage.
Defining the reference position

1. Click this button to start the definition of the reference position.
 A yellow triangle  on the button indicates that no reference 

positions have been defined yet for this stage path.
 The [Acquire Reference Images for Sample Alignment] dialog 

box opens. It guides you step-by-step through the definition of 
the reference position.

2. Move the stage to reference position 1 and focus. In order for the 
sample alignment to work well, the reference positions should 
meet the following conditions.
 The reference positions should be unambiguous.
 The reference positions should be as easy to find on the sample 

as possible.
 The reference positions should be as far away from each other 

as possible.
 Your software now acquires an image at the first reference 

position. This image is saved as a reference image together with 
the stage path.

3. Define reference positions 2 and 3.
4. Click the [Finish] button to finalize the definition of the reference 

positions.
 The button in the [Sample alignment] group changes 

appearance. A green check  on the button shows that 
reference positions have been defined for this stage path.

5. Click this button next to the [Stage path] list to save the stage path 
along with the reference positions and the reference images.
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On the left is an overview of a whole sample. Define three reference positions (1-3) on the sample. 
A reference image is acquired at each reference position. The illustration shows the reference 
image at position 2. The reference image is displayed in the live-image during the alignment of 
the sample to assist you with positioning.
On the right is a similar sample that is positioned differently on the stage. The same stage path can 
be used on both samples with the aid of the reference positions.

Aligning a sample
1. Begin a materials science analysis process that contains a stage 

path. Reference positions for the stage path are already defined.
 Your software automatically starts a wizard in the [Stage path 

settings] step in the analysis. You can cancel the wizard if you 
don't want to align the sample yet.

2. Click the [Yes] button in the message box or click the [Align images 
for sample alignment] button shown above to align the current 
sample with the aid of saved reference images and reference 
positions.
 The [Align images for sample alignment] button is only available 

if reference positions have been defined for the selected stage 
path.

 A yellow triangle  on the button indicates that the current 
sample isn't aligned yet.

 The [Align images for sample alignment] dialog box opens.
3. Decide how the reference image should be displayed. You have 

the following options in the [Align images for sample alignment] 
dialog box:
 Select the [Show reference image as thumbnail] option. Now the 

reference image for the current position will be displayed as a 
small image on the top left of the live-image.
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 Select the [Show reference image in overlay] option. Now the 
reference image is superimposed in full size on the live-image. 
Use the [Display opacity] slide control to change the 
transparency of the reference image. The smaller the value, the 
more transparent the reference image is. Select the value 0 if 
you don't want to see the reference image for orientation.

4. Move the stage to the required reference positions one after 
another. Orientate yourself using the displayed reference image.

5. When you've moved to the third reference position, click the 
[Finish] button.
 Your software now compares the positions saved in the stage 

path with the current positions you moved the stage path to and 
positions the stage path accordingly.

 The button in the [Sample alignment] group changes 
appearance. A green check  on the button shows that the 
sample is aligned.
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7.4.5 Selecting an inspection mode
Prerequisite  The options in the [Inspection Mode] group are only relevant for 

scan areas, not for XY positions.

Select the [Single frame inspection] option. Now, all of the images from 
a scan area will be individually analyzed with the selected materials 
science analysis process.
Select the [MIA image inspection] option. Now, all of the images 
acquired from a scan area will be assembled directly as they are 
acquired, like a puzzle, into a stitched image, to be analyzed with the 
selected materials science analysis process.
With MIA image inspections, the individual images are acquired with a 
certain overlap area. Your software will then use pattern recognition to 
look for two images with the same image information, in the overlap 
area.

The illustration shows a sample on which one scan area (1) is defined. 9 individual images are 
needed to fully acquire the scan area.
On the left, the [Single frame inspection] option is selected. If, for example, you do a phase analy-
sis and output a workbook as a result, you will now find the results for 9 images on the sample's 
worksheet.
On the right, the [MIA image inspection] option is selected. On the sample's worksheet you will 
now find only one result for the same scan area, as the individual images will be assembled to a 
single image before the analysis.
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7.4.6 Selecting a focus mode
When you use a stage path, the various positions that the stage moves 
to during the analysis may be at some distance from each other. In this 
case, it will generally be necessary to refocus several times during the 
analysis, so that each individual image is ideally focused and can be 
analyzed successfully.
Select the required focus mode from the [Focus mode] list. The 
selected focus mode applies for the entire stage path, which means for 
all samples and all stage positions.
Overview of the focus mode options
• Not refocusing on samples, page 78
• Manually focusing on samples, page 78
• Using a focus map, page 79
• Using the software autofocus, page 79

Not refocusing on samples
Select the [No focus] entry if you do not have to refocus during the 
analysis. In this case you will for instance focus during the [Stage path 
settings] wizard step. This focus position will be used for all of the 
images that are acquired.
Manually focusing on samples
Select the [Manual focus once per scan area] entry. In this case, you can 
focus the sample at every stage position which is defined in the stage 
path, before the images are acquired for the materials science analysis 
process. If the stage path contains scan areas, you focus the sample 
once, in the center of the scan area. This focus setting will be used for 
all of the individual images which belong to this scan area.
Select the [Manual focus every frame] entry, if the focus position within 
a scan area changes so much that you have to focus every individual 
image.
As soon as you click the [Next] button a message box will automatically 
appear at each new stage position. The message box will contain a 
prompt to focus this part of the sample. If your stage has an automatic 
Z drive, the message box will also have a slide control for the focus.
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Using a focus map
You can use a focus map if your stage path contains at lease one scan 
area. To do so, select the [Focus map] entry. You define a separate 
focus map for each scan area.

Defining a focus
map

1. Move the stage to three different positions, one after the other. 
2. Focus the image at these reference points (1-3). 
 Your software lays a plane through the XYZ-coordinates of the 

three reference points. As a result, for any given XY-position, a 
Z-position can be calculated that corresponds to the focus 
position (provided that the sample surface is an inclined plane). 
At every XY-position that is moved to, the Z-position is 
automatically changed to make it lie on the plane.

Using the software autofocus
Select the [Software AF once per scan area] entry. In this case, the 
software will autofocus the sample at every stage position which is 
defined in the stage path, before the images are acquired for the 
materials science analysis process. If the stage path contains scan areas, 
the software will focus the sample once, in the center of the scan area. 
This focus setting will be used for all of the individual images which 
belong to this scan area.
Select the [Software AF every frame] entry if the focus position within a 
scan area changes so much that refocusing is needed for every single 
image.
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7.5 Entering the sample information
The [Materials Solutions] tool window leads you step-by-step through a 
materials science analysis process. In the [Sample information] step, you 
can enter information about the sample and about individual images of 
the sample.

The [Sample information] step will not be shown if in the previous step, [Image 
source], you selected the [Skip Sample Information] check box. 

The [Sample information] step will also not be shown if, in the [Image source] 
step in the analysis, you have selected the [Stage Path] option. The information 
about the sample will then be entered when the stage path is defined. 

1 [New Sample] The [New Sample] button is only active if you are analyzing several images at 
the same time, and when the analysis of the first image has been completed. 
In this case, you can specify whether all of the images belong to the same 
sample, or whether the second and further images belong to another sample. 
Click the [New Sample] button if you want to assign the current image to 
another sample. The workbook, that can be created at the end of the analysis, 
assigns each sample its own page.
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1 [Load results] With some materials science analysis processes, the [Load results] button is 
displayed. When this button is active, you can load image results that you 
saved in a previous analysis and use them for the current analysis.

2 [Reference], 
[Group]

Here, you can enter information about the sample. If you have changed the 
default settings, the [Reference] and [Group] fields can also have another 
name. 
You can change the default settings. You have to do this before starting the 
analysis process. Click the [Options] button or use the [Shift + F8] keyboard 
shortcut to open the [Options] dialog box. Select the [Materials Solutions] 
entry and select the materials science analysis process you want. Enter the 
required designation in the [Sample reference name] and [Sample group 
name] fields.

3 [Comment] In addition to the information you have entered about the complete sample, 
you can also enter information about individual images. If you analyze several 
images at the same time, you'll find, e.g., the information Image (1 of 3) in the 
group's header. This enables you to see for which image you are currently 
entering an image comment. You'll see this image comment when you create 
a workbook or a report at the end of the analysis.
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7.6 Software options
The software options provide settings for the analysis processes of the 
[Materials Solutions] tool window. The options in the [Options] > 
[Materials Solutions] > [General] dialog box apply to all of the analysis 
processes. 

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [General] entry in the tree 
view.

Saving loaded images after analysis
Here, you specify whether and where the analyzed images are to be 
saved after the [Image results] step.

[Do not save
images]

Select the [Do not save images] entry in the list. Now, the analyzed 
images will not be saved for any materials science analysis process. The 
images that are needed for creating a report, are temporarily saved, 
and deleted after the analysis process is finished.

[Replace image] Select the [Replace image] entry in the list. Now, all image files that are 
loaded for the materials science process will be overwritten without 
further inquiry after the analysis is finished. If one of the image files is 
write protected, a message box appears. Then you can either not save 
the image, or remove the write protection and replace the image.

[Save image to file
system]

Select the [Save image to file system] entry in the list. Now, the [Save 
Image As] dialog box automatically opens when the image analysis is 
finished. You can enter the file name and storage directory as you wish.

This command is not available while an analysis is running.

When you are working with the live-image or using a stage path, a lot of 
images can be analyzed during one analysis process. In this case it doesn't 
make sense to save all of the individual images. Therefore, the saving functions 
will be ignored if you have selected the [Live image] or [Stage Path] option in 
the [Image source] step in the analysis.
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Maximum number of images per sample in reports
You can create a report that can also includes results for individual 
images as a final step in the materials science analysis process. To do 
so, select the [One page per image] check box in the [Reporting] step.
You can restrict the maximum number of images which can be included 
into the report for one sample. Enter the number you want into the 
[Maximum number of images per sample in reports] field. Your 
software will use the first images that are analyzed for the report.
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8 [Grains Intercept]
8.1 Overview

What is an intercept analysis?
The intercept analysis is used to measure grain sizes and to document 
them. It is often used in material analyses, for example, when the quality 
of steel or other metals is being tested.
When an intercept analysis is made, measuring lines are placed in an 
image. Along these measuring lines, your software searches for abrupt 
deviations in the pixels' intensity (gray value). An intensity deviation 
occurs, for example, if dark pixels are present in an image made up of 
mainly light pixels. When an intensity deviation exceeds the parameters 
that have been set, an intercept point will be plotted at this position on 
the measuring line.
The intercept points are counted. The distance between two intercept 
points is also measured. From this measurement, the mean intercept 
length is calculated.

The intensity profile is determined along the horizontal measuring line. Whenever the measuring 
line crosses a grain boundary, this leads to a distinctive minimum in the intensity profile. When an 
intercept analysis is made, these minima in the profile are used to determine the intercept points. 
In the illustration shown, the grain boundaries are dark, the process can, however, also be used on 
images with light grain boundaries. The analysis of cascaded grain boundaries (with multi-phase 
materials) is also possible.
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Results of an intercept analysis
An intercept analysis provides the so-called G-value, which is defined as 
a characteristic grain size in the corresponding industry standards. G is 
calculated from the number of intercept points and the mean intercept 
length. The grain sizes are measured in accordance with the industry 
standards:
• ASTM E 112-13
• GB/T 6394-2002
• GOST 5639-82
• EN ISO 643: 2012
• DIN 50601: 1985
• JIS G 0551: 2013
• JIS G 0552: 1998
• ASTM E1382-97 (2015)

The results of an materials science analysis process can be displayed in 
a workbook. Additionally, the results can be displayed in a report in 
MS-Word format.
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8.2 Settings
In the [Settings] step, you make important settings for the analysis.

1 [Grain boundary 
type]

Here, you specify which criteria are used to detect the grain boundaries. 
Depending on the image that is to be analyzed, the grain boundary type can 
be dark (left-hand illustration) or light (right-hand illustration). Where images 
that don't have any intensity deviations but only show different gray values 
are concerned, select the [Step] setting (middle illustration).

2 [Pattern of test 
lines]

The line pattern determines along which lines the intercept points are looked 
for. At every position along the line, intensity deviations will be searched for in 
the intensity profile. As soon as an intensity deviation fulfills the definition 
criteria set, it will be displayed as an intercept point in the image. Which line 
pattern is suitable for a specific task, depends on the type of structures that 
are to be measured, and their position in the image.
The following line patterns are available:
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2 Three circles are placed in the center of the image. The size of the 
measurement pattern corresponds to the diameter of the largest circle. This 
line pattern is appropriate for images with structures distributed equally 
throughout the image or structures which progress from the middle of the 
image to the edges.

2 The cross consists of two diagonally crossed lines, as well as a line each below 
and to the left of this cross. The size of the measurement pattern corresponds 
to the length of the horizontal line below the cross.

2 The [Cross and Circles] line pattern combines the two line patterns [Cross] 
and [Circles].

2 With this line pattern, vertical lines are distributed evenly across the 
measurement pattern. You can define the number of lines in the [Number of 
test lines] > [Vertical] field.

2 With this line pattern, horizontal lines are distributed evenly across the 
measurement pattern. You can define the number of lines in the [Number of 
test lines] > [Horizontal] field.

2 With this line pattern, horizontal and vertical lines are distributed evenly 
across the measurement pattern, forming a grid. You can define the number 
of lines in the [Number of test lines] > [Vertical] and [Horizontal] fields.

3 [Grain boundary 
width]

Here, you set the necessary width for the detection of a grain boundary. 
When a small grain boundary width is set, your software finds considerably 
more intercept points than with a wider grain boundary. 
You can move the slide control to any position you want. Keep an eye on the 
display in the image.

3 [Noise reduction] Use this slide control to apply a smoothing filter to the image. The smoothing 
filter reduces the image noise. You should therefore apply a smoothing filter 
to images that are very noisy before the intercept analysis is made. Move the 
slide control from the left to the right, to increase the strength of the 
smoothing filter in small steps. This will lead to a reduction of the detected 
intercept points.

4 [Number of test 
lines]

These fields are only active if you selected a pattern of test lines that contains 
horizontal or vertical lines. In this case, you specify here the number of lines to 
be used for the intercept analysis.

5 [Standard] In the [Standard] field, select the industry standard that is to be used.
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8.3 Performing an intercept analysis
The following step-by-step instructions describe an example for a 
grains intercept analysis.
[Image source] step

1. Load all of the images that you want to analyze. 
2. Select the images in the [Gallery] tool window.
3. Click the [Grains Intercept] button, located in the [Materials 

Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

4. You can select the [Selected images] option in the [Image source] 
group, for example. When you do this, pay attention to how many 
images have been selected. This information is shown in bold at 
the bottom of the group.
 The [Selected images] option analyzes all of the images that are 

currently selected in the [Gallery] tool window. 
5. Decide whether you want to load settings that you have saved 

while you were analyzing another image. Then you can, if 
necessary, adapt these settings and apply them to this image. Click 
the [Load from file] button to load settings that have already been 
saved.

6. Decide whether or not you want to add data about the sample or 
about individual images while the analysis process is in progress. 
Should you want to add data, (e.g., because you are analyzing 
images of several samples in the same analysis), leave the [Skip 
'Sample information'] check box clear.

7. Select the [All images] entry in the [Check settings and results] list.
8. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Sample information] step
Prerequisite  You will only see this step in the analysis if, in the previous step, the 

[Skip 'Sample information'] check box wasn't selected.

1. Enter information on your sample. By default, these fields are called 
[Reference] and [Group].
 If you have changed the default settings, these fields can also 

have another name.
2. If you want to, enter a comment about the sample. This comment 

is valid for all of the images of this sample.
3. If you want to, enter a comment about the current image, too.
4. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Settings] step
1. Select a suitable grain boundary type.
2. Select a pattern of test lines that is appropriate for the structures in 

the image that is to be analyzed. You can choose between various 
patterns.
 The pattern of test lines determines along which lines intercept 

points in the image are looked for.
3. Take a look at the intercept points that have been found in the 

image. If necessary, change the settings to optimize the results 
shown.
 The intercept points are, by default, shown in red, the measuring 

lines, in green.
You can change these color settings in the [Options] dialog box. 
You must make these settings before you start the analysis 
process.

4. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Image results] step
1. Check the results shown. You can see the results of the current 

image, and the overall results of all of the images that have already 
been analyzed for this sample.

2. Should you not be satisfied with the results for the current image: 
Click the [Back] button to go back to the [Settings] step. Then you 
can try to improve the results for this image by choosing another 
line type or by moving the slide controls to another position.

3. You can correct the intercepts that were automatically detected. To 
do so, use the [Add Intercepts] or [Delete Intercepts] buttons.
 Alternatively, click the [Reject image] button to exclude this 

image from the analysis. This only makes sense if the current 
analysis contains at least two images.

4. Click the [Next] button.
 The [Materials Solutions] tool window goes to the [Sample 

information] step for the next image.
5. Repeat the [Sample information], [Settings] and [Image results] 

steps for each image that you want to analyze.
[Results] step

1. Check the results shown. You can see the results for all of the 
images that have been analyzed.

2. Select the [Generate report] check box, if you would like to have a 
report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. If you want to save the current settings to a file, click the [Save 

settings] button. Then assign a descriptive name in the next dialog 
box.
 You can load these settings when you analyze further images. To 

do that for the new image in the [Image Source] step, click the 
[Load from file] button. The sample and image comments, the 
line pattern used, and the position of the slide controls in the 
[Settings] step will be saved.
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5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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8.3.1 Adding and deleting intercept points
You can manually edit the intercept points that your software found 
automatically. When you do this, you have the possibility of deleting 
superfluous intercept points and adding intercept points that are 
missing.
Don't use the possibility to correct intercept points manually, until 
you've changed the positions of the slide controls several times in the 
[Settings] step, and are certain that you have found the best possible 
setting.

Adding intercept points
Prerequisite  To do this, you'll have to carry out an intercept analysis, and be in 

the [Image results] step.

1. Enlarge the display of the image so much that you can easily 
recognize all of the grain boundaries. To do so, move the mouse 
pointer on the image window and rotate the mouse wheel, for 
example.

2. Click the [Add Intercepts] button to add intercept points.
3. Move the mouse pointer onto the image window.
 When you now move the mouse pointer onto the image 

window, it is surrounded by a blue circle. This indicates that your 
are in edit mode. The only thing you can do now is to add 
intercept points. In this mode, other work with your software isn't 
possible.

4. Click once on the position where you want to set the new intercept 
point. This position must be on a measuring line.

If you have manually corrected intercept points and then return to the 
[Settings] step (e.g., to change the settings of the slide controls) your manual 
validation will be deleted.
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 The intercept point will be created. The intercept points are, by 
default, shown in red, the measuring lines, in green.

 The display in the [Image Results] and [Sample Results] groups is 
updated.

5. If you want to, click additional positions in the image, at which you 
want to set new intercept points.

6. To stop the edit mode, click the right mouse button.
7. You can now proceed to the next step. Alternatively, you can also 

delete superfluous intercept points.

Deleting intercept points
Prerequisite  To do this, you'll have to carry out an intercept analysis, and be in 

the [Image results] step.

1. Enlarge the display of the image so much that you can easily 
recognize all of the grain boundaries. To do so, move the mouse 
pointer on the image window and rotate the mouse wheel, for 
example.

2. Click the [Delete Intercepts] button to delete superfluous intercept 
points.

3. Move the mouse pointer onto the image window.
 When you now move the mouse pointer onto the image 

window, it is surrounded by a blue circle. This indicates that your 
are in edit mode. The only thing you can then do, is to delete 
intercept points. In this mode, other work with your software isn't 
possible.

4. Select the intercept point you want to delete.
 The intercept point will be deleted.
 The display in the [Image Results] and [Sample Results] groups is 

updated.
5. If necessary, click further intercept points that you want to delete.
6. To stop the edit mode, click the right mouse button.
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7. You can now proceed to the next step, or delete more intercept 
points.
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8.4 Software options
The software options provide a number of intercept analysis settings.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Grains Intercept] entry in 
the tree view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an materials science 
analysis process.
Setting the colors for the display of the measurement
You can change the colors of the measurement lines and intercept 
points in the intercept analysis.
In the [Pattern color] field, set the color of the measurement lines. The 
measurement lines should be clearly recognizable in the image. By 
default, the color green is selected.
In the [Intercept point color] field, set the color of the intercept points. 
By default, the color red is selected.
Displaying the intercept lengths in the workbook
The [Display intercept lengths in the workbook] check box specifies how 
the results of a grains intercept analysis are displayed in a workbook. 
You can set whether a workbook should be created in the [Results] step 
in the analysis. 
If this check box is not selected, the workbook only contains the mean 
intercept length and the mean number of intercept points.
When the check box is selected, each workbook will also contain one or 
more worksheets for each individual intercept length. By sorting the 

This command is not available while an analysis is running.
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values in the [Intercept Length] column in descending order for 
example, you can quickly determine the longest intercept length.
In this context, the [One sheet per image] and [One sheet per sample] 
options specify how the additional worksheets that contain the 
individual results will be structured. This means that, with both options, 
the same information is given. However, the way the information is 
structured is different.
Select the [One sheet per image] option to have the individual results 
for each image that was analyzed shown in a separate worksheet.
Select the [One sheet per sample] option to have the individual results 
for all images that belong to the same sample shown in one worksheet:
Note: You can define some general settings for the appearance of 
workbooks. To do so, use the [Options] > [Workbook] > [Format] 
dialog box.
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9 [Grains Planimetric]
9.1 Overview

What is Grains Planimetric?
The grains planimetric analysis is used to measure grain sizes and to 
document them. It is often used in material analyses, for example, when 
the quality of steel or other metals is being tested. The grains 
planimetric analysis determines the grain size by means of the grains' 
area. In this way, it differs from the intercept analysis, that determines 
the grain size by means of the number of intercept points.
Samples with either dark or bright grains can be used. The analysis of 
cascaded grain boundaries (with multi-phase materials) is also possible.

The image shown above shows the results of an automatic detection of the grain boundaries. By 
default, the grain boundaries that have been detected are displayed in red (first illustration). Addi-
tionally, it's possible to have the grains that have been found displayed in color (second illustra-
tion). Small grains are displayed in darker shades than big grains.

Measuring the second phase
Samples that have a second phase can also be measured. Ferrite 
pearlite microstructures, which are important in the material analysis of 
steel, have two phases: the dark pearlite and the light ferrite.
For these kind of samples, your software can determine the area of all 
of the second phase objects and subtract them from the area of the 
first phase.

The above images display a ferrite pearlite microstructure. In the first image you can see (in red) 
the grain boundaries that have been detected. In the second image, all of the image areas that 
belong to the second phase are shown (in turquoise). The third image additionally shows (in 
green) the grains that were detected.
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Editing grain boundaries
You can manually edit the grain boundaries that your software found 
automatically. You can delete unnecessary grain boundaries and add 
boundaries that are missing.
Validating detected grains
You can correct the way that the software detected the grains by 
selecting the grains and deleting them manually. If you inadvertently 
delete any grains, you can restore them.

The above image shows the result of an automatic detection of the grain boundaries after a num-
ber of grains have been manually deleted. The deleted grains are no longer taken into account 
when the measurement results are determined. They are cross hatched in the image.

The results of a grains planimetric analysis
A grains planimetric analysis provides the so-called G-value, which is 
defined as a characteristic grain size in the corresponding industry 
standards. The following standards are available for the measurement:
• ASTM E 112-13
• GB/T 6394-2002
• GOST 5639-82
• EN ISO 643: 2012
• DIN 50601: 1985
• JIS G 0551: 2013
• JIS G 0552 1998
• ASTM E1382-97 (2015)

In addition to this, other measurement results are determined;, for 
example the total number of grains, the mean grain area and the sum 
of grain areas.
Documenting the results
The results can be displayed in a workbook and in a chart. Additionally, 
the results can be displayed in a report in MS-Word format.
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9.2 Settings
9.2.1 [Sample type] step

The selection of the sample type determines the algorithm that is used 
for the planimetric measurement. For this reason, depending on the 
sample type you choose, somewhat different setting options are 
available in the following step.
You can choose one of the following types:

1 Select the [Bright or dark grains] sample type when you want to analyze a 
sample that has distinct grain boundaries. You don't set whether the grain 
boundaries are dark or bright until the following step, the Grain boundaries 
step.

2 Select the [Bright grains with second phase] sample type when you want to 
analyze a sample that has bright grains, dark grain boundaries and a second 
phase. This sample type is suitable for samples in which the second phase is 
darker than the grains (a ferrite pearlite microsctructure for example).

3 Select the [Dark grains with second phase] sample type when you want to 
analyze a sample that has dark grains, bright grain boundaries and a second 
phase.

4 Select the [Color etched grains] sample type when you want to analyze a 
sample with multiple phases.
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9.2.2 [Second phase] step
Prerequisite  This button is only displayed if you selected the [Bright grains with 

second phase] type or the [Dark grains with second phase] type in 
the [Sample type] step.

In this step, the following possibilities are available:

1 [Name] The default name for the second phase is [Second phase]. If you want, you 
can enter a different name here. To do so, double click the [Name] field. The 
name that you have given will be used in the image results, the workbook and 
the report. In addition, the name of the phase will be saved together with the 
image and displayed in the [Properties] tool window.
The name of the phase will now be suggested as the default name for all 
additional images to be measured by the [Grains Planimetric] analysis 
process.
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2 [Phase color] In the [Phase color] field, select the color that the objects in the second phase 
will have in the image. The color should be clearly different from the color 
that you select in the Grain fill color field in the next step in the analysis, the 
Grain boundaries step.

3 [Threshold] Define the parts of the sample that will be detected as the second phase.
Use the [Threshold] slide control to set the intensity range that a pixel must 
fall into in order to be assigned to the second phase. A value of 50 is preset 
by default. When you change this value, more or less pixels are assigned to 
the second phase. The display in the image window is automatically updated 
after each change. This means that the areas of the sample that are displayed 
in the phase color increase or decrease. 

In the first illustration, the intensity range for the second phase has been set too low. This setting 
doesn't detect all of the areas of the sample that belong to the second phase. In the second illus-
tration, a higher intensity range has been set. It has detected all of the areas of the sample that 
belong to the second phase. 

4 [Close gaps in the 
phase]

Use the [Close gaps in the phase] slide control to specify to what degree to 
close gaps in the second phase. Gaps are individual or neighboring pixels 
within second phase objects that haven't been defined as second phase 
objects.
A value of 1 is preset by default. When you increase this value, these pixels are 
assigned to the second phase. 

In the first illustration, the [Close gaps in the phase] slide control is set to a low value. At this set-
ting, gaps remain in the second phase. In the second illustration, a higher value has been set. The 
gaps in the second phase have been closed. 

5 [Boundaries and 
artifact removal]

Use the [Boundaries and artifact removal] slide control to exclude from the 
analysis image artifacts or boundaries that are located within second phase 
objects.

6 [Show second 
phase]

Select the [Show second phase] check box to display in the selected phase 
color the areas of the sample that were defined as second phase.
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9.2.3 [Grain boundaries] step
In this step, you make important settings for the analysis. You'll only see 
some of the setting options described below. Which of them you see 
depends on the image type you chose in the previous step, the 
[Sample type] step.

7 [Validation] Click the [Remove or add second phase object] button to switch to edit 
mode. In this mode, you can manually delete areas of the sample that were 
erroneously detected as second phase. When you manually delete these 
objects, they will no longer be included when determining the area fraction 
covered by the second phase in percent.

1 [Grain boundary 
type]

Prerequisite: You'll only see these buttons if you chose the [Bright or dark 
grains] type in the [Sample type] step.
Here, you specify which criteria are used to detect the grain boundaries.

The appropriate grain boundary type depends on the image that you want to 
analyze. Click one of these buttons [Dark grain boundary on bright back-
ground], [Bright grain boundary on dark background] or [Bright and dark 
grain boundaries on gray background].
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2 Detecting grain 
boundaries

The positioning of the [Smoothness] and [Threshold] slide controls influences 
the detection of the grain boundaries. While you are positioning the slide 
controls, observe which grain boundaries are found. The preview is updated 
after every change in the settings.
Position the slide controls in such a way that the grain boundaries are 
detected as completely as possible. It doesn't matter if the grain boundaries 
are interrupted somewhere in between. The algorithm that calculates the G-
value will automatically close small interruptions in the boundaries.
If you are not sure whether or not a slide control is positioned correctly, click 
the [Next] button and have a look at the results in the [Image results] step. 
You can always use the [Back] button to return to the [Grain boundaries] step.

2 [Smoothness] With the help of the [Smoothness] slide control you can specify that small 
structures or patterns that are located within the grains are to be ignored for 
the analysis. These structures have nothing to do with grains. Therefore, it is 
important to exclude them from the detection. If this is not done, these small 
structures are taken for grains and will thus affect the result of a planimetric 
measurement negatively.
Set the smoothness as exactly as possible, so that small structures or patterns 
only just stop being detected. Don't choose a larger value than necessary. If 
the image smoothness chosen is unnecessarily great, real small grains won't 
be detected.

In the first illustration, the selected image smoothness is too small. With this setting, numerous 
structures (e.g., patterns) within the grains are detected, and this negatively affects the results of 
the planimetric measurement. In the second illustration, a higher value for the image smoothness 
has been chosen. You can clearly see that only a few structures were still detected within the 
grains. Therefore, the result of the planimetric measurement is more exact.
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2 [Threshold] Choose whether a smaller intensity range is sufficient for the detection of a 
grain boundary. This is, the case, when all of the grain boundaries stand out 
clearly against the background, for example. 
If not all of the grain boundaries stand out clearly against the background, 
e.g., because some grain boundaries are brighter than others, a larger 
intensity range has to be defined for the detection of the grain boundaries. 

 
In the first illustration, the selected threshold value is too high. You can see that not all of the 
grain boundaries have been detected.

 
In this illustration, a lower value for the threshold values has been given. You can see that all of 
the grain boundaries have now been detected.

3 [Grain boundary 
color]
[Grain fill color]

Here, you specify in which color the grain boundaries that have been 
detected are to be shown. To do so, click the arrow button that is located at 
the right border of the field and select a color. The grain boundaries should 
be clearly distinguishable from the sample's color. 
In the [Grain fill color] field, select the color in which the detected grains will 
be shown. To do so, click the arrow button that is located at the right border 
of the field and select a color. This setting affects the appearance of the 
image in the next step, the [Image results] step.

4 [Standard] In the [Standard] field, select the industry standard that is to be used for the 
analysis process. 

5 [Show grain 
boundaries]

Select the [Show grain boundaries] check box to display the grain boundaries 
in the image window.
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9.2.4 [Image results] step
In this step, the following options are available:

1 [Image results] 
group

1 [Fraction of 
second phase]

If you measured a sample with a second phase, the fraction of second phase 
is shown. Under the field, the name of the phase is shown and the fraction 
(expressed in percent) that the second phase has of the total area that was 
determined. 
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1 [Grain Size 
Distribution] 

Select the [Relative count (%)] entry if the number of grains per class should 
be displayed in percent. This option only takes into account the absolute 
number of grains per class and not the size of the grains.
Example: Class 1 contains 70% of all of the detected grains, class 2 contains 
30%.

Select the [Area-weighted (area%)] option if the overall area of all grains of 
the same class is to be considered in relation to the overall area of all grains 
of the other classes. When this entry is selected, the area of the grains is taken 
into account.
Example: Class 1 contains most of the detected grains, but the grains are very 
small. Class 2 contains considerably less grains, but the grains are very large. 
This is why class 1 only has a 40% share of the overall area of all grains, 
whereas class 2 has a 60% share.

2 Chart of the grain 
size distribution

Above the chart, you'll see the [Grain Size Number G] field for the current 
sample or for the current image. The grains that were detected are assigned 
to different size classes. The chart shows the grain size distribution for the 
current image or the current sample. You can save the chart. To do so, in the 
following step, the [Results] step, select the [Generate Chart] check box.

3 [Image]
[Sample]

Below the chart you'll find the [Image] and [Sample] options. Select here, 
whether you want to see the grain size distribution for all of the images of the 
sample, or only for the current image.

4 [Show grains] Select the [Show grains] check box to have the detected grains displayed in 
color. If this check box has been cleared, the image remains visible and only 
the grain boundaries are shown together with the image. 

4 [Show second 
phase]

This check box only displayed if you selected the [Bright grains with second 
phase] type or the [Dark grains with second phase] type in the [Sample type] 
step.
Select the [Show second phase] check box to display in color the objects that 
were detected for the second phase.

5 [Editing] You can still manually correct the grain boundaries that have been found. To 
do this, use the buttons in the [Editing] group.
If you have manually corrected grain boundaries, you must confirm your 
changes. To do so, click the right mouse button.
If you have manually corrected grain boundaries and return to the [Settings] 
step (e.g., to change the settings of the slide controls) your manual validation 
will be deleted.
You can find step-by-step instructions in chapter Adding and deleting grain 
boundaries on page 117.
101 OLYMPUS Cleanliness Inspector CIX ASW



9  [Grains Planimetric]
Settings
5 Click the [Add grain boundaries in free-hand mode] button to manually draw 
additional grain boundaries in the image.

5 Click the [Add grain boundaries in guided mode] button to draw additional 
grain boundaries in the image. This button helps you, when you draw the 
grain boundaries. You depress your left mouse button, then move the mouse 
pointer in the general direction of the grain boundary that is to be drawn in. 
While you do this, your software measures the different intensities in that 
image segment and draws the grain boundaries.

5 Use the [Delete grain boundaries] button to remove unwanted grain 
boundaries from the image.

6 [Validation] In the [Validation] group, you can manually correct the grains that have been 
detected. You can delete grains and also restore grains that you deleted 
inadvertently. Grains that were not detected by the software, because they 
are at the edge of the sample for example, can not be added.
If you have already measured second phase objects and want to correct the 
way that they were detected, go back to the [Second phase] step in the 
analysis. In this step, click the [Remove or add second phase object] button in 
the [Validation] group. 
The manual validation of grains is not saved when you go back to a previous 
step in the analysis. So, when you return to the [Image results] step in the 
analysis you may be required to delete the grains again.

6 Click the [Remove or add grains] button. You are now in an edit mode where 
you can only delete and restore grains. In this mode, other work with your 
software isn't possible. Select the grains that you want to delete and click your 
right mouse button to leave edit mode and to accept the changes.

7 [Reject Image] You can use the [Reject Image] button to exclude the current image from the 
analysis. When you analyze numerous images one after the other, your 
software displays the next image after you've clicked the [Next] button.
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9.3 Performing a planimetric measurement
The following step-by-step instructions describe an example of a grains 
planimetric analysis.
[Image source] step

1. Click the [Grains Planimetric] button, located in the [Materials 
Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

2. You can select the [Live image] option in the [Image source] group, 
for example. 
 When you select the [Live image] option, the additional step 

[Image acquisition] will be shown. In this step, an image is 
acquired which will then be analyzed in the following steps. 

 When the measurement has been completed, a new image will 
be automatically acquired, and analyzed. This enables you to 
analyze as many images as you would like during the same 
analysis process. You can then either save the analyzed images 
or reject them.

3. Decide whether you want to load settings that you have saved 
while you were analyzing another image. Then you can, if 
necessary, adapt these settings and apply them to this image. Click 
the [Load from file] button to load settings that have already been 
saved.

4. Decide whether or not you want to add data about the sample or 
about individual images while the analysis process is in progress. 
You can select the [Skip 'Sample information'] check box if you 
don't want to add any details about the sample.

5. Select the [All images] entry in the [Check settings and results] list.
6. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Image acquisition] step
1. Go to the required sample position in the live-image.
2. Select the acquisition settings you want.
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 Change the objective if required. The [Microscope Control] 
toolbar contains buttons for changing objectives.

 Set the exposure time. To do so, use the [Camera Control] 
toolbar.

 Focus the image.
3. Click the [Next] button.
 Live mode stops.
 The acquired image will be shown in the document group.
 The [Materials Solutions] tool window will display the next step.

[Sample type] step
1. Select the image type that is the most similar to the sample that 

you now want to measure. The sample type determines the 
algorithm that is to be used for the determination of the grain 
sizes.
You can click the [Bright grains with second phase] sample type if 
you want to analyze a sample that has bright grains, dark grain 
boundaries and a second phase. 
 When select the [Bright grains with second phase] sample type, 

an additional step is added to the analysis process. You can see 
it at the bottom of the tool window where the [Second phase] 
step is now shown. 

2. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Second phase] step
Prerequisite  This step is only displayed if you selected the [Bright grains with 

second phase] sample type or the [Dark grains with second phase] 
sample type in the previous step.

1. In the [Phase color] field, select the color that the objects in the 
second phase will have in the image. 

2. Use the [Threshold] slide control to set the intensity range that a 
pixel must fall into in order to be assigned to the second phase. A 
value of 50 is preset by default. When you change this value, more 
or less pixels are assigned to the second phase.
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 The display in the image window is automatically updated after 
each change. This means that the areas of the sample that are 
displayed in the phase color increase or decrease.

3. Use the [Close gaps in the phase] slide control to specify to what 
degree to close gaps in the second phase.
 Gaps are individual or neighboring pixels within second phase 

objects that haven't been recognized as second phase objects. A 
value of 1 is preset by default. When you increase this value, 
these pixels are assigned to the second phase. 

4. Use the [Boundaries and artifact removal] slide control to remove 
erroneous pixels from the analysis.

5. Select the [Show second phase] check box to display in the 
selected phase color the areas of the sample that were defined as 
second phase.

6. In the [Validation] group, click the [Remove or add second phase 
object] button to switch on edit mode. In this mode, you can 
manually delete areas of the sample that were erroneously 
detected as second phase objects. By manually deleting these 
objects, these areas will no longer be taken into account when 
determining the area fraction of the second phase.

7. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Grain boundaries] step
1. With the [Smoothness] slide control, adjust the degree of the 

image smoothness until artifacts located within the grains only just 
stop being detected. 
Don't choose a larger value than necessary. If the image 
smoothness that you choose is unnecessarily great, real small 
grains will no longer be detected. Detected artifacts are taken for 
small grains by the software, and therefore influence the results of 
the planimetric measurement.
 The preview is updated after every change in the settings.

2. With the [Threshold] slide control, you set the intensity range for 
the detection of a grain boundary. 
If all of the grain boundaries can be clearly made out against the 
background, move the slide control to the right.
If all of the grain boundaries can't be clearly made out against the 
background, e.g., because some grain boundaries are brighter 
than others, move the slide control to the left.

3. In the [Grain boundary color] field, select the color in which the 
detected grain boundaries will be shown. To do so, click the arrow 
button that is located at the right border of the field and select a 
color. The grain boundaries should be clearly distinguishable from 
the sample's color.

4. In the [Grain fill color] field, select the color in which the detected 
grains will be shown. To do so, click the arrow button that is 
located at the right border of the field and select a color. The color 
that you select here will be applied in the next step in the analysis, 
the [Image results] step.

5. In the [Standard] field, select the industry standard that is to be 
used for the analysis process.
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[Image results] step
1. Check the results that are displayed in the image and in the 

[Materials Solutions] tool window.
 In the image, the grains that have been detected are now 

displayed in color. Only the colored grains will be taken into 
account when the G-value is calculated. If you only want to 
display the grain boundaries in the image, clear the [Show 
grains] check box.

 In the [Materials Solutions] tool window, you'll see the mean 
grain size number G for the current sample or for the current 
image. A graphic displays the distribution of the grains that were 
detected in the different size classes.

2. Should you not be satisfied with the results for the current image: 
Click the [Back] button to switch back to the [Grain boundaries] 
step. Then you can try to improve the results for the images by 
using another position of the slide controls.

3. If you want to correct the automatically found grain boundaries, 
click the [Add grain boundaries in freehand mode], [Add grain 
boundaries in guided mode] or [Delete grain boundaries] button. 
These buttons are in the [Editing] group. You can find step-by-step 
instructions in chapter Adding and deleting grain boundaries on 
page 117.

4. In the [Validation] group, click the [Remove or add grains] button. 
You can now delete grains that have been detected and exclude 
them from the analysis.

5. Click the [Next] button.
 The [Materials Solutions] tool window shows the [Image 

acquisition] step, and switches to live mode.
6. Repeat the analysis for each image that you want to analyze.
7. To finish the analysis, click the [Get Results] button. This takes you 

to the [Results] step. 
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[Results] step
1. Check the results shown. You can see the overall results for all of 

the images, that have already been analyzed for this sample.
2. Select the [Generate report] check box, if you would like to have a 

report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. Select the [Generate Chart] check box, to save the chart showing 

the allocation of the detected grain sizes to the different size 
classes. It is the same chart that was displayed in the previous 
[Image results] step in the analysis.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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9.3.1 Adding and deleting grain boundaries
You can manually edit the grain boundaries that your software found 
automatically. When you do this, you have the possibility of deleting 
superfluous grain boundaries and adding boundaries that are missing.
Don't use the option of correcting grain boundaries manually until 
you've changed the positions of the slide controls several times in the 
[Grain boundaries] step, and are certain that you have found the best 
possible setting. You can find more information on this topic in section 
[Grain boundaries] step on page 103.
Adding grain boundaries
Grain boundaries that are not completely closed won't always be 
automatically detected by your software. For this reason, it can become 
necessary for you to manually add grain boundaries. To do this, you'll 
have to carry out planimetric measurement and be in the [Image 
results] step. You can find more information on this topic in section 
[Image results] step on page 106.

1. Increase the image display enough clearly see the positions where 
you wish to add grain boundaries. To do so, move the mouse 
pointer on the image window and rotate the mouse wheel, for 
example.

2. In the [Editing] group, click either the [Add grain boundaries in 
freehand mode] or the [Add grain boundaries in guided mode] 
button to add grain boundaries that are missing.
 Whereas the [Add grain boundaries in freehand mode] button 

leaves you completely free to draw additional grain boundaries 
in the image, the [Add grain boundaries in guided mode] button 
helps you when you draw additional grain boundaries. You 
move your mouse in the general direction of the grain boundary 
that is to be drawn in, and your software measures the different 
intensities at this position and draws in the grain boundaries 
along the intensity deviations.

 The grains that were detected are now hidden and the mouse 
pointer jumps to the image. You will then be in edit mode.

 In this mode, you can only add grain boundaries, you can't use 
any other functions of your software. 

3. Click the position at which the new grain boundary is to begin, then 
while keeping the left mouse button depressed, move your pointer 
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to the end of the grain boundary. Then release the left mouse 
button.

 
 The grain boundary will be drawn in.

4. Repeat the previous step as often as you want to add further grain 
boundaries. Use the horizontal and vertical scroll bar to move 
around the image.

5. Click your right mouse button to leave edit mode and to confirm 
the changes.
 The grains that were detected are now shown again.

6. Check the results that are displayed in the image and in the 
[Materials Solutions] tool window.

7. When you're satisfied, proceed to the next step in the analysis. 
Alternatively, you can delete superfluous grain boundaries now.

Deleting grain boundaries
To delete grain boundaries, you'll have to carry out planimetric 
measurement and be in the [Image results] step. You can find more 
information on this topic in section [Image results] step on page 106.

1. Increase the image display enough clearly see the positions where 
you wish to delete grain boundaries.

2. Click the [Delete grain boundaries] button in the [Editing] group to 
delete superfluous grain boundaries.
 The grains that were detected are now hidden and the mouse 

pointer jumps to the image. You will then be in edit mode.
 This mode only allows you to delete grain boundaries. You can't 

do anything else in your software. 
3. Move your pointer over the grain boundary you want to delete.

 The grain boundary will be shown in blue.
4. Click the grain border that has been selected, to delete it.
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 The grain boundary will be deleted.
5. Repeat the two previous steps as often as you want, to delete 

further grain boundaries. Use the horizontal and vertical scroll bar 
to move around the image.

6. Click your right mouse button to leave edit mode and to confirm 
the changes.
 The grains that were detected are now shown again.

7. Check the results that are displayed in the image and in the 
[Materials Solutions] tool window.

8. When you're satisfied, proceed to the next step in the analysis.
If you don't want to delete grain boundaries but rather whole grains, click the 
[Remove or add grains] button in the [Validation] group. 
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9.4 Software options
The software options provide a number of grains planimetric settings.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Grains Planimetric] entry in 
the tree view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an materials science 
analysis process.
Default settings for the analysis process

[Minimal
acceptable grain

size]

Here, you specify the minimum size a grain must have in order to be 
detected. You can enter the size in the [Pixels] unit for example, or 
select another unit.
Only detected grains are considered for the calculation of the G-value. 
This means that all grains that do not come up to the minimum size 
defined here, have no influence on the calculation of the G-value. In the 
[Image results] step, grains smaller than the minimum size will be 
shown without fill color.

[Bimodal grain
size measure-

ment]

Select this check box, if you measure samples in which mainly only two 
grain sizes can be seen. In this case, in addition to the G-value for the 
complete sample, a G-value for the smaller grains and a G-value for the 
larger grains will be determined. You'll see these two additionally 
determined G-values when you create a workbook or a report.
The G-value for the complete sample won't be changed by this setting.
In the [Area fraction of fine grains] field, choose what percentage of the 
smallest grains is to be assigned the [Fine] G-value. All of the other 
grains will then be assigned the [Coarse] G-value. By default, 20% is set.

This command is not available while an analysis is running.
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Example In your sample there are mainly only two different sizes of grain. In 
addition to the sample's complete G-value, you also want to know the 
G-value of the small grains and the G-value of the coarse grains. You 
select the [Bimodal grain size measurement] check box, and enter the 
value 30 in the [Area fraction of fine grains] field. When you then carry 
out a planimetric measurement, your software sorts the grain surface 
areas found and assigns the lower 30% to the G-value [Fine]. The 
remaining 70% of the grain surface areas found are used for the 
calculation of the G-value [Coarse].

[Display grain
areas in the
workbook]

The [Display grain areas in the workbook] check box specifies how the 
results of a planimetric grain size measurement are displayed in a 
workbook. You can set whether a workbook should be created in the 
[Results] step in the analysis. 
If this check box is not selected, the workbook will have two sheets. 
Amongst other information, the first sheet will display the sum of the 
area of all of the detected grains as well as the mean grain size and the 
average elongation. The second sheet displays the grain size classes for 
the grains that were detected. This means that you see how many 
grains each defined class contains.
When this check box is selected, the workbook contains one or more 
additional worksheets with the individual results for each grain that was 
detected. The [Grain Area] measurement parameter shows the exact 
area of each grain that was detected. If you sort the values in the [Grain 
Area] column in descending order, for example, you can quickly see the 
area of the largest grain that was detected.
In this context, the [One sheet per image] and [One sheet per sample] 
options specify how the additional worksheets that contain the 
individual results will be structured. This means that, with both options, 
the same information is given. However, the way the information is 
structured is different.
Select the [One sheet per image] option to have the individual results 
for each image that was analyzed shown in a separate worksheet.
Select the [One sheet per sample] option to have the individual results 
for all images that belong to the same sample shown in one worksheet:
Note: You can define some general settings for the appearance of 
workbooks. To do so, use the [Options] > [Workbook] > [Format] 
dialog box.
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[Display grains
with the selected

fill color in the
resulting image]

Select this check box if you want to display the classification of the 
grains in the selected fill color. If you manually deleted any grains, they 
will be displayed in white with dark hatching.
When this check box is selected, the classification of the grains is 
displayed in the following places in the software:
• in the report
• in the resulting image

If this check box is not selected, the grain boundaries are displayed 
(instead of the classification of the grains in the selected fill color).

In this illustration, you can see the appearance when the [Display grains with the selected fill color 
in the resulting image] check box has been selected in the software options. Along with the image, 
the grains are now displayed in the selected fill color in the report.

In this illustration, you can see the appearance when the [Display grains with the selected fill color 
in the resulting image] check box has not been selected in the software options. The grain bound-
aries are now displayed in the report together with the image. 

Prerequisite  The status of this check box only affects the display of the image in 
the report when the [One page per image] and [Show results in 
overlay] check boxes are selected in the [Reporting] step.
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10 [Layer Thickness]
10.1 Overview

What is a layer thickness measurement?
By using layer thickness measurements you can measure layers on 
calibrated images automatically or interactively. The object that is to be 
measured is the thickness of one layer or of several layers.

Definitions Each layer is defined by two borders and a neutral fiber. The neutral 
fiber is a reference line which is there to specify the layer's course. The 
neutral fiber runs along the exact middle of the layer. The program 
automatically defines it.
To find layers, your software first detects a  phase in the image, that's 
an area of the image that has homogeneous intensity or color. Two 
phases are detected by default, one phase is the background and the 
other phase is the foreground. The layer that you want to measure 
must be in the foreground.
Your software determines the contours of all of the areas of the image 
that belong to the phase that is in the foreground of the image. The 
borders of the layers are on these contours.

The illustration on the left shows a schematic example sample. The sample has two phases. The 
layer that you want to measure belongs to phase (1). Phase [2] is the image background. The first 
step determined the contours of the layer. The illustration on the right shows the borders of the 
layer (3) and the neutral fiber (4).

You can define either open or closed layer types. When you have a 
closed layer type, you can measure circular layer structures.
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Measuring an open layer: In the image, two layers have been measured. You can see 4 layer bor-
ders (blue lines) and two neutral fibers (green lines). The measurement lines (yellow lines) are 
shown for the currently selected layer.

Measuring a closed layer: In the image, the outer layer has been measured. You can see the layer 
borders (blue lines), the neutral fiber (green line) and the measurement lines (black lines).

Results of a layer thickness measurement
The results of an analysis can be displayed in a workbook. Additionally, 
the results can be displayed in a report in MS-Word format.
The borders that have been found, the neutral fibers and the 
measurement lines will be saved together with the image, if you save it 
in TIF or VSI format. This information is saved in a separate image layer 
so that you don't have to overwrite the image information.
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General procedure for a layer thickness measurement
1 Selecting the 

analysis process
Click the [Layer Thickness] button, located in the [Materials Solutions] tool 
window.

2 [Image source] In the [Image source] step you select the images that you want to measure. 
You can find more information on page 62 of the Selecting the image source 
chapter.

3 [Settings] Before it can detect the layers, your software first detects a  phase. A phase 
is an area of the image that has homogeneous intensity or color. Your 
software then determines the contours of all of the areas of the image that 
belong to the phase that is in the foreground of the image. The borders of 
the layers are on these contours.
In the [Settings] step, you select a method of defining the phases and 
contours. Select one of the definition methods, [Automatic], [Manual] or 
[Magic wand]. You can find more information on this topic in section 
[Settings] step on page 127.

4 [Magic wand] If you have selected the [Magic wand] definition method: Define the contours. 
You can find more information on this topic in section [Magic wand] step on 
page 141.

4 [Define borders] The [Define borders] step is only displayed when you have selected the 
[Automatic] or [Magic wand] definition method. On the image that you are 
analyzing, you can now see a closed contour around the layer. The borders of 
the layers are on these contours. Define the borders in this step in the 
analysis. You can find step-by-step instructions in section [Def ine borders] 
step on page 136.

5 [Define layers] Each layer has two borders. In the [Define layers] step, select the borders that 
belong to a layer. When this is done, the layer has been defined and it can 
now be measured. You can find step-by-step instructions in section [Def ine 
layers] step on page 137.

6 [Image results] The layer thickness is measured at several positions on the layer. In the 
[Settings] table, you can configure the measurements and view the 
measurement results. You can find more information on this topic in section 
[Image results] step on page 131.

7 [Results] Document the results and generate a report or a workbook.
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10.2 Settings
10.2.1 [Settings] step

In this step, the following options are available:

1 Selecting the 
definition method

The layer that you want to measure must first be defined on the image. There 
are different definition methods to do this. Click one of the three buttons to 
select the definition method you want.

1 An automatic definition  of the phases is suitable for samples whose layers 
feature distinct intensity differences (e.g., a light layer on a dark background). 
With these samples, as a rule, the automatic threshold value setting used for 
this definition method functions well. You can find step-by-step instructions in 
chapter Performing an automatic layer thickness measurement on page 134.

1 Defining using the magic wand is suitable for samples that have irregular 
borders that would be very difficult to trace manually. You can find step-by-
step instructions in chapter Performing a layer thickness measurement 
with magic wand (closed layer) on page 141.
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1 Defining phases manually is suitable for samples in which there are only very 
small intensity differences, which means that the automatic definition of the 
phases would not provide you with satisfactory results. Also when only a small 
part of a layer interests you, you can easily set it with the manual definition. 
You can find step-by-step instructions in chapter Performing a manual layer 
thickness measurement on page 145.

2 In the [Layer type] group, you select whether open or closed layers are to be 
defined. To do this, click the corresponding icon.
With an open layer type, you can, e.g., measure layer structures that continue 
all through the image. When you have a closed layer type, you can measure 
circular layer structures.
The layer type can only be specified at the beginning of a measurement. In 
contrast to the definition method, the layer type can't be changed during the 
measurement.
122OLYMPUS Cleanliness Inspector CIX ASW



10  [Layer Thickness]
Settings
10.2.2 [Edit borders] step
In this step, the following options are available:

1 [Add contours] Click the [Add contours] button if you want to define an additional layer. 
When you do this, you'll return to the [Settings] step in the analysis, where 
you can then select a definition method.

2 [Move borders] Click the [Move borders] button.
Move your mouse pointer over the border you want to move. 
The mouse pointer changes into a hand icon, and the border is displayed in 
bold. Move the border.
Click the right mouse button to end the process.

3 [Delete borders] Click the [Delete borders] button.
Move your mouse pointer over the border you want to delete. The mouse 
pointer changes into a hand icon, and the border is displayed in bold. Click 
the border to delete it.
Click the right mouse button to end the process.
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4 [Connect borders] Click the [Connect borders] button. This button is only active when you 
measure open layers. Move the mouse pointer onto the first border.
The mouse pointer changes into a hand icon, and the border is displayed in 
bold. Click this border. Then move your mouse pointer onto the second 
border and click it. The two borders will be joined.
Click the right mouse button to end the process. 
You can't use the [Connect borders] function to turn an open layer into a 
closed layer. If you want to measure a closed layer, you will have to click the 
[Closed layers] button right at the beginning of the measurement, in the 
[Settings] step.

5 [Split borders] Click the [Split borders] button. This button is only active when you measure 
open layers. 
Move your mouse pointer to the position where the border is to be split. The 
mouse pointer changes into a red cross, and the border is displayed as a thick 
line. Click on the border at the point where you want to split it. 
Click the right mouse button to end the process. Alternatively, you can split 
additional borders.

6 [Smooth borders] If the layer's borders were determined automatically, the borders may be 
ragged. This has an effect on the measurement of the layer thickness. Click 
the [Smooth borders] button to smooth the contours and the borders that 
are derived from them.
The [Smoothness] slide control becomes active. Move your mouse pointer 
over the border you want to smooth. The mouse pointer changes into a hand 
icon, and the border is displayed in bold. Click the border to smooth it. 
If necessary, move the [Smoothness] slide control to set how much the 
border is smoothed. Observe in the image how the border changes. Click the 
right mouse button to end the process.
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10.2.3 [Image results] step
In this step, the following options are available:

1 [Settings] The layer thickness is measured at several positions on the layer. In the 
[Settings] table, you can configure the measurements. The values in the 
[Steps], [Distance] and [Type] fields can be edited when you double click in 
the cell you want to edit. Then you can change the measurement lines' step 
width, or select a different type of line.

2 [Layers] You can measure several layers on a single image. In the [Settings] table, you 
can configure the measurements for each layer. The [Layers] column contains 
the name of the layer.

3 [Steps] The layer thickness is measured at several positions on the layer. The step size 
determines how many positions there are. A step size of 10 means that the 
layer thickness will be measured at 10 positions.
Double click in the [Steps] field, located in the [Settings] table. The [Steps] 
field can now be edited. Enter the step width you want for the measurement 
lines. Click once outside the cell to finish your entry.
The minimum step width is 5, the maximum 100. If you enter a bigger or 
smaller number, the value will automatically be set to the minimal value.
The display in the image will be automatically updated. The [Distance] field in 
the [Settings] table now shows the new distance between the measurement 
lines. The measurement results in the [Results] group will also be adjusted. 
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4 [Distance] The layer thickness is measured at several positions on the layer. The 
[Distance] value tells you the distance between two adjacent measurement 
lines.

5 [Type] The layer thickness is measured at several positions on the layer. Your 
selection in the [Type] field decides how the measurement lines are laid 
through the layer. All of the measurement lines are displayed in yellow in the 
image. This allows you to always check the measurement visually.
Double click in the [Type] field. Select the type of measurement line you want. 
The display in the image will be automatically updated. The number of 
measurement lines displayed doesn't change.
The measurement results in the [Results] group will also be adjusted. 

5 With this type, all of the measurement lines are parallel to one another. This 
measurement type is only available for open layer types.

5 With this type, the measurement lines with the shortest distance are shown. 

5 With this type, all of the measurement lines are perpendicular to the neutral 
fiber.

5 With this type, all of the measurement lines are radial to one another. This 
measurement type is only available for closed layer types.

6 Click the [Show all measurements] button to have the measurement lines for 
all of the layers shown (no longer only for the currently selected layer). This 
button is only of importance when you have defined at least two layers.

6 Click the [Show neutral fibers] button to show and hide the neutral fiber.

6 Click the [Add measurements] button to add individual measurement lines. 
Click with your left mouse button at the position on the top layer border 
where the measurement line is to begin. Then click with your left mouse 
button at the position on the bottom layer border where the measurement 
line is to end.
If you want to, you can add additional measurement lines.
Click the right mouse button when you've finished adding measurement lines.
Note: You can only add measurement lines between the borders of the 
selected layer. You can’t add measurement lines between borders that 
belong to different layers.
126OLYMPUS Cleanliness Inspector CIX ASW



10  [Layer Thickness]
Settings
6 Click the [Delete measurements] button to delete individual measurement 
lines.
Click the measurement line which you would like to delete. If you want to, you 
can delete further measurement lines. Click the right mouse button to finish 
the deletion of measurement lines.

7 [Results] The [Results] group displays the results for all of the layers that have been 
measured.
The [Min.] field displays the least distance between the layer's two borders. 
The [Mean] field displays the average layer thickness. The [Max.] field displays 
the greatest distance between the layer's two borders.
If you change the configuration for the measurement, the results are 
updated. If you add more measurement lines, for example, they are taken 
into account when the mean is calculated.
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10.3 Performing a layer thickness measurement
10.3.1 Performing an automatic layer thickness measurement

You can follow these step-by-step-instructions on your computer. They 
describe a layer thickness measurement on an example image. 
[Image source] step

1. Load the Coating.tif example image. 

On this image, the thin light layer is to be measured.

2. Click the [Layer Thickness] button, located in the [Materials 
Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Settings] step
1. Click the [Automatic] button.
2. In the [Layer type] group, click the icon for an open layer.
3. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Automatic] step
 Your software detects a phase in the image, that's an area of the 

image that has homogeneous intensity or color. Two phases are 
detected by default, one phase is the background and the other 
phase is the foreground.
The layer that you want to measure must be in the foreground.

1. Because the layer that you want to measure is not colored yet, it 
belongs to the phase that forms the background. This means that 
you need to define the background differently. To do this, select 
the [Dark] option in the [Background] group. The bright layer is 
now in the foreground.

 
In the illustration on the left, the phase that has been found has been colored. The layer that you 
want to measure doesn't belong to this phase. On the right you can see the image after you have 
selected the background correctly. The layer is now a component of the phase.

2. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Define borders] step
 Your software determines the contours of all of the areas of the 

image that belong to the phase that is in the foreground of the 
image. The borders of the layers are on these contours.

 
In the example shown, there are two areas in the image that belong to the phase that coincides 
with the layer. The contours of both areas are shown.

1. Click the [Define borders] button.
2. Now, specify which part of the contour represents a border. Click 

the contour once with your left mouse button, to activate the 
mode.

3. Then click with your left mouse button at the position in the 
contour where the first border is to begin.

4. Then click with your left mouse button at the position in the 
contour where the first border is to end.
 The beginning and the end of this border will be indicated by 

two green crosses.
5. Now, define the second border. To do so, click with your left 

mouse button again at the position where this border is to begin. 
Then click with your left mouse button again at the position where 
this border is to end.
 The beginning and the end of this second border will be 

indicated by two blue crosses.
6. Click once with your right mouse button in the image.
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 The borders that have been defined will be plotted in blue.
7. You can now define additional borders. Since you don't want to 

define any additional borders: Then click once more with your right 
mouse button in the image, to switch off the mode for defining the 
borders.

8. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Edit borders] step
1. Since you have already defined both of the borders, and don't 

want to change them: Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
 You can find more information on this topic in chapter [Edit 

borders] step on page 129.

[Define layers] step
1. Click the [Add layers] button.
2. Click the first border.
3. Click the second border.

 The layer has now been defined. The neutral fiber is plotted in 
green. It always lies in the middle of the layer.

 All of the layers that have been defined are listed in the [Layers] 
list.
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4. Click your right mouse button to finish the definition of the layer.
 The layer is named [Layer 1] by default. 

5. If you want, you can change the layer's name. In the [Layers] list, 
double click the name of the layer and enter a descriptive name for 
it. Click once outside the cell to finish your entry.

6. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Image results] step
 The layer thickness is measured at several positions on the layer. 

1. In the [Settings] table, you can configure the measurements. The 
values in the [Steps], [Distance] and [Type] fields can be edited 
when you double click in the cell you want to edit. Then you can 
change the measurement lines' step width, or select a different 
type of line.
 You can enter a value of 50 in the [Steps] field for 

example. Notice the changed number of measurement lines in 
the image.

2. Use the buttons under the [Settings] table to delete or add new 
measurement lines. 
 You can find more information on this topic in section [Image 

results] step on page 131.
3. Check the results shown in the image.

The image resulting from a layer thickness measurement shows the border of the layer (blue line) 
and the neutral fiber (green line). The measurement lines are shown in yellow in the image.

4. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Results] step
1. Check the results shown. You can see the results for all of the 

images that have been analyzed.
2. Select the [Generate report] check box, if you would like to have a 

report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. If you want to save the current settings to a file, click the [Save 

settings] button. Then assign a descriptive name in the next dialog 
box.
 You can load these settings when you analyze further images. To 

do that for the new image in the [Image Source] step, click the 
[Load from file] button.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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10.3.2 Performing a layer thickness measurement with magic wand (closed layer)
You can follow these step-by-step-instructions on your computer. They 
describe a layer thickness measurement on an example image.
[Image source] step

1. Load the Copper Wire Section.tif example image. 
 The image shows a cross section through a copper wire. The 

outermost layer is to be measured.
2. Click the [Layer Thickness] button, located in the [Materials 

Solutions] tool window.
3. In the [Image source] group, select the [Selected images] option to 

analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Settings] step
1. Click the [Magic Wand] button.
2. In the [Layer type] group, click the icon for a closed layer.
3. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Magic wand] step
1. Click the [Add contours] button.
2. Click the button for the HSV color space.
3. To detect layers, first define a  phase in the image, that's an area 

of the image that has homogeneous intensity or color. To do this, 
click once with your left mouse button on a position in the image 
that lies within the outermost layer.
 The contours of the phase will be shown by a red line.

4. Make sure that the contour completely includes the outer layer. 
And that the contour's outline isn't discontinued at any point on 
the outer layer. Change the position of the slide control in the 
[Tolerance] field until the contour completely includes the layer 
that is to be measured. 
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The image on the left shows a contour that has been correct defined. The settings in the image at 
the top right are incorrect. The contours don't surround the layer that is to be measured. The set-
tings in the image at the bottom right are correct.

5. Click your right mouse button to finish the definition of the 
contour.
 Now, the first border has been defined. It will be plotted in blue.

6. Then define the second contour. To do this, click a position inside 
the copper wire. Take care again that the contour contains the 
inside of the copper wire as completely as possible, and that its 
outline isn't discontinued anywhere. At the same time, this new 
contour mustn't touch the contour that has already been defined. 
Move the slide control in the [Tolerance] field until the second 
contour runs as precisely as possible along the second border of 
the layer.
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Both borders of the layer have now been defined.

7. Click your right mouse button to finish the definition of the 
contour.

8. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Edit borders] step
1. Since you have already defined both of the borders, and don't 

want to change them: Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
 You can find more information on this topic in section [Edit 

borders] step on page 129.
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[Define layers] step
1. Click the [Add layers] button.
2. Click the first border.
3. Click the second border.

On the left you can see how the image looks after the [Define layers] step. On the right you can 
see the results of the layer thickness measurement.

 The layer has now been defined. The neutral fiber is plotted in 
green. It always lies in the middle of the layer.

 All of the layers that have been defined are listed in the [Layers] 
list.

4. Click your right mouse button to finish the definition of the layer.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

Finishing a measurement
1. Check the measurement results in the [Image results] step.
2. Generate a report and/or export the results to a workbook.
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10.3.3 Performing a manual layer thickness measurement
You can follow these step-by-step-instructions on your computer. They 
describe a layer thickness measurement on an example image.
[Image source] step

1. Load the Coating with porosity.tif example image.

On this image, the middle layer is to be measured.

2. Click the [Layer Thickness] button, located in the [Materials 
Solutions] tool window.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

 [Settings] step
1. Click the [Manual] button.
2. In the [Layer type] group, click the icon for an open layer.
3. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Manual] step
1. Click the [Add borders] button.
2. Define the first border. To do so, first click with your left mouse 

button at the position in the image where the border is to begin. 
Mark the course of the border with further left mouse clicks. Then 
click with your right mouse button at the position in the image 
where the border is to end.
 The border will be shown in red.

3. Define the second border. To do this, proceed exactly as you did 
when you defined the first border.

4. Click your right mouse button to finish the definition of the two 
borders.

The borders will be shown in blue.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Edit borders] step
1. Since you have already defined both of the borders, and don't 

want to change them: Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
 You can find more information on this topic in section [Edit 

borders] step on page 129.
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[Define layers] step
1. Click the [Add layers] button.
2. Click the first border.
3. Click the second border.

The layer has now been defined. The neutral fiber is plotted in green. It always lies in the middle of 
the layer.

4. Click your right mouse button to finish the definition of the layer.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

Finishing a measurement
1. Check the measurement results in the [Image results] step.

The measurement lines are shown in yellow in the image.

2. Generate a report and/or export the results to a workbook.
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10.4 Software options
The software options provide a number of layer thickness measurement 
settings.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Layer Thickness] entry in the 
tree view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an analysis.
Setting the colors for the display of the measurement
Change the color of the lines in the layer thickness measurement. It can 
happen that you need to change a line type's color to increase the way 
it contrasts with the sample. Please note that you have to change the 
line's color before you begin the measurement.
By default, each line has a different color. This makes it possible to 
immediately establish which type of line it is, by means of its color. 
Using the same color for different types of line doesn't make sense.

[Base
measurement

unit]

Select the unit to be used for the layer thickness measurement.

This command is not available while an analysis is running.
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11 [Cast Iron]
11.1 Overview

What is a cast iron analysis?
The quality and consistency of cast iron depends on the distribution 
and the morphology of its carbon content. By using a cast iron analysis 
you can determine the cast iron's graphite fraction with the help of 
unetched samples. As well as that, with the help of etched samples you 
can determine the ferrite/pearlite ratio.
The classification of the detected particles is performed according to 
the selected industry standard. Each standard requires a different 
classification of the detected particles. These classifications are included 
in the software package purchased, and are automatically installed with 
it. The following standards are supported:
• EN ISO 945-1:2018
• ASTM A247-17
• JIS G 5502:2001
• KS D 4302:2006
• GB/T 9441-2009
• ISO 16112:2017
• JIS G 5505:2013
• NF A04-197:2017

Determination of the graphite fraction
With the [Cast Iron] software solution, you can measure the graphite 
fraction and classify the detected particles. For this purpose, the sample 
must not be etched. How the classes are defined, depends on the 
standard according to which the cast iron analysis is carried out.

You see the results of a cast iron analysis made of different forms of graphite. The color coding of 
the particles indicates that they belong to a specific size class (1), form class (2), and form factor (3).
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Results of a cast iron analysis made to determine the graphite 
fraction
The results of an analysis can be displayed in a workbook. Additionally, 
the results can be displayed in a report in MS-Word format.
While you are performing a cast iron analysis, you can create a chart 
showing the graphite size, the graphite form or the graphite nodularity. 
You can also save these charts as files.

  
Figure (1) shows a chart of the graphite size. Along the X-axis the size classes are shown, along the 
Y-axis the number of detected particles in % is shown. 
Figure (2) shows a chart of the graphite form. Along the X-axis the form classes are shown, along 
the Y-axis the number of detected particles in % is shown.
Figure (3) shows a chart of the graphite nodularity. Along the X-axis the form factor is shown, 
along the Y-axis the number of detected particles in % is shown.

General procedure for a cast iron analysis made to determine the 
graphite fraction

1 Selecting the 
analysis process

Click the [Cast Iron] button, located in the [Materials Solutions] tool window.

2 [Image source] In the [Image source] step you select the images that you want to measure. 
You can find more information on page 62 of the Selecting the image source 
chapter.

3 [Settings] In the [Settings] step, you select the sample type (etched or unetched). Set 
the graphite parameters. You can find more information on this topic in 
section Settings on page 156.

4 [Graphite 
distribution]

The [Graphite Distribution] step is optional. It is where you determine the 
distribution of the graphite particles. You can find more information on this 
topic in section [Graphite Distribution] step on page 163.

5 [Image results] You can check the image results in the [Image results] step. If necessary: 
Delete or separate detected particles, or add new ones. You can find more 
information on this topic in section [Image results] step on page 164.

6 [Results] Document the results and generate a report or a workbook. 
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Determination of the ferrite/pearlite-ratio
With the [Cast Iron] software solution, you can also measure the ferrite/
pearlite ratio. For this purpose, the sample must have been etched. 
Since graphite and pearlite have very similar gray values, it's difficult to 
differentiate between these two fractions in a sample during the same 
analysis. For this reason, determining the ferrite/pearlite ratio is done as 
follows:
To begin with, your software defines  phases to determine the ratio 
of the bright ferrite areas to the dark (graphite and pearlite) areas. 
During the analysis, the graphite fraction is entered, and is then 
subtracted from the dark areas. This graphite fraction has either been 
determined in an earlier measurement (this value can then be 
imported), or it can alternatively be estimated. Using the pearlite area 
that has in this way been corrected, the ferrite/pearlite ratio is 
calculated.

You see a step in the analysis during the determining of the ferrite/pearlite ratio. The bright ferrite 
phase has been determined by your software (shown in yellow here).
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11.2 Settings
11.2.1 [Settings] step for unetched samples

In this step, the following options are available:

1 Selecting the 
definition method

Here you select the sample type. The dialog box offers you a variety of 
settings. Which settings are available depends on the type of sample being 
analyzed. 

1 Click this button if you have an unetched sample for which you want to 
determine the graphite fraction.

2 [Threshold for 
graphite]

Use the slide control to define the threshold value for the graphite detection.
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3 [Standard] In the [Standard] pick list, select the industry standard according to which the 
cast iron analysis is to be carried out. 

4 [Graphite 
parameters]

Select the graphite parameter that is to be determined.
Note: If you loaded any sample results in the [Sample information] step, these 
check boxes won't be active. In this case, the same settings will be used here 
than in the sample results that were loaded.

4 [Graphite form] If this check box has been selected, a graphite form chart can be created in 
the [Image results] step. The detected particles are sorted into specific classes 
according to their form. Which form classes and form factors are used for the 
classification depends on the industry standard according to which the cast 
iron analysis is performed.
When you measure the graphite form of particles, you can manually assign 
selected particles to a different class. You can find step-by-step instructions in 
section Reclassifying selected particles manually on page 175.

4 [Graphite size] If this check box has been selected, a graphite size chart can be created in the 
[Image results] step. The detected particles are sorted into specific classes 
according to their size. Which size classes are used for the classification 
depends on the industry standard according to which the cast iron analysis is 
performed.

4 [Graphite 
nodularity]

If this check box has been selected, a graphite nodularity chart can be created 
in the [Image results] step. Graphite nodularity: The detected particles are 
sorted into specific classes according to their nodularity. The nodularity is a 
unit of measure for the sphericity of the graphite. Which nodularity classes are 
used for the classification depends on the industry standard according to 
which the cast iron analysis is performed.

4 [Graphite 
distribution]

This check box is not available for all industry standards. 
When this check box has been selected an additional step, the [Graphite 
Distribution] step, will be added to the cast iron analysis. In the [Graphite 
Distribution] step, you can compare the distribution of the particles in the 
current image with the distribution in specific reference images. The graphite 
distribution (types A-E) can only be determined for lamellar graphite. 
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5 [Minimum size for 
graphite particle]

In the [Minimum size for graphite particle] field, specify the minimum size that 
a  particle must have in order to be included in the cast iron analysis. All 
particles that fall short of the value entered will be ignored when the analysis 
is carried out. Particles that have been detected, but that aren't used for the 
analysis, (e.g., because they don't come up to the minimum size that has 
been set here) are displayed in white with dark hatching.
The calculation of the sample's graphite fraction is not affected by this setting, 
as the smaller particles are also used to calculate the area fraction.
Note: When you select a standard in the [Standard] pick list, the values that 
are recommended in this standard are automatically entered in the [Minimum 
size for graphite particle] field. You can change this value there. Any change 
you make is only valid for the currently selected standard. When you select 
another standard, the values that are recommended in this newly selected 
standard are automatically entered in the [Minimum size for graphite particle] 
field.

6 [Graphite particles 
of form VI are not 
present]

This check box is only displayed if the [ASTM A 247-17] standard has been 
selected in the [Standard] pick list. 
Select the [Graphite particles of form VI are not present] check box when the 
following conditions apply:
The sample that is currently being analyzed has no form VI graphite particles. 
Form VI graphite particles can be easily visually recognized in the image by 
an expert.
You want to exclude the possibility that the algorithm that the software uses 
to classify the particles falsely identifies particles as particles of form VI 
because of their geometry. 

7 [Standard for size], 
[Standard for 
nodularity], 
[Standard for size 
and form ] 

Select the industry standard according to which the nodularity is to be carried 
out from the list.
Note: Whether this list is displayed depends on the entry that is selected 
above, in the [Standard] list. Also the list’s name depends on the entry that is 
selected above, in the [Standard] list. 

7 [Classify form IV 
particles as 
nodular particles]

When the [EN ISO 945-1:2018] or [NF A04-197:2017] entry is selected in the 
[Standard] pick list, the [Classify form IV particles as nodular particles] check 
box is displayed. Select this check box if all particles that belong to the form IV 
class should be considered for the detection of the graphite nodularity. That 
means that the graphite nodularity increases and that the number of nodular 
particles per mm² is also higher.
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11.2.2 [Settings] step for etched samples
In this step, the following options are available:

7 [Shape factor 
threshold]

This check box is only displayed if the [ASTM A 247-17] entry has been 
selected in the [Standard] pick list.
In the [Shape factor threshold] field, set the  threshold value to be used for 
counting a detected graphite particle as nodular graphite. You can enter 
values between 0 and 1, the default value is 0.6. If you enter a smaller value 
(e.g. 0.4), a larger proportion of the graphite particles found will be counted 
as nodular graphite than for example with a value of 0.6.

1 Selecting the 
definition method

Here you select the sample type. The dialog box offers you a variety of 
settings. Which settings are available depends on the type of sample being 
analyzed. 

1 Click this button if you have an etched sample for which you want to 
determine the graphite fraction.
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2 [Threshold for 
ferrite]

Here, you enter whether the  threshold value for the detection of the ferrite 
fraction is high or low. By doing so, you set the range of intensity values (the 
phase) that is valid for the ferrite detection. 
If the slide control is closer to the [Low] position, the phase contains a larger 
part of the intensities that are present in the image.
If the slide control is closer to the [High] position, the phase contains a smaller 
part of the intensities. This means that only a smaller part of the intensity 
values is detected as ferrite. All of the pixels that have been detected as ferrite 
will be highlighted in yellow in the image.

3 [Close gaps in 
pearlite phase]

Use the [Close gaps in pearlite phase] slide control to define to what degree 
the voids that the pearlite contains, are to be closed. In this context, a void in 
the pearlite is an area within the pearlite that has so bright intensity values, 
that it is assigned to the ferrite. In the image, voids are visualized as an 
accumulation of small yellow points within the pearlite.
Position the slide control towards the [Coarse] end of the spectrum to detect 
the pearlite phase with relatively few voids. Position the slide control towards 
the [Fine] end of the spectrum to have areas with bright intensity values 
(within the pearlite phase) detected as ferrite. 
The [Close gaps in pearlite phase] slide control applies a morphological filter. 
Morphological filters are often used in image analysis to optimize the results 
of an automatic object analysis.

  
In illustration (1), the pearlite phase is hardly closed. This is why many voids have been detected 
within the pearlite (see arrows). Illustration (2) shows a pearlite phase that is more closed.

4 [Graphite fraction] You can either enter the graphite fraction manually, or load the value that has 
been saved.

4 [Enter manually] The [Enter manually] option is always active. Enter the value there, that you 
determined when you analyzed the unetched sample. You can have e.g., 
made a note of this value, or have saved it in a report.

4 [Result of 
unetched sample 
analysis]

The [Result of unetched sample analysis] option will only be active if one of 
the following requirements has been met.
In the same analysis, you have already measured the graphite fraction, using 
an unetched part of the sample.
You have measured the graphite fraction in the unetched sample, and have 
saved these values as a parameter set. You have then clicked the [Load 
results] button in the [Sample information] step, and have chosen this 
parameter set in the [Load Cast Iron Sample Results] dialog box.
152OLYMPUS Cleanliness Inspector CIX ASW



11  [Cast Iron]
Performing a cast iron analysis
11.3 Performing a cast iron analysis
11.3.1 Performing a cast iron analysis (unetched sample)

You can follow these step-by-step-instructions on your computer. They 
describe a cast iron analysis on an example image. 

Measure the graphite fraction on the example image.

[Image source] step
1. Load the GlobularGraphite.tif example image.
2. Click the [Cast Iron] button, located in the [Materials Solutions] tool 

window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
 This skips the [Sample information] step, which is not relevant for 

this example image. However, it is quite possible that, when 
performing your own analyses, you might want to load sample 
results (e.g., the result of a previous cast iron analysis that 
determined the graphite fraction). In this case, make sure the 
[Skip 'Sample information'] check box is cleared, which will 
enable you to use the [Load results] button in the [Sample 
information] step.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Settings] step
1. Click the button pictured on the left to specify that you want to 

determine the graphite fraction in an unetched sample.
2. Use the [Threshold for graphite] slide control to define the threshold 

value for the graphite detection. Observe the sample. The 
threshold value has been correctly set when the graphite particles 
can be completely detected.

  
In illustration (1), the threshold value has been set too high, the detected particles are too large. In 
illustration (2), the threshold value has been set too low, the particles are not detected completely. 
Illustration (3) shows a correctly set threshold value. 

3. In the [Standard] pick list, select the industry standard according to 
which the cast iron analysis is to be carried out. 
 Some standards contain either rules regarding the measurement 

of the nodularity or references to secondary standards. For this 
reason, additional fields may now be shown or hidden in the 
lower area of the tool window.

4. Select the graphite parameter that is to be determined. To do so, 
select the corresponding check box. In this example, select all of 
the graphite parameters. 
You'll find an overview of graphite parameters on page 156 of the 
[Settings] step for unetched samples section. 

5. In the [Minimum size for graphite particle] field, specify the 
minimum size that a particle must have if it is to be included in the 
cast iron analysis.
 All particles that fall short of the value entered will be ignored 

when the analysis is carried out. 
 Particles that have been detected, but that aren't used for the 

analysis, (e.g., because they don't come up to the minimum size 
that has been set here) are displayed in white with dark hatching.

 The calculation of the sample's graphite fraction is not affected 
by this setting, as the smaller particles are also used to calculate 
the area fraction.

6. Click the [Next] button.
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 The [Materials Solutions] tool window will display the next step.

[Graphite Distribution] step
Prerequisite  You will only see this step if, in the [Settings] step, you selected the 

[Graphite distribution] check box.

In the [Graphite Distribution] step, you can compare the particles that 
have been detected with reference images that show different 
distributions of graphite particles. You can then determine which of the 
reference images shows a distribution that is most similar to that of the 
current image. The reference images correspond to images that the 
chosen standard contains.

1. In the [Style] group, choose how the images are to be arranged in 
the document group for the comparison. Select an arrangement in 
which the GlobularGraphite.tif image and the selected reference 
image are superimposed. To do this, click the button pictured on 
the left.

The tool window shows all of the applicable reference images and the arrangement that has been 
selected. The selected reference image is framed in red.

 A temporary document will now be displayed in the document 
group.

2. Compare the graphite distribution of the current image with that of 
the reference image. 
 Move the slide control that is under the [Style] field. The image 

you are evaluating is superimposed on the reference image. The 
slide control varies the opacity of the image you are evaluating 
so that you can see the reference image underneath it to varying 
degrees. 
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 If you want to choose another reference image, in the 
[Overview] field, click that image with your left mouse button.

The illustration on the left shows the image that is to be checked. Because the slide control is 
located near the [Opaque] position, the reference image's structures can only be faintly 
recognized. For the illustration on the right, the slide control has been moved towards the 
[Transparent] position. Now, the reference image can be clearly recognized, and the image that is 
to be checked can be only faintly recognized.

3. When you have selected the reference image that is the most 
similar to the image that is to be checked: Click the [Accept] 
button.
 The chosen image's data will be accepted in the [Results] field.
 It's possible to accept several reference images, for example, 

with samples that have very different structures.
4. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Image results] step
1. Take a look at the results that are shown in the table and also in the 

image. 
2. Select the [Show graphite detection] check box, in the [Validation] 

group.
 Now each particle that has been detected will be displayed in 

the color of the class to which it belongs. The same colors will be 
used in the chart.

 Particles that have been detected, but that aren't used for the 
analysis (because they don't come up to the minimum size that 
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has been set in the software options), are displayed in white with 
dark hatching.

On the left, you see the colored identification of the particles in the image. On the right, you see 
the chart of graphite sizes, that uses the same colors.

3. If you selected several graphite parameters in the [Settings] step: 
Toggle between the different charts.

4. If you want to correct the automatically found particles, use the 
buttons in the [Validation] group. 
 You can find step-by-step instructions in chapter Adding, 

separating and deleting particles on page 173.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Results] step
1. Take a look at the results that are shown in the table. Among other 

things, the number of particles is shown here.
2. Select the [Generate report] check box, if you would like to have a 

report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. Click the [Save results] button, if you want to also determine the 

ferrite/pearlite-ratio in another cast iron analysis, on the basis of 
the etched sample. You can then load the graphite fraction 
determined here, and won't need to enter it manually.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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11.3.2 Performing a cast iron analysis (etched sample)
You can follow these step-by-step-instructions on your computer. They 
describe how to measure the ferrite/pearlite-ratio.

Measure the ferrite/pearlite-ratio on the example image.

[Image source] step
1. Load the Ferrite Pearlite.tif example image.
2. Click the [Cast Iron] button, located in the [Materials Solutions] tool 

window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Settings] step
1. Click the button pictured on the left to specify that you want to 

determine the ferrite/pearlite ratio of an etched sample.
 If the button for unetched samples has been active before, the 

setting options in this window will now change.
2. Use the [Threshold for ferrite] slider to define the ferrite phase. By 

doing so, you set the  phase that is valid for the ferrite detection. 
The threshold value has been correctly set when the ferrite is 
completely detected.
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 All of the pixels that have been detected as ferrite will be 
highlighted in yellow in the image.

 If the slide control is closer to the [Low] position, the phase 
contains a larger part of the intensities that are present in the 
image. 

 If the slide control is closer to the [High] position, the phase 
contains a smaller part of the intensities. This means that only a 
smaller part of the intensity values is detected as ferrite.

  
In the illustration (1), the threshold value has been set too high, too many particles are detected as 
ferrite. In the illustration (2), the threshold value has been set too low, the ferrite is not detected 
completely. Illustration (3) shows a correctly set threshold value.

3. Use the [Close gaps in pearlite phase] slide control to define to 
what degree the voids that the pearlite contains, are to be closed. 
 A void in the pearlite is an area within the pearlite that has such 

bright intensity values that it is assigned to the ferrite. In the 
image, voids are visualized as an accumulation of small yellow 
points within the pearlite.

 
In illustration (1), the pearlite phase is hardly closed. This is why many voids have been detected 
within the pearlite (see arrows). Illustration (2) shows a pearlite phase that is more closed.

4. In the [Graphite fraction] group, select how this sample's graphite 
fraction is to be entered. 
The graphite fraction will be subtracted from the detected pearlite 
fraction. Using the pearlite area that has in this way been corrected, 
the ferrite/pearlite ratio is calculated. This step is necessary because 
graphite and pearlite have very similar gray values and can 
therefore not be detected separately by the software. There are 
two possibilities how to enter the graphite fraction:
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 You select the [Enter manually] option and enter the value. This 
option is always active. You can have e.g., made a note of this 
value, or have saved it in a report.

 You select the [Result of unetched sample analysis] option. This 
option is only active if, in the same analysis, you have already 
measured the graphite fraction, using an unetched part of the 
sample. This option is also active if you measured the graphite 
fraction in a previous analysis, saved these values in a parameter 
set and loaded them in the Sample information step.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Image results] step
1. Take a look at the results that are shown in the table. Among other 

things, here you will find the ferrite/pearlite-ratio that has been 
measured.

2. Take a look at the displayed results in the image as well. To do so, 
select the [Show ferrite detection) check box, in the [Validation] 
group.

3. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Results] step
1. Select the results you want.
2. Select the [Generate report] check box, if you would like to have a 

report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. If you want to save the current settings to a file, click the [Save 

settings] button. Then assign a descriptive name in the next dialog 
box.
 You can load these settings when you analyze further images. To 

do that for the new image in the [Image Source] step, click the 
[Load from file] button.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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11.3.3 Adding, separating and deleting particles
You can manually edit the particles that your software automatically 
found during the cast iron analysis. 

Prerequisite  It is only possible to edit particles in unetched samples. In this case, 
the [Image results] step offers several buttons with which you can 
delete particles, add particles or separate them.

Don't use the possibility to correct particles manually, until you've 
changed the positions of the slide controls several times in the 
[Settings] step, and are certain that you have found the best possible 
setting.

Deleting particles
1. Enlarge the display of the image so much that you can easily 

recognize the particle you want to delete. To do so, move the 
mouse pointer on the image window and rotate the mouse wheel, 
for example.

2. In the [Validation] group, click the [Delete selected particles] 
button.
 The mouse pointer will change its form. You will then be in edit 

mode. The only thing you can do now is to delete particles. In 
this mode, other work with your software isn't possible.

3. Position your mouse pointer on the particle you want to delete.
 The mouse pointer becomes a hand.

4. Click the left mouse button.
 The particle is displayed in white with dark hatching.

5. Click your right mouse button to leave the edit mode, and to 
confirm the changes.
 The particle will be deleted. This particle will now no longer be 

taken into account for the cast iron analysis.
 The results will be updated.

If you have manually corrected particles and return to the [Settings] step (e.g., 
to change the settings of the slide controls) your manual validation will be 
deleted.
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Adding particles
1. Enlarge the display of the image so much that you can easily 

recognize the particle you want to add.
2. In the [Validation] group, click the button pictured on the left.
 The mouse pointer will change its form. You will then be in edit 

mode.
 You can now add a particle. In this mode, other work with your 

software isn't possible.
3. Now, define the particle that is to be added with as many left 

mouse clicks as you wish. The line you plot must roughly enclose 
the particle. The starting and end point need not lie exactly one 
over the other, since the line will be automatically changed into a 
(closed) polygon by your software.

4. Click the right mouse button and select the [Confirm Input] 
command in the context menu.
 The particle will be drawn in. This particle will now be taken into 

account for the cast iron analysis.
 The results will be updated.

Separating particles
You can separate particles automatically or interactively. If the 
automatic separation process doesn’t work you can use the interactive 
separation process. To do this, you simply drag out an arbitrary 
separation line though the particle with your mouse.

Separating
particles

automatically

1. Enlarge the display of the image so much that you can easily 
recognize the particle you want to separate.

2. In the [Validation] group, click the [Automatically separate selected 
particles ] button.
 The mouse pointer will change its form. You will then be in edit 

mode.
 The only thing you can do now is to separate particles. In this 

mode, other work with your software isn't possible.
3. Click on the particle that you want to automatically separate.
 The particle is displayed in white with dark hatching.

4. Right click to finish the particle separation.
 The selected particle will be separated. The two new particles will 

be shown in the color of the class to which they belong.
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 The results will be updated. Now two particles will be taken into 
account for the cast iron analysis.

Interactively separate particles
1. Enlarge the display of the image so much that you can easily 

recognize the particle you want to separate.
2. In the [Validation] group, click the [Interactively separate particles ] 

button.
 The mouse pointer will change its form.

3. Use your mouse pointer to drag a line through the particle that is 
to be separated. To do this, click once with your left mouse button 
at the point where the line is to begin. Then click once with your 
right mouse button at the point where the line is to end. 

4. Click the right mouse button and select the [Confirm Input] 
command in the context menu.
 The particle will be split. The two new particles will be shown in 

the color of the class to which they belong.
 The results will be updated. Now two particles will be taken into 

account for the cast iron analysis.
Reclassifying selected particles manually
When you measure the graphite form of particles, you can manually 
assign selected particles to a different class. This overrides the 
classification made by the software. Which new form classes are 
available for selection depends on the standard being used.

1. Enlarge the display of the image until you can easily recognize the 
particles that you want to assign to a different class.

1. Perform a cast iron analysis.
2. Select the [Graphite form] check box in the [Settings] step.
3. In the [Image results] step in the analysis, select the [Graphite form 

chart] option.
4. In the [Validation] group, click the button pictured on the left.
 The mouse pointer will change its form. You will then be in edit 

mode.
 The only thing you can do now is to reclassify particles. In this 

mode, other work with your software isn't possible.
5. In the image window, click on all of the particles that you want to 

manually assign to a different class. 
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 All of the of the particles that you select in this step can only be 
assigned to the same new class. This means that if you want to 
assign particles to different classes, you have to do this in 
separate steps.

 The fill color of the selected particles changes. The particles are 
displayed in white with dark hatching.

6. Right click and select the form class in the context menu that you 
want to assign the particles to. Which form classes are shown in the 
context menu depends on the standard being used.
 The particles are displayed in the color of the newly selected 

form class.
 The graphite form chart and the information in the [Image 

results] field are updated.
7. If necessary, repeat the last steps to reclassify additional particles.

 
After you exit edit mode, the particles that are shown with diagonal lines are assigned to a 
different graphite form.
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11.4 Software options
The software options provide a number of cast iron analysis settings.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Cast Iron] entry in the tree 
view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an analysis.
Displaying the particle results in the workbook
The [Display particle results in the workbook] check box specifies how 
the results of a cast iron analysis are displayed in a workbook. You can 
set whether a workbook should be created in the [Results] step in the 
analysis. 
If this check box is not selected, the workbook only contains the overall 
results for each sample that was evaluated:
When the check box is selected, the workbook contains additional 
worksheets with the individual results for each particle that was 
detected. The [Area] measurement parameter, for example, shows the 
exact area of each particle that was detected. If you sort the values in 
the [Area] column in descending order, for example, you can thus 
quickly see the area of the largest particle that was detected.
In this context, the [One sheet per image] and [One sheet per sample] 
options specify how the additional worksheets that contain the 
individual results will be structured. This means that, with both options, 
the same information is given. However, the way the information is 
structured is different.

This command is not available while an analysis is running.
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Select the [One sheet per image] option to have the individual results 
for each image that was analyzed shown in a separate worksheet. The 
worksheet's name is identical to the image's name. It shows the exact 
individual results (for example, the area) for each particle that was 
detected on this image.
Select the [One sheet per sample] option to have the individual results 
for all images that belong to the same sample shown in one worksheet:
Note: You can define some general settings for the appearance of 
workbooks. To do so, use the [Options] > [Workbook] > [Format] 
dialog box.
Specifying the graphite form

[Classification
routines]

You can use either the discriminant method or the threshold method to 
assign a particle to a particular form class. The method that you select 
determines the algorithm that is used. Because of the complexity of the 
algorithms, they can't be described here. We recommend that you 
perform a number of tests with both methods until you find a suitable 
method for your samples. 

[Display results] Specify whether form classes whose cumulative particle area is less than 
10% of the total particle area will be listed in the [Image results] step.
Select the [All classes] option to display all of the form classes that were 
detected in the [Graphite form] field, even those whose cumulative 
particle area is less than 10% of the total particle area. 
Select the [Main classes] option to display in the [Graphite] form field 
only the form classes whose cumulative particle area is at least 10% of 
the total particle area. The results for the classes whose cumulative 
particle area is less than 10% will be interpolated and distributed among 
the other form classes so that the total particle area adds up to 100%.
Note: The graphite form chart always shows all of the form classes, 
regardless of whether they make up at least 10% of the total particle 
area.
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12 [Inclusions Worst Field] & [Inclusion Content]
There are two analysis processes available in your software for the 
analysis of non-metallic inclusions in metal samples:
• an analysis of the inclusion content
• an inclusions worst field analysis

The two analysis processes for non-metallic inclusions in metal samples 
support the same standards, but use different methods.
What are non-metallic inclusions?
During the production processes, non-metallic inclusions can accrue 
within steel alloys. Inclusions affect the chemical and mechanical 
properties of the steel. The fewer inclusions there are in a steel, and the 
smaller and homogeneous these are, the better is its quality.

Microscope image of different inclusions in a polished steel sample. The inclusions differ in their 
color and form. The images show a sulfide inclusion (1), a silicate inclusion (2), and an aluminum 
inclusion (3).

The nature and appearance of the non-metallic inclusions depend on a 
variety of factors, such as, e.g., the steel type, or the production 
process. The inclusions are divided into different classes according to 
their appearance (color, form, and size). The classification is made 
according to different industry standards.
Since all inclusions are darker than the color of the steel, they can easily 
be detected by means of an automatic image analysis. When detecting 
the inclusions, your software searches for particles. For the image 
analysis software, a particle is a cohesive number of pixels, that all lie 
within a defined intensity range. For this reason, you first have to define 
the intensity range. Since between the different inclusions there are also 
intensity differences, (sulfides are, e.g., brighter than oxides), you can 
also define two intensity ranges.
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Example of a particle detection during an inclusions worst field analysis. When a suitable definition 
of the gray value ranges has been made, the sulfides (green) and the oxides (redish black) will be 
detected.

Editing inclusions
You can manually edit the inclusions that your software found 
automatically. You have the possibility of deleting, splitting, or joining 
up inclusions, and you can also change their type. You can find step-
by-step instructions in chapter Editing inclusions on page 201.

12.1 Overview - Inclusions Worst Field analysis
An inclusions worst field analysis is used to detect non-metallic 
inclusions in metal samples. This analysis is, e.g., used to measure the 
amount, size and distribution of sulfides and oxides in steel. With the 
measurement results, different production processes can be compared, 
or the quality of a product determined.
Results of an inclusions worst field analysis
The inclusions worst field analysis determines which is the largest non-
metallic inclusion within the sample under investigation. This is done for 
each inclusion type separately. The classification and naming 
convention of the inclusions differs from industry standard to industry 
standard. The sizes are measured in accordance with the industry 
standards:
• ASTM E 45-18 method A
• DIN 50602:1985 method M
• ISO 4967:2013 method A
• GB/T 10561:2005 method A
• JIS G 0555:2003 method A
• UNI 3244:1980 method M
• EN 10247:2017 method M(L/n)
• EN 10247:2017 method M(L/d)
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• EN 10247:2017 method M(a)
• EN 10247:2017 method M(a/n)
• EN 10247:2017 method P(a)
• EN 10247:2017 method P(L/d)
• SEP 1571:2017 method M

The results of an analysis can be displayed in a workbook. Additionally, 
the results can be displayed in a report in MS-Word format.

12.2 Overview - Analysis of the Inclusion Content
If the sample is suitable and the thresholds are set correctly, the analysis 
of the inclusion content detects all of the non-metallic inclusions in the 
sample being analyzed. 
Because of the complexity, an analysis of the inclusion content can 
currently only be performed on monochrome 8 bit images.
The images to be analyzed are usually stitched images of a polished 
steel sample. The whole image is divided into fields by default. All of the 
fields are called the [Area of fields]. The inclusions that you want to 
analyze must be within the area of fields. 
Each field has a size of 710 µm x 710 µm as specified by the standard. 
This corresponds to an area of the sample of 0.5 mm2 per field. The 
supported standards recommend a minimum sample area of 10 mm x 
16 mm. This amounts to 320 fields.

It is also possible to perform an inclusions worst field analysis with the EN 
10247 standards’ version from 2007. To do so, select this version of the 
standard in the software options. You have to do this before starting the 
analysis process.
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The illustration shows an image (3) with the area of fields (2). The area of fields is made up of 
individual fields (1).

Viewing the results for the currently selected inclusion in the image 
window 
In the [Image results] step, it is possible to view the results for a 
currently selected inclusion in the image window. To do so, in the 
image window, hover over the inclusion that you are interested in. A 
tooltip containing detailed information on this inclusion is displayed. 
Which details these are depends on the standard that has been 
selected. 
Observing ambiguous inclusions at the microscope
In the [Image results] step, you can click on an inclusion in the image 
window. Your stage will then move to the corresponding part of the 
sample and you can observe this inclusion in detail at the microscope. 
This option is only available if you made all the necessary settings for 
the stage path and the scan area.
The results of an analysis of the inclusion content
If the sample is suitable and the thresholds are set correctly, the analysis 
of the inclusion content detects all of the non-metallic inclusions in the 
sample being analyzed. This is done for each inclusion type separately. 
The classification and naming convention of the inclusions differs from 
industry standard to industry standard. The analysis is performed in 
accordance with the selected standard and the selected method. 
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The following standards are available:
• ASTM E 45-18 method D
• ISO 4967:2013 method B
• EN 10247:2017 method K
• SEP 1571:2017 method K

The results of the different standards are displayed differently in the 
image window and in the [Image Navigator] tool window.
With the [ASTM E 45-18 method D] and [ISO 4967:2013 method B] 
standards, a colored outline is displayed around each field (and around 
each inclusion) that contains a detected inclusion of the currently 
selected type. 
With the [EN 10247:2017] and [SEP 1571:2017] standards, a colored 
outline is displayed around each inclusion that is detected. The fields 
don't have a colored outline.

Illustration on the left: Display of the results in the [Image Navigator] tool window when the 
analysis is performed in accordance with the [ ASTM E 45-18 method D] or the [ISO 4967:2013 
method B] standard. In the example shown, all fields have a colored outline in which inclusions 
have been detected that belong to the currently selected type of inclusion.

Illustration on the right: Display of the results in the [Image Navigator] tool window when the 
analysis is performed in accordance with the [EN 10247:2017 method K] or the [SEP 1571:2017 
method K] standard. The inclusions that belong to the inclusion type that is currently selected have 
a colored outline.

Viewing inclusion results in the image
If you want to view detailed results for individual inclusions while the 
analysis is still in progress, use the [Show Inclusion Results] button in the 
[Image results] step. When this button is active, a tooltip with the details 
for the selected inclusion is displayed when you hover over it in the 
image window. Which details these are depends on the standard that 
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has been selected. Usually, the type, the length, and the width are 
indicated. For some standards, the area is also shown. 
For some standards, if the length or width of an inclusion exceeds the 
specified limit, the information [oversized] will also be displayed.
Displaying the results in the workbook
The results of an analysis can be displayed in a workbook. If the [Display 
inclusion results in the workbook] check box in the software options has 
been selected, in addition to the overall results the workbook will also 
contain the individual results for each inclusion that was detected. If 
oversized inclusions were detected, they will be identified with a plus 
sign [(+) ]in the [Type] column in the workbook.
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12.3 Settings
12.3.1 [Settings] step

Most of the settings are identical for both analysis processes. If a setting 
is only relevant for one of the two analysis process, this is indicated in a 
note.
In this step, the following possibilities are available:

1 [Evaluation 
method]

Here, you specify by which standard is to be analyzed. Then all of the images 
from this analysis process will be analyzed according to this standard. 
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2 [All inclusions] Define here the  threshold value for the detection of the inclusions. You are 
specifying an intensity range. All of the sections of the image that are within 
this intensity range are inclusions. All of the pixels that are detected as an 
inclusion will be highlighted in green in the image.

When the threshold value is closer to the [High] position, the intensity range 
will incorporate a greater part of the intensities that are present in the image.
When the threshold value is closer to the [Low] position, the intensity range 
will incorporate a smaller intensity range. This means that only a smaller part 
of the intensity values is detected as an inclusion.

3 [Oxide inclusions] Set the threshold value for all of the oxide inclusions here. Because the oxide 
inclusions are always the inclusions with the darkest color, the software here 
only allows a value that is below the [All inclusions] threshold. All of the pixels 
that are recognized as an oxide inclusion will be highlighted in red in the 
image.

4 [Sensitivity of color 
inclusions]

Note: This field is only displayed when you are performing an inclusions worst 
field analysis on a true-color image.

If you analyze non-metallic inclusions according to the [EN 10247] industry 
standard, the additional field [Sensitivity of color inclusions] will appear below 
the [Oxide inclusions] field. Define here the threshold value for the detection 
of the inclusions.
With this field, you set a third phase that can be used for the detection of 
nitride (TiN) inclusions. On color images, nitride can be clearly distinguished 
from other inclusions due to its typical golden color.
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5 [Smallest class] Note: This field is only displayed when you are performing an inclusions worst 
field analysis or analysis of the inclusion content and when the [SEP 1571:2017 
method K] evaluation method has been selected.

In this field, you can specify a minimum size that detected inclusions must 
have in order to be taken into account by the analysis. Values between [0-8] 
are available. The sizes are defined by the [SEP 1571:2017] standard. The value 
[0] means that all of the detected inclusions will be taken into account by the 
results of the analysis. The value [8] means that only detected particles larger 
than size 8 will be taken into account by the results of the analysis. 

Example: In the [Smallest class] field, you enter the size [6]. All of the detected 
inclusions with a size of [0-5] are not taken into account by the results of the 
analysis. In the [Image results] step, the image results and the workbook now 
only display the results for the size classes [6-9]. The inclusions with a size of 
0-5 are still displayed in the image. 
When the [Show Inclusion Results] button is active and you move the mouse 
over an inclusion of this size, the tool tip will additionally display the text [not 
considered]. The [Show Inclusion Results] button is displayed in the [Edit 
inclusions] group in the [Image results] step.
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12.3.2 [Image results] step
In this step, the following options are available:

1 Measurement 
Results

In the [Image results] step, you'll find a table with the measurement results. In 
it, you'll find a classification of the inclusions that were found. How this 
classification looks like, depends on the standard by which the analysis was 
performed. The standard that has been used is displayed in the [Evaluation 
method] field above the table.
For example, the [ASTM E 45-18 method A] standard uses the classification A 
(Sulfide), B (Alumina), C (Silicate) and D (Globular Oxide). Furthermore, this 
standard groups the inclusions into "t" (thin) and "h" (heavy ), according to 
their mean width (inclusion types A, B, C) or to their diameter (inclusion type 
D). 
Other standards use another classification of the inclusions, and don't further 
divide them up into groups.

2 [Image]
[Sample]

Should you have analyzed several images of the same sample, you can switch 
between a display of the image results for the current image and the results 
for all of the images. To do this, select the corresponding option.

3 [Show Inclusion 
Results]

Click the [Show Inclusion Results] button if you want to see the exact results 
for an inclusion. Now, when you hover over a particular inclusion in the image 
window, a small tool tip is displayed with the details for this inclusion.

4 [Edit inclusions] In this group, you'll find several buttons, with which you can edit the detection 
of the inclusions. You can find step-by-step instructions in chapter Performing 
an analysis of the inclusion content on page 195.
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4 Click this button to merge two inclusions into one inclusion.

4 Click this button to divide inclusions.

4 Click this button to assign inclusions to a different class.

4 Click this button to delete inclusions.

[Reject Image] Click the [Reject image] button to exclude this image from the analysis. This 
only makes sense if the current analysis contains at least two images.
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12.4 Performing an inclusions worst field analysis
You can follow these step-by-step-instructions on your computer. It 
describes how you can detect the largest non-metallic inclusion in a 
sample.

Prerequisite  In order to analyze images with the [Inclusions Worst Field] 
analysis, make sure that the sample is placed on the stage in a way 
that the inclusions have a horizontal orientation in the image.

Measure the largest nonmetallic inclusion on the example image.

[Image source] step
1. Load the NMI0_0.tif example image.
2. Click the [Inclusions Worst Field] button, located in the [Materials 

Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Settings] step
1. In the [Evaluation method] field, set the standard you are going to 

use for the analysis.
2. Use the [Thresholds] > [All inclusions] slide control to define the  

threshold value for all of the inclusions.
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3. Observe the sample. The threshold value has been correctly set 
when the inclusions are completely recognized.

The illustration shows a correctly set threshold value.

4. Since in this sample there are no oxide inclusions, set the [Oxide 
inclusions] slide control to the position [Low].

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Image results] step
1. Take a look at the results that are shown in the table. 
 The table with the measurement results contains a classification 

of the inclusions that have been detected. How this classification 
looks like, depends on the standard by which the analysis was 
performed.

2. Take a look at the displayed results in the image as well.
 In the image, every detected inclusion will now be outlined with 

a colored line.

The illustration shows a detected inclusion.

3. If you want to correct the automatically found inclusions, use the 
buttons in the [Edit inclusions] group.
 You can find step-by-step instructions in chapter Editing 

inclusions on page 201.
4. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Results] step
1. Take a look at the results that are shown in the table. 
 In the [Results] step, you see, for each inclusion type separately, 

the largest inclusion found in any of the analyzed images.
184OLYMPUS Cleanliness Inspector CIX ASW



12  [Inclusions Worst Field] & [Inclusion Content]
Performing an inclusions worst field analysis
2. Select the [Generate report] check box, if you would like to have a 
report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. If you want to save the current settings to a file, click the [Save 

settings] button. Then assign a descriptive name in the next dialog 
box.
 You can load these settings when you analyze further images. To 

do that for the new image in the [Image Source] step, click the 
[Load from file] button. The sample and image comments and 
the position of the slide controls in the [Settings] step will be 
saved. The standard that was used will also be saved.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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12.5 Performing an analysis of the inclusion content
The following step-by-step instruction describes, in a simplified way, 
how you can detect the inclusion content in a sample.

Preparation When working with stitched images, it is useful to have the [Image 
Navigator] tool window always displayed. Then you can easily zoom in 
and out of the stitched image without losing orientation. Therefore, 
click the [Disable Auto Hide] button once in the [Image Navigator] tool 
window before starting the analysis process.

Prerequisite The following prerequisites must be met so that an analysis of the 
inclusion content can be successfully performed on a stitched image:
• the steel sample must be optimally prepared for analysis of the 

inclusion content (cleaned and polished)
• the steel sample must be Illuminated appropriately for the acquisition 

(no overexposure)
• the steel sample must show inclusions that are suitable for an 

automatic analysis
• the inclusions must be aligned horizontally in the image
[Image source] step

1. Load the image that you want to analyze. You want to measure all 
non-metallic inclusions on this image.

2. Click the [Inclusion Content] button, located in the [Materials 
Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

As a rule, stitched images are saved in VSI file format. When you load images, 
the default file format is TIF. If you don’t see the image that you want to 
analyze in the [Open Image] dialog box, select [All] file format.
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4. Select the [Skip 'Sample information'] check box.
5. Select the [All images] entry in the [Check settings and results] list.
6. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Area of fields] step
1. In the [Area of fields] field, decide whether you want the area of 

fields to be a rectangle or a polygon. For these step-by-step 
instructions, select the [Rectangle] option.
 By default, the area of fields is rectangular and covers the whole 

image. 
2. Use the mouse to reduce the size of the area of fields and then 

place it at a suitable position on the sample (see illustrations).

Illustration on the left: Position the pointer on a marker in the image window. The mouse pointer 
will change shape (see the red ellipse). Drag the handle in the required direction.
Illustration in the center: The size of the area of fields has been reduced. The values in the [Area] 
and [Number of fields] fields are automatically updated.
Illustration on the right: To change the area of fields, position your mouse pointer over one of its 
handles again. The mouse pointer turns into a four headed arrow (see the red circle). While 
pressing the left mouse button, drag the area of fields to the required position.

3. If required, change the line color that is used to show the area of 
fields.

4. Click the [Next] button.

When you select the [Stage path] option and make all the necessary settings 
for the stage path and the scan area, then you have the following possibility: 
In the [Image results] step, you can click on an inclusion in the image window. 
Your stage will then move to the corresponding part of the sample and you 
can observe this inclusion in detail at the microscope.
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 The [Materials Solutions] tool window will display the next step.

[Settings] step
1. In the [Evaluation method] field, set the standard you are going to 

use for the analysis. For these step-by-step instructions, the [EN 
10247:2017 method K] industry standard is selected.

2. Set the slide control for [All inclusions] more to the position [High] 
(for example, to the value [200]). Observe the sample. The  
threshold value has been correctly set when the inclusions are 
completely recognized.

The illustration shows a threshold setting with which all inclusions are detected.

3. Set the slide control for [Oxide inclusions] more to the position 
[Low] (for example, to the value [50]).

4. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Image results] step
1. First, take a look at the displayed results in the image. Each 

inclusion that has been detected is now outlined in the color of the 
inclusion type it has been assigned to.
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 The table with the measurement results contains a classification 
of the inclusions that have been detected. How this classification 
looks like, depends on the standard by which the analysis was 
performed.

 Should you have analyzed several images of the same sample, 
you can switch between a display of the image results for the 
current image and the results for all of the images. To do this, 
select either the [Image] option, or the [Sample] option, located 
below the table.

2. Then take a look at the results that are shown in the [Inclusions 
results] table. The table with the measurement results contains a 
classification of the inclusions that have been detected.

3. Select the required type in the [Inclusion Type] field.
 The results that are shown in the table are updated immediately.

4. Click on a cell in the [Number] column to have all inclusions 
displayed in bold that correspond to the selected inclusion type 
and that have been assigned to the selected length class. The 
length classes can be found in the left column in the [Inclusions 
results] table.
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In the table, all inclusions that belong to the [89.0] length class are selected. In this example, this 
applies to [34] inclusions. 
The illustration on the right shows the image window where these 34 inclusions are displayed in 
bold.

5. Select the [Show all inclusions of selected type] check box to 
display all inclusions of the currently selected type in bold in the 
image window, no matter what their size is.

When the [Show all inclusions of selected type] check box is selected, all inclusions of the currently 
selected type are displayed in bold in the image window, no matter what their size is. In this 
example, there are a total of [297] inclusions that belong to the currently selected type of inclusion 
(see red ellipse).

6. If you want to see detailed results for an inclusion: Click the [Show 
Inclusion Results] button and move the mouse pointer in the image 
window to the required inclusion.
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When you position the mouse pointer over an inclusion, a tool tip appears with more detailed 
information.

 The details for the selected inclusion will be shown. Which details 
these are depends on the standard that has been selected. 
Usually, the type as well as the exact length and width are 
displayed. For some standards, the area is also shown. For some 
standards, if the length or width of an inclusion exceeds the 
specified limit, the information [oversized] will also be displayed.

7. If you want to correct the automatically found inclusions, use the 
buttons in the [Edit inclusions] group.

8. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Results] step
1. Take a look at the results that are shown in the table. The following 

information is given:
 Industry standard and method used
 Sample name
 Number of images
 Total area of fields
 Detailed sample results, sorted by inclusion types

2. Select the [Generate workbook] check box to have a document of 
the [Workbook] type automatically created at the end of the 
analysis.

3. If you want to save the current settings to a file, click the [Save 
settings] button. Then assign a descriptive name in the next dialog 
box.
192OLYMPUS Cleanliness Inspector CIX ASW



12  [Inclusions Worst Field] & [Inclusion Content]
Performing an analysis of the inclusion content
 You can load these settings when you analyze further images. To 
do that for the new image in the [Image Source] step, click the 
[Load from file] button. The sample and image comments and 
the position of the slide controls in the [Settings] step will be 
saved. The standard that was used will also be saved.

4. Click the [Finish] button.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

5. Save the image in the TIF or VSI file format.
6. If you created a workbook at the end of the analysis, you can save 

it in the OWB file format.

12.5.1 Editing inclusions
There are two analysis processes available in your software for the 
analysis of non-metallic inclusions in metal samples:
• an analysis of the inclusion content
• an inclusions worst field analysis

In both analysis processes, you can manually edit the inclusions that 
your software found automatically. In the [Image results] step, you have 
the possibility of deleting, splitting, or joining inclusions, and you can 
also change their type.

Merging inclusions
1. Enlarge the display of the image until you can easily recognize the 

two inclusions that you want to join.

If you have manually corrected inclusions and return to the [Settings] step 
(e.g., to change the settings of the slide controls), your manual corrections will 
be deleted.
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2. In the [Edit inclusions] group, click the [Merge inclusions] button.
 The mouse pointer will change its form. You will then be in edit 

mode. The only thing you can do now is to add inclusions. 
3. With your left mouse button, click the two inclusions.
 Should you join two inclusions that belong to different inclusion 

types, the inclusion type of the first inclusion you selected will be 
used for the new joint inclusion. In this case, take care that you 
click the two inclusions in the right order.

 The inclusions will be joined. The results will be updated.
4. If you want to, you can merge further inclusions.
 Click your right mouse button to leave the edit mode, and to 

confirm the changes.

In this example, these two inclusions are to be joined.

Two inclusions have become a single inclusion in the results.

Splitting inclusions
1. Enlarge the display of the image until you can easily recognize the 

inclusions that are to be split.
2. In the [Edit inclusions] group, click the [Split inclusion] button.
 The mouse pointer will change its form. You will then be in edit 

mode. The only thing you can do now is to split inclusions.
3. Click once with your left mouse button at an arbitrary position on 

the line surrounding the inclusion.
 The surrounding line and all of the particles that belong to this 

inclusion will be displayed bold.
4. Click with your left mouse button at the position in the image 

where the separation line is to begin. This defines the line’s start 
point.
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5. Move the mouse pointer to draw a separation line through the 
object.

6. Click the left mouse button to confirm the separation.
 The inclusion will be split.

7. If you want to, you can split further inclusions. 
8. Click your right mouse button to leave the edit mode, and to 

confirm the changes.
 The results will be updated.

In this example, the particle on the far left-hand side of the inclusion that is indicated by an arrow 
is to be split.

Define a separation line on the image.

One inclusion has become two inclusions in the results.

Deleting inclusions
1. Enlarge the display of the image until you can easily recognize the 

inclusion that is to be deleted. To do so, move the mouse pointer 
on the image window and rotate the mouse wheel, for example.

2. In the [Edit inclusions] group, click the [Delete inclusion] button.
 The mouse pointer will change its form. You will then be in edit 

mode. The only thing you can do now is to delete inclusions. 
3. Click the inclusions that you want to delete.
 The inclusions are deleted.

4. Click your right mouse button to leave the edit mode, and to 
confirm the changes.
 The results will be updated.
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Changing the inclusion type
1. Enlarge the display of the image until you can easily recognize the 

inclusion that is to be changed.
2. In the [Edit inclusions] group, click the [Change inclusion type] 

button.
 You will then be in edit mode. The only thing you can do now, is 

to change an inclusion's type. In this mode, other work with your 
software isn't possible.

3. Left click once on the inclusion that you want to assign to a 
different inclusion type.
 A menu opens. It shows all of the inclusion types that the 

currently chosen standard contains. A check marks the currently 
chosen inclusion type.

4. Select the new type of inclusion you want.
 The new inclusion type will be assigned. In the image, the 

inclusion will now be displayed with a surrounding line in 
another color.

5. If you want to, you can change other inclusion types.
6. Click your right mouse button to leave the edit mode, and to 

confirm the changes.
 The results will be updated.

 
The illustration shows an example of a menu with different inclusion type. Depending on the 
standard that has been chosen, the menu can contain different entries. The image on the right 
shows the inclusion after the inclusion type has been changed.
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12.6 Software options
The software options provide a number of settings for these two 
analysis processes. Most of the settings are identical for both analysis 
processes. If a setting is only relevant for one of the two analysis 
process, this is indicated in a note.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select either the [Materials Solutions] > [Inclusions Worst 
Field] or the [Inclusion Content] entry in the tree view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an analysis.
Default settings for the analysis process

[Minimum object
size]

In the [Minimum object size] field, set the minimum size that an object 
must be, if it is to be taken into account for the analysis. The size is 
indicated in the unit of pixels. All objects that fall short of this size, won't 
be detected. By using this setting, you can exclude artifacts and small 
spots from the analysis, which enables a quicker performing of the 
analysis.

[Minimum aspect
ratio for

elongated types]

In this field, enter the minimum aspect ratio that linear inclusions must 
have, in order to be classified as elongated inclusions. Here, the length/
width ratio is meant. In many standards, a value of 2 or 3 is 
recommended. Only change the default settings in this field if essential.
The value 2 in this field means, for example, that an object has to be 
double as long as it is wide, to be classified as an elongated inclusion. 
The length is always measured in conformity with the direction in which 
the steel is rolled.

This command is not available while an analysis is running.
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[Show ignored
particles]

Select the [Show ignored particles] check box, when you want to also 
have the particles that weren't included in the analysis, shown. Particles 
will be ignored if they don't fulfill the requirements that were specified 
in the [Minimum object size] and [Minimum aspect ratio for elongated 
types] fields. These particles will be shown outlined in yellow in the 
image.

[Handling of
unspecified types]

Here, you decide how inclusion types that aren't specified in the 
standard used, are to be handled. This can be the case, for example, 
when the analysis is performed according to a standard that doesn't 
take all of the possible types of inclusion into account. 
If you select the [Ignore] option, the unspecified inclusion types will be 
ignored in the analysis.
If you select the [Find the type by color] option, unspecified inclusions 
will be determined by their color.
If you select the [Find the type by shape] option, unspecified inclusions 
will be determined by their shape.

[Version of the
standard]

If you want to perform an inclusions worst field analysis using the EN 
10247 standard, the 2017 version is used by default. If you want to 
perform the inclusions worst field analysis using the 2007 version of the 
EN 10247 standard, you can select this version in the [Version of the 
standard] field. The contents of the [Evaluation method] field in the 
[Settings] step will be updated accordingly.

[ASTM E 45-18
severity level]

Here you can set how many severity levels you want the detected 
inclusions to be sorted into. The standard allows between 0.5 and 5 
severity levels. When the value [0.5] is selected, only 1 size class is 
available. When the value [5] is selected, a total of 10 size classes are 
available.

The setting in the [Minimum aspect ratio for elongated types] field is only 
relevant, when you perform a inclusions worst field analysis with the [DIN 
50602] or [UNI 3244] standard. 

The setting in the [Version of the standard] field is only applicable when you 
perform an inclusions worst field analysis using the [EN 10247] standard. 
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The illustration shows the possible appearance of the table [Inclusion results] that is displayed in 
the [Image results] step.
In the example on the left, the value [3] has been set in the [ASTM E 45-18 severity level] field, in 
the software options. Therefore, 6 size classes are available. 
In the example on the right, the value [1] has been set in the [ASTM E 45-18 severity level] field, in 
the software options. Therefore, only 2 size classes are available.

[EN 10247
inclusion type

separation]

Select the option according to which the inclusion types are to be 
separated. The available options refer specifically to the EN10247 
industry standard which is used in Europe for the analysis of non-
metallic inclusions.

[Display inclusion
results in the

workbook]

This check box specifies how the results are displayed in a workbook. 
You can set whether a workbook should be created in the [Results] step 
in the analysis. A workbook can contain several worksheets.
If you are not creating a workbook but are only creating reports at the 
end of an analysis, for example, the explanation below doesn't apply to 
you.
The [Display inclusion results in the workbook] check box specifies 
whether or not the workbook should contain individual results for each 
inclusion that has been detected. Which data the individual results 
contain depends on the standard that has been selected.
When this check box is not selected, the workbook will contain only the 
largest inclusion that has been detected for each class. 

This setting only applies to the ASTM 45-18 standard. If you use a different 
industry standard for the analysis of the inclusion content, this setting is not 
relevant for you.
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When the [Display inclusion results in the workbook] check box is 
selected, the workbook will contain further worksheets with the 
individual results for each detected inclusion. These worksheets will be 
created in addition to the worksheets mentioned above.
In this context, the [One sheet per image] and [One sheet per sample] 
options specify how the additional worksheets that contain the 
individual results will be structured. This means that, with both options, 
the same information is given. However, the way the information is 
structured is different.
Select the [One sheet per image] option to have the individual results 
for each image that was analyzed shown in a separate worksheet.
Select the [One sheet per sample] option to have the individual results 
for all images that belong to the same sample shown in one worksheet:
Note: You can define some general settings for the appearance of 
workbooks. To do so, use the [Options] > [Workbook] > [Format] 
dialog box.
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13 [Porosity]
13.1 Overview

What is a porosity measurement?
With a porosity measurement, you measure the percentage of the 
surface of your sample which is made up of pores as well as 
determining the number and density of the pores. If the size of the 
pores is also being determined, all of the pores that exceed a defined 
maximum pore size can be displayed in color in the image. In this case, 
the largest pore can be displayed in color in the image as well.
The samples are usually metallographic sections that have been 
prepared especially for porosity measurements. The porosity that is 
measured only applies to the exposed cross-sectional plane of the 
sample. Therefore the porosity of other parts of the sample that are 
above or below the cross-sectional plane may be different.

Prerequisite  It is a precondition for a porosity measurement that the pores differ 
from the rest of the sample, for example, because they are darker. 
In the image, the pores thus have different intensity values than the 
rest of the sample, making automatic image analysis possible. For 
the image analysis, so-called phases are defined which cover a 
certain range of intensity values.

Porosity measurement on one image. All of the pixels which lie within the defined intensity range, 
will be shown in color during this step in the analysis. In the example shown, red has been selected 
for the phase.

Selecting the industry standard
One of the following standards can be used for the porosity 
measurement if required. 
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• VW 50093/P 6093:2012
• VDG P 201-2002
• VDG P 202-2010
• VDG P 211-2010

Manually processing the image porosity value
You can manually adjust the result of the automatic image analysis. You 
do this interactively on the image. Note that you are not changing the 
image itself, but the image's measurement layer. You can manually 
delete parts of the image which have been recognized as pores (in 
image analysis, one speaks of detected objects). This can be necessary, 
if for example artifacts in the image are recognized as pores because 
they have similar intensity values. By manually deleting these objects, 
the artifacts will be excluded from the analysis. 
In addition, you can also manually add other image segments which 
were not detected as such but which are actually pores. With the 
manual addition and deletion of objects, you always change the 
percentage porosity value of the image. 
Measuring on ROIs
You can choose whether you would like to measure the entire image or 
if the measurement should only be carried out on a part of the image, a 
so called ROI (Region Of Interest). You can also define several ROIs.

On the image, the porosity of an ROI is measured. The ROI encompasses the shape of the object.

Results of a porosity measurement
The results of an analysis can be displayed in a workbook. Additionally, 
the results can be displayed in a report in MS-Word format. The results 
of the porosity measurement will be saved along with the image, when 
you save the image in the TIF or VSI file format. This information is 
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saved in a separate image layer so that no image information is 
overwritten.
General procedure for a porosity measurement

1 Selecting the 
analysis process

Click the [Porosity] button, located in the [Materials Solutions] tool window.

2 [Image source] In the [Image source] step you select the images that you want to measure. 
You can find more information on page 62 of the Selecting the image source 
chapter.

3 [Settings] Define the parameters for the pore size and porosity. If required, you can 
select a standard.

4 [Target values] If necessary, you can change the preset target values. This step is optional.
5 [ROIs] Define the ROIs, or measure the porosity of the whole sample. 
6 [Threshold] Define the intensity range for the pores. You can define further intensity 

ranges. 
7 [Image results] Check the image results. If necessary: delete pores, or add new ones.

[Results] Document the results and generate a report or a workbook. 
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13.2 Settings
13.2.1 [Settings] step

1 [Standard] Decide whether you want to use a standard for the porosity measurement. 
The [None] entry is selected by default. This means that no standard will be 
used. 
When a standard is selected, some of the fields in the tool window change. 
For example, the [Pore accumulations] and [Pore nests] check boxes are only 
displayed when you have selected a standard.

2 [Pore size 
parameter]

In the [Pore size parameter] field, select how the pore size is calculated. 
Select the [Max. (Feret)] setting to use the maximum spacing of parallel 
tangents on opposing sides of the pore.
Select the [Equivalent Circle Diameter] setting, to use the diameter of a circle 
which has the same area as the pore.
If necessary, click the button which shows the units and select the unit to be 
used for the pore size.
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3 [Disregarded 
pores]

In the [Lower limit] field, enter the minimum size that an object must have to 
be considered when determining the number of pores. In the [Upper limit] 
field, enter the maximum size that an object may have to be considered when 
determining the number of pores. 
Note: In the [Image results] step, the disregarded pores are shown as not 
having been detected. They don’t have a colored overlay.

Example of the way that disregarded pores are displayed in the [Image results] step. The pores 
that are displayed without a colored overlay exceed the value specified in the [Upper limit] field.

4 [Porosity 
parameters]

4 [Porosity] When this check box is selected, the porosity will be determined. Which 
algorithm will be used depends on the standard that has been selected and 
on the settings in the [Settings] and [Target values] steps. The porosity is 
expressed in %.

4 [Pore size] When this check box is selected, the pore size will be determined. Pores that 
exceed the maximum permissible pore size are displayed with a colored edge 
in the [Image results] step. If required, the maximum permissible pore size is 
defined by the standard being used.

4 [Number of pores] When this check box is selected, the number of pores will be determined. If 
you have defined ROIs, only the number of pores that are inside the ROIs will 
be determined. 

4 [Distance of 
adjacent pores]

When this check box is selected, the distance between two adjacent pores will 
be determined. Pores that are at less than the permissible distance will not be 
included in the results. 

4 [Pore accumula-
tions] > [Distance 
factor]

When this check box is selected, your software will search for what are called 
pore accumulations. The definition of a pore accumulation is that the distance 
between two pores is smaller than the diameter of the smaller of the two 
pores (when the value is set to 1 in the [Distance factor] field). 
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4 [Pore nests] > 
[Max. permissible 
pore size]

When this check box is selected, your software will search for what are called 
pore nests. These are groups of pores that have an even larger area than 
pore accumulations. Pore nests will only be searched for if the value in the 
[Max. permissible pore size] field is larger than 0.

4 [Pore density] > 
[Unit]

When this check box is selected, your software will calculate how densely the 
found objects are spaced in the defined area. If required, in the [Unit] field, 
change the units used to show the pore density in the results. The unit is 
always a unit of area (for example, 1 mm² or 1 µm²). The sample density 
selected in the [Unit] field must match the unit in which the image that you 
want to analyze is calibrated.

5 [Define target 
values]

The [Target values] step is optional. Select the [Define target values] check 
box if you want to view or change the default settings, or if you want to view 
the [Target key] field.
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13.2.2 [Target values] step
Prerequisite  This step is only displayed if you have selected the [Define target 

values] check box in the [Settings] step.

In this step in the analysis, you can view and modify the values for the 
parameters that were specified in the [Settings] step.

1 [Permissible 
porosity]

This field is only displayed if you selected the [Porosity] check box in the 
[Settings] step. You can view and modify the preset value here. The porosity is 
expressed in %.

2 [Max. Permissible 
Pore Size]

This field is only displayed if you selected the [Pore size] check box in the 
[Settings] step. You can view and modify the preset value here. 

3 [Permissible 
Number of Pores]

This field is only displayed if you selected the [Number of pores] check box in 
the [Settings] step. You can view and modify the preset value here. 

4 [Permissible 
distance factor]

This field is only displayed if you selected the [Distance of adjacent pores] 
check box in the [Settings] step. You can view and modify the preset value 
here.

5 [Pore accumula-
tions]

This field is only displayed if you selected the [Pore accumulations] check box 
in the [Settings] step. You can view and modify the preset value here.

6 [Pore nests] This field is only displayed if you selected the [Pore nests] check box in the 
[Settings] step. You can view and modify the preset value here.

7 [Permissible pore 
density]

This field is only displayed if you selected the [Pore density] check box in the 
[Settings] step. You can view and modify the preset value here. 
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8 [Target key] The [Target key] field is only displayed if you are using a standard for the 
porosity measurement. 
The target key formats the values that you entered in a way specified by the 
standard you are using. Some of the values in the target key are rounded up 
or down. The unit that was selected in the [Settings] step will always be used. 
The unit will not be shown in the target key. The more parameters that are 
analyzed for the porosity measurement, the longer the target key will be. 
Example: The target key [VDG P202-%10/Ø1] means: The [VDG P202] 
standard was used. The permissible porosity is 10% (written [%10]). The 
maximum permissible pore size is 1mm (written [Ø1]). 

Note: At the end of the analysis process, the [Porosity key] field is displayed in 
the [Image results] step. The porosity key shows the results of the 
measurement. Some of the porosity key values have been rounded up or 
down. The format of the porosity key and the target key are identical. This 
enables you to quickly compare the required measurement results with the 
measurement results that were attained. Like the other measurement results, 
the target value is saved along with the image if you save the image in the TIF 
or VSI format.
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13.2.3 [ROIs] step
In this step you define whether you would like to measure the entire 
image or if the measurement should only be carried out for defined 
parts of the image (ROIs). If you would like to measure the entire image, 
click directly on the [Next] button without defining an ROI.

1 [ROIs] Use one of the buttons in the toolbar at the top of the tool window to define 
an image segment as a ROI (Region Of Interest). Your software will then only 
perform the porosity measurement on the areas marked as ROI, all other 
parts of the sample will be ignored.

1 Click the [Load ROIs] button. The dialog box for loading parameter sets 
opens. Select the parameter set that contains the ROIs you want from the list, 
then click on the [Load] button.
The saved ROIs will be loaded on the current image. Now, you can adjust the 
positions and sizes of the ROIs to the active image.

1 Click the [Save ROIs] button. The dialog box for saving parameter sets opens. 
Enter a descriptive name.

1 Use the [Create Rectangular ROIs] button to define a rectangular image 
segment as an ROI. After clicking the button, you define the rectangle in the 
image. You can move the mouse pointer over a handle to change the size 
and position of the rectangle.
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1 Use the [Create Rotated Rectangular ROIs] button to define a rectangular 
image segment as an ROI. After clicking the button, you define the rectangle 
in the image. You can define the first side of the rectangle by clicking the 
mouse at the beginning and end of the required line. Then make the 
rectangle the required height. Click once to finish defining the rectangle. You 
can move the mouse pointer over a handle to change the size and position of 
the rectangle.

1 Use the [Create Square ROIs] button to define a square image segment as an 
ROI. After clicking the button, you define the square in the image. You can 
move the mouse pointer over a handle to change the size and position of the 
square.

1 Use the [Create Rotated Square ROIs] button to define a square image 
segment as an ROI. After clicking the button, you define the square in the 
image. You can define the first side of the square by clicking the mouse at the 
beginning and end of the required line. Click once to finish defining the 
rectangle. You can move the mouse pointer over a handle to change the size 
and position of the square.

1 Use the [Create Circular ROIs] button to define a circular image segment as 
an ROI. After clicking the button, you define the circle in the image with three 
more mouse clicks.

1 Use the [Create Triangular ROIs] button to define a triangular image segment 
as an ROI. After clicking the button, you define the triangle in the image with 
three more mouse clicks. The triangle is always a right triangle.

1 Use the [Create Polygonal ROIs] button to define any shape of image 
segment as an ROI. After clicking the button, with several mouse clicks in the 
image, you define the corners of a polygon in any shape.
For the last corner, click using the right instead of the left mouse button.

1 Use the [Create Magic Wand ROIs] button to define the ROI based on pixels 
that have the same or a similar color value.
After clicking the button, click a part of the object in the image for which you 
want to create a ROI. The ROI is now displayed in the image. You can change 
the size and shape of the ROI by changing the parameters in the [Magic 
wand properties] group at the bottom of the tool window.

1 If you would like to delete an ROI, select it in the table in the top of the tool 
window and click the [Delete Currently Selected ROIs] button.

2 Table of ROIs that 
have been defined

The table in the tool window lists all of the ROIs that have been defined in the 
current image. In the table, you can change the name and the line color of a 
ROI. 
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3 [Use for next 
images]

Select this check box if you want to use the same ROIs on all of the images 
that are selected for the current analysis process.
Note: The ROI that is defined only applies for the current analysis process. 
When you start a new analysis process, you have to define new ROIs. If you 
want to use the same ROIs for more than one analysis process, save them and 
reload them later.

4 [Rectangle 
properties]

The [Rectangle properties] group is only displayed when the one of the two 
buttons for creating rectangular ROIs is selected or when a rectangular ROI is 
selected in the image. 

4 [Square 
properties]

The [Square properties] group is only displayed when the one of the two 
buttons for creating square ROIs is selected or when a square ROI is selected 
in the image. 

4 [Use discrete size], 
[Step]

Select this check box to create rectangular or square ROIs that all have a size 
(or a multiple of a size) defined by you. 
In the [Step] field, enter the multiple by which the size of the ROI can change. 
Example: If you entered a value of [100] and the unit [µm] in the [Step] field, 
this means that each rectangular ROI that you now define will have a length 
and width that is divisible by 100. You can now draw two rectangular ROIs that 
are 100 x 100 µm and two additional rectangles that are 200 x 200 µm, for 
example.

5 [Magic wand 
properties]

In the table, select a ROI that was created using the magic wand. The [Magic 
wand properties] group now appears at the bottom of the tool window.

5 [Tolerance] Use the [Tolerance] slide control to increase or decrease the size of the ROI 
that was found.
When you use the magic wand, select a typical color value in the image. The 
value in the [Tolerance] field is added to, and subtracted from, the selected 
pixel's intensity value. This determines an intensity range that defines the 
phase. 
When you define an object on an image with the magic wand, a small cross 
indicates the selected point in the object. Simultaneously, a small square will 
also be displayed in the image. The distance between the square and the 
cross is a measure for the size of the tolerance value.
You can alter the tolerance directly on the image with your mouse. To do so, 
select the measurement object, then, while keeping your left mouse button 
depressed, move the small square. In the image, you can observe what effect 
the changed settings have on the image.

5 [Smoothness] You can smoothen the image before you use the magic wand. When you do 
this, image defects are suppressed and the object becomes, e.g., rounder in 
shape. The larger the value in the [Smoothness] field, the greater is the effect 
of the smoothing.
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13.2.4 [Threshold] step
The phases in an image must be defined for the software so that it can 
recognize them. All of the pixels that are within a particular intensity 
range belong to the same phase. The intensity value range is limited by 
a top and a bottom intensity value. These are the so-called threshold 
values.
In this step in the analysis you can change the threshold values. You can 
also create another phase. 

5 [Color space] The four buttons in the [Color space] group are options with which you can 
specify the color space within which you define the tolerance. These buttons 
are only relevant for 24-bit true-color images. You can choose between the 
[Intensity], [RGB], [HSV] and [Color] color spaces.

1 [Component] If you measure the porosity in a color image, you can select whether the 
threshold value is to be determined on the intensity value or on the red, 
green or blue part of the image. Select the component you want in the 
[Component] list. 
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1 Click the [Automatic Threshold Computation] button to have the threshold 
values initially calculated automatically. Then you can manually process them, 
if necessary. The [Automatic Threshold Computation] dialog box opens. 

2 Click the [Add Phase] button to create a phase. 
The intensity range for the phase will be automatically calculated. A new 
phase always directly adjoins an existing phase. When a new phase is added, 
its left-hand threshold corresponds to the right-hand threshold of the existing 
phase.
If the entire intensity range of the image is already assigned to a phase you 
can't add a new phase.

2 In the table, select the phase that you want to delete. Then click the [Remove 
Phase] button to delete the selected phase. It's only possible to remove a 
phase when at least two phases have been defined.

2 Note: If you would like to set threshold values for several phases, you will have 
to begin by setting the threshold value for the darkest phase. Then set the 
threshold value for the next phase, and so on.
Click the [New Threshold] button to define a threshold right on the image. 
This resets the existing thresholds for the selected phase.
As soon as you move your mouse pointer onto the image it will change its 
shape to that of a pipette. Click on one pixel or on the image area whose 
intensity value is to be utilized as the initial value for the threshold range. All 
of the pixels that have the same intensity value will be colored in the image, 
and displayed in the histogram. Continue clicking relevant pixels or threshold 
value ranges, until all of the required structures in the image are a part of the 
phase. 

2 Click the [Add Threshold ] button to select additional pixels that are to belong 
to the phase's intensity range. The image segments will be colored and 
displayed in the histogram. The current threshold value range will continue to 
be expanded until it contains the intensity values of all of the selected pixels.

2 Click the [Shrink Threshold] button to select pixels that aren't to belong to the 
threshold value range. The threshold value range will continue to be reduced 
until it no longer contains the pixels you have selected.

2 Click the [Undo Pipet] button to undo the last change that was made to the 
thresholds. Clicking the button again undoes the previous change, and so on. 
Click the [Redo Pipet] button to restore the last change that was 
undone. Clicking the button again restores the previous change, and so on.
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Dialog box - [Automatic Threshold Computation]
In the [Count] field, located in the [Phases] group, enter the number of 
phases that are to be calculated.
In the [Background] group, you define whether the bright or the dark 
image structures, or alternatively the complete image, are to be used 
for the automatic analysis. The term [Background] is used in this context 
for all of the image structures that are not within the threshold values.
Select the [Dark] option if the dark image structures are to be used as 
background. In this case, bright image structures will be defined as a 
phase and will be analyzed in the automatic analysis. Select the [Bright] 
option if the bright image structures are to be used as background.
Select the [Automatic] option if the classifying of the image structures 
as either phase or background, is to occur automatically. In this case 
your software evaluates the image's histogram. Please note that the 
number of phases to be defined isn't automatically adjusted. The 
number of phases to be defined has to be set correctly so that the 
image structures can be correctly assigned to a phase.

3 Table of phases 
that have been 
defined

The table in the tool window lists all of the phases that have been defined in 
the current image. In the table, you can change the name and the color of a 
phase. 
Double click on the field in the [Phase Name] column to enter a name for the 
phase.
Double click on the field in the [Color] column to choose a color. The phase 
will be displayed in the color you have assigned it, in the image window and 
in the histogram.

4 Histogram The histogram shows the intensity distribution of the active image. 
The intensity range which was defined for a phase will be shown in color in 
the histogram. You can move the edges of the range in the histogram.
To do that, move the mouse pointer to the edge of the slide. If you have 
more than one phase, the phase that you would like to change must be 
selected in the table.
When the mouse pointer changes shape, click and drag the edge of the 
range in the required direction. The threshold values in the table change 
correspondingly. In the image, there will now be more or less pixels in the 
color of the phase.
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Select the [None] option if no image area is to be defined as 
background. In this case, the complete image will be analyzed when 
the automatic analysis is carried out. 

13.2.5 [Image results] step
In this step, you see the results for the current image or for the current 
sample. If necessary, you can also manually add or remove objects 
used to determine the porosity value.

1 [ROI results] In this field, you can see the values that have been determined for each ROI. 
Which values are determined depends on the standard that has been 
selected and on the settings that you made in the [Settings] and [Target 
values] steps. If you haven't defined any ROIs, this list will be empty.

2 [Image 
results],[Sample 
results]

Here you either see the results of the current image or the overall results of all 
of the images that have already been analyzed for this sample.

[Show ROI with 
highest porosity]

This check box is only displayed when at least two ROIs have been defined. 
Select this check box to display in bold the border of the ROI that has the 
highest porosity. This option is useful when you have defined more than one 
ROI and quickly want to see in which ROI the highest porosity was 
determined.
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[Show pores] Select this check box to display the detected pores in color in the overlay.

[Show largest 
pore]

Select this check box to display the largest detected pores in color in the 
overlay. In the software options, the color [Blue] is the default color. The 
largest detected pore will be searched for either in the whole image or in all 
of the ROIs that have been defined.

[Show pores 
exceeding max. 
permissible pore 
size]

Select this check box to display the pores that exceed the maximum 
permissible pore size in color in the overlay. In the software options, the color 
[Green] is the default color.

[Show pore 
accumulations]

Select this check box to display a border around all of the pores that form a 
pore accumulation. In the software options, the color [Cyan] is the default 
color. Your software will only search for pore accumulations if you have 
selected a standard in the [Settings] step. Your software adopts the value that 
defines a pore accumulation from the standard that is being used. Whether 
pore accumulations are found in your samples depends on the sample itself 
and on the settings that you have made in the [Settings] and [Target values] 
steps.

[Show pore nests] Select this check box to display a border around all of the pores that form a 
pore nest. In the software options, the color [Cyan] is the default color. Your 
software will only search for pore nests if you have selected a standard in the 
[Settings] step. Whether pore nests are found in your samples depends on 
the sample itself and on the settings that you have made in the [Settings] and 
[Target values] steps. Because pore nests are particularly large pore 
accumulations. pore nests can’t be found if pore accumulations have already 
been found.
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3 Manually 
correcting results

If necessary, manually change which sections of the image your software uses 
to determine the area fraction covered by a phase in percent.
Note: When you delete objects from a phase or add objects to a phase, you 
change the area fraction covered by the phase in percent. The [Fraction] 
values shown in the image results will be immediately updated.

Note: If you have manually deleted or added objects and return to a previous 
step in the analysis (e.g. to change the minimum or maximum object size), 
this will delete the corrections you have made manually. If necessary, you will 
then again have to delete or add objects in the [Image results] step in the 
analysis.

3 Add objects by first clicking on this button. Then draw a freehand polygon 
around the object to be added.
End the definition of the polygon with the right mouse button. If you are 
using several phases, select the phase to which the added object should 
belong from the context menu. The polygon added will be shown in the color 
of the phase. The area fraction that is displayed will be increased.

3 Delete objects by first clicking on the object to be deleted in the image and 
then clicking on the [Delete selected objects] button. The area fraction 
covered by the corresponding phase in percent will be reduced. 
You can also delete several objects at once, by holding the [Ctrl] key pressed, 
while clicking on the objects. To exclude an entire section from the area 
fraction covered by a phase in percent, draw a rectangle on the image. All of 
the objects within the rectangle will now be shown hatched. Click the [Delete 
selected objects] button to delete all of the marked objects at once.

4 [Reject Image] Click the [Reject image] button to exclude the current image from the 
analysis. This only makes sense if the current analysis contains at least two 
images.
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13.3 Performing a porosity measurement
The following step-by-step instructions describe an example for a 
porosity measurement.
[Image source] step

1. Load the image that you want to analyze. The 
MacroscopicComponent.tif example image is used for the 
following step-by-step instructions.

2. Click the [Porosity] button, located in the [Materials Solutions] tool 
window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
5. Click the [Next] button.

[Settings] step
1. Decide whether you want to perform the porosity measurement 

according to a particular standard. For these step-by-step 
instructions, use the [VDG P 202-2010] standard. 

2. In the [Pore size parameter] field, select how the pore size is 
calculated.
 Select the [Max. (Feret)] setting to use the maximum spacing of 

parallel tangents on opposing sides of particles.

 Select the [Equivalent Circle Diameter] setting, to use the 
diameter of a circle which has the same area as the particle.

3. The example image is calibrated in millimeters. You should thus 
click on the button which shows the units (at the right, next to the 
[Minimum size for counting] field), and select [mm] as the units.
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4. For these step-by-step instructions, leave the [Lower limit] check 
box and the [Upper limit] check box in the [Disregarded pores] 
group clear. 

5. In the [Porosity parameters] group, select the following check 
boxes: [Porosity], [Pore size], [Number of pores]. Leave the other 
check boxes clear for these step-by-step instructions.

6. Leave the [Define target values] check box selected.
  Then the [Target values] step, which is optional, will be shown.

7. Click the [Next] button.
[Target values] step

1. The values that the sample you are analyzing must attain to pass 
the porosity measurement are displayed at the top of the [Target 
values] step. These values are shown in the [Target key] field in the 
lower part of the tool window. 
 The target key displays the permissible values in a way specified 

by the standard you are using. Some of the values in the target 
key are rounded up or down. The more parameters that are 
analyzed for the porosity measurement, the longer the target 
key will be.
Example: The target key [VDG P202-%10/Ø1] means: The VDG 
P202 standard was used. The permissible porosity is 10% (written 
[%10]). The maximum permissible pore size is 1mm (written [Ø1]). 

 At the end of the measurement, the [Porosity key] field is 
displayed in the [Image results] step. The porosity key shows the 
results of the measurement. All of these values have also been 
rounded up or down. The format of the porosity key and the 
target key are identical. This enables you to quickly compare the 
required measurement results with the measurement results that 
were attained.

2. Because no adjustments are required for the 
MacroscopicComponent.tif example image: Click the [Next] button.
 For your own samples you will later need to enter suitable values 

here. You can save these and use them for subsequent 
measurements.
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 [ROIs] step
1. For the MacroscopicComponent.tif example image, define a ROI 

which encompasses the shape of the object. To do this click the 
[Create magic wand ROIs] button and click a bright point in the 
image inside the component whose porosity you are measuring.

 
 The ROI will be displayed. If required, you can change the size 

and shape of the ROI by changing the parameters in the [Magic 
wand properties] group. 

 It is not absolutely necessary to define ROIs. So you can’t make 
any settings in the [ROIs] step.

2. Click the [Next] button.
[Threshold] step
All of the pixels which lie within a defined intensity range, will be shown 
in color during this step in the analysis. This intensity range is called a 
"phase". The intensity value range is limited by a top and a bottom 
intensity value. These are the so-called threshold values.

Please note that the defined ROI will not be considered in this step in the 
analysis, but only in the next step. This is why the background color in this step 
is also shown in color.
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1. If necessary, reduce or increase the intensity range of the phase. In 
the image, watch how the object areas found become larger and 
more objects are found.
 To do this, change the values in the [Min.] and [Max.] fields in the 

table in the tool window. Alternatively, interactively change the 
lower and upper threshold values in the histogram shown at the 
bottom of the tool window. Move the mouse pointer over the 
edge of the phase, until the pointer changes and, with the left 
mouse button pressed, drag the edge in the required direction.

2. Click the [Next] button.
[Image results] step

1. Take a look at the results in the overlay. All of the objects used to 
determine the porosity value will, in this step in the analysis, be 
shown in the color that has been selected for the phase.

 When the [Show largest pore] check box is selected, the largest 
pore that was detected will be displayed with a colored edge in 
the overlay. In the software options, the color [Blue] is the default 
color.

 When the [Show pores exceeding max. permissible pore size] 
check box is selected, the pores that exceed the maximum pore 
size will also be displayed with a colored edge. In the software 
options, the color [Green] is the default color. 
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2. Select the [Image] option and take a look at the results displayed in 
the table.
 The porosity value is displayed. You can also compare the target 

key with the porosity key here.
3. If necessary, manually add objects or delete objects that have been 

detected. To do this, use the two buttons in the lower part of the 
tool window.
 The results that are shown in the table are refreshed 

immediately.
4. Click the [Next] button.

[Results] step
1. Select the results you want. 
2. Click the [Next] button.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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13.4 Software options
The software options provide a number of settings for a porosity 
measurement.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Porosity] entry in the tree 
view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an analysis.
Threshold mode for color images
This group is only of importance when you measure the porosity on 
color images. In this case, you specify here color space to be used for 
the threshold value setting. By default, the [Simplified color space (I/R/
G/B)] option is selected. With this option, the [Threshold] step in the 
analysis shows the [Component] list. In this list, you can select whether 
the value is to be determined on the intensity value or on the red, 
green or blue part of the image. 
Select the [Advanced color space (HSV)] option to use the HSV color 
space for the threshold value setting. With this option, the [Threshold] 
step in the analysis shows the [Channels] table. In the table, select the 
[Intensity Value], [Hue] or [Saturation] entry in order to determine how 
the threshold value is set.
[Min. object size]
In this field, you can specify the minimum number of pixels an object 
can consist of and still be included in the analysis. This enables you to 
exclude from the analysis unimportant small objects in the image that 
have the same color as the pores (image noise for example). 

This command is not available while an analysis is running.
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Note: Use this setting to exclude from the analysis very small objects 
that are being detected but that are usually not pores. If, on the other 
hand, you want to exclude real pores from the porosity measurement, 
make the corresponding settings during the porosity 
measurement. The [Disregarded pores] group with the [Lower limit 
]and [Upper limit] fields in the [Settings] step can be used for this.
[Image overlay colors]
In this group you can view and change the colors used to display 
particular pores in the overlay. 

[Largest pore] Specify the color in which the largest pore in the image will be 
displayed.

[Pores exceeding
max. pore size]

Specify the color in which all of the pores that exceed the maximum 
pore size will be displayed. You can view and change the maximum 
pore size in the [Max. permissible pore size] field, in the [Settings] and 
[Target values] steps.

[Pore accumula-
tions]

Specify the color of the border around all of the pores that form a pore 
accumulation. The definition of a pore accumulation is that the distance 
between two pores is smaller than the diameter of the smaller of the 
two pores (when the value is set to [1] in the [Distance factor] field). You 
can find the [Distance factor] field in the [Settings] step.

[Pore nests] Specify the color of the border around all of the pores that form a pore 
nest. Pore nests are groups of pores that have an even larger area than 
pore accumulations.
[Display particle results in the workbook]
The [Display particle results in the workbook] check box specifies how 
the results of a porosity measurement are displayed in a workbook. You 
can set whether a workbook should be created in the [Results] step in 
the analysis. 
If this check box is not selected, the workbook only contains the overall 
results for each sample that was analyzed:

By selecting the colors you are only specifying a default setting. You 
don’t determine whether these elements will be displayed in the image 
(assuming they are present on the sample) until you select the relevant check 
boxes in the [Image results] step. 
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When the [Display particle results in the workbook] check box is 
selected, the workbook will contain further worksheets with the 
individual results for each detected pore. 
With the [Area] measurement parameter, for example, the individual 
results contain the exact area of each pore that was detected. If you 
sort the values in the [Area] column in descending order, for example, 
you can thus quickly see the area of the largest pore that was detected.
In this context, the [One sheet per image] and [One sheet per sample] 
options specify how the additional worksheets that contain the 
individual results will be structured. This means that, with both options, 
the same information is given. However, the way the information is 
structured is different.
Select the [One sheet per image] option to have the individual results 
for each image that was analyzed shown in a separate worksheet. The 
worksheet's name is identical to the image's name. It shows the exact 
individual results (for example, the area) for each pore that was 
detected on this image.
Select the [One sheet per sample] option to have the individual results 
for all images that belong to the same sample shown in one worksheet:
Note: You can define some general settings for the appearance of 
workbooks. To do so, use the [Options] > [Workbook] > [Format] 
dialog box.
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ID_12701
14 [Phase Analysis]
14.1 Overview

What is a phase analysis?
With a phase analysis, you measure the percentage of the area fraction 
that the phase covers in your samples. A phase is a number of pixels 
which lie within a defined intensity range. The intensity value range is 
limited by a top and a bottom intensity value. These are the so-called 
threshold values.
It is a precondition for the phase analysis, that the phases differ from 
the rest of the sample e.g. because they are darker or lighter. You can 
define one or more phases.

At the left side, you can see the source image showing three phases (dark, gray, and bright). The 
histogram in the middle shows the distribution of the intensity values. Phases 1-3 are clearly visible 
in the histogram as local maxima. In the histogram, the thresholds and the color of the phases are 
shown. In the right image, all pixels are assigned to one of the three phases.

Object filter
The result of the phase analysis can be restricted by an object filter. 
Objects which do not reach the minimum object size will not be 
included when determining the area fraction covered by the phase in 
percent. In this way you can, for example, prevent dust particles being 
assigned to a phase and distorting the result.
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Measuring on ROIs
You can choose whether you would like to measure the entire image or 
if the measurement should only be carried out on a part of the image, a 
so called ROI (Region Of Interest). You can also define several ROIs.

Manually adjusting the result of the phase analysis
You can manually adjust the result of the phase analysis. You do this 
interactively on the image. Note that you are not changing the image 
itself, but the image's measurement layer.
You can manually delete parts of the image which were detected as 
objects. This can be necessary, if for example artifacts in the image are 
detected as objects because they have intensity values similar to the 
defined phase. By manually deleting these objects, the artifacts will no 
longer be included when determining the area fraction covered by this 
phase.
In addition, you can also manually add other image segments which 
were not detected as such but which are actually objects. When you 
manually add and delete objects, you always change the area fraction 
covered by the corresponding phase.

Results of a phase analysis
The results of an analysis can be displayed in a workbook. Additionally, 
the results can be displayed in a report in MS-Word format.
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General procedure for a phase analysis
1 Selecting the 

analysis process
Click the [Phase Analysis] button, located in the [Materials Solutions] tool 
window.

2 [Image source] In the [Image source] step you select the images that you want to measure. 
You can find more information on page 62 of the Selecting the image source 
chapter.

3 [ROIs] Define the ROIs, or measure the whole sample. You can find more 
information on this topic in section [ROIs] step on page 244.

4 [Threshold] Define the intensity range for the first phase, and define other phases if 
necessary. You can find more information on this topic in section [Threshold] 
step on page 252.

5 [Object Filter] Define the minimum object size. You can find step-by-step instructions in 
section [Object f ilter] step on page 257.

6 [Image results] You can check the image results in the [Image results] step. If necessary: 
Delete or separate detected particles, or add new ones. You can find more 
information on this topic in section [Image results] step on page 252.

7 [Results] Document the results and generate a report or a workbook. You can find 
step-by-step instructions in section [Results] step on page 257.
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14.2 Settings
14.2.1 [ROIs] step

In this step you define whether to perform the phase analysis on the 
whole image, or only on defined image segments (ROIs). In this step, 
the following options are available:

1 [ROIs] Use one of the buttons in the toolbar at the top of the tool window to define 
an image segment as a ROI (Region Of Interest). Your software will then only 
perform the phase analysis on the areas marked as ROI, all other parts of the 
sample will be ignored.

1 Click the [Load ROIs] button. The dialog box for loading parameter sets 
opens. Select the parameter set that contains the ROIs you want from the list, 
then click on the [Load] button.
The saved ROIs will be loaded on the current image. Now, you can adjust the 
positions and sizes of the ROIs to the active image.
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1 Click the [Save ROIs] button. The dialog box for saving parameter sets opens. 
Enter a descriptive name. 
This enables you to use a pattern of ROIs that you have defined as a template 
for additional phase analyses.

1 Use the [Create Rectangular ROIs] button to define a rectangular image 
segment as an ROI. After clicking the button, you define the rectangle in the 
image. You can move the mouse pointer over a handle to change the size 
and position of the rectangle.

1 Use the [Create Rotated Rectangular ROIs] button to define a rectangular 
image segment as an ROI. After clicking the button, you define the rectangle 
in the image. You can define the first side of the rectangle by clicking the 
mouse at the beginning and end of the required line. Then make the 
rectangle the required height. Click once to finish defining the rectangle. You 
can move the mouse pointer over a handle to change the size and position of 
the rectangle.

1 Use the [Create Square ROIs] button to define a square image segment as an 
ROI. After clicking the button, you define the square in the image. You can 
move the mouse pointer over a handle to change the size and position of the 
square.

1 Use the [Create Rotated Square ROIs] button to define a square image 
segment as an ROI. After clicking the button, you define the square in the 
image. You can define the first side of the square by clicking the mouse at the 
beginning and end of the required line. Click once to finish defining the 
rectangle. You can move the mouse pointer over a handle to change the size 
and position of the square.

1 Use the [Create Circular ROIs] button to define a circular image segment as 
an ROI. After clicking the button, you define the circle in the image with three 
more mouse clicks.

1 Use the [Create Triangular ROIs] button to define a triangular image segment 
as an ROI. After clicking the button, you define the triangle in the image with 
three more mouse clicks. The triangle is always a right triangle.

1 Use the [Create Polygonal ROIs] button to define any shape of image 
segment as an ROI. After clicking the button, with several mouse clicks in the 
image, you define the corners of a polygon in any shape.
For the last corner, click using the right instead of the left mouse button.
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1 Use the [Create Magic Wand ROIs] button to define the ROI based on pixels 
that have the same or a similar color value.
After clicking the button, click a part of the object in the image for which you 
want to create a ROI. The ROI is now displayed in the image. You can change 
the size and shape of the ROI by changing the parameters in the [Magic 
wand properties] group at the bottom of the tool window.

1 If you would like to delete an ROI, select it in the table in the top of the tool 
window and click the [Delete Currently Selected ROIs] button.

2 Table of ROIs that 
have been defined

The table in the tool window lists all of the ROIs that have been defined in the 
current image. In the table, you can change the name and the line color of a 
ROI. 

3 [Use for next 
images]

Select this check box if you want to use the same ROIs on all of the images 
that are selected for the current analysis process.
Note: The ROI that is defined only applies for the current analysis process. 
When you start a new analysis process, you have to define new ROIs. If you 
want to use the same ROIs for more than one analysis process, save them and 
reload them later.

4 [Rectangle 
properties]

The [Rectangle properties] group is only displayed when the one of the two 
buttons for creating rectangular ROIs is selected or when a rectangular ROI is 
selected in the image. 

4 [Square 
properties]

The [Square properties] group is only displayed when the one of the two 
buttons for creating square ROIs is selected or when a square ROI is selected 
in the image. 

4 [Use discrete size]
[Step]

Select this check box to create rectangular ROIs that all have a size (or a 
multiple of a size) defined by you. 
In the [Step] field, enter the multiple by which the size of the rectangular ROI 
can change. 
Example: If you entered a value of 100 and the unit [µm] in the [Step] field, this 
means that each rectangular ROI that you now define will have a length and 
width that is divisible by 100. You can now draw two rectangular ROIs that are 
100 x 100 µm and two additional rectangles that are 200 x 200 µm, for 
example.

5 [Magic wand 
properties]

In the table, select a ROI that was created using the magic wand. The [Magic 
wand properties] group now appears at the bottom of the tool window.
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5 [Tolerance] Use the [Tolerance] slide control to increase or decrease the size of the ROI 
that was found.
When you use the magic wand, select a typical color value in the image. The 
value in the [Tolerance] field is added to, and subtracted from, the selected 
pixel's intensity value. This determines an intensity range that defines the 
phase. 
When you define an object on an image with the magic wand, a small cross 
indicates the selected point in the object. Simultaneously, a small square will 
also be displayed in the image. The distance between the square and the 
cross is a measure for the size of the tolerance value.
You can alter the tolerance directly on the image with your mouse. To do so, 
select the measurement object, then, while keeping your left mouse button 
depressed, move the small square. 
In the image, you can observe what effect the changed settings have on the 
image.

5 [Smoothness] You can smoothen the image before you use the magic wand. When you do 
this, image defects are suppressed and the object becomes, e.g., rounder in 
shape. 
The larger the value in the [Smoothness] field, the greater is the effect of the 
smoothing.

5 [Color space] The four buttons in the [Color space] group are options with which you can 
specify the color space within which you define the tolerance. These buttons 
are only relevant for 24-bit true-color images. You can choose between the 
[Intensity], [RGB], [HSV] and [Color] color spaces.
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14.2.2 [Threshold] step
The phases in an image must be defined for the software so that it can 
recognize them. All of the pixels that are within a particular intensity 
range belong to the same phase. The intensity value range is limited by 
a top and a bottom intensity value. These are the so-called threshold 
values.
In this step in the analysis you can change the threshold values. You can 
also create another phase. 

1 [Component] If you measure the phase analysis in a color image, you can select whether 
the threshold value is to be determined on the intensity value or on the red, 
green or blue part of the image. Select the component you want in the 
[Component] list. 

1 Click the [Automatic Threshold Computation] button to have the threshold 
values initially calculated automatically. Then you can manually process them, 
if necessary. The [Automatic Threshold Computation] dialog box opens. 
You can find more information on this topic in section [Automatic Threshold 
Computation] dialog box on page 250.
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2 Click the [Add Phase] button to create a phase. 
The intensity range for the phase will be automatically calculated. A new 
phase always directly adjoins an existing phase. When a new phase is added, 
its left-hand threshold corresponds to the right-hand threshold of the existing 
phase.
If the entire intensity range of the image is already assigned to a phase you 
can't add a new phase.

2 In the table, select the phase that you want to delete. Then click the [Remove 
Phase] button to delete the selected phase. It's only possible to remove a 
phase when at least two phases have been defined.

2 Note: If you would like to set threshold values for several phases, you will have 
to begin by setting the threshold value for the darkest phase. Then set the 
threshold value for the next phase, and so on.
Click the [New Threshold] button to define a threshold right on the image. 
This resets the existing thresholds for the selected phase.
As soon as you move your mouse pointer onto the image it will change its 
shape to that of a pipette. Click on one pixel or on the image area whose 
intensity value is to be utilized as the initial value for the threshold range. All 
of the pixels that have the same intensity value will be colored in the image, 
and displayed in the histogram. Continue clicking relevant pixels or threshold 
value ranges, until all of the required structures in the image are a part of the 
phase. 

2 Click the [Add Threshold ] button to select additional pixels that are to belong 
to the phase's intensity range. The image segments will be colored and 
displayed in the histogram. The current threshold value range will continue to 
be expanded until it contains the intensity values of all of the selected pixels.

2 Click the [Shrink Threshold] button to select pixels that aren't to belong to the 
threshold value range. The threshold value range will continue to be reduced 
until it no longer contains the pixels you have selected.

2 Click the [Undo Pipet] button to undo the last change that was made to the 
thresholds. Clicking the button again undoes the previous change, and so on. 
Click the [Redo Pipet] button to restore the last change that was 
undone. Clicking the button again restores the previous change, and so on.
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[Automatic Threshold Computation] dialog box
In the [Count] field, located in the [Phases] group, enter the number of 
phases that are to be calculated.
In the [Background] group, you define whether the bright or the dark 
image structures, or alternatively the complete image, are to be used 
for the phase analysis. The term [Background] is used in this context for 
all of the image structures that are not within the threshold values.
Select the [Dark] option if the dark image structures are to be used as 
background. In this case, bright image structures will be defined as a 
phase and will be analyzed in the phase analysis.
Select the [Bright] option if the bright image structures are to be used 
as background.
Select the [Automatic] option if the classifying of the image structures 
as either phase or background, is to occur automatically. In this case 
your software evaluates the image's histogram. Please note that the 
number of phases to be defined isn't automatically adjusted. The 
number of phases to be defined has to be set correctly so that the 
image structures can be correctly assigned to a phase.

3 Table of phases 
that have been 
defined

The table in the tool window lists all of the phases that have been defined in 
the current image. In the table, you can change the name and the color of a 
phase. 
Double click on the field in the [Phase Name] column to enter a name for the 
phase.
Double click on the field in the [Color] column to choose a color. The phase 
will be displayed in the color you have assigned it, in the image window and 
in the histogram.

4 Histogram The histogram shows the intensity distribution of the active image. 
The intensity range which was defined for a phase will be shown in color in 
the histogram. You can move the edges of the range in the histogram.
To do that, move the mouse pointer to the edge of the slide. If you have 
more than one phase, the phase that you would like to change must be 
selected in the table.
When the mouse pointer changes shape, click and drag the edge of the 
range in the required direction. The threshold values in the table change 
correspondingly. In the image, there will now be more or less pixels in the 
color of the phase.
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Select the [None] option if no image area is to be defined as 
background. In this case, the complete image will be analyzed when 
the phase analysis is carried out. 

In image (1), you can see objects with three different gray intensity values. 
In image (2), the bright image structures are the background. The rest of the image is assigned to 
one single phase. The phase is colored red here. 
In image (3), the dark phases are defined as background. The bright phase is detected.
In image (4), no background has been chosen, all image structures are defined as phases. In this 
case, three phases are defined.
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14.2.3 [Image results] step
In this step, the following options are available:

1 [Image results] In the [Image results] field, you see the results for the current image. The area 
fraction for each phase is displayed.

2 [Sample results] In the [Sample Results] field, you can see the sum of the results of all of the 
images of the current sample, that have up till now been analyzed.

3 Manually 
correcting results

If necessary, manually change which sections of the image your software uses 
to determine the area fraction covered by a phase in percent.
Note: When you delete objects from a phase or add objects to a phase, you 
change the area fraction covered by the phase in percent. The [Fraction] 
values shown in the image results will be immediately updated.
Note: If you have manually deleted or added objects and return to a previous 
step in the analysis (e.g. to change the minimum or maximum object size), 
this will delete the corrections you have made manually. If necessary, you will 
then again have to delete or add objects in the [Image results] step in the 
analysis.

3 Add objects by first clicking on this button. Then draw a freehand polygon 
around the object to be added.
End the definition of the polygon with the right mouse button. If you are 
using several phases, select the phase to which the added object should 
belong from the context menu. The polygon added will be shown in the color 
of the phase. The area fraction that is displayed will be increased.
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14.3 Performing a phase analysis
You can follow these step-by-step-instructions on your computer. They 
describe a phase analysis on an example image. 

In this image, the percentage area of the bright and the dark phases are to be measured within an 
ROI.

[Image source] step
1. Load the SprayCoating.tif example image.
2. Click the [Phase Analysis] button, located in the [Materials 

Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.

3 Delete objects by first clicking on the object to be deleted in the image and 
then clicking on the [Delete selected objects] button. The area fraction 
covered by the corresponding phase in percent will be reduced. 
You can also delete several objects at once, by holding the [Ctrl] key pressed, 
while clicking on the objects. To exclude an entire section from the area 
fraction covered by a phase in percent, draw a rectangle on the image. All of 
the objects within the rectangle will now be shown hatched. Click the [Delete 
selected objects] button to delete all of the marked objects at once.

4 [Reject Image] Click the [Reject image] button to exclude the current image from the 
analysis. This only makes sense if the current analysis contains at least two 
images.
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 This skips the [Sample information] step, which is not relevant for 
this example image. 

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[ROIs] step
1. For the SprayCoatingt.tif example image, define a rectangular  

ROI which covers the part of the sample that you would like to 
analyze. To do so, click the [Create Rectangular ROIs] button, and 
define the rectangle on the image. With two mouse clicks, define 
the position of one side of the rectangle. Then make the rectangle 
the required height. Click once to finish defining the rectangle. 
 The button will appear clicked. You can recognize this status by 

the fact that the button's background color changes.
 You are now in the mode for defining ROIs.
 The ROI is represented by an object in the [Measurement and 

ROI] tool window. You can also view the area of the ROI there.
2. You can now continue to define additional ROIs. 
3. When you have defined all of the ROIs, click the [Create 

Rectangular ROIs] button again to release the button and to exit 
the definition mode.
 If you perform a phase analysis on your own images later on, it 

may be more sensible to create a circular, triangular, or 
polygonal ROI.

 You can also define several ROIs with different shapes. The 
phase fraction will always be measured over all ROIs.

 ROIs can overlap. Objects in the overlapping areas will be 
counted twice.

 It is not absolutely necessary to define ROIs. If you want to 
measure the entire image, in the [ROIs] step in the analysis, click 
directly on the [Next] button without defining a ROI.

 The ROI that is defined only applies for the current analysis 
process. When you start a new analysis process, you have to 
define new ROIs. If you want to use the same ROIs for more than 
one analysis process, save them and reload them later.

4. Leave the [Use for next images] check box clear, because these 
instructions only analyze one image. 
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 Later on, when you are using your own images and want to 
analyze more than one image at the same time, you can select 
this check box to use the same ROI on all of the images that are 
selected in the current analysis process.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

A ROI has been defined on the example image.

[Threshold] step
 All of the pixels which lie within a defined intensity range, will be 

shown in color during this step in the analysis. This intensity 
range is called a phase. The intensity value range is limited by a 
top and a bottom intensity value. These are the so-called 
threshold values.

 Please note that the defined ROI will not be considered in this 
step in the analysis, but only in the next step. In this step in the 
analysis, pixels which are outside of the ROI will thus also be 
shown in color.

1. If necessary, reduce or increase the intensity range of the first 
automatically created phase. Make sure that the first phase covers 
the dark pixels. You can only define the phase for the bright pixels 
in the next step. In the image, watch how the object areas found 
become larger and more objects are found.
 To reduce or increase the intensity range, in the tool window's 

table, change the values in the [Min.] and [Max.] fields. 
 Alternatively, interactively change the lower and upper threshold 

values in the  histogram shown at the bottom of the tool 
window. Move the mouse pointer over the edge of the phase, 
until the pointer changes and, with the left mouse button 
pressed, drag the edge in the required direction.
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You can also define the thresholds in the histogram itself.

2. Now, define the second phase. To do so, click the [Add Marker] 
button.
 An additional phase is now automatically added to the table in 

the tool window.

 
The second phase is displayed in the image, in the table, and in the histogram.

3. Click the [New Threshold] button. You can now adopt the intensity 
range for the new phase from the image.
 The mouse pointer turns into a pipet.
 All of the phases that have already been defined disappear from 

the image.
4. Now keep clicking in the bright areas within the ROI until they are 

displayed in the color of the phase.
5. If necessary, change the two phases which have already been 

defined. To do that, select the phase that you want to change in 
the table in the tool window and change the thresholds.

6. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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Two phases are defined on the example image.

[Object filter] step
 In this step in the analysis, only the pixels within the defined ROI 

are considered. All objects which meet the conditions defined in 
the object filter, will be shown in the color of the phases.

 All objects which do not meet the conditions defined in the 
object filter, will be shown in this step in the analysis in red 
hatching. This means that these objects will not be taken into 
account when determining the percentage area of the phase.

1. In the [Minimum object area] field, enter the minimum size that an 
object must have in order to be considered when determining the 
area fraction covered by the phase. You can thus exclude small 
objects such as dust particles from the determination of the 
percentage area of the phase. 

2. Watch how more or less object areas are found as the hatched 
objects in the image increase or decrease.

3. During the analysis process, you can use your software's zoom 
function as usual. Move your mouse pointer onto the appropriate 
position in the image, then use the mouse wheel to zoom into or 
out of the image.

4. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Image results] step
 In this step in the analysis, all of the objects used to determine 

the phase fraction will be shown in the color of the phase. 

Objects which do not come up to the minimum area and which were thus shown hatched in the 
previous step in the analysis, will now be shown with no color.
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1. Take a look at the results that are shown in the table. In the [Image 
results] field, you will see the area fraction covered by each phase.

2. If necessary, manually change which objects your software uses to 
determine the area fraction of the phase. You can delete, or add 
objects.

3. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Results] step
1. Check the results shown. You can see the results for all of the 

images that have been analyzed.
2. Select the [Generate report] check box, if you would like to have a 

report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. If you want to save the current settings to a file, click the [Save 

settings] button. Then assign a descriptive name in the next dialog 
box.
 You can load these settings when you analyze further images. To 

do that for the new image in the [Image Source] step, click the 
[Load from file] button. The sample and image comments are 
saved, as are the phases used and the settings in the [Object 
filter] step in the analysis.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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14.4 Software options
The software options offer a few phase analysis settings.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Phase analysis] entry in the 
tree view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an analysis.

This command is not available while an analysis is running.
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15 [Coating Thickness]
15.1 Overview

What is a coating thickness measurement?
Using the [Coating Thickness] analysis process you can analyze ball 
indentation cuts of thin coatings and determine their coating thickness. 
The sample under test should be a substrate, which has one or more 
coatings that were applied using different coating methods (PVD, CVD, 
VPS, APS etc.).
To determine the coating thickness, a ball indentation is ground into 
the sample. This is done using a rotating grinding ball, which has a 
diameter between about 10 and 50 mm. The ball indentation must have 
the minimum thickness of the sum of all coatings.
The indentation that the grinding ball made in the sample surface 
depends on the sample surface. In case of a flat or spherical sample 
surface, the indentation is round. If the sample surface is curved in one 
direction, the grinding ball's indentation is ellipse-shaped. You can 
choose between the following sample surfaces: [Flat], [Cylindrical 
convex], [Cylindrical concave], [Spherical convex], or [Spherical 
concave].

        

Number of measurements per image
Every image is only measured once by default. However, you can 
specify in the software options that an image will be measured several 
times. Then the results of the last measurement will constantly be 
compared to the results of the previous measurement. The average 
value of all of the measurements performed to date is always displayed.
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Results of a coating thickness measurement
The coating thickness is measured in accordance with the industry 
standard that is set in the software options. The following industry 
standards are available:
• EN 1071-2 : 2002
• VDI 3824 : 2001
• EN ISO 26423 : 2016

The results of an analysis can be displayed in a workbook. Additionally, 
the results can be displayed in a report in MS-Word format.
If the [Create image with results shown in information bar] check box 
has been marked in the software options, a new image document will 
be created additionally during the measurement. This image document 
shows the measured image with the borderlines and an information bar 
(under the image). You can determine the contents of the information 
bar. You can save the image document as a TIF file and send it to 
others who don't have access to your software, for example.
General procedure for a coating thickness measurement

1 Selecting the 
analysis process

Click the [Coating Thickness] button, located in the [Materials Solutions] tool 
window.

2 [Image source] In the [Image source] step you select the images that you want to measure. 
You can find more information on page 62 of the Selecting the image source 
chapter.

3 [Settings] Select the sample surface type, [Flat] for example. Specify further 
measurement parameters. You can find more information on this topic in 
section [Settings] step on page 266.

4 [Measurement] Define the borders of the coating in the image. You can find more 
information on this topic in section [Measurement] step on page 271.

5 [Results] Document the results and generate a report or a workbook. You can find 
step-by-step instructions in section [Reporting] step on page 276.
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15.2 Settings
15.2.1 [Settings] step

In this step, the following options are available:

1 [Sample surface] This is where you select the sample surface type. The functions that appear in 
the tool window vary depending on which sample surface you selected.
You can choose between the following sample surfaces: 
[Flat], [Cylindrical convex], [Cylindrical concave], [Spherical convex], or 
[Spherical concave].
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2 [Crater shape] The indentation that the grinding ball makes in the sample's surface is called a 
crater. 
The indentation is round if you have selected the [Flat ], [Spherical convex] or 
[Spherical concave] entry from the [Sample surface] list. 
If you have selected the [Cylindrical convex] or [Cylindrical concave] entry 
from the [Sample surface] list, the indentation is elliptical. In this case, select 
the direction of the ellipse's long axis. This information is taken into account 
when calculating the coating thickness.

3 [Measure long 
axis]

The check box is only displayed if you have selected the [Cylindrical convex ] 
or the [Cylindrical concave] entry from the [Sample surface] list.
Because the indentation for both of these sample surfaces is elliptical, you can 
decide which axis of the ellipse you want to measure.
Leave the check box clear if you want to measure the short axis.
Select the check box clear if you want to measure the long axis.

4 [Measure using 
multiple points]

Select the [Measure using multiple points] check box if you want to define all 
of the borders of the coating using three clicks of the mouse, not just the first 
one. This setting can be helpful when the indentation left in the sample 
surface by the grinding ball isn't completely symmetrical. This check box is 
clear by default, which means that one click of the mouse is enough to define 
the second border.

5 [Number of 
coatings]

Specify how many coatings you want to measure in the [Number of coatings] 
field. A maximum of 20 coatings can be measured. 

6 Parameters for the 
grinding ball

Enter the diameter of the grinding ball used in the [Grinding ball diameter] 
field. The grinding ball's diameter must be known in order to produce an 
accurate coating thickness measurement. If necessary, change the suggested 
unit.
Click the [...] button next to the [Grinding ball diameters] field to display a 
predefined list of commercially available grinding ball diameters.
Enter the curvature radius of the surface used in the [Curvature radius of 
surface] field. This value must be known because it's needed for the 
calculation of the coating thickness. If necessary, change the suggested unit.
Note: The curvature radius of the surface is only important for the 
measurement of the coating of spherical sample surfaces. That's why this field 
isn't displayed when you've selected a different sample surface type.
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15.2.2 [Measurement] step
In this step you carry out the actual coating thickness measurement. 
The exact procedure depends on which sample surface you selected in 
the [Settings] step.
In this step, the following options are available:
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1 Schematic 
illustration

This schematic illustration tells you how a coating's borders have to be 
defined. The illustration is updated as soon as the required points have been 
defined on the image. When the borders have been defined, the illustration 
disappears.

For flat and spherical sample surfaces, the first border is defined using three 
mouse clicks. One mouse click is enough to define the next and all further 
borders.

With cylindrical sample surfaces, the outer borderline is defined by clicking 
twice on the ellipse's outer border taking the direction of the selected long 
axis into account. One mouse click is enough to define the next and all further 
borders.

2 Table with 
measurement 
results

As soon as enough data is available, the results of the current measurement 
are displayed. The values are continually updated during a measurement.
The [Measurements (1 of 1)] field is only relevant when you measure the same 
image more than once. If you specified that you want to measure the same 
image more than once in the software options, this field displays which 
measurement is currently being performed and how many measurements are 
to be carried out in total.
The table displays the thickness that was measured for each coating. You can 
measure up to 20 coatings. If not all of the measurement values are visible, 
use the slide control at the right-hand edge of the table.

3 [Total thickness] The [Total thickness] field displays the sum of all of the coating thicknesses 
that were measured.

3 [Total penetration 
depth]

The [Total penetration depth] field shows the sum of the values in the [Total 
thickness] and [Penetration depth in substrate] fields.

3 If the total penetration depth is not sufficient to achieve precise results, a 
small warning triangle is displayed in this field. At the same time, the [More 
information] button is displayed. If you click this button, you can view more 
information about the problem. Measurements in which the total penetration 
depth is not sufficient are displayed in red in the report and in the workbook. 
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Measurement order
You can carry out the measurements in any the order you want. You 
can measure the coatings from the outside to the inside, for example. 
To do this, the coating's outer border is defined first on the image and, 
following that, all of the remaining borders.
Alternatively, you can also measure the coatings in the reverse order, 
from the inside to the outside. It's also possible, for example, to specify 
a border on a middle coating to begin with and to first measure from 
this border towards the inside and then towards the outside.

3 [Penetration depth 
in substrate]

The [Penetration depth in substrate] field displays how deep the grinding ball 
entered the substrate after permeating all of the coatings. 
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15.3 Measuring the coating thickness
This step-by-step instruction describes how you can measure the 
thickness of a coating. An image of the flat sample surface on which 2 
coatings are to be measured has been selected as an example. If you 
selected an image with a different surface in the [Settings] step, there 
will be small differences in the procedure.

The thickness of two coatings is to be measured on this image.

[Image source] step
1. Load the CoatingThickness1_GrindingBallDiameter_40mm.tif 

example image.
2. Click the [Coating Thickness] button, located in the [Materials 

Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
 This skips the [Sample information] step, which is not relevant for 

this example image. 
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Settings] step
1. Select the sample surface type. For the example image, select the 

[Flat] sample surface.
 With a flat sample, the indentation that the grinding ball makes 

in the surface of the sample is always round. This means that you 
don't need to select a crater shape.

2. Clear the [Measure using multiple points] check box. You will now 
need fewer clicks to define the coating.

3. Specify how many coatings you want to measure in the [Number of 
coatings] field. In this example, adopt the value 2 that is displayed 
in the field because there are two coatings.

4. Enter the diameter of the grinding ball used in the [Grinding ball 
diameter] field. In this example, enter a value of 40 in the field.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Measurement] step
 In the [Measurement] step, define the borders of the coating on 

the image. The schematic illustration in the tool window shows 
you which points in the image you need to click on.

1. Move the mouse pointer onto the image window. All other areas of 
your software can't be used in this step.
 The mouse pointer turns into a cross.

Defining the
borderlines

2. Define the borders of the coating on the image. The schematic 
illustration in the tool window shows you which points in the image 
you need to click on. Click on three positions on the outer border 
of the coating. 
 After the third click, the schematic illustration in the tool window 

changes. It now shows you where you need to click next in the 
image

3. Conclude the definition of the first coating by clicking once on the 
inner border of the first coating. 

4. Define the second coating with one click on the inner border. 
264OLYMPUS Cleanliness Inspector CIX ASW



15  [Coating Thickness]
Measuring the coating thickness
You'll find a schematic illustration of the coating in the tool window. This illustration tells you how a 
coating's borders have to be defined.

 As soon as you have defined the specified coatings, the 
definition process is finished. The mouse pointer turns back into 
an arrow on the image and the schematic illustration in the tool 
window disappears.

 The borderlines that have been defined are displayed. They are 
red by default. In the software options, you can set a different 
color or thickness for the borderlines. Make these settings before 
you start the analysis process. 

5. Check the values in the table.
Correcting

borderlines
6. If you want, you can correct a borderline. To do that, move the 

mouse pointer to the small handle on the borderline. Now click the 
left mouse button and move the borderline to where you want it.
 The borderline is corrected and the values in the 

[Measurements] table are updated.
7. You can also move all of the borderlines at the same time. To do 

this, move the mouse pointer to one of the borderlines. Your 
mouse pointer turns into a four pointed arrow. Drag the 
borderlines to a different position.

8. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

The borders of the coating are defined with 5 clicks of the mouse in the image.

[Results] step
1. Check the results shown. You can see the results for all of the 

images that have been analyzed. 
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 The average values are displayed in the [Coating thickness], 
[Total Thickness], [Total Penetration Depth], and [Penetration 
Depth in Substrate] fields. 

2. Select the [Generate report] check box, if you would like to have a 
report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. Select the [Generate workbook] check box to export the results to a 

sheet.
4. If you want to save the current settings to a file, click the [Save 

settings] button. Then assign a descriptive name in the next dialog 
box.
 You can load these settings when you analyze further images. To 

do that for the new image in the [Image Source] step, click the 
[Load from file] button.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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15.4 Software options
The software options offer a few coating thickness settings.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Coating Thickness] entry in 
the tree view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an analysis.
Specifying the units and the number of decimal places used for the 
measurement

[Measurement
unit]

In the [Measurement unit] field, select which measurement unit is 
preset. Select, for example, the [µm] entry from the list to have all of the 
measurements output in units of µm by default. In the [Settings] step, 
you can change the measurement unit while an analysis process is in 
progress.

[Decimal places] In the [Decimal places] field, enter the number of decimal places that 
are to be, by default, shown for the results. It's possible to set a 
maximum of 9 digits after the decimal point.
Setting the thickness and color for the display of the measurement 
in the image

[Line Width] In the [Line width] field, select the thickness of the line that shows the 
borders of the coating.

[Measurement
color]

In the [Measurement color] field, select the [Alternating colors] option if 
you want to display every measurement line in a different color. The 
sequence of colors is determined by the software and cannot be 
changed. It remains the same for each measurement to facilitate the 
comparison of more than one measurement that uses alternating 
colors.

This command is not available while an analysis is running.
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In the [Measurement color] field, select the [Fixed colors] option if you 
want to display every measurement line in the same color. Select a 
color which is clearly visible on your images.
Selecting the industry standard
In the [Standard] field, select the industry standard that is to be used for 
the analysis process. The following industry standards are available:
• EN 1071-2 : 2002
• VDI 3824 : 2001
• EN ISO 26423 : 2016

Specifying the number of measurements per image
In the [Number of measurements per image] field, specify whether you 
want to perform a measurement on an image more than once. Every 
image is only measured once by default.
If you are measuring an image more than once, the results of the last 
measurement will constantly be compared to the results of the previous 
measurement. The average value of all of the measurements 
performed to date is always displayed.
Create image with results shown in information bar
Select the [Create image with results shown in information bar] check 
box to create a new image document from the measurement. The 
image document has the following content:
• the measured image
• the borderlines (these are burnt into the image and can't be hidden)
• an information bar (under the image).

You can save the image document as a TIF file and send it to others 
who don't have access to the image analysis program, for example.

Determining the
content of the

information bar

You can determine the contents of the information bar. To do this, in 
the [Available results] list, select all of the fields that you want to include 
in the information bar. The fields you've selected are then added to the 
[Selected results] list.
You can still change the order of the fields by selecting a field and 
moving it upwards or downwards with the arrow buttons.
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Note: If there are no results for a field, it is automatically not shown in 
the information bar, even though it has been selected in the [Selected 
results] list. This ensures that the information bar under the image 
doesn't have any empty fields.
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16 [Dendrite Arm Spacing]
16.1 Overview

What is a dendrite arm spacing measurement?
Dendrites are formed in metal alloys when they solidify. They are 
branching, tree-like structures. A dendrite arm spacing measurement, 
to put it simply, measures the distance between the individual branches 
of the tree. 
From the dendrite arm spacing an expert can tell whether a metal alloy 
solidified quickly or slowly, among other things. The samples are usually 
metallographic sections that have been prepared especially for the 
measurement of dendrite arm spacing.
In order for your results to be valid, the dendrite arms that you measure 
must lie entirely within the cross-sectional plane. The measurement 
lines should be positioned in the image so that they intersect several 
neighboring dendrite arms at a right angle. 

Schematic diagram of a measurement line that intersects four dendrite arms. The black double 
arrow shows the dendrite arm spacing between the second and third dendrite arm.

It is a precondition for a dendrite arm spacing measurement that the 
dendrites differ in some way from the rest of the sample, because they 
are brighter for example. In this case, the dendrites will have different 
intensity values from the rest of the sample, making automatic analysis 
of the image possible. For the image analysis, so-called phases are 
defined which cover a certain range of intensity values. 
Different methods for detecting dendrites
If your images are suitable, the dendrites can be detected using 
automatic threshold setting. The image's foreground is separated from 
its background by using the threshold value setting method. All of the 
objects that are to be analyzed have to belong to the image's 
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foreground. The number of dendrite arms that are on the 
measurement line that you drew will then be detected by the software. 

Three dendrite arm spacing measurements using the automatic method of dendrite detection. All 
of the pixels that have been detected as part of a dendrite are displayed in [Dark Cyan] in the 
image.

If using automatic threshold detection doesn't produce adequate 
results, manually enter the number of dendrite arms that intersect the 
measurement line that you drew.

Three dendrite arm spacing measurements using the manual method of detecting of dendrites.

Displaying the results
The results of an analysis can be displayed in a workbook. The following 
information is given:
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• Sample name
• [Number of Measurement Lines]
• [Total Length]
• [Dendrite arms]
• [Average DAS]
• [Median DAS]
• [Variance of average DAS]

Additionally, the results can be displayed in a report in MS-Word 
format. The user can specify the structure of the report. The reports can 
also contain images and the measurement lines that were used.

Example of a page in a report in MS-Word that shows the image that was measured and the posi-
tions of the measurement lines.
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16.2 Settings
16.2.1 [Settings] step

In this step, the following options are available:

1 [Method] Here you specify the method for detecting the dendrites. If your images are 
suitable, the dendrites can be detected using thresholds that your software 
sets. Select the [Automatic] option. The image's foreground is separated from 
its background by using the threshold value setting method. All of the objects 
that are to be analyzed have to belong to the image's foreground. 
If the automatic detection of the thresholds doesn't produce satisfactory 
results: Select the [Manual] option. Then the method of threshold setting will 
not be used and you will have to manually enter the number of dendrite arms 
that are on the measuring line that you drew.

2 [Threshold for 
dendrites]

Define the threshold value for the detection of the dendrites here. By doing 
this, you set the range for the intensity values (the phase) that is of relevance 
for the detection. When the threshold value is closer to the [Low] position, the 
phase will incorporate a large portion of the intensities that are present in the 
image. When the threshold value is closer to the [High] position, the phase 
will incorporate a smaller intensity range. You can select intensity values from 
0-255. The intensity value 0 corresponds to black and 255 is white. You can 
either use the slide control to set the threshold value, or use your keyboard to 
enter it in the input field. 
All of the pixels that have been detected as part of a dendrite are displayed in 
[Dark Cyan] in the image. This is only the case if the [Show dendrite detection] 
check box is selected. You can't change the color.
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3 [Improve dendrite 
detection]

Use the [Improve dendrite detection] slide control to optimize the threshold 
for the detection of the dendrites. It enables you to define more precisely 
which pixels represent a dendrite arm and which don't. This slide control only 
applies to bright particles. That means particles that have intensity values that 
could represent a dendrite arm or the background. The [Improve dendrite 
detection] slide control specifies a second phase. This phase only includes 
gray values from 0-100. 
Example: On a gray-value image comprising 256 colors, define a phase that 
includes all gray values from 0-130. Every pixel with a value of up to 129 is 
classed as a dendrite. In a second phase, you specify that all values from 0-80 
are dendrites. Every pixel with a value above 81 will be classed as background.

4 [Calculate solidifi-
cation time]

If required, select the [Calculate solidification time] check box. In the 
[Material-dependent constant] field, enter the solidification time for the metal 
alloy that you are examining. This will compute the solidification time for each 
measurement line individually and for the sample as a whole. If you create a 
workbook or a report at the end of the analysis, it will display the solidification 
time. 
Note: The solidification time that you enter in the [Material-dependent 
constant] field will apply to all of the samples or images that you measure 
together in one analysis. For this reason, leave the field empty if you want to 
measure samples of different alloys together in the same analysis. If you don't 
know the value, leave the [Material-dependent constant] field clear. In this 
case it won't be possible to compute the solidification time. 
Note: The solidification times for some alloys are given in the relevant 
standards.
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16.2.2 [Measurement] step
In this step, the following possibilities are available:

When you go to this step in the analysis, your software automatically 
switches into a measurement mode. In the measurement mode, your 
mouse pointer will turn into a cross on the image. The measurement 
function icon appears at the bottom right of the mouse pointer.

1 [Measurement 
Results]

Perform a number of measurements on the active image and then leave the 
measurement mode by right clicking. Take a look at the results in the 
[Measurement results] table. You can add and delete measurement lines as 
well as changing the number of dendrite arms. Use the buttons below the 
table for this.

2 [Results] In this field you can see the overall results and the averaged results for the 
measurements that have already been made. In the [Image] column, the 
results for the current image are displayed. The [Sample] column displays the 
overall results for all of the images of the sample that have already been 
measured.
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16.3 Measuring dendrite arm spacing
You can follow these step-by-step-instructions on your computer. They 
describe a dendrite arm spacing measurement on an example image. 
[Image source] step

1. Load the DAS1.tif example image. 
2. Click the [Dendrite Arm Spacing] button, located in the [Materials 

Solutions] tool window.
 As soon as you've started this analysis process you'll be guided 

step by step through the measurement. A lot of your software's 
other functions will not be available while an analysis process is 
running.

3. In the [Image source] group, select the [Selected images] option to 
analyze the example image. For this to work, the image must be 
open and active in the document group.

4. Select the [Skip 'Sample information'] check box.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

3 [Show dendrite 
detection]

When the [Show dendrite detection] check box is selected, all of the pixels 
that have been detected as dendrite arms will be shown in the color [Dark 
Cyan] in the image. This check box is only displayed if you have selected the 
[Automatic] mode for detecting dendrites in the [Settings] step.

4 [Show DAS on 
measurement line]

Select this check box to display marks on the measurement line for each 
dendrite arm space that was detected.

You see the same measurement. In the illustration on the left, the [Show DAS on measurement 
line] check box has not been selected. In the illustration on the right, the [Show DAS on measure-
ment line] check box has been selected. This is why 2 display marks are displayed on the mea-
surement line (see red arrows).

5 [Reject Image] You can use the [Reject Image] button to exclude the current image from the 
analysis. When you analyze numerous images one after the other, your 
software displays the next image after you've clicked the [Next] button.
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[Settings] step
1. Because the DAS1.tif example image is suited for automatic 

threshold setting: Select the [Automatic] option.
2. Use the [Threshold for dendrites] slide control to define a suitable 

threshold for the detection of the dendrites.
 All of the pixels that have been detected as part of a dendrite are 

displayed in [Dark Cyan] in the image. This is only the case if the 
[Show dendrite detection] check box is selected. 

3. Use the [Improve dendrite detection] slide control to optimize the 
threshold for the detection of the dendrites.
 The [Improve dendrite detection] slide control specifies a second 

phase. This phase only includes gray values from 0-100. 
4. With the DAS1.tif example image, leave the [Material-dependent 

constant] field clear.
5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Measurement] step
1. When you go to this step in the analysis, your software 

automatically switches into a measurement mode.
 The mouse pointer turns into a cross on the image. The 

measurement function icon appears at the bottom right of the 
mouse pointer.

 You will remain in this measurement mode until you explicitly 
switch it off.

2. Draw a measurement line through the first dendrites that you want 
to measure. To do this, left click once on the image to mark the 
start of the measurement line. Then move the mouse pointer to the 
end of the measuring line and left click again.
 Note: The dendrite arms that you want to measure must lie in 

the sample's cross-sectional plane in order to deliver reliable 
results.

 The measurement line is shown in red. The measurement line is 
also shown in blue where it runs through parts of the sample 
that belong to the detected phase.
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Image with one measurement line.

3. Draw more measurement lines through dendrites whose arm 
spacing you want to measure.

4. Right click or press the [Esc] key on your keyboard to leave the 
measurement mode.
 Now you can move the mouse pointer freely again. 
 You can now still move the existing measurement lines if 

necessary. A measurement line must be selected before you can 
move it.

5. Take a look at the measurement results in the [Measurement 
results] table. You can still make the following changes. Use the 
buttons below the table for this.
 Adding measurement lines
 Changing the number of dendrite arms in a measurement line
 Deleting measurement lines

6. Take a look at the measurement results in the [Results] field. What 
you see here is the overall results for all of the measurement lines. 
When you measure more than one image or more than one 
sample in an analysis, the [Results] field shows the overall results for 
all of the measuring lines. 
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7. Should you not be satisfied with the results for the current image: 
Click the [Back] button to go back to the [Settings] step. Then you 
can try to improve the results for the images by using another 
position of the slide controls. However, going back to the previous 
step deletes all measurement lines and you must create them again 
in the [Measurement] step.

8. Leave the [Show DAS on measurement line] check box cleared for 
these step-by-step instructions.

9. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.

[Results] step
1. Check the results shown. You can see the overall results for all of 

the images, that have already been analyzed for this sample.
2. Select the [Generate report] check box, if you would like to have a 

report automatically generated once the analysis is completed.
 The additional step [Reporting] will be added to the current 

analysis. 
 The [Next] button at the bottom of the dialog box becomes 

active.
3. If you want to save the current settings to a file, click the [Save 

settings] button. Then assign a descriptive name in the next dialog 
box.
 You can load these settings when you analyze further images. To 

do that for the new image in the [Image Source] step, click the 
[Load from file] button.

4. Select the [Generate workbook] check box to export the results to a 
sheet.

5. Click the [Next] button.
 The [Materials Solutions] tool window will display the next step.
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[Reporting] step
Define what the report containing the measurement results looks like.

1. Select the [Default] option to use the template that has been 
defined as the default template. If you want to select another 
template, select the [User-defined] option. Then click the button 
with the three points and select the new template in the [Open] 
dialog box.

2. In the [Content] group, select the check box for the pages the 
report should contain.
 Select the [Summary page] check box, if the first page of the 

report is to contain a summary of all of the results of the current 
analysis. The creation of a summary page can, e.g., be useful, 
when you have analyzed a large number of images of a variety 
of different samples.

 Select the [One page per sample] check box, if the report should 
contain one page for every sample. This page displays the 
overall results for all of the images belonging to that sample.

 Select the [One page per image] check box, if the report should 
contain a page for every image that was analyzed. Should only 
this check box have been selected, and you have analyzed three 
images, your report will contain exactly three pages.

 Select the [Show results in overlay] check box if the image layer 
that contains the results is to be displayed along with the images.

3. Click the [Finish] button.
 The report will be generated and displayed in MS-Word.
 The workbook will be created. It always contains a minimum of 

two worksheets. On the first worksheet, you'll see a summary of 
the results. On the second worksheet you'll see the details 
concerning the sample used. Should you have analyzed several 
samples, the workbook will contain additional worksheets.

 The [Materials Solutions] tool window switches back to the start 
position. You can now use all of your software's functions again.

4. The images have been given one or more additional image layers 
by the materials science analysis process. If required, save the 
images in TIF or VSI format to retain these newly created image 
layers.

5. Save the workbook and the report.
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16.4 Software options
The software options provide a number of settings for a dendrite arm 
spacing measurement.

Opening the
dialog box

Click the [Options] button on the [CIX Standard] toolbar to open the 
[Options] dialog box. You can also use the [Shift + F8] keyboard 
shortcut. Select the [Materials Solutions] > [Dendrite Arm Spacing] 
entry in the tree view.

Determining the sample identifiers
Specify what you want to call the two uppermost fields that are 
displayed in the [Sample information] step. To do so, enter the required 
designation in the [Sample reference name] and [Sample group name] 
fields. The name for the fields that you specify here is also used in the 
workbooks that you can create at the end of an analysis.
Specifying the units and the number of decimal places used for the 
measurement
In the [Measurement unit] field, select which measurement unit is 
preset. Select, for example, the [µm] entry from the list to have all of the 
measurements output in units of [µm] by default. In the [Settings] step, 
you can change the measurement unit while an analysis process is in 
progress.
In the [Decimal places] field, enter the number of decimal places that 
are to be, by default, shown for the results. One decimal place is preset, 
and a maximum of 9 decimal places is possible.
Setting the line thickness of the measurement in the image
In the [Line thickness] field, select the thickness for the line used to 
display the measurement.
Selecting the DAS algorithm
The following settings will only be used if the [Automatic] method of 
detecting dendrites was selected in the [Settings] step. With the 
[Manual] method, you define the measurement lines in the image 

This command is not available while an analysis is running.
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interactively. In this case, your first mouse click defines the start of the 
measurement line and the second mouse click defines the end.
Select the first option if you want the measurement line to go from the 
middle of the first dendrite arm to the middle of the last dendrite arm. 

Select the second option if you want the measurement line to go from 
the outer border of the first dendrite arm to the outer border of the last 
dendrite arm.
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Expert mode
In the [Analyze Materials] software mode, the components of the user 
interface are configurable and can be customized to the requirements 
of individual users and tasks. Whether you are in the standard mode or 
expert mode is the decisive factor as to which possibilities you have to 
change the appearance of the user interface.

Expert mode In the expert mode, you can drag all of the tool windows from their 
position on the edge of the user interface to any other position on your 
screen.

Standard mode In the standard mode there are more limited possibilities for changing 
the user interface. Tool windows and the document group can then no 
longer be dragged out of the user interface.
Switching from standard mode to expert mode

1. Click the [Options] button or use the [Shift + F8] keyboard shortcut 
to open the [Options] dialog box.

2. Select the [Environment] > [General] entry in the tree view to edit 
your software's general options.

3. In the [User Interface] group, select one of the two options 
[Standard mode] or [Expert mode].

Histogram
In the histogram, the number of pixels is plotted against the intensity. 
That is to say, it shows how many pixels are present in the image, with 
which intensity, or also the intensity distribution in the image. With a 
true-color image the histogram shows three curves, namely the 
intensity distribution for the red, green and blue color channels.

The histogram shown above shows the intensity distribution of the 8-bit 
gray-value image shown next to it. On the histogram you can already 
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see that the image is made up of two phases, one dark and the other 
bright. Middle gray values are hardly present in the image at all.

Particle
The software defines a particle as a continuous area of pixels that are all 
within a certain intensity range. This means that pixels belonging to the 
same particle are all more or less equally light or dark or have the same 
color.

Phase analysis
A phase is a number of pixels which lie within a defined intensity range. 
The intensity value range is limited by a top and a bottom intensity 
value. These are the so-called threshold values. A phase analysis 
automatically detects the phases in an image.
It is a prerequisite for a phase analysis that the phases have a 
homogeneous intensity. An image can contain one or more phases. If 
an image only contains one phase, the foreground will constitute one 
phase and the background will constitute a second phase.

Threshold
The objects in an image must be defined for the software so that it can 
recognize them. The software defines an object as a continuous area of 
pixels that are all within a certain intensity range. Pixels belonging to the 
object are all more or less equally light or dark or have the same color. 
The intensity value range is limited by a top and a bottom intensity 
value. These two intensity values constitute the thresholds.
In contrast to objects, phases are whole sections of the image that have 
the same intensity or color. Just like objects, phases are defined for the 
software using thresholds.

ROI
A ROI (Region Of Interest) is a section of an image. It limits the analysis 
of an image to this section of the image. ROIs can have different 
shapes, rectangular or circular for example.
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Stage path
For most materials science analysis processes, you can define several 
stage positions on each sample and can save them as a stage path. 
Here, stage positions can either be entire scan areas or individual XY 
positions. Use the [Stage path settings] step in the [Materials Solutions] 
tool window to define a stage path. You can find more information on 
this topic in chapter Settings for the stage path on page 66.
The stage path contains the number of samples to be analyzed, and 
information about which scan areas and/or XY positions are defined on 
each sample.
During an analysis process, the stage positions that have been defined 
are moved to one after the other. At each XY position, an image will be 
automatically acquired. For a scan area, several images will 
automatically be acquired and will be assembled into a single image. 
Each image acquired will be analyzed with the selected materials 
science analysis process.
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